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 ABOUT THIS GUIDE

This User Guide is a reference for Silhouette and is available as an Acrobat 
PDF file. You can read from start to finish or jump around as you please.

Copyright
No part of this document may be reproduced or transmitted in any form or by 
any means, electronic or mechanical, including photocopying and recording, 
for any purpose without the express written consent of Boris FX.

Copyright © Boris FX 2020. All Rights Reserved

October 9, 2020

About Us
Founded in 1995, Boris FX is a leading developer of VFX, compositing, titling, 
video editing, and workflow tools for broadcast, post-production, and film 
professionals. Boris FX products have grown to serve over a million artists 
worldwide. The company’s success lies in its ability to tightly integrate and 
leverage technologies through strong partnerships with Adobe, Apple, Avid, 
Blackmagic Design, Autodesk, FilmLight, Grass Valley, Magix, SGO, and other 
leading developers of video editing software. In 2014, Boris FX acquired 
Imagineer Systems, the Academy Award-winning developer of Mocha planar 
tracking software. In 2016, Boris FX acquired GenArts, the developer of 
Sapphire, the gold standard plug-in package for high-end visual effects. In 
2019, Boris FX acquired the Academy Award-winning Silhouette for advanced 
feature film rotoscoping, painting, and effects.
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 SILHOUETTE FEATURES

Invaluable in post-production, Silhouette continues to bring best of class tools 
to the visual effects industry. As a fully featured GPU accelerated compositing 
system, its standout features are award winning rotoscoping and non-
destructive paint as well as keying, matting, warping, morphing, and a total of 
146 different nodes--all stereo enabled.

Developed over the years with input by those working in the trenches, 
Silhouette runs like a well oiled machine and is easy to use. You will be up to 
speed with minimal effort and have the tools you need to handle the most 
challenging of shots. As visual effects artists in previous lives, we understand 
your challenges and timelines. Our goal is to help you get the job done right, on 
time and on budget.
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Trees and Nodes
Trees

The power of Silhouette lies in the Trees window where your effects are built. 
A tree is a series of clips and nodes, such as color correction, image processing 
and composite nodes, plugged together to create the desired effect. The tree 
is grown by adding clips and nodes in any order. The ability to view any node 
while editing another allows for very complex composites that can be set up 
and rendered in one pass.
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Nodes
Silhouette is a node based system and different nodes are used for various 
functions. Located in the Nodes tab at the bottom of the screen, nodes are 
grouped into various categories.

Trees and Nodes Features
• 146 different nodes organized into Color, Composite, Diffusion, Filter, Film Lab, 

Image, Key, Light, Silhouette, Special Effects, Time, Tints, Transform, Warp and 
OFX groups

• Horizontal and vertical node layouts

• Gestural node workflow

• Visual presets for most nodes

• OFX third party plug-in compatible
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Composite
A well rounded collection of compositing nodes that provide all that is needed 
to combine multiple images. Utilize compositing tricks and techniques, color 
correction, blur, grain, matte manipulation, lens distortion, lighting effects and 
edge blending. Eradicate the most common effects problems or employ 
specialized tools for combining imagery such as fire, smoke and explosions.

Composite Features
• Compositing tricks and techniques

• Effectively composite fire, explosions and smoke

• Edge tools to color correct or blur the composite's edge

• Proprietary matte generation

• Matte manipulation using shrink, grow, blur and wrap functions
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Roto
Silhouette allows you to quickly create sophisticated animated mattes using B-
Spline, Bézier or X-Spline shapes. Intelligent design and easy-to-use tools, 
such as variable edge softness on a point by point basis and realistic motion 
blur, assist you in creating complicated shape animations. Integrated motion 
tracking makes the normally tedious task of rotoscoping a breeze.

Where did the term Rotoscope come from? A rotoscope was a mechanical 
device patented by Max Fleischer in 1917. It projected single frames of live 
action footage onto the animators drawing board. By simply tracing the 
projected shape, the animator could quickly produce incredibly lifelike 
drawings. With the passage of time, Rotoscoping or “Roto” for short has 
become a generic term for drawing shapes to extract, isolate or affect a portion 
of an image. It is tedious work, but it’s one of the most important parts of the 
visual effects process.
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Roto Features
• Unlimited number of animated B-spline, X-Spline, Bézier or Freehand shapes

• Stereo rotoscoping workflow and tools

• Integrated Motion Tracker that can apply motion data to points or shapes

• Planar tracker provides automatic, markerless motion analysis and tracking

• IK (Inverse Kinematics) for animating humans, animals and all manner of jointed 
creatures

• Support for open or closed shapes

• Move, scale, rotate, shear, and corner-pin shapes and groups of shapes

• Create magnetic freehand shapes with or without magnetic properties

• Edge Snapping tool that snaps the control points of an X-Spline to an object edge

• Point-by-Point variable edge softness

• Animation changes for one point or selected points across all keyframes

• Realistic motion blur

• RotoOverlay tool provides three options to visualize the selected shape’s 
animation and motion blur: Motion Path, Motion Blur and Onion Skin

• Independent shape viewing and hiding

• User-definable names, colors, blurs and blend modes for each shape

• Render shape animation over image as an outline or filled color

• Shape import and export

• Support for video fields
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Tracker
Tracking is a technique that involves analyzing the motion of an image over 
time. In Silhouette, images can be tracked using an automatic image tracking 
system called Planar Tracking or Point Tracking which utilizes either one, two 
or four track points. Silhouette includes two Planar Trackers: Silhouette’s 
Planar Tracker and the Mocha Planar Tracker.

Planar Tracking
Silhouette’s Planar Tracker tracks several points (corners, edges and ridges) 
on the image while automatically handling partial occlusions of the tracked 
object, producing excellent results even with textureless objects.

Mocha Planar Tracker technology provides 2D transformation data by tracking 
planes rather than points.
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Point Tracker
The Point Tracker uses individual trackers which are placed on distinguishable 
image features.

Tracker Features
• Planar Tracking using either Silhouette’s Planar Tracker or the Mocha Planar 

Tracker

• Planar Trackers provide automatic, markerless motion analysis and tracking

• Planar Tracker tracks corners, edges or ridges

• Track multiple planes simultaneously

• Unlimited Point Trackers for manual precision

• Match Moving or stabilization

• Pre-processing filters for problematic shots include: Blur, Sharpen, Contrast, 
Gamma, De-Noise and Remove Flicker will increase tracker accuracy for 
problematic images

• Post-processing of point tracking data to include: Average, Smooth and Merge

• Tracker export to popular formats
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Paint
Paint is a high dynamic range, non-destructive, 2D paint system designed from 
the ground up to handle the demands of feature film and television production. 
Whether it’s image restoration, dustbusting, wire and rig removal or just plain 
paint, Silhouette provides simple and sensible tools to get the job done.

As you paint, every action you make is recorded as events. These events can 
be selectively played back on the same frame, different frames, multiple frames 
and with or without tracking data applied. This makes for a very powerful and 
versatile Auto Paint feature that provides the flexibility of a vector paint system 
with the speed of a raster paint system.

Paint Features
• Black & White, Blemish, Blur, Burn, Clone, Color, Color Correct, Cutout, Detail, 

Dodge, Drag, Eraser, Grain, Mosaic, Repair and Scatter brushes
• Non-destructive raster paint system allows playback of paint strokes on a range 

of frames or the entire clip
• Detail separation separates the image into color and detail layers
• Automatic recording of paint events with selective stroke playback
• Track paint strokes and Clone sources
• Sophisticated cloning interface
• Motion track, position, scale, rotate, skew and corner pin clone sources
• Color Correct, Blur, Sharpen or Warp the Clone source
• Paint on left and right stereo images simultaneously using an adjustable, 

keyframeable interocular offset
• Onion-Skin and Align tools to match up elements
• Automatically redo all paint strokes if a source sequence changes
• High dynamic range painting in 32 bit float



Silhouette User Guide    

• • • •••

Silhouette Features  22 
• • • •••

Warps and Morphs
Silhouette includes a fully-featured shape based image warping and morphing 
system as well as a pin warper which provide the highest level of control and 
quality available. Image warping and morphing can take place on stills as well 
as moving images. Warping can be used to enhance or exaggerate facial 
features, adjust sizing of image elements, create talking animals or any other 
type of image deformation. Morphing has been traditionally used to transform 
one object or person into another and more recently to seamlessly transform a 
live action element into a CG (computer generated) object and vice versa.

Pin Warp

Pin Warp Features
• Distort specific image areas using pins

• Protect image areas using tacks

• Track pins and tacks

Before

Photo by Tim Easley on Unsplash

After
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Morph

Morph Features
• Distort and morph

• Shape based morphing

• Transformations on a layer by layer basis

• Depth and folding control

• Integrated motion tracking

• Interactive preview

Before Middle

Copyright © 2008--www.iofoto.com

After
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Keying and Matting
Using proprietary matte extraction techniques, the zMatte and Power Matte 
nodes are capable of extracting almost any object in an image quickly and 
simply even if you are dealing with fine hair detail, smoke, or reflections. They 
are easy to use, yet provide the needed tools when faced with good, bad, or 
ugly shots.

Keying Features
• Interactive image matting tool capable of extracting almost any object in an image

• DV/HD deartifacting

• Multiple matte creation

• Color suppression

• Sophisticated matte manipulation

• Generate mattes without blue or green screens

Before After

Matte Shapes
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Depth
The Depth node contains a dedicated tool set for creating depth channels.

Depth Features
• Shapes can be assigned individual depth values

• Horizon, Ramp, Hall and Tunnel gradient depth tools

• Alpha tool that converts the alpha channel generated by other Silhouette nodes 
(zMatte, Power Matte, Roto, Paint, etc) into a depth map

• Output to stereo displays

Original Depth

Copyright © 2008--www.iofoto.com
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Sequence Editor
Silhouette can perform editing tasks such as cutting, joining, moving, copying, 
replacing, trimming, retiming and repeating clips in the Sequence Editor.

Sequence Editor Features
• Set clip in and out points

• Automatically assemble selected clips

• Copy, move, insert or replace clips

• Trim in, trim out or trim both sides of an edit

• Clip retiming
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Architecture
• Node based workflow

• Resolution Independent

• OFX third party plug-in compatible including Boris FX Sapphire, Boris FX Mocha, 
RE:Vision FX Twixtor and ReelSmart Motion Blur.

• Stereo viewing and editing

• Region of Interest for enhanced performance

• Command-Line Rendering

• Scripting and Actions

• OpenColorIO Color Management

• GPU and OpenGL® accelerated

• Multi-processor support

• Proxy management for large image sizes

Compatibility
• File Formats: Cineon, DPX, IFF, JPEG, OpenEXR, PNG, SGI/RGB, TIFF and TARGA

• Export Autodesk® gMask, Elastic Reality®, Fusion®, Nuke® and Shake® 4.x SSF 
shapes

• Import Mocha Pro, Commotion, Elastic Reality and Shake 4.x SSF shapes

• Mask interchange with After Effects® using the Silhouette Shape Import/Export 
Plug-in

• Export After Effects, Autodesk, Nuke and Shake 4.x trackers

• Import Mocha Pro, After Effects Corner-Pin, Nuke 8+ and Shake 4.x trackers

• Macintosh®, Windows®, Linux®
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 INSTALLATION

Windows / Macintosh
1 Download the Silhouette software at www.borisfx.com

2 Double-click on the installer file that you downloaded to install Silhouette.
The default installation folder on Windows systems is C:\Program 
Files\SilhouetteFX\Silhouette 2020. On Macintosh systems, the default 
installation folder is /Applications/SilhouetteFX/Silhouette 2020.

3 When you get to the Select Components screen, select Silhouette.

4 If you have After Effects installed, you can also select the Silhouette Shape I/O 
Plug-in.

5 Complete the installation.

6 Start Silhouette on Windows systems by selecting Programs > SilhouetteFX > 
Silhouette 2020 > Silhouette 2020 in the Windows Start menu.

or

7 Start Silhouette on Macintosh systems by going to the 
/Applications/SilhouetteFX/Silhouette 2020 folder and double-clicking on 
Silhouette.
The Silhouette user interface opens.

https://borisfx.com/downloads/?
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Linux
1 Download the Silhouette software at www.borisfx.com

2 Open a Terminal window and change to the directory where you downloaded the 
file.

3 Type: tar xvzf <name of file>

4 Change to the new directory that is created.

5 To install the Silhouette software, run the “install_silhouette.ph” script by typing: 
./install_silhouette.sh

Silhouette is unpacked into the current directory.

6 Change to the new directory that is created.
7 To run Silhouette, type: ./run.sh

The Silhouette user interface opens.

Library Dependencies
Silhouette 2020 no longer uses -rpath to hard-code the location of its 
dependent libraries which are included in the “lib” folder. Instead, 
LD_LIBRARY_PATH should be set to point to the Silhouette “lib” folder. The 
included run.sh script shows how to do this. The LD_LIBRARY_PATH can be 
used to have Silhouette use a different Qt or python package as well.

https://borisfx.com/downloads/?
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Linux Modifier Key Configuration
When using the KDE or GNOME desktops, by default there is a Move Window 
modifier key combination set up, so that if you Alt-drag a window, it will move. 
This interferes with our Alt-drag capability in some tools, so you will want to 
disable this desktop feature.

KDE Desktop
1 Run the KDE Control Center.

2 Go to the Desktop/Window Behavior panel and select the “Actions” tab.

3 Down in the Inner Window, Titlebar & Frame area, change the “Modifier Key” 
option from Alt to Meta.

GNOME Desktop
1 Run the Control Center in Preferences.

2 Select Windows.

3 Select Super (or “windows logo”). 

Linux Tablet Configuration
We require that proper tablet support is enabled in the X server. This part is left 
up to the user, as it is very distribution and version specific. This site can be 
used for more information: http://linuxwacom.sourceforge.net/index.php/all

http://linuxwacom.sourceforge.net/index.php/all
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 LICENSING

Node-Locked Licenses
When you purchase your license, you will be emailed a serial number. 

Internet Activation
When your machine is connected to the Internet, you can activate directly in a 
few simple steps.

1 Make sure you are connected to the Internet.

2 Start Silhouette and select Activate nodelock license in the License window and 
click OK.

The Boris FX License Tool will load. 
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3 Choose Activate your license now and press Next.

4 Paste the serial number into the Activation Key field and click Next.
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If the activation is successful, details will appear on the next page.

5 Select Finish.

Your license is now installed and Silhouette’s New Project dialog box opens.
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Offline Activation
If your machine is not connected to the Internet or you are behind a firewall, use 
the Activate your license manually option.

1 Start Silhouette and select Activate nodelock license from the License window 
and click OK.

The Boris FX License Tool will load. 

2 Choose Activate your license manually using another computer’s web browser 
and press Next.
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3 You will be provided with file fields to load a key file.

4 Download and save the key file that you received from your license email from a 
computer that has an Internet connection.

5 Transfer the key file to your offline machine you are going to activate via a 
flash/thumb drive or a shared network.

6 Select the location of the key file in the first field.

7 Pick a location for the request file (which will be created) in the second field.

8 Copy the request file (.req) to a machine with an Internet connection.

9 Upload it to http://activation.borisfx.com/offline-activation.php.

10 Save the activation file it returns (via download or email), and copy that back to 
the offline machine.
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11 Enter its location into to the license tool and click Next.

Your license is now installed and Silhouette’s New Project dialog box opens.

Internet Deactivation
Once Silhouette has been activated, you can access the deactivate option by 
selecting the Help > License menu.

1 Make sure you are connected to the Internet.

2 Start Silhouette and select the Help > License menu.

The Boris FX License Tool loads.

3 Choose Deactivate your license now and press Next.

Silhouette deactivates.
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Node-Locked License Troubleshooting
1 It is important that your Silhouette software matches your activation code, so 

check your purchase order to make sure everything matches up version wise. It 
may be that you don’t have the correct version of Silhouette installed from our 
download section. This is especially important for legacy software before 
Silhouette 2020, where a different licensing method is used.

2 Check to make sure you are not restricted to using certain ports due to a firewall 
or other admin permissions. When in doubt, temporarily turn your firewalls off 
for the duration of the installation and then turn them back on when you are 
done.

3 Troubleshoot your machine; try uninstalling all your Silhouette software, 
restarting your machine, and installing the software again from scratch, and 
make sure you follow installation directions off our website exactly. It sounds 
redundant, but sometimes it’s a great way to figure out what is going on inside 
your machine.

4 If all else fails, our support team is happy to help you figure this out. Please 
contact support.
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Floating Licenses
This section will walk you through the process of installing floating licenses. 
Installing nodelocked licenses does not require the use of the license manager. 
See above.

Floating licenses - How it works
A floating license allows central administration of your license deployment, 
avoiding the need to manually activate and deactivate our software on every 
machine, which is particularly beneficial for large facilities.

Configuring a new machine to use your floating license server is very 
straightforward and requires no Internet connection. 

Similarly, replacing a failed machine can be done without needing to contact 
technical support for the license to be released.

How do I Install the Floating License Server?
Silhouette uses the Boris FX RLM License server for floating licenses.

You can download the license server from the Boris FX website. See the steps 
below.

Floating licenses are easy to set up if you are familiar with configuring network 
services, but if you need any help with the process, please contact technical 
support.

Note: To configure a license server you must have Administrator (or root) privileges.

Installing Floating Licenses with Online Activation
1 Download the RLM License Manager from the download section here: RLM 

License Server

2 Run the License Manager file then follow the installation prompts.

3 Open a Web browser and go to: http://SERVERNAME:5054/goforms/activate 

4 Replace SERVERNAME with the name of the license server.

5 Click BEGIN License Activation.

6 Enter activation.genarts.com in the ISV activation website field and click Next.

7 Enter genarts in the ISV field.

https://borisfx.com/downloads/?&product=RLM%20License%20Server
https://borisfx.com/downloads/?&product=RLM%20License%20Server
http://SERVERNAME:5054/goforms/activate
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8 Copy and paste your Silhouette Activation Key license that you received from 
your license email into the License activation key field. Then, click Next.

9 Your Ethernet address will auto-populate in the License Server or Node-lock 
hostid field. Accept the auto-populated Ethernet address

10 Enter the number of licenses that should be locked to this server in the License 
count (for floating licenses) field. Or just enter 0 to assign all licenses to the 
specified server. Click Next.

A default license location will auto-populate in the License File to create or edit 
field. Accept the default license location and click Next.

11 On the Activation Request Data screen, verify all the information you have 
entered, and click REQUEST LICENSE.

12 On the License Activation page, click on (Re)start License Server.

13 Then, on the Reread/Restart Servers page, click on Reread/Restart.

The license server should now be set up.

14 To confirm that the Boris FX license server is working, go to 
http://SERVERNAME:5054

15 Replace SERVERNAME with the name of the server, and click Status on the top 
left hand corner.

genarts should show up under the ISV Servers and it will say Running: Yes.

Installing Floating Licenses With Offline Activation
In cases where you cannot install the license via an Activation code (normally 
where the server is not connected to the Internet) you can manually install your 
license:

1 On a machine with Internet access, download the RLM License Manager from the 
download section here: RLM License Server

2 Install the License Manager on both the machine that has an Internet connection 
and the offline server you intend to run on.

Note: You will use the online machine to get the license for your offline server.

3 One the online computer, open a web browser and go to: 
http://SERVERNAME:5054/goforms/activate

4 Replace SERVERNAME with the name of the license server.

5 Click BEGIN License Activation.

https://borisfx.com/downloads/?&product=RLM%20License%20Server
http://SERVERNAME:5054/goforms/activate
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6 Enter activation.genarts.com in the ISV activation website field and click Next.

7 Enter genarts in the ISV field.

8 Copy and paste your Silhouette Activation Key license that you received from 
your license email into the License activation key field. Then, click Next.

9 The Ethernet address of the machine you are on will auto-populate in the License 
Server or Node-lock hostid field. You will need to overwrite it with the Ethernet 
address of the offline license server. To find the Ethernet address on the offline 
license server:

For RLM Server v13 and newer:

• On Windows: Go to Start > Boris FX RLM Server > Get RLM HostID

• On Mac: In a console type: /Library/Application Support/BorisFX/rlm/GetHostid.py

• On Linux: In a terminal type: /usr/borisfx/rlm/hostid_wrapper.py

For older versions of RLM Server:

• On Windows: Go to Start > GenArtsRLMServer > Get RLM HostID

• On Mac: In a console type: /Library/Application Support/GenArts/rlm/Get 
Hostid.py

• On Linux: In a terminal type: /usr/genarts/rlm/hostid_wrapper.py

The command above will print out the results.

10 Get the first mac address from the first line: Hostid of this machine.

11 Enter the mac address into the online License Server or Node-lock hostid field.

12 Enter the number of licenses that should be locked to this server in the License 
count (for floating licenses) field. Or just enter 0 to assign all licenses to the 
specified server.

13 Click Next.

14 A default license location will auto-populate in the License File to create or edit 
field. Replace the default location to a location that you can easily write to and 
access the file, such as your Desktop or the Downloads folder.

15 Click Next.

16 On the Activation Request Data screen, verify all the information you have 
entered, and click REQUEST LICENSE.

17 On the License Activation page, click on (Re)start License Server.

18 Then, on the Reread/Restart Servers page, click on Reread/Restart.
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19 Transfer the License File onto the offline license server and save the License File 
to the RLM directory.

For RLM Server v13 and newer:

• For Windows: C:\Program Files\BorisFX\rlm

• For Mac: /Library/Application Support/BorisFX/rlm/

• For Linux: /usr/borisfx/rlm/

For older versions of RLM Server:

• For Windows: C:\Program Files (x86)\GenArts\rlm

• For Mac: /Library/Application Support/GenArts/rlm/

• For Linux: /usr/genarts/rlm/

20 Open the License File in a text editor and edit the file with your offline server’s 
Hostname.

21 Open a Web browser on the offline server, go to http://localhost:5054 and click 
on (Re)Start License Server.

This completes the License server set up.

22 To confirm that the Boris FX license server is working, go to 
http://SERVERNAME:5054

23 Replace SERVERNAME with the name of the server, and click Status on the top 
left hand corner.

genarts should show up under the ISV Servers and it will say Running: Yes.

Now that everything is installed and activated, you no longer need the RLM 
server installed on the temporary online computer – you can remove it at this 
time.

Installing The Floating License On A Client Machine 
(Manual Install)

If you haven’t yet installed the server license, follow the instructions above in 
How do I Install the Floating License Server. Once you have the server 
license installed, perform the following steps to get the client license running.

Install Floating Client License Using The License Window
1 Install Silhouette on the client machine.
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2 Get the host line from the server license, which looks like this: HOST 
ServerName EthernetAddress PortNumber

For example, HOST camelot 00000000042e 5053

3 Start Silhouette and select Use floating license in the License window.

4 Enter the PortNumber and ServerName from the server license in the Server field 
in the following format: port@ServerName. In the server license example above, 
you would enter 5053@camelot

5 Click OK.

Your client machine is now connected to the license server and Silhouette’s 
New Project dialog box opens.

Install Floating Client License Using a License File
1 Install Silhouette on the client machine.

2 Get the host line from the server license, which looks like this: HOST 
ServerName EthernetAddress PortNumber

For example, HOST camelot 00000000042e 5053

3 Create a new file in a text editor called silhouette_client.lic. The file name is not 
important, as long as the .lic extension exists.

4 Paste in the HOST line into the client license file and press enter to create a new 
line.

5 You can either keep the server Mac address in the client or replace it with the 
word “any”. See example below.

HOST camelot any 5053

6 Save the file to the appropriate location. For your particular system this is:



Silhouette User Guide    

• • • •••

Licensing  43 
• • • •••

• For Windows: C:\ProgramData\GenArts\rlm

• For Mac: /Library/Application Support/GenArts/rlm/

• For Linux: /usr/genarts/rlm/

7 Start Silhouette.

Your client machine is now connected to the license server and Silhouette’s 
New Project dialog box opens.

Install Floating Client License Using An Environment Variable
If you want to point to a license file via environment variable, use 
genarts_LICENSE. It uses the usual RLM syntax, e.g:

genarts_LICENSE=5053@server-name

genarts_LICENSE=/path/to/file.lic

You can also set up the RLM environment variable to read all .lic files in a 
directory:

genarts_LICENSE=your/rlm/directory

Note: The genarts in the environment variable name must be lower case.

Troubleshooting Floating Licenses
As with any software, problems may arise during the installation process. 
Please take a moment to read our troubleshooting section and check for 
common errors.

If you continue to have issues installing, please contact support and we will be 
happy to help you. You may contact our support team here: 
https://borisfx.com/support/open-a-case/

Verify Server License Has Been Successfully Installed
Check that your license actually exists on the Server.

For RLM Server v13 and newer:

• For Windows: C:\Program Files\BorisFX\rlm

• For Mac: /Library/Application Support/BorisFX/rlm/

• For Linux: /usr/borisfx/rlm/

For older versions of RLM Server:

https://borisfx.com/support/open-a-case/
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• For Windows: C:\Program Files (x86)\GenArts\rlm

• For Mac: /Library/Application Support/GenArts/rlm/

• For Linux: /usr/genarts/rlm/

Verify License Server Software Is Latest Version
Check to make sure your License Manager is up to date.

Verify Firewall Is Not Running Between Server And Client
If your organization needs to run a firewall, you will need to check if the ports 
for the RLM server are open for use.

Check That Silhouette Version Matches Activation Code
Check your purchase order to make sure everything matches up version wise. 
It may be that you don’t have the correct version of Silhouette installed from our 
download section. This is especially important for legacy software.

Check Conflicting Licenses Installed In Licensing Folder
If you have more than one Silhouette license installed on the server or client 
machine check to make sure they are not expired licenses. While rare, 
sometimes these licenses can conflict with any current ones you have on your 
system.

The Client Does Not Connect Or See The Server Host Name
If your client machine does not connect to the server based on the server name, 
try replacing the server name with the IP address of the server instead in the 
license file. You can easily do this via the License Manager or via a text editor.

When In Doubt, Check The Logs!
Check logs and their paths: Read the logs from Silhouette and from your server. 
They will tell you all about what is happening to your machine.

Check Your Firewall Settings
Check to make sure you are not restricted to using certain ports due to a firewall 
or other admin permissions. When in doubt, temporarily turn your firewalls off 
for the duration of the installation and then turn them back on when you are 
done.
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Check Your Host Name Settings
If your client machine is not able to connect to the server you may have a 
networking issue. Try changing the server name on the client machine to the IP 
address of the server instead when entering the port@host, or check to see if 
your host has “.local” appended to the end of it.

Sometimes The Best Solution Is To Start Again
You might roll your eyes at this one, but try uninstalling, restarting your 
machine, and installing the software again from scratch. Make sure you follow 
installation directions off our website exactly. It sounds redundant, but 
sometimes it’s a great way to troubleshoot what is going on inside your 
machine.

When All Else Fails…
Contact us! Our support team are more than happy to help you fix any floating 
license issues you may have. Please contact support here: 
https://borisfx.com/support/open-a-case/

Installing Render Licenses
This section will discuss the installation of floating render licenses and how they 
differ from standard interactive floating licensed.

Render Floating Licenses vs Interactive Floating Licenses
A render license is a specific kind of floating license that only allows rendering 
of Silhouette project output.

When you are using a floating license, it is broken into two parts: The interactive 
portion and the rendering portion.

1 If you open Silhouette (and a license is available) you are entering the interactive 
portion.

2 If you have Silhouette closed and are using the command-line renderer, you are 
utilizing the rendering portion.

https://borisfx.com/support/open-a-case/
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If the interactive license is in use elsewhere or missing, the Silhouette GUI will 
become unlicensed and attempting further work may encrypt your project if you 
choose to save. If you have no interactive floating licenses available to render 
with, additional render licenses can be helpful to let you free up interactive 
licenses elsewhere.

Workflow For Render Licenses - Example 1
To help illustrate the Render License workflow, let’s look at the following 
situation:

• 5 floating licenses (interactive)

• 10 render licenses (render only)

• There is only 1 user

The license server is operating with both sets of licenses.

• If only one person is using Silhouette on the network, there are 4 interactive and 
10 render licenses still available to use.

• If only that one person was using Silhouette on the network, they would have 15 
render machines available for use including the one they were working with.

• If another person started working and all machines were in use for rendering, their 
version of Silhouette would be unlicensed, as there would be no available seats.

Workflow For Render Licenses - Example 2
To help illustrate the Render License workflow, let’s look at another situation.

• 5 floating licenses (interactive)

• 10 render licenses (render only)

• There are 5 users

The license server is operating with both sets of licenses.

• There are 5 people working in Silhouette.

• If another user tries to work on a 6th machine, they will open Silhouette 
unlicensed, because all interactive licenses are in use.

• They open an existing Silhouette project (or render from the command line), they 
will be able to render, because all render licenses are available. 

Now, what if one person wants to send off a render to the network?
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• If 5 people are using Silhouette on the network already, there would be 11 render 
machines available for use including the one the user was presently working with.

• If another person stopped working in Silhouette, the interactive license would be 
released, and a new machine would then be free to either use for work (interactive) 
or render (non-interactive) by another user.

Installing Render Floating Licenses
The installation of a render license is exactly the same as that of a standard 
interactive floating license. See Floating Licenses for a complete guide.

Run in Demo Mode
Runs Silhouette in a watermarked demo mode which does not allow saving, 
exporting or rendering.
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Request A Trial
Request a 15 day, unrestricted trial license.

Note: Internet access is required for nodelocked trial licenses.

Node-locked License Trial
1 Select Request a trial and click OK.

2 Fill out the Request Trial License form that appears and click OK.
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A 15 day trial license is automatically installed.

Floating License Trial
1 Request a Silhouette floating trial license here: Contact Us

2 Fill out the required information indicating that you would like a Silhouette 
floating trial license and if you have a current RLM license server, provide your 
server’s Hostid and name.

https://borisfx.com/store/contact-us/


Silhouette User Guide    

• • • •••

Tutorials  50 
• • • •••

 TUTORIALS

Starting Silhouette
1 Start Silhouette on Windows systems by selecting Programs > SilhouetteFX > 

Silhouette 2020 > Silhouette 2020 in the Windows Start menu.

or

2 Start Silhouette on Macintosh systems by going to the 
/Applications/SilhouetteFX/Silhouette 2020 folder and double-clicking on 
Silhouette.

or

3 Start Silhouette on Linux systems by opening a Terminal window and typing: 
silhouette
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Creating a Project
When you start Silhouette, you are required to create or open a project. A 
project contains footage and sessions. A session in Silhouette is where you 
composite, rotoscope and paint.

1 Select New Project.

The New Project dialog box opens.

2 Enter a name for the project, choose a folder to store the project and then click 
Create Project.
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The Silhouette user interface opens once the project is created. When the new 
project is created, a folder is generated using the name of the project and 
contains the project file as well as paint data, autosave, and backups.

Importing and Replacing Media
Before you can start using Silhouette, media or footage has to be imported.

Importing Media
1 Select File > Import > Media.

or 

2 Click the Import icon at the bottom left of the Sources window.

or

3 Double-click on an open space in the Sources window.

4 When the File Browser opens, navigate to the location of your clip.
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We currently support the following file formats: Cineon, DPX, IFF, JPEG, 
OpenEXR, PNG, SGI/RGB, TIFF and TARGA.

5 Select the first frame in the clip and click on Open.

The entire clip is imported into Silhouette.

Replacing Media
1 In the Sources window, click on a clip to select it.

2 In the Object window, click the Browse icon at the far right of the File field.

The File Browser opens.

3 Navigate to your clip, select it and hit the Open button.

The old clip is replaced with the new clip.
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Managing Media Paths
You can virtualize media paths in order to improve asset sharing between 
users, asset management and render servers by specifying the file path with a 
SFX_MEDIA environment variable. 

Note: This is accomplished through a default SfxContentResolver that maps a “sfx” 
scheme to the SFX_MEDIA environment variable, and vice versa.

1 Using the standard method for setting an environment variable on your OS, 
create an environment variable named SFX_MEDIA with a value being the path 
where you media is stored, for instance, C:\Media\footage\.

2 Import a clip that is nested under the path you set for the environment variable.

3 Select the imported clip in the Sources window.

Please note that in the Object window > File field, the beginning of the source’s 
path is now sfx://.

4 Go to another computer with the same media, but a different folder structure, and 
set the SFX_Media to the new path.

5 Open the project created by the first machine and all of the source footage will 
be linked properly on your second machine.
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Creating Sessions
Once media is imported into Silhouette, a session has to be created. A session 
in Silhouette is where you composite, rotoscope and paint.

Using Session Templates
Templates are presets for automatically adding Roto and Paint nodes to the 
session and selecting a workspace.

1 Load some source footage.

2 Highlight the clip in the Sources window.

3 Choose Session > New Session, press Ctrl/Cmd-N or click the New Session icon 
at the bottom of the Sources window.

or
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4 Drag the clip thumbnail from the Sources window to the Trees window.

The clip settings are automatically imported into the session settings.

Note: If an in and out point has been marked for a source clip, the marked duration will 
be used for the session duration. For more information on source clip in and out points, 
see Source In and Out Points.

5 Select the Roto template.
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You can choose from the following templates:

• Composite: Automatically adds an Output node to the Source and selects the 
Composite workspace.

• Paint: Automatically adds Paint and Output nodes to the Source and selects the 
Streamlined workspace.

• Roto: Automatically adds Roto and Output nodes to the Source and selects the 
Streamlined workspace.

• Roto+Paint: Automatically adds Roto, Paint and Output nodes to the Source, 
connects the Roto > Objects output to the Paint > Objects input and selects the 
Streamlined workspace.

6 If you’d like, rename the session in the Name field and click OK.

The source node is automatically connected to Roto and Output nodes. The 
Output node determines the file format, file name, disk storage location, and 
channels to be rendered. In addition, the Streamlined workspace is selected. 
Optimized for Roto and Paint projects, the Streamlined workspace reduces the 
size of the Trees window to make room for the Object List and Paint History 
immediately below.
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Compositing and Multiple Nodes
1 Import some footage conducive to compositing, for instance, a foreground 

RGBA and a background clip.

2 Highlight the foreground RGBA clip in the Sources window.

3 Press Ctrl/Cmd-N and create a session using a Composite template.

The source node is automatically connected to an Output node and the 
Composite workspace is selected which provides ample space to create trees.

4 Select the Nodes tab at the bottom of the screen.
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Silhouette is a node based system and different nodes are used for various 
functions.The node groups are displayed and are organized into Color, 
Composite, Diffusion, Filter, Film Lab, Image, Key, Light, Silhouette, Special 
Effects, Time, Tints, Transform and Warp groups.

You can search for nodes by clicking the Search icon at the top left of the Nodes 
window. Type in the node that you want to search for and it will appear. Click 
the Search icon when done to return to the normal Nodes window view.

5 Select the Composite category and the nodes for that group are displayed.

6 Click and drag a Composite node to the Trees window and drop it onto the 
existing node wire between the source and output nodes.
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The node wire will automatically grab on to the Composite node. In case you 
were wondering, the different colored bars on the border of the node allow you 
to connect into and out of it.

The Composite node can use either two or three inputs.

• Two inputs: Foreground RGBA and Background

• Three inputs: Foreground, Background, Matte

Note: You can change Composite’s input order with the User Interface > Trees > Input 
Order preference. By default, FG, BG is selected, but you can change it to BG, FG if 
you’d like.

7 Drag your background clip from the Source window to the Trees window.

Output

Inputs

Obey Matte

Edit Node

View Node

Aux Input
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8 Click on the background clip’s output port and drag to the Composite node’s 
background input (middle input).

Silhouette is a straight, unmatted compositor and its composite nodes expect 
unpremultiplied images. In addition, it is best practice to unpremultiply before 
color correcting premultiplied images so as to avoid unexpected results. If you 
are working with premultiplied images, you have the following options:

• In the Source parameters, identify the alpha as Premultiplied. This will 
unpremultiply it.

• Unpremultiply the image within the Composite node.

• Use a Composite > Unpremultiply node before the premultiplied image hits the 
Composite node.

9 Single-click in the center of the Composite node to view and edit it.

When a node is single-clicked, a couple of things happen. First, it is loaded into 
the Viewer so you can see its affect on the image. Second, its parameters are 
loaded into the Node parameters window so its controls can be edited. You can 
tell which node is being viewed and edited by the state of the View and Edit 
Node icons on the node. They are colored blue when enabled.
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When you have multiple nodes, you can view one node while editing another. 
Just click on either the View Node or Edit Node icons. Let’s connect another 
node.

10 From the Image tab, click and drag a Roto node to the Trees window. Press the 
Ctrl/Cmd key before dropping it onto the background source clip.

This creates a new branch.

11 Hook the Roto node’s output (far left output port) to the Obey Matte input (right 
edge of node) of the Composite node.

Whatever is plugged in to the Obey Matte input will constrain or limit the effect 
of the node.
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12 Click the View Node icon on the Composite node and the Edit Node icon on the 
Roto node.

This configuration will allow you to view the Composite node while editing the 
Roto node.

13 Click the Circle icon located on the left side of the Viewer and drag out a circle 
over a portion of the foreground that is being composited.

14 Click the Edit icon on the Composite node, switch to the Obey Matte tab in the 
Node window and enable Obey.
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Now, the composite only occurs in the area defined by the Obey Matte input.

For all the ways you can add and connect nodes, see the Adding and 
Connecting Nodes sections for more information.

Editing Sessions
Once you have created a session, you can change its settings at any time by 
using one of the two methods listed below.

1 From the pull-down menu at the top of the screen, select Session > Session 
Settings.

or

2 Press Ctrl/Cmd-Shift-S.

In either case, the session window opens and you can change the settings. 
When the Edit Session window opens, make the desired changes.

Obey Matte Disabled Obey Matte Enabled



Silhouette User Guide    

• • • •••

Tutorials  65 
• • • •••

Cineon/DPX Log Session Workflow
To ensure that Cineon/DPX images display correctly, use the workflow outlined 
below.

Note: Silhouette tries to figure out whether a DPX file is logarithmic or linear based on 
the file’s header information. Sometimes the program used to create the DPX file writes 
the wrong information into the header causing Silhouette to think it is Logarithmic when 
it is Linear and vice versa. To explicitly set whether or not the file is Logarithmic or 
Linear, see the Edit Source > Interpretation section for more information.

Working in Linear Space
Our preferred Cineon/DPX Log workflow is to use linearized Cineon/DPX Log 
images in a Float session.

1 Load a Cineon or DPX clip and create a Float session.

2 Use the default Color Management > Cineon/DPX Working Space preference 
setting of Linear.

This converts log Cineon/DPX files to scene linear.

3 Make sure that the Display Options icon is enabled in the Viewer.

Silhouette automatically tries to determine the colorspace based on the data in 
the file and other information from the header. If a colorspace can’t be detected, 
Linear will be selected.

4 In the Color Management toolbar located below the Display Options icon, make 
sure that the Colorspace is Linear and the View Xform is sRGB.

These settings will ensure that the linearized Cineon/DPX images will look 
correct in the Viewer. If you’d like, you can also adjust the Gain (exposure) and 
Gamma of the image.

5 To adjust the brightness of the image in the Viewer, use the Viewer > Display > 
Gain and Gamma settings.
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Working in Log Space
If you would like to work with Cineon/DPX images in log space, you can bypass 
Silhouette’s Cineon conversion. This allows you to work with the raw 
Cineon/DPX files without a conversion.

1 Load a Cineon or DPX clip and create a Float session.

2 Set the Color Management > Cineon/DPX Working Space preference setting to 
Log.

This keeps the Cineon/DPX files in log space.

3 Make sure that the Display Options icon is enabled in the Viewer.

4 In the Color Management toolbar located below the Display Options icon, make 
sure that the Colorspace is Cineon and the View Xform is sRGB.

These settings will ensure that the log Cineon/DPX images will look correct in 
the Viewer. If you’d like, you can also adjust the Gain (exposure) and Gamma 
of the image.

5 To adjust the brightness of the image in the Viewer, use the Viewer > Display > 
Gain and Gamma settings.
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Favorite Nodes
Nodes can be tagged as a Favorite allowing them to be grouped separately in 
the Favorites tab of the Nodes window. 

1 Select a node in the Nodes windows by single clicking on it.

2 Tag the selected node as a Favorite by pressing the Favorite icon at the top left 
of the Nodes window.

3 Click on the Favorites node tab to see the favorite nodes.
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Shifting a Source Node in Time
You can shift a Source node in time. This is useful for lining up frames that are 
numbered differently.

1 Single-click on the Source node in the Trees window to view and edit it.

Once active, the Source node’s parameters appear in the Node parameters.

2 Drag the Time Shift numeric field to the desired frame or enter a value by clicking 
on the number.

The start frame for the node is adjusted by the Time Shift value.
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Viewer

Color Management
Silhouette uses the OpenColorIO standard originally developed by Sony 
Pictures Imageworks for its color management. You can load custom color 
configuration files and custom LUTs, apply colorspace conversions, as well as 
use other controls for fine tuning.

1 Make sure that the Display Options icon is enabled in the Viewer.

Silhouette automatically tries to determine the colorspace based on the data in 
the file and other information from the header.
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2 If not set correctly, change the input colorspace of the current scene using the 
Colorspace pop-up menu.

When using Cineon/DPX images with the Color Management > Cineon/DPX 
Working Space preference set to Linear, the input colorspace should be set to 
Linear. When the preference is set to Log, the Cineon colorspace should be 
used.

3 If you are using a custom OCIO configuration with multiple Display options, 
choose the colorspace of the display using the Display pop-up menu.

Note: If there is only one Display option, the Display pop-up menu is hidden.

4 Select the colorspace transform to apply to the scene from the View Xform pop-
up menu.

5 To adjust the brightness of the image in the Viewer, use the Viewer > Display > 
Gain and Gamma settings.

You can select a custom OpenColorIO (.ocio) configuration file by choosing it 
in the Color Management > OCIO Configuration preference.

For more information on OpenColorIO, including the OCIO file format, please 
visit http://opencolorio.org/.

http://opencolorio.org/
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Using the RGBA buttons in the Viewer
1 Click on the Red, Green, Blue or Alpha buttons to solo that channel as a gray 

scale image.

If only one component is selected, it is displayed in gray scale. The horizontal 
white bar above the RGBA buttons quickly toggles the display of the image 
back to full color mode.

2 Select the horizontal white bar above the RGBA buttons to quickly toggle the 
display of the image back to full color mode.

3 Either press the Alpha button (to the right of the blue button) or the A key to cycle 
the state of the alpha display.

Note: To view a shape’s alpha channel, you must first set the View to Output before 
pressing the Alpha button or A key.

Hitting the Alpha button or A key once superimposes the alpha channel over 
the image. Pressing a second time displays the alpha channel over black. 
Hitting again shows only the color image. 

Shift-A activates RGBA mode which does the following: Toggles the View to 
Output, superimposes the alpha channel over the image and deactivates the 
Overlay. Pressing Shift-A again returns the Viewer to its previous state.
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Viewer Navigation
Zooming

1 Select a value between 25% and 500% in the Zoom pop-up menu.

or

2 Use the scroll wheel on your mouse to zoom in and out of the image.

or

3 Press Space Bar-Shift and move the mouse up to zoom in or down to zoom out.

or

4 Use the + or = keys to zoom in and the - key to zoom out.

Zoom and Centering Presets
1 Press the F keyboard shortcut or select Fit from the zoom pop-up window to 

display the image as large as possible within the Viewer window.

2 Press the H keyboard shortcut or double-click the middle mouse button to set 
the image to a 100% zoom level and center it in the Viewer.

3 Press Ctrl/Cmd-F to center the selected object in the Viewer.
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Viewer Rotation
Rotating the Viewer can facilitate rotoscoping and painting.

1 Select the Rotate icon to enable Viewer rotation mode.

Once Rotate is enabled, the Adjust Rotation editing control (hand icon) 
becomes available.

2 Press the Adjust Rotation icon to enable it.

3 Click and drag in the Viewer to set the angle.

Once the angle has been set, you will need to disable Adjust Rotation to use 
the node’s tools.

4 Select the Adjust Rotation icon again to disable it.
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Opening Additional Viewers
Open additional Viewers that can be set to any node or view.

1 At the top left of the Viewer, click the New Viewer icon.

A new viewer opens as a floating window.

2 Select the node to view.

The new Viewer has the following controls: Node, View, Update Mode, Stereo 
View, Channels and Zoom. The remainder of the controls are shared with the 
main Viewer.

Note: Multiple viewers from the same node have the option of being synchronized in 
terms of zoom and pan using the Use Viewer > Synchronize Viewers preference.
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Optimizing Playback
Silhouette can cache frames into RAM to guarantee real-time playback. When 
you hit the play button, each frame is cached into RAM. Once the clip is played 
through once, it will then play in real-time if enough RAM is available. At the 
bottom right corner of the interface, there is a numeric readout (Cache Display). 
It displays the length of your clip, the maximum frames that can be cached into 
RAM, the percentage of RAM currently being used as well as the session’s bit 
depth.

If your clip is longer than the maximum frames that can be cached into RAM, 
the clip will not play in real-time.

Preload Frames
1 Play your source clip to cache it into memory.

Once cached, playback is instantaneous since the frames are already loaded. 
In addition, source frames are also automatically cached in a background 
thread. The amount of preloaded frames is controlled by a Cache > Preload 
Frames preference with the default value being 10 frames.

2 Select File > Preferences on Windows and Linux or Silhouette > Preferences on 
Macintosh.

3 Go to the Cache group.

4 If you’d like, you can change Preload Frames to a higher value.

5 Click Apply.

Increase Amount of Frames During Playback
There are number of ways to increase the amount of frames that can be played 
back in real time.

1 Enable the Viewer > ROI (Region of Interest) to work on a sub-region of the 
image.
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2 Select File > Preferences on Windows and Linux or Silhouette > Preferences on 
Mac and increase the %Total Physical RAM parameter in the Cache preferences 
(requires a restart of Silhouette to take effect). Please note that setting the % 
Total Physical RAM too high could cause instability if running other memory 
intensive programs.

3 In the Roto node, change the View from Output to Foreground.

4 Shorten the length of the clip by adjusting the First and Last Frame in the 
Timebar.

5 Change the proxy setting to 2:1, 3:1 or 4:1.

6 If you are working with film resolution files in a Float session, change the session 
depth to 8 bits while you work, then switch back to Float for rendering.

Note: When painting, do not use a proxy setting other than 1:1 and make sure that you 
remain at the sessions original bit depth. Do not use steps 5 and 6 when painting.
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Sequence Editor
Silhouette can perform editing tasks such as cutting, joining, moving, copying, 
replacing, trimming, retiming and repeating clips in the Sequence Editor. The 
sequence can then be used as an element in the Trees window.

Creating a Sequence
A sequence is comprised of multiple clips edited together.

1 Select the New Sequence icon in the Sources window.

A sequence object is created in the Sources window and the Sequence Editor 
appears.

2 Drag and drop clips from the Sources window into the Sequence Editor.

3 Drag and drop to insert clips or Alt-drag and drop to replace clips.

If you select one or more clips in the Sources window before pressing the New 
Sequence icon, the clips are assembled in selection order using in and out 
points, if they are set, into a new sequence.

4 Drag and drop the sequence from the Sources window into the Trees window.

The sequence can now be used as an element in the Trees window just like 
any other source.

Marking In and Out Points
Clips in the Sources window can have in and out points which are used when 
creating a sequence. In and out points are also useful within the sequence to 
define a region to be moved, copied, replaced or deleted.
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1 Double-click on a clip in the Sources window. 

The clip is loaded into the Viewer and Mark IN and Mark OUT icons appear.

2 Set the Timebar to the in point.

3 Click the Mark IN icon or press the I key.

4 Set the Timebar to the out point.

5 Click the Mark OUT icon or press the O key.

When setting in and out points for a clip, the clip takes over the Viewer. To 
return the Viewer to a sequence or a node, double-click the sequence in the 
Sources window or a node in the Trees window.

Moving, Copying, Replacing and Deleting
The highlighted selection can be moved, copied, replaced or deleted.

Moving
1 Click on a clip or drag select multiple clips to select them.

2 Click somewhere in the highlighted region and drag and drop to a new location. 

The selection is moved.

Copying
1 Click on a clip or drag select multiple clips to select them.

2 Click somewhere in the highlighted region and Shift-drag and drop to a new 
location. 

The selection is copied.

Replacing
1 Click on a clip or drag select multiple clips to select them.

2 Click somewhere in the highlighted region and Alt-drag and drop on either a 
destination clip or a marked region.

The destination clip or marked region is replaced.
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Deleting
1 Click on a clip or drag select multiple clips to select them.

or

2 Mark IN and Mark OUT points in the Sequence Editor.

3 Press the Delete key.

The selection is deleted.

Trimming
The head and tail of a clip can be lengthened or shortened using the Trim 
controls.

Clicking on a cut enables trimming and displays both sides of the cut in the 
Viewer.

1 Click and drag in the center of a cut between two clips (double-arrow cursor 
appears) and both sides of the cut are trimmed.

Trim Out Trim Both Trim In
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2 Click and drag to the left of the cut (left arrow cursor appears) and the outgoing 
clip is trimmed.

3 Click and drag to the right of the cut (right arrow cursor appears) and the 
incoming clip is trimmed.

Note: After selecting the left, right or center of a cut, the left and right arrow keys can 
be used to trim frames one at a time.

Change Speed and Direction
Modification of the speed and direction of selected clips is possible in the 
Sequence Editor.

Changing Speed
1 Click on a clip or drag select multiple clips to select them.

The Segment Speed field controls the speed of selected clips and displays as 
a percentage. A value of 50 slows down by 50%, a value of 100 does nothing, 
and a value of 200 is twice as fast. 

2 Using the Segment Speed field, enter a value of 200 to double the speed.

3 Enter a value of 50 to slow the clip down by half.

Note how the duration field has doubled in duration.

Reversing Direction
1 Click on a clip or drag select multiple clips to select them.

2 Change the playback mode to Reverse in the Segment Direction field.
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The order of the frames is reversed.

Looping A Clip
1 Click on a clip or drag select multiple clips to select them.

2 At the bottom left of the Sequence Editor, increase the Loop Count value from 1 
to 3.

The clip is repeated three times.

3 Select the Segment Direction: Forward, Reverse or Bounce.

The clip is repeated three times using the selected direction.

Freeze Frame
1 Drag the Timebar to the frame you would like to freeze.

2 Use Add Edit before and after the frame so a single frame clip is created within 
the Sequence.

Note: The Add Edit icon is located at the bottom left of the Sequence Editor.

3 Zoom the Sequence Editor in using either Middle mouse scroll or Shift-Middle 
mouse scroll (10x faster) while hovering the cursor over the single frame clip.

Note: Selecting a single frame clip is difficult unless you zoom in because the trim 
handles will most likely be selected instead.

4 Click on the single frame clip to select it.

5 Enter the freeze frame duration in the Loop Count field, for instance, 10 for 10 
frames.

6 Click OK.

The frame is frozen for the specified period.
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Roto
Rotoscoping or “Roto” for short has become a generic term for drawing shapes 
to extract, isolate or affect a portion of an image. It is tedious work, but it’s one 
of the most important parts of the visual effects process. Within the Roto node, 
there are all the tools needed to make quick work of any Roto job.

Creating usable shape animations can be a bit tricky with the most common 
problem being edge chatter. Here’s a few tips to help you on your way.

Analyze the Clip
View your clip to determine the frame that requires the greatest number of 
points to create the shape. It is easier to draw your shape on the most complex 
frame as opposed to starting on a simpler frame and adding points later.

Select a Spline Type
In Silhouette, you can create B-Splines (also known as natural splines), X-
Splines, Bézier splines, Circles and Squares.

Create Shapes with Less Points 
Use as many points as needed to create the shape, but avoid using more than 
is necessary. The fewer the points, the easier it is to successfully animate the 
shape. Unnecessary shape complexity inevitably leads to inconsistency when 
editing points.

Create Multiple Shapes
Create multiple shapes to Roto complex objects. Drawing separate shapes for 
the major parts of an object give you finer control over motion especially when 
separate objects intersect with each other.

Edit the Shape in Groups
Try not to individually move points in a shape unless absolutely necessary. 
Moving points in groups will maintain consistency and eliminate edge chatter.

Use the Tracker
Use the tracker to analyze the motion of your clip and then apply that motion to 
your shapes. This will cut down on the number of keyframes needed.
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Keyframe, Keyframe, Keyframe
By editing your shape at various frames in the clip, Silhouette animates the 
shape in between those keyframes. This saves you work. Make as few 
keyframes as possible, but as many as needed so the shape properly follows 
the object that you are rotoing. For instance, on a 80 frame clip, start by adding 
keyframes at 1, 20 and 40. If more animation is needed, add keyframes at 10 
and 30. Get the idea? Creating too many keyframes will cause the shape to 
jitter or chatter.

Quick Start
For the inpatient among you, here’s a Roto quick start. For all others, Roto 
features are covered in more detail after this exercise.

1 Load some source footage and create a session using the Roto template.

2 Make sure you are viewing and editing the Roto node by single-clicking on it.

When the Roto node is edited, a number of different tools are selectable from 
the Toolbar to the left of the Viewer.

3 View your clip to determine the frame that requires the greatest number of points 
to create the shape. It is easier to draw your shape on the most complex frame 
as opposed to starting on a simpler frame and adding points later.

Transform

Reshape

X-Spline

Square

B-Spline

Magnetic Freehand

IK

Bézier

Tracker
Circle

MultiFrame
RotoOverlay
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4 Select B-Spline (B) from the Toolbar.

5 Click on the screen to create a control point.

A control point is created.

6 Add as many points as you like.

7 When finished adding points, click the first control point that you added to close 
the shape.

Use as many points as needed to create the shape, but avoid using more than 
is necessary. The fewer the points, the easier it is to successfully animate the 
shape.

Now that you have a shape, you can use either Reshape or Transform to 
perform editing functions.

8 Select Reshape (R).

Reshape modifies shapes by adjusting their control points and tangents.

9 To move points, select one or more control points and drag the point or points to 
a new location. 

10 To add a new control point, Alt-click on a selected shape. 

11 To delete control points, select them and press the Delete key.

12 Go to various frames in your clip and edit the shape using the Reshape tool.

As the shape is edited on different frames, a keyframe marker is shown in the 
Timebar to provide a visual display of where there are shape keyframes. The 
color of the markers is determined by the shape color. If multiple selected 
shapes have a keyframe on the same frame, the most recently selected 
object's color has precedence. 

Next, instead of modifying the shape’s control points, try modifying the entire shape.
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13 Click on Transform (T) in the Toolbar.

Transform affects an entire shape or a group of shapes

14 Select a shape and use one of the on-screen controls to modify it.

The Q, W and E keys allow you to quickly translate, rotate or scale selected 
shapes while using the Transform tool.

15 Press the Q key to activate translation mode, the W key for rotation mode or the 
E Key for Scale mode and click and drag to transform the selected shape. You 
must press the Q, W or E key, whichever one was selected, a second time to 
deactivate the mode.

Shortcut Action

Drag within large center circle Moves the layer

Shift-drag within large center circle Constrain layer movement horizontally or vertically

Drag the center square horizontal and 
vertical halfway points

Scales the layer horizontally or vertically

Drag a center square corner Proportionally scale the layer

Drag large center circle Rotate the layer

Ctrl/Cmd-drag large center circle Rotates the layer with finer control

Drag small center circle Moves the Anchor point

Q Activates / Deactivates translation of selected layers

W Activates / Deactivates rotation of selected layers

E Activates / Deactivates scaling of selected layers

Q, W, E then Ctrl/Cmd Translates, Rotates or Scales in finer increments
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Bézier
Bézier splines are defined by control points and tangents. The position of the 
two tangent handles control the amount of a point's curvature.

1 Select Bézier (Shift-B) from the Toolbar.

2 Click on the image to place the first control point.

The starting control point is created and sets the direction of the shape’s path.

3 To extend the control point’s tangents, drag the cursor while keeping the mouse 
pressed.

Although you can use the Reshape tool to later change a shape’s look after 
drawing it, you can also use the same Reshape keyboard shortcuts to modify 
a shape while drawing it. See Adjusting Bézier Curves for more information 
on the various ways to change a control point’s tangents.

4 Click on the screen to add more control points.

5 When finished adding points, click the first control point that you added to close 
the shape.

Use as many points as needed to create the shape, but avoid using more than 
is necessary. The fewer the points, the easier it is to successfully animate the 
shape.
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B-Spline
In contrast to Béziers, B-Splines don’t use tangents and are created by only 
using control points. The position of the points, their intensity settings as well 
as their proximity to each other determine the curvature of the shape.

1 Select B-Spline (B) from the Toolbar.

2 Click on the screen to create a control point.

A control point is created.

3 Add as many points as you like.

4 When finished adding points, click the first control point that you added to close 
the shape.

Use as many points as needed to create the shape, but avoid using more than 
is necessary. The fewer the points, the easier it is to successfully animate the 
shape.
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X-Spline
A X-Spline is an intuitive and easily editable spline format whereby its points 
can be of three different types: Cardinal, Corner or B-Spline.

1 Select X-Spline (S) from the Toolbar.

2 Click on the screen to create a control point.

A control point is created.

3 Add as many points as you like.

4 When finished adding points, click the first control point that you added to close 
the shape.

Use as many points as needed to create the shape, but avoid using more than 
is necessary. The fewer the points, the easier it is to successfully animate the 
shape.

Edge Snapping
You can snap the control points of an X-spline to edges of an object by using 
the Edge Snapping tool.

1 Select some points on an X-Spline.

2 Press the Alt-S key to snap.

The points snap to the nearest detectable edge. Alternatively, start dragging the 
points, hold the Alt-S key down and they will snap to the nearest detectable 
edge. In some cases, the points may not snap to where you want them to. If 
this happens, adjust the points manually.

Cardinal Corner B-Spline
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Magnetic Freehand
Creating A Magnetic Shape
Using the Magnetic Freehand tool, you can create a freehand shape with 
magnetic properties. There are two methods of creating a magnetic shape: 
Tracing or Strokes.

Tracing
Trace the cursor along the edge you want to follow and the shape boundary 
snaps to the nearest edge.

1 Select Magnetic Freehand (Shift-F) from the toolbar.

2 Click once near the edge you want to start with.

3 Move your cursor along the edge you want to follow.

4 Click once any time you want to anchor the currently drawn path along the route 
and a point is added.

5 If there is a tricky section of the edge that the Magnetic Freehand tool doesn’t 
want to line up with, click-hold and drag to draw a freehand shape.
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If you want to draw off the edge of the frame, click-hold and drag while tracing 
to switch to freehand mode.

6 To complete the drawn line, click the first control point that you added.

Strokes
Draw temporary foreground (inside the shape) and background (outside the 
shape) strokes for the object you want to create a shape around.

1 Define foreground areas by Shift-click-dragging.
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2 Define background areas by Alt-click-dragging.

As soon as the first background stroke is drawn, an X- Spline is created around 
the object.

3 Add additional foreground and background strokes as needed so that the shape 
properly surrounds the object.

4 Press Esc to clear the foreground and background strokes as well as deselect 
the current shape. You can now create a new magnetic shape or new 
foreground/background strokes.

Creating A Freehand Shape
1 Select Magnetic Freehand (Shift-F) from the toolbar.

2 Click-hold and drag to create a freehand shape.

BG

FG
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3 To complete the drawn line, release the mouse on the first control point that you 
added.

Adjusting Detail
Magnetic and freehand shapes have a fairly high point count to match the 
subtle changes in the line.The amount of points can be reduced or increased.

1 Select Magnetic Freehand (Shift-F) from the Toolbar.

2 Select an X- Spline in the Object List.

3 Adjust the Detail slider directly above the Viewer to reduce or increase the 
number of points.

Adjusting the Detail reduces points for X-Splines created with the Magnetic 
Freehand tool, while increasing points for normal X-Splines.

Square
1 Select Square (Shift-S) from the Toolbar.

2 Do one of the following:

• Click and drag in the shape of a square.

• To create a perfect square, hold down the Shift key while clicking and dragging in 
the shape of a square.

3 When you release the mouse button, a square shape appears.
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Circle
1 Select Circle (Shift-C) from the Toolbar.

2 Do one of the following:

• Click and drag in the shape of a circle.

• To create a perfect circle, hold down the Shift key while clicking and dragging in 
the shape of a circle.

3 When you release the mouse button, a circular shape appears.

Open Shapes
Open shapes are good for rotoscoping strands of hair or thin objects.

1 Select either Bézier, B-Spline or X-Spline from the Toolbar.

2 Click on the screen to create a control point.

A control point is created.

3 Add as many points as you like.

4 When finished adding points, select the Reshape tool.

You can also press the Esc key to finish the shape.

5 Select the open shape and in the Object window, adjust the Stroke Width to set 
its thickness and choose a Flat or Round Cap Style.
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Transform
Once you draw a shape, there are various ways to modify it. As the object that 
you are attempting to Roto changes over time, you will need to adjust the shape 
so that it exactly matches the object. The Transform tool affects an entire shape 
or a group of shapes.

Shape Mode
Transform Shape Mode allows you to position, move, scale, rotate, shear or 
corner-pin a shape or selection of shapes using the on-screen controls.

1 Click on Transform (T) in the Toolbar.

2 Select a shape.

3 Use one of the on-screen controls to modify the shape. See the tutorials to follow 
for more detail on using the On-screen controls.
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Points Mode
Transform Points Mode allows you to position, move, scale, rotate, shear or 
corner-pin a selection of points using the on-screen controls.

1 Using Reshape (R), select multiple points on the shape.

2 In the Toolbar, click on Transform twice (TT).

A bounding box with on-screen controls appears around the selected points 
instead of around the entire shape.

3 Use one of the on-screen controls to modify the shape. See the tutorials to follow 
for more detail on using the On-screen controls.

Moving Shapes
Shapes can be moved horizontally or vertically.

Note: The remainder of the Transform tutorials assume that Transform Shape Mode is 
enabled in the Toolbar.

1 Make sure that Transform (T) Shape Mode is enabled.

2 Select a shape or series of shapes.
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3 Drag on the outline of one of the shapes.

or

4 Press the Q key to activate translation mode and click and drag to move the 
shapes.

5 You must press the Q key a second time to deactivate translation mode.

To constrain movement along an axis:
1 Select a shape or series of shapes.

2 Press the Shift key while dragging the outline of a shape. The movement is 
constrained by the first direction (horizontal or vertical) that you drag in.

Nudging Shapes
Shapes can be nudged horizontally or vertically using the Arrow keys. One 
press of the Arrow key moves the shapes 1 pixel. Using the Shift key in 
conjunction with the Arrow keys moves the shapes 10 pixels.

1 Select a shape or series of shapes.

2 Use the Arrow keys to nudge the shapes.

Scaling Shapes
Scaling changes the size of the shapes.

1 Select a shape or series of shapes.

2 Drag any of the points on the shape bounding box.

or
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3 Press the E key to activate scaling mode and click and drag to scale.

Note: The position of the cursor when E is pressed sets the anchor point for the 
scaling.

To proportionately scale, hold down the Shift key when scaling.

4 You must press the E key a second time to deactivate scaling mode.

Rotating Shapes
Rotating changes the angle of the shapes.

1 Select a shape or series of shapes.

2 Ctrl/Cmd-drag on a shape bounding box corner handle.

or

3 Press the W key to activate rotation mode and click and drag to rotate.

Note: The position of the cursor when W is pressed sets the anchor point for the 
rotation.

4 You must press the W key a second time to deactivate rotation mode.

Corner-Pinning Shapes
The corner points of a shape’s bounding box can be corner-pinned. For 
instance, you could fit the corners of a shape into the corners of a billboard.

1 Select a shape.

2 Alt-drag the corners of the shape’s bounding box.
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Shearing Shapes
Shapes can be sheared resulting in the shape being skewed horizontally or 
vertically.

1 Select a shape.

2 Ctrl/Cmd-drag on the midpoints of a shape bounding box on either the horizontal 
or vertical axis.

Anchor Point
A shape rotates around its center point, but scales from the opposite handle. 
Moving the anchor point changes the center of rotation and scaling when using 
the on-screen controls.

1 Press the . (period key).

The Anchor Point is displayed on the screen.

2 Click and drag the Anchor Point to the desired location.

3 Select your shape and then rotate or scale it.

Notice how the shape rotates and scales around the Anchor Point.

Note: If more than one shape is selected, they will both rotate and scale around the 
Anchor Point.

Copying and Pasting Shapes
Shapes can be cut(Ctrl/Cmd-X), copied(Ctrl/Cmd-C) and pasted(Ctrl/Cmd-
V).
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Deleting Shapes
A shape or selection of shapes can be easily deleted using none other than the 
Delete key.

1 Select a shape or set of shapes.

2 Hit the Delete key.

Reshape
The Reshape (R) tool modifies shapes by adjusting their control points and 
tangents.

Selecting Control Points
1 Select Reshape (R) from the Toolbar.

2 Select a shape.

3 Click on a single point to select it, Shift-click to add to the selection or Ctrl/Cmd-
click to toggle the point selection.

Rectangular Selection
Control points can be selected by drawing a rectangular selection. This is the 
default behavior.

4 Click and drag a rectangle over multiple control points.

A rectangular selection is created.

Note: A Shape > Freehand Point Selection preference controls whether freehand 
selection is used by default. Pressing Ctrl/Cmd and dragging uses the non-default 
method of selection. See the Shape Preferences for more information.

Freehand Selection
Control points can be selected by drawing a freehand polygon.

5 Ctrl/Cmd-drag in the Viewer to begin the selection. Once the selection is started, 
release Ctrl/Cmd and complete the selection.

A freehand selection is created.

Adding Control Points
Adding control points assists in tracing more detailed objects.
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1 Select a shape.

2 Alt-click on a selected shape to add a new control point. 

Don’t click on an existing control point because it will move it instead.

Deleting Control Points
1 Select the control points and press the Delete key.

or

2 Right-click on a control point and select Delete from the Reshape pop-up menu.

Moving Control Points
1 Select one or more control points.

2 Drag the point or points to a new location. 

Nudging Points
Points can be nudged using the Arrow keys. One press of the Arrow key 
moves the points 1 pixel. Using the Shift key in conjunction with the Arrow 
keys moves the points 10 pixels.

1 Select a point or series of points.

2 Use the Arrow keys to nudge the points.

Magnet Mode
1 In the Toolbar, click on Reshape to cycle between Normal and Magnet mode.

2 Select a series of points.

3 Drag one of the selected points.
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Points near the cursor move more than points farther away.

Numbering Points
All points or a selection of points can be numbered.

Numbering All Points
1 Go to File > Preferences > Shape on Windows and Linux or Silhouette > 

Preferences > Shape on Mac.

2 Set the Number Points preference to All.

3 Click OK.

Numbers are now displayed next to all points.

Number One Point or a Selection of Points
1 Using the Reshape (R) tool, select one or more points.

2 Right-click on one of the selected control points and select Tag.

The points are now tagged for numbering.

3 Go to File > Preferences > Shape on Windows and Linux or Silhouette > 
Preferences > Shape on Mac.

4 Set the Number Points preference to Tagged.

5 Click OK.
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Numbers are now only displayed next to tagged points.

Feather
Shape points can be feathered to create variable edged blurs on a point by 
point basis.

Closed Shapes
1 Select Reshape (R) from the Toolbar.

2 Select a shape point and a red, outward feather handle appears. Dragging this 
handle outward will pull the feather out.

After the initial drag, the outer feather point can be dragged around 
independently.
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Multiple selected points can be dragged simultaneously and by a proportionate 
amount. To move the shape and feather points simultaneously, press Shift 
while moving the shape point.

Note: The display of the feather handles can be hidden using Alt-F.

Open Shapes
1 Select Reshape (R) from the Toolbar.

2 Select an open shape, adjust the Stroke Width to set its thickness and choose 
either a flat or round Cap Style in the Object window.

Once you've done this, additional per-point feather handles appear--a red one 
for the Stroke Width and a green one for the Feather.

Just drag on the handles to make adjustments.

3 Multiple selected points can be dragged simultaneously and by a proportionate 
amount.



Silhouette User Guide    

• • • •••

Tutorials  104 
• • • •••

Adjusting Bézier Curves
The length and direction of a control point’s tangents direct the curve through 
that control point.

Control points have two tangents that can extend from it. The path of the curve 
through the control point is determined by the length and orientation of the 
tangents. When you drag one tangent’s handle, the adjacent tangent moves as 
well.

1 Select a control point on a Bézier shape.

2 Click and drag a tangent handle.

This adjusts the length of one tangent while retaining a fixed angle between the 
two tangents.

3 Ctrl/Cmd-drag a tangent.

This adjusts both tangents simultaneously while retaining a fixed angle 
between the two tangents.

4 Alt-drag a tangent.

Tangent Handle

Tangent

Curve Join

Control Point
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Only one tangent is moved which is useful for creating corners.

5 Right-click over a control point and select Linear, Corner or Cardinal.

Linear adjusts both tangents one quarter the distance and in the direction of 
their adjoining control points. Corner collapses both tangents to create a corner 
point. Cardinal creates a smooth point where the curve passes smoothly 
through it.

Extending Short Tangents 
Sometimes a control point’s tangents are so close together that trying to modify 
the tangent results in movement of the control point. If this is the case, you can 
force the tangents to move without affecting the control point.

1 Press the Alt key while dragging the tangent.

Only the tangent will move, leaving the control point unaffected.

Moving Curve Segments
Normally, you move control points to adjust the form of a shape, but you can 
also move the portion of the curve between control points.

1 Deselect all control points by clicking somewhere off the shape.

2 Ctrl/Cmd-drag a Bézier curve segment between control points.

Once you start dragging, the Ctrl/Cmd key can be released.

Note: The surrounding tangents remain smooth, but if you want to keep adjacent 
tangents from moving, hold down the Alt key while dragging.
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Adjusting B-Splines
B-Splines are created by only using control points and are simple to adjust. The 
position of the points, their weight settings as well as their proximity to each 
other determine the curvature of the shape. The weight (amount of pull on a 
point) decides how sharp or smooth it is. Silhouette employs variable weight 
intensities on a point by point basis.

1 Select a control point on a B-Spline shape.

2 Alt-drag the point to the right to create a corner point or Alt-drag to the left to 
create a smooth point.

or 

3 Alt-click to cycle through the preset weight settings of the point.

or

4 Right-click over a control point and select Corner or B-Spline.

Note: The Alt-click and pop-up menu preset weight settings for Corner and B-Spline 
can’t be animated.

Adjusting X-Splines
X-Splines are created by using control points and then adjusting their weight to 
coincide with one of the point types: Cardinal, Polygon or B-Spline. The point 
type can even be somewhere in between one point type and another.

1 Select a control point on a X-Spline shape.

2 Alt-drag the point to the right. The tension of the point goes from Cardinal to 
Corner to B-Spline.

or 

3 Alt-click to cycle through the different point types.

or

4 Right-click over a control point and select Corner, Cardinal or B-Spline.

Converting B-Splines or X-Splines to Bézier Splines
You may convert your B-Splines or X-Splines to Bézier Splines at any time.

1 Select a B-Spline or X-Spline shape.

2 Select Actions > Edit > Convert to Bézier.
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Once you select Convert to Bézier, a couple of things happen. The visibility of 
the B-Spline or X-Spline is toggled to off. A new Bézier Spline is created and is 
named the same as the B-Spline or X-Spline but has an * at the end of the 
name.

Note: The Bézier conversion of B-Splines that use extreme, variable weight 
adjustments will not exactly match the original B-Spline. Do not use extreme, variable 
weight adjustments if you are planning on converting the B-Spline to a Bézier.

Copying and Pasting Shapes
Selected shapes can be cut(Ctrl/Cmd-X), copied(Ctrl/Cmd-C) and 
pasted(Ctrl/Cmd-V).

Breaking Shapes
In the Reshape tool, closed shapes can be opened using the Break option from 
the control point pop-up menu.

1 Select and right-click on a control point.

2 Choose Break from the pop-up menu.

The shape opens at the selected control point.

Closing and Extending Shapes
Shapes can be closed or extended with just a few mouse clicks. It is necessary 
to use the Reshape tool to perform the following actions.

Closing Shapes
1 Select one of the control points at the end of the shape.

2 Alt-click on the other end point to close the shape.

Extending Shapes
1 Select a control point at either end of an open shape.

2 Alt-click somewhere off the shape.

Joining Open Shapes
In the Reshape tool, open shapes can be joined together.

1 Select one of the end points of the source shape by clicking on it.

2 Make sure both shapes are selected in the Object window.

3 Alt-click on one of the end points of the target shape.
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The two shapes are now joined together as one.

4 Repeat steps 1 and 3 for the two remaining end points to close the shape.

Note: The target shape inherits the attributes of the source shape.

Combine Shapes
Copies the selected control points from a source shape into a target shape, 
placing them between two adjacent selected points in the target shape.

1 Select one or more points on a source shape.

2 Ctrl/Cmd-click the target shape in the Object List.

3 Select two adjacent points on a target shape.

4 Choose Combine Shapes from the pop-up menu.

The selected points from the source shape are copied between the two 
selected points in the target shape.

Extract Shape
Extracts the selected points of a shape into a new closed shape.

1 Select three or more shape control points.

2 Choose Extract Shape from the pop-up menu.

The selected controls points are used to create a new closed shape while 
removing the points from the original shape.
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IK (Inverse Kinematics)
In computer graphics, inverse kinematics (IK) is a technique that provides 
automatic movement of objects. It allows elements of an object to be linked, 
such as the parts of an arm or leg, and causes them to move in a prescribed, 
realistic manner. IK simplifies the process of rotoscoping jointed, segmented 
figures by making the motion of each part related to the motion of the linked 
parts. That way, you simply have to animate the starting and ending joints, and 
the ones in between will adjust themselves and create more natural looking 
movement.

1 To create an IK chain for an arm, create three layers.

2 Name the layers as follows: Arm, Elbow, Wrist.

3 Move the Elbow layer into the Arm layer.

4 Move the Wrist layer into the Elbow layer.

Your layers should look like this:

Create shapes for each layer.

5 Select the Arm layer and create a shape for the upper arm.

6 Select the Elbow layer and create a shape for the forearm.

7 Select the Wrist layer and create a shape for the hand.

The layers and shapes should look like this:

Now that the layers and shape have been setup, the joints need to be placed 
by positioning the Anchor Point of each layer using the Transform tool.

8 Select the Arm layer in the Object List and activate the Transform (T) tool.
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9 Move the center Anchor Point on-screen control so that it is positioned at the top 
of the shoulder.

10 Select the Elbow layer and position the Anchor point at the elbow.

11 Select the Wrist layer and position the Anchor point at the wrist.

Your image will be different, but the joints should look something like this:

12 Select IK (Y) in the Toolbar.

Arm

Elbow

Wrist

Joints
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13 Select the Upper Arm, Forearm and Wrist shapes and an IK chain is built on the 
fly that flows up the shape's layer tree to the top-most layer.

Each layer’s Anchor Point becomes a joint in the IK chain. The “bones” are just 
the connections between the layer anchors.

14 Click-drag a bone or shape to rotate the shape around the parent’s anchor point.

When animated, keyframes are automatically set for each layer’s rotation 
parameter. However, you can explicitly set the layer rotation keyframes by right-
clicking on a selected bone and a choosing Add Key.

15 Click-drag a joint to use IK to rotate all joints up the chain.

16 Alt-click-drag a joint to move the joint while attempting to keep other joints in 
place.

IK greatly simplifies the rotoscoping of humans, animals and all manner of 
jointed creatures.

Note: To quickly jump between the Reshape, Transform, and IK tools while editing a 
shape, use the shortcut keys: R for Reshape, T for Transform and Y for IK. R, T and Y 
are very convenient since they are right next to each other.
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MultiFrame
MultiFrame modifies the Transform and Reshape tools to allow you to make 
adjustments across all previously set keyframes or a selection of keyframes.

1 Select MultiFrame (M) in the Toolbar.

A red outline is drawn around the Viewer to let you know that MultiFrame is 
active. 

2 Drag the red ends of the MultiFrame range bar at the top of the Timeline to limit 
the keyframes affected by MultiFrame.

The MultiFrame range is displayed in the status bar while it is being edited.

3 Select either the Transform or Reshape tools, make a selection and modify the 
shape.

Only keyframes defined in the MultiFrame range are adjusted.
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RotoOverlay
The RotoOverlay tool provides three options to visualize the selected shape’s 
animation and motion blur: Motion Path, Motion Blur and Onion Skin.

1 Select RotoOverlay (O) in the Toolbar.

Once selected, a Roto Overlay window opens allowing you to select or deselect 
various options.

2 View each option separately. 

• Motion Path

Displays the shape’s motion path with visual indicators for frames and 
keyframes.

3 Hold Alt over a motion path marker and the frame number is displayed in the 
status bar. Click on the marker and the Timebar will jump to that frame.
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• Motion Blur

Displays a dashed line to show the width of the motion blur.

Note: When the Viewer is set to Foreground, this option allows you to visualize the 
motion blur without rendering it. This provides a significant speed increase when using 
many shapes with motion blur.

• Onion Skin

Shows the shape outline on previous and future frames.

4 Hold Alt over an onion skin shape and the frame number is displayed in the 
status bar. Click on the shape and the Timebar will jump to that frame.
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5 Change the Onion Skin Frame Range in the Roto Overlay window. This 
determines the amount of frames used in the onion skin.

Note: The first numeric field displays the frames before the current frame while the 
second numeric field displays frames after the current frame. By default, the two fields 
are ganged together. Click the lock icon to decouple them.

As an alternative to using the pre-defined colors for the Motion Path, Motion 
Blur and Onion Skin, you can use the default shape colors.

6 Enable Use Shape Color.

The color of the shape is now used for the selected overlay function.
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Rendering Shapes to Channels
Shapes can be assigned to different channels of an image when rendering.

1 Create four shapes.

2 Select a shape and in the Object window, set the Channel parameter to Red.

3 Assign the other three shapes as Green, Blue and Alpha.

Now that you have assigned the shapes to different channels, you can visualize 
the results prior to rendering using View > Channels in conjunction with the Alt-
R, G, B and A shortcut keys.

4 Choose View > Channels.

5 Use the Alt-R, G, B and A shortcut keys to see which shapes are assigned to the 
various channels.

6 When ready, render shapes into the assigned channels by connecting the Roto 
node’s Channels output to an Output node.

7 In the Output node, choose a file format that supports RGBA and make sure that 
RGB and Alpha are enabled in the Channels field.

Rendering Shape Outlines or Color Filled Shapes
Shapes can be outlined or filled with a color and rendered in the RGB output. 

1 Create some shapes.

2 In the Node parameters, activate Color > Enable.

3 Turn up the Outline Size parameter.

The shape outlines will now render in the RGB output. To change the shape’s 
outline color, use the Shape > Color parameter.

4 Set the Outline Size parameter to 0 and turn up the Fill Opacity.

The shapes are now filled with a color in the RGB output.

5 Select an individual shape and change the color in the Object window.

Each shape can have its own color.

6 If you’d like, you can globally change the opacity using the Color > Fill Opacity 
node parameter. You can also change the opacity of each shape separately using 
the Shape > Opacity control in the Object window.
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Importing and Exporting Shapes
Export
Silhouette, After Effects, Elastic Reality, Fusion, gMask (Combustion, Flint, 
Flame, Inferno), Nuke and Shake 4.x SSF shapes can all be exported. 

Silhouette
1 Select the shapes that you want to export.

If you are exporting using the Silhouette Shapes format, you can also export 
layers.

Note: Open shapes can only be exported using the Silhouette and Nuke 9+ Shapes 
formats.

2 Choose File > Export and select the shape format that you would like to export to.

To export to After Effects masks, use the Silhouette Shapes option. The 
Silhouette Shape Import/Export Plug-in is then required to import Silhouette 
Shapes into After Effects.

3 When the file browser opens, type a name and click OK to save the file.

A file is saved with the appropriate file extension.

Note: When exporting to Nuke, you can optionally fully bake shape and transform data, 
convert opacity to Nuke Lifetime, and export the Silhouette project name as determined 
by the Nuke 9+ Shapes preferences. 

Mocha Pro
Mocha Pro can export to the Silhouette Shapes format.

1 Select the shapes that you want to export.

2 Choose File > Export Shape Data and select Silhouette Shapes (*.fxs).

3 Click Copy to Clipboard or Save.

• Copy to Clipboard: The shapes and layers are copied to the system clipboard and 
can then be pasted into a Silhouette Roto node.

• Save: A file browser opens, type a name and click OK to save the file.

A file is saved with the appropriate file extension.
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After Effects
The Silhouette Shape Import/Export Plug-in for After Effects is required to 
export After Effects masks to Silhouette Shapes. When exporting After Effects 
masks, the following shape parameters transfer into Silhouette: opacity, blur, 
shape color, shape name, invert and locked states, transfer mode and per-
shape motion blur state.

1 Start Adobe After Effects, open a project and select a layer in the Timeline that 
contains After Effects masks.

2 From the After Effects File menu, choose Export > Silhouette Shapes.

A file browser opens.

3 Type a name and press OK to save the file.

All After Effects masks from the selected layer are exported and a file is saved 
with a .fxs file extension. 

Import
Silhouette
Silhouette, Mocha Pro, After Effects, Commotion, Elastic Reality and Shake 4.x 
SSF shapes can all be imported into Silhouette.

1 Choose File > Import and select the shape format that you would like to import.

A file browser opens.

2 Select the shape file to import and click OK.

The shapes are added to the current session.

Mocha Pro
Mocha Pro shapes and layers are imported into Silhouette using the Silhouette 
Shapes format. If Copy to Clipboard was used in Mocha Pro instead of saving 
to a file, the shapes and layers are copied to the system clipboard and can then 
be pasted into a Silhouette Roto node.
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Commotion
When importing Commotion shapes into Silhouette, the following shape 
parameters transfer into Silhouette: shape visibility, shape locked state, shape 
motion blur on/off state. If the shape is invisible in Commotion, it will start out 
invisible in Silhouette, so it might not look like it was imported unless you have 
the Object List open.

Shake
Shake 4.x shapes are imported into Silhouette, but attributes such as 
feathering, color and opacity are ignored.

After Effects
The Silhouette Shape Import/Export Plug-in for After Effects is required to 
import Silhouette Shapes and convert them to After Effects masks. When 
importing Silhouette Shapes, the following shape parameters transfer into After 
Effects: opacity, blur, shape color, shape name, invert and locked states, 
transfer mode and per-shape motion blur state.

1 Start Adobe After Effects, open a project and select a layer in the Timeline.

2 From the After Effects File menu, select Import > Silhouette Shapes.

A file browser opens.

3 Select the shape file to import and click OK.

Combustion
Import Shapes into Combustion

1 In a Mask operator, click on the Settings tab.

2 Under Mask Setups, click on Import and select the gMask file that you saved from 
Silhouette.

Elastic Reality
Import Shapes into Elastic Reality

1 With an Elastic Reality project open, select Shape >Import.

2 When the File Browser opens, choose the .ers file that you saved from 
Silhouette.
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Flint / Flame / Inferno
Importing Shapes into Flint / Flame / Inferno

1 Open the Garbage Mask Setup menu.

2 Click Load Setup.

3 When the File Browser opens, select the gMask file that you saved from 
Silhouette.

Fusion
Importing Shapes into Fusion

1 From a file browser window, drag the .setting file that you saved from Silhouette 
and drop it into a Fusion flow.

Nuke
Importing Shapes into Nuke
When using the Nuke 9+ Shapes export option, Nuke will import open/closed 
shapes, the shape feather, opacity, blend mode, invert, motion blur, outline 
color, fill color, shape blur (inner and outer blur only), and visibility. The layer’s 
blur, visibility and motion blur are also imported in addition to the node blur. You 
can optionally fully bake shape and transform data, convert opacity to Nuke 
Lifetime, and export the Silhouette project name as determined by the Nuke 9+ 
Shapes preferences.

1 Select File > Open and choose the .nk file that you saved from Silhouette.

Note: The imported shapes are set to render into the alpha channel only.

Importing Shapes into Shake 4.x
Shake will import the shape name, locked/unlocked state, opacity, visibility, 
motion blur on/off, shutter angle, and shutter phase. In addition, subtractive 
shapes import into Shake as black in the RGB channels with a white alpha 
channel.

1 Create a RotoShape node.

2 Click on the Import Shape Data from File icon.

3 When the File Browser opens, select the .ssf file that you saved from Silhouette.

4 Drag the slider in the Timebar to see your shape.
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Motion Blur
Motion blur is the directional blurring of rapidly moving shapes. To use Motion 
Blur, it must be activated for each individual shape as well as in the Roto node.

1 Select one or more shapes and enable Motion Blur in the Object window.

2 In the Node parameters, enable Motion Blur and adjust the Shutter Angle, Shutter 
Phase and Samples as desired.

When working with motion blur, it is best to keep your View set to Foreground. 
This way editing your shape will be quick and interactive.

3 Set your View to Foreground.
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When you need to view the motion blurred alpha channel, use Shift-A. Shift-A 
toggles the View to Output, superimposes the alpha channel over the image 
and deactivates the Overlay. Pressing Shift-A again returns the Viewer to its 
previous state.

4 To view the motion blurred alpha channel, press Shift-A.

Note: Normally, motion blur is calculated going forward, so if there is no shape motion 
beyond the end of a clip, there won’t be motion blur on the last frame. To work around 
this, add an extra frame or two to the end of the work range in the Timebar, make sure 
Show Work Range is disabled in the Timeline context menu, and then move the 
shape’s last keyframe to be outside of the Session range.

Renaming Objects
You can rename a shape, layer or tracker by:

1 Click on the object once to select it, hit the Enter key, type in the new name and 
press Enter again.

or

2 Double-click the object, type in a new name and hit the Enter key.

or

3 Right-click on the object, select Rename and type in a new name.
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Adding Notes
You can type an arbitrary length note for selected objects. Currently, only 
shapes, trackers and layers are supported.

1 Select a shape, tracker or layer.

2 In the Object List, click the Notes icon to the right of the selected object.

The Notes window comes forward.

3 Click in the Notes tab and type your note.

Because you can type multiple paragraphs into the Notes window, you must 
press Apply to assign the note.

4 Click Apply in the notes window.

The center of the Notes icon fills in once a note is applied to the object.

5 Hover over the Note icon in the Object List and the note is displayed as a tool tip.
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Timebar Keyframes
Colored markers in the shuttle area signify where selected objects have 
keyframes. These keyframes can be moved to a new position. Objects that 
display keyframes in the Timebar are shapes, trackers and painted frames. 
Path keyframes are shown for shapes, position keyframes for trackers and 
painted frames when in the Paint node.

The color of the markers is determined by the object color. If multiple selected 
objects have a keyframe on the same frame, the most recently selected 
object's color has precedence.

1 Press Shift-Alt and hover over one of the colored markers.

2 When the cursor changes to a double arrow, click and drag the marker to a new 
location.
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Using the Timeline
The Timeline is an overall view of all animated parameters. It provides you with 
the tools necessary to view, edit, move or delete keyframes as well as change 
their interpolation type using a Curve Editor.

Zooming the Timeline In or Out 
1 Use the scroll wheel to zoom the Timeline in and out.

or

2 Shift-Middle-mouse drag in the Timeline.

Panning the Timeline 
1 Use the Spacebar and click and drag to pan horizontally or vertically in the 

Timeline.
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Changing the Work Range
The Timeline displays the full session range with the work range displayed 
using a gray bar at the top of the Timeline.

The work range can quickly be adjusted by: 

1 Ctrl/Cmd-drag the ends of the work range bar to change the start and end.

2 Ctrl/Cmd-drag the work range bar to slide it forward and back while maintaining 
the duration.

Moving One Keyframe
1 Click on a keyframe to select it. 

2 Drag the selected keyframe to its new time.

Moving a Selection of Keyframes
1 Click on the starting keyframe to select it. 

2 Shift-click on the ending keyframe.

A range of keyframes is selected.

3 Click and drag one of the selected keyframes to the new location.

All selected keyframes move to the new location.

Adding a Marker
1 Move the Timebar to the desired frame.

2 Right-click in the Timeline and select Marker > Create/Edit.

3 Enter the marker text and click OK.

A light blue marker is displayed at the top of the Timeline.
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Curve Editor
The Curve Editor is a view mode in the Timeline that allows you to work with 
keyframe animations expressed as curves on a graph. It allows you to visualize 
the interpolation of the animation.

1 Animate a parameter by setting a couple of keyframes.
Once a parameter is animated, the Curve Editor icon appears to the right of the 
parameter in the Timeline.

2 Enable the Curve Editor icon.

The Curve Editor appears at the bottom of the Timeline.

3 Use the + or = keys to zoom in, the - key to zoom out or Space Bar-move mouse 
to pan the Curve Editor.

4 Click and drag a point to move it and Alt-click on the curve to add a new point.

5 Right-click on a keyframe in the Timeline or a point in the Curve Editor to bring 
up the pop-up menu.

The pop-up menu allows you to change the keyframe interpolation.
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Roto Blend
The Roto Blend node smoothly blends the opacity of shapes together.

1 Load some source footage and create a session.

2 In the Trees window, add a Roto Blend node from the Nodes > Image group and 
connect it to the source node.

3 Single-click in the center of the Roto Blend node to view and edit it.

4 Create multiple shapes.

5 Set each shape’s opacity to a different level.

The shape's different opacities automatically blend from one to another.

6 In the Roto Blend node parameters, you can change the Precision from Normal 
to Better for higher quality shape blending.

Before

Copyright © 2008--www.iofoto.com

After
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Tracker
Planar Trackers

Silhouette includes two Planar Trackers: Silhouette’s Planar Tracker and the 
Mocha Planar Tracker. Regardless of which one you use, the workflow is the 
same.

The key to getting the most out of the Planar and Mocha trackers is to learn to 
find planes of movement in your shot which coincide with the object that you 
want to track. Sometimes it will be obvious--other times you may have to break 
your object into different planes of movement. For instance, if you were tracking 
a tabletop, you would want to draw a spline to avoid a flower arrangement in 
the center of the table, since it is not on the same plane and will make your track 
less accurate.

Both the Planar and Mocha trackers require a selected layer with at least one 
shape in it to drive the tracker.

Note: If shapes are selected and not in a layer, clicking the Track Forward/Backward 
buttons will create a new layer, select it and begin tracking.

If shapes are selected in an unselected layer, clicking the Track Forward/Backward 
buttons will select the layer and begin tracking.

1 Load some source footage and create a session using the Roto template.

2 Make sure you are viewing and editing the Roto node by single-clicking on it.

Note: The Tracker is available as a separate node, but is also built into the Depth, 
Morph and Roto nodes. This tutorial demonstrates the use of the Tracker from within 
the Roto node.

3 Go to the frame where you want to start tracking.

4 Set the View to Foreground for the fastest speed when tracking. In the 
Foreground view, no processing occurs and therefore it is faster than View > 
Output.

5 Create a shape around the object that you would like to track and make sure that 
there is some detail inside of the shape. It does not have to be exact and it is best 
to leave a little extra room around the object. In addition, you can use more than 
one shape as long as they are on the same geometric plane.
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6 Choose the Tracker (Shift-T) in the Toolbar.

7 In the Tracker tab located at the bottom of the screen, select either the Planar 
Tracker or Mocha Tracker tab.

8 Enable Preview in Pre-Processing.

The image in the Viewer becomes black and white and displays the color space 
that you will track in.
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9 Select the color space to track with in the Channel pop-up menu. 

Pick the color space that displays the best contrast in the object you are 
tracking.

10 Disable Preview in Pre-Processing.

11 Select the tracking shape you created in the Object List.

12 Hit either the forward or backward track button depending on which direction 
you are tracking.
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Both the Planar and Mocha trackers require a selected layer with at least one 
shape in it to drive the tracker.

Note: If shapes are selected and not in a layer, clicking the Track Forward/Backward 
buttons will create a new layer, make it active and begin tracking.

If shapes are selected in an unselected layer, clicking the Track Forward/Backward 
buttons will make the layer active and begin tracking.

13 When the tracking is done, that’s it, you're done.

The tracking data is automatically applied to the selected layer.

14 After tracking, if you are not happy with the results, try the different techniques 
listed in Planar Tracking Tips and Tricks and Mocha Tracker Tips and Tricks.

15 If you want to use Stabilization, click the Stabilize icon above the Viewer and 
choose either the Active Layer or a layer from the list. Available layers are 
organized by node.



Silhouette User Guide    

• • • •••

Tutorials  133 
• • • •••

The Viewer is now stabilized based on the selected layer’s tracking data.

16 Make shape adjustments and keyframe it as necessary using the Reshape and 
Transform tools.

17 When shape editing is complete, click on the Stabilize icon (if it was activated) 
and select None to turn it off.

The Viewer is returned to its normal state.

Exclude Areas While Planar Tracking
In some cases, there are parts of an image that can interfere with the 
effectiveness of the Planar or Mocha trackers. To handle this, you can create 
subtractive shapes to exclude those areas from tracking.

Exclude Shape - To Be Tracked
When the exclude shape should be tracked by the Planar or Mocha trackers, 
create a subtractive shape above the primary tracking shape.

1 Create a shape around the object that you would like to track.

2 Create a shape around the area that you would like to exclude from the tracking 
process. Set the shape’s Blend mode to Subtract.

3 Place the subtractive shape above the primary tracking shape.

4 Select both shapes.

5 Hit either the Track Forward or Backward button depending on which direction 
you are tracking.

Note: When shapes are selected and not in a layer, clicking the Track 
Forward/Backward buttons will create a new layer, make it active and begin tracking.
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Now the area within the subtract shape is not analyzed by the Planar or Mocha 
trackers.

Exclude Shape - No Tracking
When the exclude shape should not be tracked by the Planar or Mocha 
trackers, create a subtractive shape above the layer to be tracked.

1 Create a shape around the object that you would like to track and place it in a 
layer.

2 Create a shape around the area that you would like to exclude from the tracking 
process. Set the shape’s Blend mode to Subtract.

3 Place the subtractive shape above the layer containing the primary tracking 
shape.

4 Select the layer you are tracking and then add the subtract shape to the selection 
by using Ctrl/Cmd-click.

Note: The same method used for shapes to exclude areas while tracking can be used 
for layers.

5 Hit either the Track Forward or Backward button depending on which direction 
you are tracking.

Now the area within the subtract shape is not analyzed by the Planar or Mocha 
trackers.
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Offset Planar Tracking Using Layers
There are times when the object you are planar tracking becomes obscured, 
and in these instances, you can use a layer to compensate for the obscured 
object.

1 Track an object using either the Planer Tracker or the Mocha Tracker.

2 When the object you are tracking becomes obscured or the track fails, hit the 
Cancel button in the Tracker Progress window.

3 Back up to the last properly tracked frame.

4 Select the Timeline tab at the bottom left of the screen.

5 After this point in the Timeline, delete any Transform:Matrix keyframes for the 
tracked layer.

6 Click on Transform (T) in the Toolbar.
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7 Set Transform keyframes for the selected layer at the last properly tracked frame 
by enabling the Animate icon for the layer parameters that you will be adjusting.

8 Move the Timebar forward to where the object you are tracking is no longer 
obscured and animate the layer parameters so that your shape matches the 
object you are tracking.

The manual keyframes you set take care of the animation of the object while 
the object was obscured.

9 Choose the Tracker (Shift-T) in the Toolbar.

10 If you are using the Planar Tracker, press the Reset button to reset the track 
points to account for the new location. This sets a new Reference point.

11 Hit either the forward or backward track button depending on which direction 
you are tracking.

Off     Enabled
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Smoothing Planar Tracked Layers
Smoothing planar tracked layers removes inaccuracies in the tracking data.

1 Select a layer which has been planar tracked.

Once selected, the layer displays tracking paths on the four corners and in the 
center of the frame.

2 Zoom into one of tracking paths on a corner of the image.

Viewing the path while adjusting the Smooth slider will provide visual feedback.

3 In the Tracker tab, choose Smooth and adjust the slider when it pops-up.
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The planar tracked layer is smoothed.
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Group Tracking
Multiple layers containing non-overlapping shapes can be tracked as separate 
planar surfaces.

1 Select multiple layers that contain non-overlapping shapes.

2 Track using the Planar Tracker.

Each layer is tracked as a separate planar surface.
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Part Tracking
Part Tracking uses multiple layers that contain overlapping shapes to aid in 
tracking non-planar surfaces.

1 Select multiple layers that contain overlapping shapes.

Make sure there is a good overlap between the shapes.

2 Track using the Planar Tracker.

The overlapping shapes share coarse motion, but have individual motion at the 
fine scale. This is helpful when tracking non-planar surfaces.



Silhouette User Guide    

• • • •••

Tutorials  141 
• • • •••

Planar Tracking Tips and Tricks
If you have trouble tracking a shot using the Planar Trackers, here are some 
tips and tricks.

General Tips and Tricks
Scrub Your Timeline
When starting a track, go through your footage a few times to see what your 
best options are for tracking. You will save yourself a lot of time by making note 
of obstructions and possible problem areas in advance.

Change The Tracking Features
By default, Tracking Features is set to Auto which tracks corners, edges and 
ridges simultaneously and then automatically selects the best result. Changing 
from Auto to Corners, Edges or Ridges may yield a better result.

Switch The Motion Model
Perspective is the default motion model, but Affine (tracks translation, rotation, 
scale, and skew) or Translation (tracks the XY offset) may better choices for 
your clip. In general, use Perspective for tracking larger shapes, Affine for 
medium shapes and Translation for small shapes.

Use Edges
When tracking surfaces, you will usually get a much better track if you include 
the edges and not just the interior of an object. This is because the Planar 
Trackers can define the difference between the background and the foreground 
and lock on better.

Track From The Largest, Clearest Point
In order for Planar Trackers to keep the best possible track, it is usually best to 
scrub through the timeline and find the largest and clearest area to begin 
tracking from, draw your shape there, then use backwards and forward tracking 
from that point.

For example, if you have a shot of a sign coming toward you down a freeway, 
it is usually better to start at the end of the clip where the sign is largest, draw 
your shape and track backwards, rather than start from the beginning of the 
clip.
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A Planar Surface Does Not Necessarily Have To Be Flat
We have a Planar Tracker which specifically tracks planes of motion, but this is 
not limited to tables, walls and other flat objects. Faces can be tracked very 
successfully around the eyes and bridge of the nose. Rocky ground, rumpled 
cushions, clumps of bushes, human torsos and curved car bodies are all good 
candidates. The key is low parallax or no obvious moving depth. When in 
doubt, try quickly tracking an area to see if it will work, as you can quite often 
trick the Planar Trackers into thinking something is planar.

Draw More Shapes
Remember you are not limited to one shape in a layer. Use a combination of 
shapes to add further areas or cut holes in existing areas to maximize your 
search.

Use Shapes Only For Tracking
You can use shapes for tracking purposes only and once the track is 
completed, you can hide or delete them.

Create Subtract Shapes
In some cases, there are parts of an image that can interfere with the 
effectiveness of the Planar or Mocha trackers. To handle this, you can create 
subtractive shapes in the area you are tracking.

Create a shape to subtract out areas of unwanted motion that may interfere 
with tracking and keyframe the shape as necessary. Place this shape above the 
layer that you are tracking and set the shape’s Blend mode to Subtract. Select 
the layer you are tracking and then add the subtract shape to the selection by 
using Ctrl/Cmd-click. Now when you track, the area within the subtract shape 
will be excluded.

Track From Different Points In Time
Depending on the motion of the object to be tracked, you may get better results 
if you track from the end to the beginning. You may also track from the middle 
to the beginning and then from the middle to the end.

Use A Different Channel To Track On
Change the Channel parameter from Luminance to Red, Green or Blue. The 
Channel parameter determines which image value the tracking algorithm uses.
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Utilize The Pre-Processing Filters
Use the Blur, Sharpen, Contrast, Gamma, De-Noise or Remove Flicker pre-
processing parameters.

Track The Foreground
Set the View to Foreground for the fastest speed when tracking. In the 
Foreground view, no processing occurs and therefore it is faster than View > 
Output.

There Is No Magic Bullet
The Planar Trackers are very flexible trackers and will save a lot of time, but 
you will eventually run into a piece of footage that just will not track. Large or 
continuous obstructions, extreme blur, low contrast details and sudden flashes 
can all cause drift or untrackable situations.

Mocha Tracker Tips and Tricks
In addition to the Planar Tracker Tips and Tricks previously mentioned, here is 
an important Mocha Tracker tip.

When In Doubt, Ramp Up Your Pixels
You can quite often get a great result with the default settings, but if you’re 
getting a lot of drift, try setting the Min % Pixels Used value higher. The 
processing can be slower, but you will usually get a much more solid track.
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Point Tracker
The Point Tracker uses trackers which are placed on distinguishable image 
features.

Note: The Tracker is available as a separate node, but is also built into the Depth, 
Morph and Roto nodes. This tutorial demonstrates the use of the Tracker from within 
the Roto node.

Creating a Tracker
1 Select the Tracker (Shift-T) in the Toolbar.

2 Go to the frame where you want to start tracking.

3 Set the View to Foreground for the fastest speed when tracking. In the 
Foreground view, no processing occurs and therefore it is faster than View > 
Output.

4 In the Tracker window located at the bottom of the screen, select the Point 
Tracker tab.

5 Press the Create button and a tracker is placed in the center of the image.

or

6 Alt-click on an open space in the image.
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As you pass your cursor over the image with the Alt key depressed, a zoomed 
region to the right of the tracker aids in selecting your Match Area.

Moving Tracker Components
1 Clicking and dragging directly on the Track point will move all components of the 

Tracker: Match Area, Search Region and Track Point simultaneously.

2 Clicking and dragging within the area of the Search Region will move only the 
Search Region.
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3 Clicking and dragging within the area of the Match Area will move both the 
Search Region and Match Area simultaneously, leaving the Track Point at its 
current location. This would be used for Offset Tracking when the original track 
point becomes obscured.

Scaling Tracker Components
1 Clicking and dragging on the corners of the Match Area bounding box scales 

both the Match Area and Search Region.

2 Clicking and dragging on the corners of the Search Region bounding box scales 
only the Search Region.

Tracking an Image
1 Adjust the size and position of the Match Area and Search Region.

2 Right-click on the tracker and select the color space to use in the Channel sub-
menu.

3 Hit either the forward or backward track button.

Silhouette will analyze the motion for each frame in the clip.
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Offset Tracking
There are times when your original Match Area gets obscured, and in these 
instances, you can offset the Match Area and Search Region from the Track 
Point.

1 Create a tracker and track a portion of the clip until the Match Area becomes 
obscured.

2 Hit the Stop button in the Tracker Progress window.

3 Back up to the last properly tracked frame.

4 Click and drag somewhere within the Match Area and both the Match Area and 
Search Region will move simultaneously, leaving the Track Point at its current 
location.

5 Click the forward tracking button to continue tracking.

The Track Point follows the same path, but the new Match Area is used to 
acquire the tracking data.

Tracking Difficult Shots
Some clips are difficult to track because of erratic motion or the occlusion of the 
feature that you are attempting to track. In these cases, you can do a bit of hand 
tracking using one of two methods: 

• By pre-keyframing the tracker at various frames throughout the clip.

• Keyframing a shape and then creating tracker keyframes based on the shape’s 
motion.

Keyframing the Tracker
1 Create a tracker.

2 Adjust the tracker to match the object at various frames throughout the clip.
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3 In the Tracker tab, change the Behavior to Key Frames.

The Tracker Match Area will now use these keyframes as a reference while 
tracking.

Create Tracker from Shape Center
1 Create a shape around the feature that you would like to track. Go to various 

frames throughout the clip and adjust the shape to match the feature.

2 Select the Tracker tool and right-click on the shape. 

3 From the pop-up menu, select Create Tracker from Shape Center.

A tracker is automatically created around the center point of the shape and any 
shape keyframes are automatically applied to the Tracker. 

4 In the Tracker tab, change the Behavior to Key Frames.

The Tracker Match Area will now use these keyframes as a reference while 
tracking.
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Modifying Tracking Data
Averaging Trackers
Averages multiple tracks into a new destination track. A common technique is 
to track forwards from the first frame to the last, and then create a second track, 
tracking backwards from the last frame to the first. These two trackers are then 
averaged together to derive a more accurate track. 

1 Select more than one tracker.

2 In the Tracker tab, choose Average.

A new averaged tracker is created.

Smoothing Trackers
Smoothing trackers removes inaccuracies in the tracking data.

1 Select a tracker to smooth.

2 Zoom into the tracker’s path.

Viewing the path while adjusting the Smooth slider will provide visual feedback.
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3 In the Tracker tab, choose Smooth and adjust the slider when it pops-up.

The tracker is smoothed.

Merging Trackers
If you have multiple trackers that cover different frame ranges, they can be 
merged into one tracker, automatically compensating for the different offsets.

1 Select multiple point trackers that cover different frame ranges.

For instance, you may have one tracker that covers frames 1-25, another 25-
75 and the last one from 75-100. Ideally, the trackers should overlap in time by 
at least one keyframe.

2 Click the Merge button.

A new tracker is created that covers the frame range encompassed by the three 
trackers.
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Applying Trackers
Match Moving and Stabilizing Layers
In general, tracking data should be applied to layers instead of individual 
shapes. The tracking data is copied into the transform of a layer (containing 
shapes) allowing you to have separate keyframes for both the layer 
transformation and for the shapes. This results in far fewer shape keyframes 
than other methods and is the preferred way of working with clips in motion. 
The result is a very flexible method for discrete editing of layer and shape 
transformations.

Once applied to a layer, the tracking data can be used in Match Move or 
Stabilize mode. In Match Move mode, the clip moves as normal and the shape 
follows along according to the tracking data. In Stabilize mode, the clip is locked 
in place by stabilizing the Viewer. In either mode, you only need to keyframe 
the shape when it changes form.

1 Select the trackers that you would like to use.

2 Press the Apply button.

• With only trackers selected, clicking Apply creates a new layer and the tracking 
data will be applied to that layer.

• If a layer is selected along with the trackers, the tracking data will be applied to the 
selected layer.

You have a choice of applying position, scaling and/or rotation. However, 
scaling and rotation require two trackers.
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3 Select Position, Rotation and/or Scaling and click OK.

The tracking data is applied to the Layer’s > Transform > Matrix parameter.

4 Create a shape inside of the layer.

If you look at various frames in the clip, you’ll see that the shape is match 
moved to the motion of the image. 

5 If you want to use Stabilization, click the Stabilize icon above the Viewer and 
choose either the Active Layer or a layer from the list. Available layers are 
organized by node.

The Viewer is now stabilized based on the selected layer’s tracking data.

6 Make shape adjustments and keyframe it as necessary using the Reshape and 
Transform tools.
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7 When shape editing is complete, click on the Stabilize icon and select None to 
turn it off.

The Viewer is returned to its normal state.

Each layer can have different tracking data applied to it. Just go to the Tracker 
tab and apply the motion from other trackers to other layers.

Four Point Corner-Pin Tracking
Four-point tracking is traditionally used to match the perspective of a square or 
rectangular shape by tracking its four corners and applying a corner-pin 
transformation.

1 Create four trackers on the corners of a square or rectangular object and track 
the motion.

2 Create a layer in the Object List using the Add Layer icon. 

The new layer is active and you can tell by the check mark icon in the box to 
the right of the layer name in the Object List. 

Note: Point tracking data is only applied to the active layer.

3 Select the four trackers.

4 Press the Apply button.

The corner-pin data from the four trackers is applied to the layer.

5 Create a square shape inside of the selected layer. When drawing the shape, it 
should be placed near the location of the four trackers.

If you look at various frames in the clip, you’ll see that the shape’s motion is 
matched to the motion of the image. 
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Match Moving Points
Match moving applies the motion of a tracker to individual points on a shape. 

Note: Match moving individual points results in keyframes being set on every frame of 
the shape and can make it cumbersome to later edit those points. This functionality has 
been added to Silhouette as some users prefer to work with this way.

1 Select a tracker.

2 Click on a shape to select it and then select a point.

Note: To select points on a shape, you must first select the shape by clicking on the 
shape outline. Then, Ctrl/Cmd-click each point that you would like to select. Also, when 
a tracker overlaps a point, it will be difficult to select the point while in the Tracker. To 
select a point that overlaps a tracker, switch to the Reshape tool, select the point and 
switch back to the Tracker.

3 Right-click over a selected point and choose Apply from the pop-up menu.

The tracking data is applied to the point.
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Point Tracker Tips and Tricks
If you have trouble tracking a shot using the Point Tracker, here are some tips:

• Set the View to Foreground for the fastest speed when tracking. In the Foreground 
view, no processing occurs and therefore it is faster than View > Output.

• Stop the tracker, go to the bad frame and reposition the Track Point, and hit the 
tracking button again. You don't need to go back to your start frame. 

• Lower the Tolerance value, and track again from the beginning, or the frame 
before the bad frames. The lower the Tolerance, the more forgiving the tracker will 
be--but also less accurate.

• Start over and switch Behavior from Start Frame to Every Frame. This means that 
instead of trying to compare the tracking region with the first “pure” frame, it will 
try to match to the previous frame. If you re-track from the middle of a clip, it will 
consider your new start frame as your reference frame with either setting.

• Use the Blur, Sharpen, Contrast, Gamma, De-Noise or Remove Flicker pre-
processing parameters.

• At any time, you can manually adjust the Track Point by simply grabbing it and 
putting it where you need to.

• Change the Channel parameter from RGB to Luminance, Red, Green or Blue and 
re-track. The Channel parameter determines which image value the tracking 
algorithm uses.

• A technique you can use to assist with difficult shots is to manually insert tracking 
keyframes. For example, if you have 100 frames to track, you can put in a keyframe 
every 5 or 10 frames by repositioning the Tracker. Once your keyframes are 
manually entered, return to frame 1 and set the Behavior to Key Frames. The 
tracker searches along the tracker's pre-existing motion path to find matching 
patterns.

• You can use the same technique as in the previous tip, but with the following 
differences. Create a shape around the feature that you would like to track. Go to 
various frames throughout the clip and adjust the shape to match the feature. 
Select the Tracker tool and right-click on the shape. From the pop-up menu, select 
Create Tracker from Shape Center. A tracker is automatically created around the 
center point of the shape and any shape keyframes are automatically applied to 
the tracker. In the Tracker window, change the Behavior to Key Frames. The 
tracker Match Area will now use these keyframes as a reference while tracking.
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Match Move or Stabilize Images
Match moving and stabilization is achieved through the Transform node in 
conjunction with the Tracker. The Tracker outputs transformed layers for use in 
other nodes. For instance, the Transform and Paint nodes have tracker inputs 
as do other nodes that contain point controls. When the output of a Tracker 
node is plugged into a node’s Transform input, the Tracker’s transformed layers 
are available to match move or stabilize.

Match Move
1 Load some source footage and create a session.

2 In the Trees window, drag a Tracker node from the Nodes > Transform group onto 
the source node you want to track.

3 Add a Transform node from the Nodes > Transform group and connect it to the 
source node you want to match move.

4 Connect the Tracker output into the Transform node’s Transform input located at 
the top right of the node.

The Transform input is colored yellow.

5 Single-click in the center of the Tracker node to view and edit it.

6 Track an object and apply the tracker to a layer.

7 Single-click in the center of the Transform node to view and edit it.
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8 Select a point tracker or tracked layer from the Transform > Transform pop-up 
menu.

9 Select Match Move in the Transform > Mode pop-up menu.

The tracking data from the selected layer is applied to the image and it is match 
moved.

10 If necessary, you can use the Transform node’s parameters in conjunction with 
the tracking transform.

Stabilize
1 Load some source footage and create a session.

2 In the Trees window, add a Transform node from the Nodes > Transform group 
and connect it to the source node.

3 Drag a Tracker node from the Nodes > Transform group onto the source node.

A new branch is created.

4 Connect the Tracker output into the Transform node’s Transform input located at 
the top right of the node.

5 Select Stabilize in the Transform > Mode pop-up menu.

The tracking data from the selected layer is applied to the image and it is 
stabilized.

6 If you’d like, you can now add various elements to the stabilized image.
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7 To reapply the clip’s original motion, copy the original Transform node used to 
stabilize the image, paste it after the added elements, and hook the Tracker 
node’s output into the new Transform node’s Transform input.

8 Change the new Transform node’s Transform > Mode from Stabilize to Match 
Move.

The image now has the original motion applied to it.
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Importing and Exporting Tracking Data
Exporting Tracking Data
Trackers can be exported to the After Effects, Autodesk, Nuke and Shake 
tracker formats. In addition, the tracking data applied to a layer, either by Point 
Trackers or Planar Trackers, can be exported as a four point corner-pin track.

Note: Mocha Planar tracking data can not be exported as external trackers.

Exporting One to Two Trackers
1 Choose the Tracker (Shift-T) in the Toolbar.

2 Select the trackers that you want to export.

3 Choose Export in the Tracker tab and select the tracker format.

4 When the window pops-up, type in a name and click Save.

Currently, you can export to the After Effects, Autodesk, Nuke and Shake 
tracker formats.

Exporting Four Trackers for Corner-Pinning
1 Choose the Tracker (Shift-T) in the Toolbar.

2 Using the Shift key, select the four trackers that you want to export in a Z pattern: 
Upper Left, Upper Right, Lower Left and Lower Right.

3 Choose Export in the Tracker tab and select the tracker format.

4 When the window pops-up, type in a name and click Save.

Exporting a Layer as a Four Point Corner-Pin
1 Select the layer that you want to export.

2 Press the Tracker (Shift-T) in the Toolbar, Choose Export in the Tracker tab and 
select the tracker format. 

3 When the window pops-up, type in a name and click Save.

Note: When exporting a four point corner-pin track to Autodesk products, it is better to 
use four trackers instead of the tracking information from a layer.
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Importing Tracking Data
Mocha Pro, After Effects Corner-Pin, Nuke 8 and above, Shake or Simple 
Format formatted trackers can be imported into Silhouette. If you would like to 
import trackers from non-supported applications, simply export a Silhouette 
tracker in Simple Format to see how it should be formatted.

Silhouette
1 Select the Tracker (Shift-T) in the Toolbar.

2 Choose Import in the Tracker tab.

3 Select the Mocha Pro, After Effects Corner Pin, Nuke, Shake or Simple Format 
tracker file that you would like to import and click Open.

If you select multiple trackers in the import dialog, more than one tracker can 
be imported at a time.

4 If you used Copy to Clipboard when exporting to Silhouette Corner Pin in Mocha 
Pro, you can paste the trackers into a Silhouette Roto node.

Note: With some formats, the imported trackers may not line up with the tracked 
feature. If so, use MultiFrame mode to move the tracker and it’s keyframes into the 
proper location.

After Effects
1 Double-click on the tracker text file that you exported from Silhouette.

The value of the Comp Pixel Aspect Ratio line at the top of the exported tracker 
file must match the Pixel Aspect Ratio in the After Effects Composition settings. 
Edit the exported tracker file as needed.

2 Press Ctrl/Cmd-A to select all and Ctrl/Cmd-C to copy.

3 In After Effects, select a layer in the Timeline and press Ctrl/Cmd-V to paste the 
Tracker Data.

Note: If you exported a limited work range in Silhouette, go to the start frame of the 
work range in After Effects before pasting. 

4 Open the Window > Tracker controls.

5 In the Motion Source pop-up, select the layer where you pasted the tracking data.

6 From the Current Tracker pop-up, select the Tracker that you just pasted. If you 
only have one tracker, this would be Tracker 1.

7 Change the Track Type from Raw to one of the available options.
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8 Click Edit Target and choose the layer that you would like to apply the motion to.

9 Hit Apply.

Combustion
Importing One to Two Trackers into Combustion

1 Click on the Tracker tab.

2 In the Source pop-up, choose your layer.

3 Select the Track type: Position, Scale or Rotate.

4 Click on the Import Data button and pick Discreet Tracker Setup.

5 Load the tracker file that you saved from Silhouette.

Importing Four Trackers into Combustion
1 Create a 3D Workspace.

2 Import two layers into your Composite workspace.

3 Click and select the layer that you want to corner-pin and make sure it is at the 
top of the stack.

4 In the Composite Controls > Layer Tab, activate Four Corner.

In your Viewport, the layer will have a point on each corner of the image. 

5 Click and drag each corner point to the position where you want your layer 
placed after the trackers are imported.

6 Using the Shift key, select the four corner points.

The points turn yellow when they are selected.

7 Click on the Tracker tab.

8 In the Source pop-up, choose the layer the tracking data was derived from.

9 Select the Position Track type.

10 Click on the Import Data button and pick Discreet Tracker Setup.

11 Load the tracker file that you saved from Silhouette.

Note: When importing a four point corner-pin track in Combustion, it is better to use 
four trackers instead of the tracking information from a layer.

Flint / Flame / Inferno
1 Select the Stabilizer.
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2 Click on the Imp button below the Track fields and select the tracker file that you 
saved from Silhouette.

Note: When importing a four point corner-pin track in Flint, Flame and Inferno, it is 
better to use four trackers instead of the tracking information from a layer.

Nuke
1 Choose File > Import Script and select the tracker file that you saved from 

Silhouette.

Shake
1 Add a Tracker, Match Move or Stabilize node.

2 In the Tracker node, click the Load button in the Parameter tab and select the 
tracker file that you saved from Silhouette.

3 For the Match Move and Stabilize nodes, right-click on one of the trackName's in 
the Parameter tab and choose Load Track File.

4 Select the tracker file that you saved from Silhouette.
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Paint
Paint is a high dynamic range, non-destructive, 2D raster based paint system 
designed from the ground up to handle the demands of feature film and 
television production. Whether it’s image restoration, dustbusting, wire and rig 
removal or just plain paint, Silhouette provides simple and sensible tools to get 
the job done.

Using Paint
1 Load some source footage and create a session using the Paint template.

2 Make sure you are viewing and editing the Paint node by single-clicking on it.

In the Paint node, various non-animateable controls appear in a Paint window 
located at the bottom portion of the screen. Silhouette provides a wide variety 
of paint tools that are organized into Presets, Brush, Profile and Paint tabs.
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In addition, a number of different brushes are selectable from the Paint Toolbar 
to the left of the Viewer.

Black & White

Blemish
Blur

Cutout

Drag

Mosaic

Repair

Color

Clone

Scatter

Stroke

Color Correct

Eraser

Detail

Dodge

Burn

Grain
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Once a brush is selected, its controls appear on the left side of the Paint 
window.

3 Select the Color brush (Shift-C). By default, it is preset to white.

4 Paint on the image in the Viewer by pressing and dragging with your pen or 
clicking and dragging with your mouse. You can quickly draw straight lines if you 
press Alt, click and then click in a different location. If you keep Alt depressed 
while clicking, you will create interconnected straight lines.

5 In the Paint window’s Profile tab, adjust some of the settings to see how it 
changes your brush. 

In addition to the Profile > Size control, the brush can also be resized by using 
the [ and ] bracket keys in the Viewer or by holding Ctrl/Cmd and dragging the 
brush outline.

6 Experiment with some of the other brushes in the Brush Toolbar.
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7 Adjusting the brush parameters located on the left side of Paint window will 
change the effect of the brush when you paint. 

By default, you are painting on the RGB channels of the image. However, you 
can paint individually on the red, green, blue or alpha channels as well as 
simultaneously paint on the RGB and alpha channels using the Paint tab.

8 In the Paint window’s Paint tab, click on R to paint only the Red channel.

9 Paint on the image.

10 If you view the individual Red, Green and Blue channels using the RGBA buttons 
in the Viewer, you will see that only the Red channel is affected.

11 Select the horizontal white bar above the RGBA buttons to quickly toggle the 
display of the image back to full color mode.

At any time, you can clear all paint strokes and restore the original unpainted 
frames by using Delete in the Paint tab. You can restore the Current Frame, the 
Work Range, or All Frames.

12 In the Paint tab, select Delete > All Frames to clear all paint strokes on all frames.

13 Go to frame 1 of the clip and paint on the image.

14 Advance to frame 2.

As you change frames in the clip, the painted frames are stored to disk. Paint 
on the current frame is also saved with File > Save.

15 Go back to frame 1 and you will see that your paint stroke has been recorded.

16 Paint some more frames in the clip.
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As frames are painted, a marker is shown in the Timebar to provide a visual 
display of which frames are painted.
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Onion Skin
The Viewer > Onion Skin mode is useful for creating frame by frame, hand 
painted animations. Onion Skin does a mix, as defined by the Mix value, 
between the current frame and either previous or later frames.

1 Click the Onion Skin icon in the Viewer and then the down bracket to reveal the 
controls.

By default, Onion Skin is set up to display a mix to the previous frame.

2 To change the Onion Skin frame range, adjust the Backward/Forward numeric 
fields.

Paint Presets
Brush presets can be saved using the Presets tab on the left side of the Paint 
window. It allows you to save all of the brush parameters as a preset.

1 To save a preset, select a brush and adjust its controls.

2 Click Save and then choose one of the numbered presets.

Note: Saved presets are highlighted blue. Clicking a blue preset after selecting Save 
will overwrite it.
Once saved, you can use the Alt-0 through Alt-09 keyboard shortcuts to 
quickly select one of the presets.

3 Clear a paint preset by pressing Save, then Alt-clicking on the preset.
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Clone Brush
Paints with sampled pixels from an image with the ability to grade (color 
correct), blur, sharpen or warp the clone source.

Selecting the Clone Source
1 Choose the Clone brush (C) from the Toolbar.

2 In the Clone controls, select Output, Foreground or Input 1-5 in the Source pop-
up menu.

Output is the painted output of the Paint node and when selected, clones from 
previously painted areas. Foreground clones from the foreground image, while 
Input 1-5 are additional clone sources that clips can be connected to on the 
Paint node.

3 If you’d like, set the Frame parameter to choose which source frame to paint 
from.
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Setting the Clone Offset
Set your clone source offset by one of the following methods:

1 Shift-clicking, dragging and releasing in the Viewer.

2 Press and hold down the Shift key. Click once to set the clone source and click 
once again in a different location to set the Clone target.

3 Press Q (Translate), W (Rotate) or E (Scale) and click and drag to translate, rotate 
or scale the clone source. Onion Skin mode is automatically activated once the 
Q, W or E key is pressed. Press whatever key you pressed (Q, W or E) again to 
deactivate the mode.
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4 Turn on Interactive mode and use the on-screen controls.

• Use the up, down, left and right arrow keys to nudge the clone source.

• Adjust the Position (Offset), Scale, Rotate, and Corner-Pin > TL (Top Left), TR (Top 
Right), BL (Bottom Left) and BR (Bottom Right) numeric fields.

 Clone Transform On-Screen Controls

Shortcut Action

Drag within large center circle Moves the clone source

Shift-drag within large center circle Constrain clone source movement horizontally or 
vertically

Drag the center square horizontal and vertical 
halfway points

Scales the clone source horizontally or vertically

Drag a center square corner Proportionally scale the clone source

Drag large center circle Rotate the clone source

Ctrl/Cmd-drag large center circle Rotates the clone source with finer control

Drag handles on corners of image Corner-pins the clone source

Drag dash above large circle Skews the clone source horizontally

Drag dash to the right of large circle Skews the clone source vertically
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Define a Clone Transform Region
You can change the position and size of the Clone transform on-screen control 
rectangle which allows the effect of the corner-pin to be controlled from a 
specific region.

1 Press the Region button to enable it.

2 Click-drag to create a region.

3 Alt-click and drag to create new region when one already exists.

4 Click and drag inside a region to move it or drag the region handles to resize.

5 When you are ready to adjust the Clone transform, enable Interactive mode.

Note: When there are no on-screen controls (center square and circle) within the Clone 
transform bounding box, a region is active.

6 Use the on-screen controls to adjust the clone source.

The effect of the corner-pin is now controlled by the region, and the scale and 
rotation anchor points are set to the region’s center.

7 To clear a region, enable Region and tap outside a region box without dragging.
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Brush Compare Modes
Four brush compare modes preview brush settings prior to painting. You can 
choose from Onion Skin, Align, Vertical Split and Horizontal Split.

The Caps Lock key toggles the compare modes on and off.

Note: The compare modes are not available for the Drag, Repair, and Cutout brushes. 
Onion Skin and Align mode only work with the Clone brush.

Using Brush Compare Modes With the Clone Brush
1 Activate Onion Skin or compare mode if you need to line up the clone source and 

target images.

• Select the Onion Skin icon to activate it and then align the clone source.

or

• Select the Align icon to activate it and then align the clone source.
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Align inverts the clone source and mixes it with the foreground, creating an 
embossed effect when similar images are not aligned. When perfectly aligned, 
the Viewer appears gray or black depending on the state of the Paint > Clone 
> Alignment Type preference.

2 Once the clone source offset is set, deactivate Onion Skin or Align mode by: 

• Clicking the selected icon.

 or 

• Pressing the Caps Lock key to toggle the compare mode off.

Very often, you will encounter two images from the same location that are not color 
matched.

3 If the clone source needs to be color corrected to match the area to be painted, 
select the Grade/Filter tab.

4 Choose the Vertical Split icon to compare the clone source and target using a 
split screen.

The split is handy when using the Grade/Filter controls to color match the clone 
source to the target.

Note: The | key (vertical bar) keyboard shortcut snaps the vertical split position to the 
cursor position.

5 Adjust the Gain/Gamma/Lift numeric controls by dragging on them.

Not Aligned Aligned



Silhouette User Guide    

• • • •••

Tutorials  175 
• • • •••

6 Click the Lock icon to move the numeric fields individually. This un-gangs them.

Note: Once a Grade/Filter or Warp parameter has been adjusted, a green dot appears 
to the right of the tab to indicate that a change was made.

7 Prior to painting, click the Vertical Split icon to disable it.
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Automatic Color Correction
The Grade/Filter > Auto Grade feature automatically color corrects the clone 
source to match the location you are painting.

1 Select the Grade/Filter tab.

2 Enable Auto Grade.

3 Paint a stroke.

Now, when you paint, Silhouette automatically color corrects the clone source 
to match the location you are painting.

Note: The Gain, Gamma, Lift, Hue and Saturation controls are disabled when using 
Auto Grade.

Manual Color Correction
The steps below contain some useful tips when doing manual color correction.

1 Select the Grade/Filter tab.

2 Make sure Auto Grade is not enabled.

3 Choose the Vertical Split icon to compare the clone source and target using a 
split screen.

The split is handy when using the Grade/Filter controls to color match the clone 
source to the target.

4 Move your cursor into the image area over the split line and when the cursor 
changes to a double-arrow, click and drag to move the split line to the location 
where you will be painting and where you want to do the color matching. The 
split line may not be obvious, so white triangles on the edges of the Viewer will 
help you find it.

By isolating individual color channels, it is easier to match the colors.

5 In the Viewer, look only at the Red channel (Alt-R).
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6 Ctrl/Cmd-drag (for finer accuracy) the Gain > Red numeric field so that the 
luminance values on either side of the split line match.

Tip: Set your Update mode to Drag or Adaptive. As you drag a parameter, Silhouette 
is constantly rendering. This makes the color adjustments more interactive.

7 In the Viewer, look only at the Green channel (Alt-G).

8 Ctrl/Cmd-drag (for finer accuracy) the Gain > Green numeric field so that the 
luminance values on either side of the split line match.

9 In the Viewer, look only at the Blue channel (Alt-B).

10 Ctrl/Cmd-drag (for finer accuracy) the Gain > Blue numeric field so that the 
luminance values on either side of the split line match.

11 Press Alt-B again to toggle off the Blue channel and to display the RGB channels 
in the Viewer at the same time.

Your clone source and target should now be color matched.

12 Toggle off the Vertical Split and paint the image.

13 To reset the Clone offset, press Shift and without moving the cursor, click your 
mouse or tap your pen on the screen once.

The Clone offset is quickly set to a 0,0 offset.
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Using Clone > Warp
The Warp tab in the Clone Brush allows you to warp specific image areas using 
pins, while leaving other areas untouched. Adjustments can range from subtle 
nip and tucks to something more obvious like repositioning an arm or leg.

1 Choose the Clone brush (C) from the Toolbar.

2 Select the Warp tab.

When the Warp tab is selected, Onion Skin mode is automatically activated so 
you can see the warp effect once a pin is added.

Tip: Change the Mix value to 100 if you want to see the warped image at 100%.

3 Click-drag on the image to create a pin that contains a source and target.The 
farther the target (red circle) is dragged from the source (green circle), the more 
the image warps. You can add up to 20 pins.

4 To constrain the warp, click-release on the image to set a tack.

Before

Photo by Tim Easley on Unsplash

After
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The tack acts as a barrier and limits the effects of the warp.

In addition, each pin and tack has a radius which determines its strength.

5 Hover over a pin to display the radius.

6 Shift-drag the pin radius to adjust it.

7 To track the pins and tacks, select a tracked layer from the Warp > Transform 
pop-up menu.

The pins and tacks are now transformed by the motion of the tracked layer.

Go to the Pin Warp node for more information.

Source

Target

Tack
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Aligning Features from Different Images
Oftentimes, you need to align the same feature in two different frames of a clip 
when painting with the Clone brush.

1 In the Clone controls, select Output, Foreground or Input 1-5 in the Source pop-
up menu and then set the Frame parameter to choose which source frame to 
paint from.

2 Press the ‘ key (located to the left of 1 key).

The clone source image automatically appears in the Viewer.

3 Set the Onion Skin mix to 100.

4 Click on the clone source feature that you want to paint from.

The Clone target image automatically appears in the Viewer.

5 Click on the Clone target feature that you want to paint on.

The Clone offset is set.
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Dual Clone Brush
Two Clone presets can be activated at once. This allows you to paint from two 
different images or locations, using separate Transform, Grade/Filter and Warp 
settings.

1 Select the number 1 Clone preset.

2 Set the clone source Transform, timing, Grade/Filter and Warp controls.

3 Choose the number 2 Clone preset and set its clone source Transform, timing, 
Grade/Filter and Warp controls.

4 Press the Dual icon below the presets.

A Mix control now appears at the top right of the Clone controls.

5 Change the Mix parameter to set the relative opacity of the two clone sources.

6 When you paint, both Clone presets will contribute to the painted result.
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Create And Paint An Oversized Plate
Using the DOD (Domain of Definition) node in conjunction with the Viewer > 
ROI (Region of Interest) is a simple way to create an oversized plate to paint on.

1 Load some source footage and create a Session.

2 Connect a DOD node from the Transform tab to the source.

The DOD node defines the size of the DOD. The DOD can be expanded or 
reduced.

3 Set the Size > Width and Height to a size larger than the Session. Alternatively, 
you can drag the DOD’s on-screen controls or Shift-drag any on-screen control 
handle to add the equivalent amount to the other side.

Setting the DOD larger than the Session size will pad the image and the ROI 
can access the additional image area.

4 Display the ROI controls by clicking the ROI icon above the Viewer.

Once the ROI icon is activated, the ROI controls appear above the Viewer.

5 Make sure the Enable button is active.

6 Click the Set ROI to Current DOD icon in the ROI controls. 

The ROI will automatically be set to match the size of the DOD’s width and 
height.

7 You can now select a brush and paint beyond the boundaries of the original into 
the padded areas.
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Display Roto Shape Outlines In the Paint Node
Shape outlines from a Roto node can be displayed in a Paint node. While 
painting, this can be useful in determining the edge of a shape’s alpha channel 
without viewing it.

1 Connect a Roto node’s Objects output into a Paint node’s Objects input.

2  Enable Show Shapes in the Paint tab.

The shape outlines from the Roto node can now be seen in the Paint node.

3 Enable Obey Alpha with Alpha Source set to Foreground.

Painted strokes will now only appear within the area of the Foreground alpha.

4 Click Invert Alpha to paint outside of the input alpha.

See the Obey Alpha - Use Input Alpha section for more information.
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Alpha Channels
Alpha channels can be used to control where you paint in the RGB channels 
with the source of the alpha coming from an image or by painted strokes. Alpha 
channels can also be painted on and modified.

Obey Alpha - Using Painted Alpha
Paint Temporary Alpha
Painting temporary alpha can limit where you paint in the RGB channels.

1 Select the Color brush (Shift-C).

2 Enable only the A channel in the Paint tab.

3 Press the A key once to superimpose the alpha channel over the image.

Now when you paint, you will see the alpha channel superimposed as a blue 
color over the RGB channels.

4 Paint over an area of the image.

5 Press the A key twice more to remove the alpha overlay.

6 Disable A and enable RGB.

Obey Alpha
1 Enable Obey Alpha in the Paint tab.

2 Set the Alpha Source to Output.

Output uses the painted output alpha as the obey alpha source.

3 Paint some strokes.
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When you paint, you can only modify the RGB channels in the area of the 
painted alpha.

4 If you’d like, enable Invert Alpha to paint the RGB channels anywhere but where 
the alpha exists.

Obey Alpha - Use Input Alpha
The alpha from source layers and images can be used to control where you 
paint.

1 Enable Obey Alpha in the Paint tab.

2 Set the Alpha Source to Foreground or Input 1-5.

Foreground uses the alpha from the Foreground input as the obey alpha 
source. For instance, you can use the Roto node plugged into the Foreground 
input to control where you paint in the RGB channels.

3 Paint some strokes.

When you paint, you can only modify the RGB channels in the area of the input 
alpha.

4 If you’d like, enable Invert Alpha to paint the RGB channels anywhere but where 
the alpha exists.

Note: To view the input alpha, you will need to switch the View pop-up menu to the 
source containing the alpha.
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Detail Separation In the Paint Node
Paint separates the image into color and detail layers. By default, the color and 
detail layers are painted simultaneously in Normal mode, but can also be 
painted separately in Color and Detail modes. Painting in Color mode 
preserves detail while painting in Detail mode preserves color.

Preserving Detail
Selecting Color mode preserves detail and only affects the color layer. This is 
useful for evening out the color and tone of the image.

1 Click the Color button in the Paint tab.

2 Select View > Detail Layer or press the 9 keyboard shortcut.

The Detail Layer is now displayed in the Viewer.

3 Click the pop-up menu to the right of Detail Level field and select the Fine preset.
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This sets the Detail Level to 1 which selects fine details such as skin blemishes, 
pores, hair, and wrinkles. A Detail Level of 0 is coarse detail, .5 is medium detail 
and 1 is fine detail.

Note: You can also variably set the Detail Level using the numeric field.

Original Coarse

Medium Fine
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4 Select View > Output or press the 1 keyboard shortcut.

The output of the Paint node is now displayed in the Viewer.

Note: With the exception of Cutout and Eraser, all brushes can be used in the Color 
and Detail modes.

5 Use the Dodge brush (Alt-Shift-D) to lighten areas in the image or the Burn brush 
(Alt-Shift-B) to darken areas in the image.

As you paint, only the color layer is affected and detail is preserved.

6 Use the Clone, Blur and Drag brushes to even out the color and tone.

Modify Detail
Selecting Detail mode preserves color and only affects the detail layer.

1 Click the Detail button in the Paint tab.

Color Only - Before Color Only - After
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2 Select View > Detail Layer or press the 9 keyboard shortcut.

The Detail Layer is now displayed in the Viewer.

3 Drag in the Detail Level field to set a value of 1.

A value of 1 selects fine details.

4 Select View > Output or press the 1 keyboard shortcut.

The output of the Paint node is now displayed in the Viewer.
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5 Select the Clone brush (C), set an offset and paint in an area of texture.

The detail is modified and the color layer is preserved. Fine details in this 
example are removed without affecting with the color and tone.

6 Use the Color brush (Shift-C) with a 50% gray color to remove texture completely.

Detail Only - Before Detail Only - After



Silhouette User Guide    

• • • •••

Tutorials  191 
• • • •••

Detail Separation Using Nodes
Separating the image into color and detail layers using nodes is an alternative 
to doing it directly in the Paint node. This can have the advantage of better 
performance depending on the size of your image and paint brush.

1 Connect an Extract Detail node to a source.

Extract Detail separates the image into color and detail layers.

2 Set the Detail slider to a value of 1.

A value of 1 selects fine details such as skin blemishes, pores, hair, and 
wrinkles. A value of 0 is coarse detail, .5 is medium detail and 1 is fine detail.

Original Coarse

Medium Fine
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3 Connect the first output of Extract Detail (the color layer) to a Paint node and 
rename the Paint node to Paint Color.

4 Connect the second output of Extract Detail (the detail layer) to a Paint node and 
rename the Paint node to Paint Detail.

This configuration allows you to paint separately on the color and detail layers.

5 Add a Grain Composite node and connect the Paint Color node to the first input 
and Paint Detail to the second input.

6 Set the Grain Composite > Channels to Luminance.

Grain Composite combines the Color and Detail layers back together. Now you 
can view the Grain Composite while painting on either the color or detail layers 
separately.
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Auto Paint
Auto Paint is a highly unique automated paint feature that records all paint 
activity with tight integration of both point and planar trackers. Paint strokes can 
be match moved or stabilized giving Silhouette the speed of raster paint with 
the repeatability of vector paint. The beauty of the system lies in the automatic 
recording of the paint strokes and brush settings. Individual paint strokes can 
be selected and repeated over many frames, as well as deleted. If the original 
footage changes, the entire paint history can be used to rebuild the painted 
shot, automatically.

Replay Last Stroke
1 Paint a stroke.

2 Change to a different frame.

3 Press Replay in the Auto Paint window.

The last stroke is replayed on the new frame. Replay can be used to apply the 
last stroke with changed settings and/or on a different frame.

Event Playback
1 Go to frame 1 and paint some strokes.

Groups are created each time painting is started on a frame and recorded with 
the current time stamp. So the first time you begin painting on frame 1, for 
instance, a renamable “event group” containing a current time stamp is created. 
Then, events are created for the current paint state: channels/flags, brush 
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profile, brush, and brush parameters. And finally, a new stroke event is created 
for the new stroke. After the first stroke, state changes are stored in their own 
events (ie. Brush Size change, Opacity, etc).

2 In the Paint History, select the frame number group, paint event group, or a sub 
set of the paint events you want to play back.

or

3 Choose the Stroke (S) tool and select strokes by clicking or drag selecting in the 
Viewer. Hold Shift to add to the selection and Ctrl to toggle the selection.
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When strokes are selected, they are highlighted in the Viewer and the Paint 
History.

4 In the Auto Paint window, choose an option from the Frame Range pop-up menu.

If you choose Custom, you will be able to enter values in the numeric input 
fields.

5 Press either the Play Selected Events Forward or Backward icon in the Auto 
Paint window.
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This will play back all of the selected events for the desired frame range. The 
playback is smart, so if you try to play back starting on the frame from where 
the source events are coming from, it will skip this frame and just move on to 
the next.

As it plays, Silhouette copies the paint events from the start frame on to the end 
of the history for successive frames, as if you were manually performing those 
events.
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Event Playback - Tracking Paint Strokes
Let’s suppose you want to paint out some facial blemishes on frame 1 and 
apply those strokes to the rest of the clip, while taking into account the camera 
movement. With Silhouette’s Auto Paint features, you can easily do this by 
playing back the paint strokes from frame 1 and using tracking data to match 
move the strokes on successive frames.

1 Load some source footage that has some camera movement to it and create a 
session using the Paint template.

2 Drag a Tracker node from the Nodes > Transform group and drop it onto the 
source node.

A new branch is created.

3 Connect the Tracker output into the Paint node’s Objects input located at the top 
right of the node.

The Paint > Objects input is colored yellow.

4 Single-click in the center of the Tracker node to view and edit it.

5 In the Tracker node, add a layer in the Object List.
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6 Track an object whose motion you want to apply to paint strokes.

7 Go to frame 1, select the tracker, select the layer, and apply the tracking data.

8 In the Trees window, single-click in the center of the Paint node to view and edit 
it.

9 Paint some strokes that you would like to duplicate over the entire clip.
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For this image, I used the Blemish brush to remove acne from the girl’s face.

10 Select a tracked layer in the Paint tab’s Transform pop-up menu.
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11 Enable Match Move located at the bottom of the Auto Paint window.

Activating Match Move will use the tracking data from the selected layer and 
apply it to the paint strokes when playing back selected events.

12 In the Paint History, select the paint event group or a sub set of the paint events 
you want to play back. In this example, selecting the top group is good.

13 In the Auto Paint window, select All Fames from the Frame Range pop-up menu.

14 Press either the Play Selected Events Forward or Backward icon in the Auto 
Paint window.

The paint strokes from the start frame are duplicated on successive frames with 
tracking data applied to them so they will follow the motion of the clip.
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Event Playback -Tracking the Clone Source
Tracking the clone source is useful for when you want the clone source to 
match the motion of the clip you are painting on.

1 Load some source footage that has some camera movement to it and create a 
session using the Paint template.

2 Drag a Tracker node from the Nodes > Transform group and drop it onto the 
source node.

A new branch is created.

3 Connect the Tracker output into the Paint node’s Objects input located at the top 
right of the node. The Objects input is colored yellow.

In the example above, I have also hooked up a clone source into the first clone 
input of the Paint node.

4 Single-click in the center of the Tracker node to view and edit it.

5 In the Tracker node, add a layer in the Object List.
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6 Track an object whose motion you want to apply to paint strokes.

7 Go to frame 1, select the tracker, select the layer, and apply the tracking data.

8 In the Trees window, single-click in the center of the Paint node to view and edit 
it.

9 Choose the Clone Brush in the Toolbar.

10 Select the Clone source by choosing Input 1 from the Clone > Source pop-up 
menu.
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11 Select a tracked layer in the Paint tab’s Transform pop-up menu.

12 Enable Source Match Move in the Clone transform controls.

Selecting a layer and activating Source Match Move in the Clone transform 
controls applies the tracking data of the selected layer to the clone source. In 
this configuration, the painted clone source is match moved.

13 Paint some strokes that you would like to duplicate over the entire clip.
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For this image, I am painting a graphic into the face of the watch.

Once you are done painting the frame, you can then duplicate it over the rest 
of the clip.

14 Enable Match Move located at the bottom of the Auto Paint window.

Activating Match Move will use the tracking data from the selected layer and 
apply it to the paint strokes when playing back the events.
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15 In the Paint History, select the paint event group or a sub set of the paint events 
you want to play back. In this example, selecting the top group is good.

16 In the Auto Paint window, select All Fames from the Frame Range pop-up menu.

17 Press either the Play Selected Events Forward or Backward icon in the Auto 
Paint window.

The paint strokes from the start frame are duplicated on successive frames with 
tracking data applied not only to the paint strokes but to the clone source as 
well.
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Rebuild
The Rebuild feature in the Auto Paint window will rebuild the paint events for all 
frames defined in the Frame Range in the order in which they were painted. 
This is useful if you replace your footage with a different color correction than 
the original and want the result of painting with the Clone brush to match the 
new footage.

1 In the Auto Paint window, select All Frames from the Frame Range pop-up menu.

2 Click the Rebuild button in the Auto Paint window.
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Paint Only Node Output
The Paint Only node output outputs only the painted portions of the frame along 
with an automatically generated alpha channel (where the brush painted). This 
will allow you to seamlessly composite the painted areas in a Composite node 
without having to do a difference matte.

1 In the Paint node, select View > Paint or press the P key to display what would 
be rendered when using the Paint Only output.

2 If you press the A key to overlay the alpha, you will see an automatically 
generated alpha channel where the brush painted.

3 Connect the Paint Only node output to a Composite node.

The paint strokes will be seamlessly composited over whatever background 
image you have connected.

4 Using the Paint > Node > Paint Only Alpha parameter, select either a hard or soft 
edged alpha channel.
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Power Matte
Open Shape Method

Power Matte creates mattes by using a trimap--a pre-segmented image 
consisting of three regions of foreground (what you want to cut out), 
background (what you want to get rid of) and unknown. Partial opacity values 
are then computed only for pixels inside the unknown region. Two trimap 
methods can be used: Open Shape or Closed Shape. This tutorial will use the 
Open Shape Method.

Unlike previous approaches, our trimaps can be relatively sparse consisting of 
open foreground and background shapes. All pixels left unmarked will be 
treated as unknown.

A good Open Shape technique is to draw an inner and outer outline around the 
object you are extracting using open shapes. Shapes should be near the 
boundary of the foreground or background, but not right up against the edge. 
Also, if the foreground or background has varying colors, the shapes should 
cross over these colors.

Note: The general rule is to not put foreground and background shapes too close 
together unless you need to.

1 Load some source footage and create a session.

2 In the Trees window, add a Power Matte node from the Nodes > Key tab and 
connect it to the source node.

3 Single-click in the center of the Power Matte node to view and edit it.

Original Shapes
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4 Define foreground area (what you want to cut out) by drawing an open shape 
around the inner edge of the object.

5 Start by selecting either Bézier, B-Spline or X-Spline from the Toolbar.

6 Click on the screen to create a control point.

A control point is created.

7 Add as many points as you like.

8 When finished adding points, press the Esc key to finish the open shape.

9 Now, draw shapes to define background areas (what you want to get rid of). 
Press the Esc key each time you want to finish an open shape.

If the background has varying colors, the shapes should cover these colors.

10 Choose the Reshape tool when you are done drawing open shapes.

Warning: If you only provide a few sparse shapes, the Open Shape Method will take 
longer to process with a less accurate result than the Closed Shape Method.

Good Shape Example Bad Shape Example
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11 In the Object List, feel free to change the name and color of your shapes. In the 
example below, I named the inner shape Foreground and changed the color to 
green. Also, I named all of the outer shapes Background and left their color set 
to red. Although this is not a necessary step, it is helpful to identify what the 
shapes are being used for.

Power Matte won’t process until you assign the shapes as either foreground or 
background.

12 Select the inner, foreground shape and set the type to Foreground in the Object 
window.

13 Select all the outer, background shapes and set the type to Background in the 
Object window.
Once a foreground and background shape are assigned, Power Matte 
processes the matte.The Viewer displays the composite of the foreground over 
the background based on your shapes. If you have not input a background clip, 
the foreground will be composited over black. The default color is black.
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Now that you have foreground and background shapes, animate them over 
time so that they follow the motion of what you are cutting out. However, since 
you already assigned the shapes as foreground and background, Power Matte 
will try and update every time you adjust the shapes.

14 Set the View to Foreground. This way Power Matte is not constantly trying to 
update when you change a parameter.

15 Animate the foreground and background shapes over time so that they follow 
the motion of what you are cutting out.

It is best to use the Tracker (Shift-T) to animate the motion of your shapes as 
it will most likely ensure that the motion is consistent from frame to frame.

16 Play through the clip to make sure that the shapes are properly following your 
object.

17 Use View > Matte to display the generated matte.

18 Hit the Play button to check your results so far. When you hit the Play button, 
Power Matte renders each frame.

19 If at any time you want to turn off the display of the shapes, click the Overlay icon 
above the Viewer or press 0 (the number zero) shortcut key.
In the generated matte, white is foreground, black is background and any gray 
areas in between represent a level of transparency. If the matte is not 
acceptable after processing, you can either adjust the shapes or add additional 
shapes near the region where the matte is not accurate. 

20 If you see gray areas in the foreground object that should be completely white, 
make additional foreground shapes in those areas.

21 If you see gray areas in the background that should be completely black, make 
additional background shapes in those areas.



Silhouette User Guide    

• • • •••

Tutorials  212 
• • • •••

22 Gray values in Unknown areas can be reduced by increasing the Deartifact value 
located in the Node parameters.
If you need to adjust the shapes after they have been created and assigned in 
Power Matte, you can enhance performance by either: 

• Set the View to Foreground while editing shapes.
• Set the Update mode to Manual and hit the Enter key when you want to process. 

This way Power Matte is not constantly trying to update when you change a 
parameter. 

• Use a lower quality proxy image by using the Proxy pull-down menu above the 
Viewer.

23 Choose View > Composite to display the Composite.
If you look closely at the edges of our dog example, you will see some white 
fringing created by the sky from the original image. By activating Power Matte’s 
Color Estimation feature, the fringing can be removed by estimating the color 
of the foreground in unknown and semi-transparent areas.

Note: Color Estimation can cause color flickering in edge areas of partial opacity if your 
shape position is not consistent from frame to frame or if your source footage is grainy. 
Disable Color Estimation if you see flickering in the edge areas.

Color Estimation Off Color Estimation On
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24 To remove fringing around the object being cutout, go to the Node parameters 
and turn on Color Estimation.

25 When you press the Play button while viewing the Composite, you will see the 
result in full color.
Now that I have shown you how to generate a matte using open shapes, an 
alternative method is to use a mix of open and closed shapes. If you have large 
contiguous areas of background, surrounding the background with a closed 
shape and enabling Filled in the Object window will speed up Power Matte’s 
processing.

Original Composite

Open Shape Example Open/Closed Shape Example

Closed
Shape
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Closed Shape Method
Power Matte creates mattes by using a trimap--a pre-segmented image 
consisting of three regions of foreground (what you want to cut out), 
background (what you want to get rid of) and unknown.

The Closed Shape Method uses closed shapes to mark definite foreground and 
background areas of the image. Any unmarked areas are considered unknown 
and partial opacity values are then computed for the pixels inside the unknown 
region. So, make sure that any hair detail, transparent or blurry portions fall 
within the unknown areas 

Note: The Closed Shape method does not handle a foreground object with background 
holes in it, and therefore the Open Shape method would be a better choice when 
extracting an object with holes.

1 Define foreground area (what you want to cut out) by drawing a closed shape.

2 Start by selecting either Bézier, B-Spline or X-Spline from the Toolbar.

3 Draw a shape around the inner edge of the object, in this case, the hiker.

Original Shapes
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4 To close the shape, click on the first point that you created.

5 To tell Power Matte that you are using a closed shape, enable Filled in the Object 
window as well as set the Type for this shape to Foreground.

6 Now, draw closed shapes to define background area (what you want to get rid 
of). If your foreground object is completely surrounded by background, like the hiker 
example below, a quick way to define the background area is to first draw a closed 
shape around the outside of the foreground and then invert it in the Object window. 
The areas outside of the background shape are then considered as background.

7 After drawing the background shape, enable Filled in the Object window as well 
as set the Type for this shape to Background. Invert the shape if you drew around 
the boundary of your foreground object as in the example above. 
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Once a foreground and background shape are assigned, Power Matte 
processes the matte. The Viewer displays the composite of the foreground over 
the background based on your shapes. If you have not input a background clip, 
the foreground will be composited over black. The default color is black.

Now that you have a foreground and background shape, animate them over 
time so that they follow the motion of what you are cutting out. However, since 
you already assigned the shapes as foreground and background, Power Matte 
will try and update every time you adjust the shapes.

8 Set the View to Foreground. This way Power Matte is not constantly trying to 
update when you change a parameter.

9 Animate the foreground and background shapes over time so that they follow 
the motion of what you are cutting out.

It is best to use the Tracker (Shift-T) to animate the motion of your shapes as 
it will most likely ensure that the motion is consistent from frame to frame.

10 Play through the clip to make sure that the shapes are properly following your 
object.
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11 Use View > Matte to display the generated matte.

12 Hit the Play button to check your results so far. When you hit the Play button, 
Power Matte renders each frame.

13 If at any time you want to turn off the display of the shapes, click the Overlay icon 
above the Viewer or press 0 (the number zero) shortcut key.
In the generated matte, white is foreground, black is background and any gray 
areas in between represent a level of transparency. If the matte is not 
acceptable after processing, you can adjust the shapes. 

14 If you see gray areas in the foreground object that should be completely white, 
adjust the foreground shape in those areas.

15 If you see gray areas in the background that should be completely black, adjust 
the background shape in those areas.

16 Gray values in Unknown areas can be reduced by increasing the Deartifact value 
located in the Node parameters.
If you need to adjust the shapes after they have been created and assigned in 
Power Matte, you can enhance performance by either: 

• Set the View to Foreground while editing shapes.
• Set the Update mode to Manual and hit the Enter key when you want to process. 

This way Power Matte is not constantly trying to update when you change a 
parameter. 
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• Use a lower quality proxy image by using the Proxy pull-down menu above the 
Viewer.

17 Choose View > Composite to display the Composite.
If you look closely at the edges of our hiker example, you will see some white 
fringing created by the sky from the original image. By activating Power Matte’s 
Color Estimation feature, the fringing can be removed by estimating the color 
of the foreground in unknown and semi-transparent areas.

18 To remove fringing around the cutout object, go to the Node parameters and turn 
on Color Estimation.
Note: Color Estimation can cause color flickering in edge areas of partial opacity if your 
shape position is not constant from frame to frame or if your source footage is grainy. 
Disable Color Estimation if you see flickering in the edge areas after a preview or 
render.

Color Estimation Off Color Estimation On
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19 When you press the Play button while viewing the Composite, you will see the 
result in full color.

Original Result
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Blue/Green Screen Keying
Keying is a technique for blending two images, in which a color from one image 
is removed, or made transparent, revealing another image behind it. Either the 
Open or Closed Shape Method can be used when creating mattes for Blue or 
Green screen photography. Power Matte doesn’t require any specific color for 
the object to be photographed against, but blue and green screens will be 
referred to as these are the most common.

Let’s start by creating some open shapes. The shapes should be near the 
boundary of the foreground or background, but not right up against the edge. 
Also, if the foreground or background has varying colors, the shapes should 
cross over these colors.

1 Define foreground area (what you want to cut out) by drawing a open shape.

2 Start by selecting either Bézier, B-Spline or X-Spline from the Toolbar.

Original

Shapes
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3 Draw a shape around the edge of the object that you want to cutout, in this case, 
the television screen. When done adding points, press the Esc key to finish the 
open shape. 

4 Next, draw a shape to define background areas. In the example below, this would 
be the blue area within the television screen. Press the Esc key when you want 
to finish the open shape.

5 Choose the Reshape tool when you are done drawing the open shapes.

Power Matte won’t process until you assign the shapes as either foreground or 
background.

6 Select the foreground shape and in the Object window, set the type to 
Foreground.

7 Select the background shape and in the Object window, set the type to 
Background.
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Once a foreground and background shape are assigned, Power Matte 
processes the matte. The Viewer displays the composite of the foreground over 
the background based on your shapes. If you have not input a background clip, 
the foreground will be composited over black. The default color is black.

Now that you have foreground and background shapes, animate them over 
time so that they follow the motion of what you are cutting out. However, since 
you already assigned the shapes as foreground and background, Power Matte 
will try and update every time you adjust the shapes.

8 Set the View to Foreground. This way Power Matte is not constantly trying to 
update when you change a parameter.

9 Animate the foreground and background shapes over time so that they follow 
the motion of what you are cutting out.

It is best to use the Tracker (Shift-T) to animate the motion of your shapes as 
it will most likely ensure that the motion is consistent from frame to frame.

10 Play through the clip to make sure that the shapes are properly following your 
object.

11 Use View > Matte to display the generated matte.
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12 Hit the Play button to check your results so far. When you hit the Play button, 
Power Matte renders each frame.

13 If at any time you want to turn off the display of the shapes, click the Overlay icon 
above the Viewer or press 0 (the number zero) shortcut key.
In the generated matte, white is foreground, black is background and any gray 
areas in between represent a level of transparency. If the matte is not 
acceptable after processing, you can adjust the shapes.

14 If you see gray areas in the foreground object that should be completely white, 
adjust the foreground shape in those areas.

15 If you see gray areas in the background that should be completely black, adjust 
the background shape in those areas.

16 Gray values in Unknown areas can be reduced by increasing the Deartifact value 
located in the Node parameters.
If you need to adjust the shapes after they have been created and assigned in 
Power Matte, you can enhance performance by either: 

• Set the View to Foreground while editing shapes.
• Set the Update mode to Manual and hit the Enter key when you want to process. 

This way Power Matte is not constantly trying to update when you change a 
parameter. 

• Use a lower quality proxy image by using the Proxy pull-down menu above the 
Viewer.

17 Choose View > Composite to display the Composite.
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When a foreground object has been photographed against a solid blue or green 
backdrop, the blue or green color can have a tendency to spill onto the 
foreground object. When extracting an object photographed against one of 
these colors, you may find it necessary to remove the blue or green spill. This 
is a process called Color Suppression.

18 To remove color spill from your object, go to the Node parameters and change 
the Color Suppression > Type parameter from None to Blue or Green.

19 Click Play button to see the RGB image results.

Color Suppression Off Color Suppression On

Result

Original
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Pin Based Warping
Pin Warp allows you to warp specific image areas using pins, while leaving 
other areas untouched. Adjustments can range from subtle nip and tucks to 
something more obvious like repositioning an arm or leg.

1 Load some source footage and create a session.

2 In the Trees window, add a Pin Warp node from the Nodes > Warp tab and 
connect it to the source node.

3 Click-drag on the image to create a pin that contains a source and target. You can 
add up to 20 pins.

The farther the target (red circle) is dragged from the source (green circle), the 
more the image warps.

4 To constrain the warp, click-release on the image to set a tack.

Before

Photo by Tim Easley on Unsplash

After
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The tack acts as a barrier and limits the effects of the warp.

In addition, each pin and tack has a radius which determines its strength.

5 Hover over a pin to display the radius.

6 Shift-drag the pin radius to adjust it.

7 To track the pins and tacks, connect a Tracker output into the Pin Warp node’s 
Transform input located at the top right of the node and select a point tracker or 
tracked layer from the Transform pop-up menu.

The pins and tacks are now transformed by the motion of the tracked layer.

Go to the Pin Warp node for more information.

Source

Target

Tack
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Shape Based Warping
Image warping can take place on a stills as well as moving images. Warping 
can be used to enhance or exaggerate facial features, adjust sizing of image 
elements, create talking animals or any other type of image deformation.

Create Source and Target Shapes
A source and target shape are required for a warp.

1 Load some source footage and create a session

2 In the Trees window, add a Morph node from the Nodes > Warp tab and connect 
the A input to the source node.

3 Single-click in the center of the Morph node to view and edit it.

4 Select View > A.

Viewing the A side while creating and editing shapes will give faster interaction 
than View > Output.

Before After

Copyright © 2008--www.iofoto.com
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5 Create source and target shapes.

6 If necessary, keyframe the position of both the source and target shapes.

Joining Shapes
Joining shapes specifies the direction of a warp. Joining shapes is done with 
the Correspondence tool. When two shapes are joined, correspondence points 
define where elements in the source shape match to elements in the target 
shape.

1 Select the Correspondence (C) tool in the Toolbar.

2 Click the source shape and drag a line to the target shape.

3 When the cursor is over the target shape, release the mouse button to join the 
shapes.

As the shapes are joined, one correspondence point is created on each shape 
and a line connects them.

4 Move the correspondence points to match up to like features. For instance, in the 
image above, the points are placed at the corner of the mouth in both shapes.

Source

Target
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Adding Correspondence Points
When a new shape is created, Silhouette adds a single correspondence point 
on the shape. It is best to add and position these points so that logically similar 
features are connected together. Correspondence points serve as guides that 
define the location of identifiable areas on a shape.

1 With the Correspondence tool active, select a shape.

2 Alt-click the shape where you want to place the new correspondence point.

Correspondence points determine how to transform the areas of the image 
defined by your source and target shapes.

3 Place correspondence points at key positions on the shape.
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Setting the Distortion
The Distortion parameter warps the image from the source to the target shape.

1 Change the View to Output.

The Output view is where you can see the actual warp.

2 Select the Node parameters tab.

3 Set the Distortion to 0 at the start frame and 100 at the end frame.

4 For faster interaction, you can use a lower quality proxy image by using the 
Proxy pull-down menu above the Viewer.

Start Middle End
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Barrier Shapes
Besides creating shapes to define areas that warp and morph, you can also use 
shapes as ways of restricting movement beyond certain parts of the image. 
These shapes are called barrier shapes and tack down an area and keep it 
stationary. Any unjoined shape will serve as a barrier.

1 Use a barrier shape (an unjoined shape) to tack down an area and keep it 
stationary.

In the example above, the barrier shape will prevent any movement outside of 
the shape. Compare the results below.

The barrier shape has successfully pinned down the image outside of its 
boundaries.

Barrier

No Barrier With Barrier
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Previewing the Warp
1 Press the Play button in the Timebar.

Silhouette will render each frame in order. If the view mode is set to Output and 
you have enough RAM to fit the clip into memory, Silhouette will play the results 
in real time once it is completed. 

Note: If the view mode is set to A Warp, the results of each frame are not cached into 
memory.

2 If you see artifacts in the preview, go to the Node tab and change the Precision 
to Normal first and then Better if you still see artifacts.

Note: By default, the precision or quality of the warp is set to Draft.

3 For faster processing, you can use a lower quality proxy image by using the 
Proxy pull-down menu above the Viewer.
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Morphing
Image morphing can take place on stills as well as moving images. Morphing 
has been traditionally used to transform one object or person into another and 
more recently to seamlessly transform a live action element into a CG 
(computer generated) object and vice versa.

Assigning Inputs
A and B inputs are required for a morph.

1 Choose two images to morph together and wire them into a Morph node.

The A input (A-roll) is considered the source and the B input (B-roll) is 
considered the target. The A-roll will morph into the B-roll.

Start Middle

Copyright © 2008--www.iofoto.com
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Create A-roll and B-roll Shapes
1 Select View > A and create shapes for the A-roll image. Shapes should be added 

to key areas of the image. When doing a facial morph, shapes should be placed 
for the face, eyes, eyebrows, nose, nostrils, mouth, lips, etc. You can use both 
open and closed shapes.

The A-roll shapes are automatically colored red.

2 If necessary, keyframe the position of the A-roll shapes.
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3 Select View > B and create shapes for the B-roll image.

The B-roll shapes are automatically colored blue.

4 If necessary, keyframe the position of the B-roll shapes.

Joining Shapes / Adding Correspondence Points
Joining shapes specifies the direction of a warp.

1 Select the Correspondence (C) tool and join similar shapes.

For instance, the shapes for the eyes in the source image are joined to the 
shape for the eyes in the target image, mouth shapes to mouth shapes, nose 
shapes to nose shapes--you get the idea.

2 For the newly joined shapes, add additional correspondence points to the areas 
where the shapes change direction by Alt-clicking on a selected shape.

Setting the Distortion and Transparency
The Distortion parameter warps the image from the A-roll to the B-roll shapes 
while the Transparency dissolves between them.

1 Change the View to Output. 
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The Output view is where you can see the actual morph.

2 Select the Node parameters tab.

3 Set the Distortion to 0 at the start frame and 100 at the end frame.

4 Set the Transparency to 0 at the start frame and 100 at the end frame.

5 If you’d like, you can set the Distortion and Transparency to start and end at 
different times in the clip to create a more natural looking morph for your 
particular clip.

6 For faster interaction, you can use a lower quality proxy image by using the 
Proxy pull-down menu above the Viewer.

Previewing the Morph
The Viewer can display a wireframe preview to quickly visualize the morph.

1 Select View > Wireframe. You can also use Alt-W to toggle the wireframe view 
mode on or off.

2 Press the Play button in the Timebar.

Silhouette will play a wireframe representation of the A-roll shapes morphing 
into the B-roll shapes.

Start Middle End
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3 Change the View to Output and press 0 to turn off the shape display. This will 
allow you to see the image better.

4 Press the Play button.

Silhouette will render each frame. If you have enough RAM to fit the clip into 
memory, it will playback in real time once it is completed.

5 If you see artifacts in the preview, go to the Node tab and change the Precision 
to Normal first and then Better if you still see artifacts.

Note: By default, the precision or quality of the warp is set to Draft.

6 For faster processing, you can use a lower quality proxy image by using the 
Proxy pull-down menu above the Viewer.

7 Press 0 again to turn shape display back on.

Start Middle End
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Adjusting the Morph
There are a number of ways to modify the look of the morph. By default, shapes 
and layers inherit their Distortion, Transparency and Depth from the Morph 
node settings. To “override” the value at the layer or shape, click the Override 
icon (dot) to the right of the numeric field and the parameter will override the 
parent.

1 Override the Distortion and Transparency to have independent control over 
these parameters at either the layer or shape.

2 Use barrier shapes (unjoined shapes) to tack down areas and keep them 
stationary.
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Folding
Sometimes the warping of a pair of joined shapes can overtake other shapes 
(joined or barrier). The overtaking shapes will necessarily fold over or under the 
shapes they overtake. For instance, you can warp eye lids over a pupil without 
distorting the pupil, as seen below.

1 Select View > A.

Viewing the A roll while creating and editing shapes will give faster interaction 
than View > Output.

2 Create source and target shapes.

3 Select the Correspondence (C) tool and join the source to the target shape.

The source shape describes the current form of the object, while the target 
shape describes where you want it to fold.

Source
Target
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4 Add correspondence points where necessary.

5 Create a barrier shape by copying and pasting the source shape.

Note: Folding can happen even with non-barrier shapes. Folding happens anytime one 
shape crosses over another.

6 Size the barrier shape to be slightly smaller than the source shape.

By using a barrier shape, the source shape will appear to fold over or under 
(depending on shape order in the Morph node's Object List) as it is transformed 
into the target shape.

7 In the Object List, arrange the barrier shape to be below the source and target 
shapes.

Source
Target

Barrier
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The upper level shapes or layers will appear to fold over the lower, barrier 
shape. The portion of the image between the barrier shape and target shape is 
not affected.

Note: The rendering order in the Object List is from bottom to top, so objects that are 
higher up are rendered in front of objects lower down.

8 Select the Node parameters tab.

9 Change the View to Output.

The Output view is where you can see the actual warp.

10 Set the Distortion to 100.

The eyelid folds over the eye creating a blink effect.
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Check out the difference between the warp with and without folding.
Warp w/out folding Warp with folding

Original
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zMatte
Using proprietary matte extraction techniques, zMatte quickly and simply 
creates mattes with minimal parameters even if you are dealing with fine hair 
detail, smoke, or reflections.

Blue/Green Screen Keying
Of course, you can use zMatte to create just a single matte for blue/green 
screen footage, but we like to use an inner / outer keying method that involves 
creating a Primary Matte which has gray values in the foreground’s edge. This 
will give a nice, smooth edge in the final composite. Next, the trick is to use the 
Secondary Matte to fill in any gray areas of the Primary Matte while retaining 
the gray values in the edge. You can do this by adjusting the Blur, Shrink/Grow 
and/or Wrap parameters of the Secondary Matte to retain the Primary Matte’s 
edge values.

1 Load some green or blue screen source footage and create a session.

2 In the Trees window, add a zMatte node from the Nodes > Key tab and connect it 
to the source node.

3 Single-click in the center of the zMatte node to view and edit it.
4 Start by selecting Primary Matte from the View pop-up menu.
5 Set the Primary Matte > Extract On to Blue or Green Screen.
6 Adjust the Background so that the background areas are completely black.
7 Set the Foreground so that the Primary Matte has gray values, especially in the 

edges.

This Primary Matte will be used for the edges.

Note: If you are not going to use the Inner / Outer Keying method, you would adjust the 
Foreground so that the foreground values would be completely white in the Primary 
Matte. In this case, a Secondary Matte would not be used.
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8 From the View menu, select Secondary Matte.
The screen is black, because you must first enable it.

9 Expand the Secondary Matte group and click on the Enable checkbox.
You can now see the Secondary Matte in the Viewer.

10 Set the Secondary Matte > Extract On to the same setting as the Primary Matte.
11 Adjust the Secondary Matte so that the foreground is completely white and the 

background is completely black.

12 Switch the View menu to Combined Matte.
The Combined Matte view shows the combination of the two mattes.

13 Adjust the Secondary Matte > Wrap parameter to pull back the hard edges of the 
Secondary Matte to reveal the gray edges of the Primary Matte.
Note: You could also use Secondary Matte > Shrink/Grow and Blur instead of or in 
conjunction with Wrap to blend the two mattes together.

14 Change the View pop-up menu to Composite.

If you have not input a background, the foreground will be composited over 
black.

15 If you have a clip that you would like to use for the background instead of black, 
connect it to the Background input of zMatte.
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The foreground will then be composited over the background.

If you see any color spill from the blue or green screen, it can be eliminated 
using the Color Suppression controls.

16 Expand the Color Suppression group and click the Enable check box.

17 Adjust the Color Suppression > Foreground and Range controls as needed.

Generating Mattes Without A Blue/Green Screen
If your footage does not use a blue or green screen background, you have a 
number of matte extraction methods to choose from such as: Luminance, Hue, 
Saturation, Average, Red, Green, Blue, Cyan, Magenta and Yellow.

1 Change the Primary Matte > Extract On parameter to create a matte based on a 
whatever image values you choose. Extract On determines the image values that 
will be used to generate the matte.
You may have noticed that the Foreground and Background numeric fields gray 
out when not using the Blue or Green Screen extraction methods. Position and 
Range controls are used instead.

Green Color Spill

Green Suppressed
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2 Change the Primary Matte > Position parameter if you want to select different 
values to be used for the matte.
The Position control selects the image values to be used in the matte based on 
the Extract On setting. If the matte is created using Luminance, a high Position 
value shows the brightest image values as white values in the matte. A low 
Position value shows the darkest image values as white values in the matte.

3 Increase the Primary Matte > Range control to add more values to the matte. 
Decrease for less values.
Range increases or decreases the range of values in the matte. A low Range 
value indicates a narrow range of values. A high Range value indicates a large 
range of values included in the matte.

4 The rest of the Primary Matte matte controls can be used the same as when using 
the Blue or Green Screen extraction methods.

Holdout Matte/Garbage Matte
A Holdout Matte defines foreground areas that should not be keyed out, while 
a Garbage Matte defines background areas that should be keyed out. zMatte 
has Holdout Matte and Garbage Matte auxiliary inputs that can come from a 
source image or a node like Roto.

1 If there are foreground areas that are not keying properly, hook a Roto node into 
the Holdout Matte input. Roto the appropriate foreground areas and they will be 
added to the output matte.

2 If there are background areas that are not keying properly, hook a Roto node into 
the Garbage Matte input. Roto the appropriate background areas and they will be 
subtracted from the output matte.

Using Light Wrap
Light Wrap helps blend the foreground into the background by making the color 
of the background wrap into the foreground edges without completely losing 
the edge.

1 Adjust the Light Wrap > Brightness setting to the appropriate brightness.

2 Change the View to Light Wrap.
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3 Using the Light Wrap > Wrap control, set the thickness of the Light Wrap.

4 Switch the View back to Composite.

Light Wrap Source

No Light Wrap

With Light Wrap
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zMatte Output Options
zMatte can output either the output (foreground plus generated matte) or a 
composite.

1 If you plan to do further work on the RGBA channels downstream from zMatte, 
use zMatte’s Output. It will output the foreground plus the generated matte.

2 Use zMatte’s optional Composite output if you want zMatte to do the composite.

Go to the zMatte node for more information.

Output Composite
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Depth
The Depth node contains a dedicated toolset for creating depth channels.

Creating Depth Objects
There are a number of tools to create depth maps for 2D images which include: 
Constant, Horizon, Ramp, Hall, Tunnel, Edges, and Alpha.

Constant
The Constant depth object sets a constant depth for the entire frame. It is useful 
for setting the depth of objects that are completely flat.

1 Load some source footage and create a session.

2 In the Trees window, add a Depth node from the Nodes > Image group and 
connect it to the source node.

3 Single-click in the center of the Depth node to view and edit it.

4 Select the Constant icon and click on the screen to create the object.

5 Click the D icon above the Viewer or press the D key to view the depth map.

6 In the Object window, adjust the Depth numeric field to set the level of depth.
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A value of 1 is nearest (white), 0 is farthest (black) and .5 is a mid depth (50% 
gray). The depth can be set interactively by Ctrl/Cmd-vertical dragging on the 
image in the Viewer.

7 Press the D key to toggle the Depth view off.

Before Constant
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Horizon
The horizon depth object creates a horizon line.

1 Select the Horizon icon and click on the screen to create the object.

2 The position can be set by dragging the center point.

3 The rotation can be set by dragging the solid line.

4 The size can be set by dragging the dashed line.

5 Click the D icon above the Viewer or press the D key to view the depth map.

6 Select the Blend Amount icon above the Viewer and adjust the slider that 
appears to control how much of the image is mixed into the Depth map. The 
setting is remembered the next time you view the Depth map.
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7 In the Object window, adjust the Near and Far Depth numeric fields to set the 
level of depth.
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Ramp
The Ramp depth object creates a horizontal or vertical ramp blending out from 
the center. 

1 Select the Ramp icon and click on the screen to create the object.

2 The position can be set by dragging the center point.

3 The rotation can be set by dragging the solid line.

4 The size can be set by dragging the dashed lines.

5 Click the D icon above the Viewer or press the D key to view the depth map.
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6 In the Object window, adjust the Center, Left and Right Depth numeric fields to 
set the level of depth.

7 Press the D key to toggle the Depth view off.

Use the Depth Preview window to visualize and edit the objects’ depth position 
in 3D space.

8 Click and drag in the Depth Preview window to move the image around in a 
perspective view, and then adjust the depth of your objects as needed.
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Hall
The Hall depth object creates a perspective gradient as if you are looking down 
a hallway. 

1 Select the Hall icon and click on the screen to create the object.

2 The position can be set by dragging the center point.

3 The rotation can be set by dragging the corner of one of the squares.

4 The outer square can be offset from the center position by Alt-dragging the 
center point or outer square.

5 The size can be set by dragging the inner and outer squares.
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6 Click the D icon above the Viewer or press the D key to view the depth map.

7 In the Object window, adjust the Inner and Outer Depth numeric fields to set the 
level of depth.

8 Press the D key to toggle the Depth view off.

Use the Depth Preview window to visualize and edit the objects’ depth position 
in 3D space.

9 Click and drag in the Depth Preview window to move the image around in a 
perspective view, and then adjust the depth of your objects as needed.
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Tunnel
The Tunnel depth object creates a circular gradient as if you are looking down 
a tunnel.

1 Select the Tunnel icon and click on the screen to create the object.

2 The position can be set by dragging the center point.

3 The outer circle can be offset from the center position by Alt-dragging the center 
point or outer circle.

4 The size can be set by dragging the inner and outer circles.

5 The aspect ratio can be set by dragging the point at the bottom of the outer circle.

6 Click the D icon above the Viewer or press the D key to view the depth map.
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7 In the Object window, adjust the Inner and Outer Depth numeric fields to set the 
level of depth.

8 Press the D key to toggle the Depth view off.

Use the Depth Preview window to visualize and edit the objects’ depth position 
in 3D space.

9 Click and drag in the Depth Preview window to move the image around in a 
perspective view, and then adjust the depth of your objects as needed.
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Edges
The Edges depth object runs an edge detection and objects with edges or a lot 
of structure are placed in front.

1 Select the Edges icon and click on the screen to create the object.

2 Click the D icon above the Viewer or press the D key to view the depth map.

3 In the Object window, adjust the Amount to set the edge brightness.

4 Change the Threshold to limit the amount of edges that are detected.

5 Press the D key to toggle the Depth view off.

Before Edges+Horizon
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Alpha
Converts the alpha channel hooked into the Depth node’s alpha inputs into a 
depth map.

1 Generate an alpha channel from either the Power Matte, Roto, Paint or zMatte 
nodes. 

2 Connect the output of the node generating the alpha into one of the Depth node’s 
alpha inputs. For instance, Alpha 1.

3 In the Depth node, select the Alpha icon and click on the screen to create the 
object.

4 In the Object window, select the node input that you plugged your alpha source 
into.

5 Click the D icon above the Viewer or press the D key to view the depth map.

The alpha channel produced in one of the other Silhouette nodes is converted 
to a depth map. In the above example, Power Matte was used with open 
shapes placed far apart which generates an organic looking gradient with edge 
detail.

Note: Another beneficial node to use in conjunction with the Depth node is Roto Blend 
which blends the opacity of shapes together creating smooth gradients. Go to the Roto 
Blend tutorial to see how it works.

Before
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6 Select Constant, Linear, Radial or Ramp from the Depth Type pop-up in the 
Object window.

• Constant sets a constant depth for the entire depth map.

• Linear fills the depth map in areas of the original alpha with a linear gradient 
containing two depth values.

• Radial fills the depth map in areas of the original alpha with a radial gradient.

• Ramp fills the depth map in areas of the original alpha with a linear gradient 
containing three depth values.

7 Depending on the Depth Type selected, adjust the depth numeric fields that are 
displayed.

8 Press the D key to toggle the Depth view off.
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Combining Shapes with Depth Objects
All of the tools from the Roto node are included in the Depth node so that they 
may be used in together with the depth objects. Multiple gradients used in 
conjunction with shapes can create a virtual soft box yielding natural depth 
gradients. The workflow is to create one or more gradient depth objects in a 
layer and then use a shape to mask them.

1 Add a gradient depth object inside of a layer.

2 Click the D icon above the Viewer or press the D key to view the depth map.

3 Create the proper depth shading using the gradient.

A shape can now be used to mask the gradient.

4 Create a shape to mask the gradient.

5 Set the shape’s Depth > Type to None.

Setting the shape’s depth to none is done since the shape is not contributing to 
depth in this example--it is only masking it.

6 Select the layer and enable its Depth > Obey Alpha control.

Before After

Copyright © 2008--www.iofoto.com
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The layer now uses the alpha from the shape to mask whatever else is in the 
layer, in this case, the gradient.

7 Use multiple gradients, mix them together with Blend Modes and then mask them 
with one or more shapes.

Each layer allows separate control over the Near Depth > and Far Depth.

8 Select a layer and use the Near Depth and Far Depth controls to adjust the near 
and far depth for the entire layer.

The technique of using gradients masked by shapes within layers is a very 
powerful feature which creates accurate and realistic depth maps.

Gradient Gradient Masked By Shape
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Before After
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Working with Stereo Images
Creating a Session Using Left and Right Clips
1 Load left and right clips and create a session based on the left view.

2 In the Trees window, add a Roto node from the Nodes > Image group and connect 
it to the source node.

3 Add a Paint node after the Roto node.

4 Double-click the source node in the Trees window to view and edit it.

5 In the Node parameters, select the right clip in the Stream > Right pop-up menu.

6 Single-click in the center of the Roto node in the Trees window to view and edit it.

You are now ready to create shapes.

Creating a Session Using Stereo EXR Files
Since stereo EXR files contain both the Left and Right Views within one file, 
they are automatically connected to the Left and Right views.

Using Merge Views to Create Stereo
You can use the Image > Merge Views node to merge input images into a 
combined left, right and depth view. This bypasses the source node’s Stream 
parameters.

Stereo Roto
1 Above the Viewer, make sure that the Left View icon (Shift-1) is highlighted. 
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When using a stereo EXR file or when left and right clips have been assigned 
in the Source node’s Stream > Left and Right parameters, the Viewer displays 
additional view modes.

The Left View icon displays the Left View in the Viewer.

The Right View icon displays the Right View.

The Left/Right View icon displays both the Left and Right Views simultaneously.

When shapes and layers are created, they will be associated with either the 
Left or Right View.

2 Create a shape around an object and keyframe as necessary.
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Since the Left View is selected, the shape is automatically associated with the 
Left View and an L is displayed for it in the Object List’s View icon.

3 Select the shape if it is not already selected and from the Edit > Stereo menu, 
choose Duplicate > New Layer.

The shape and all of its keyframes from the Left View are duplicated to the 
Right View in a new layer and the two shapes are linked together. The newly 
duplicated shape and layer have a R displayed for it in the Object List’s View 
icon signifying that it is associated with the Right View.

Note: Clicking on the View icon in the Object List toggles which view the object is 
located in.

When using shapes inside of a transformed layer, you can duplicate the layer 
instead. This will copy the layer along with its transform data into the other view, 
copy any unlinked stereo children into it and then link the shapes. You can 
stereo duplicate one layer at a time using this method.

4 Select the Right View (Shift-2).

You probably noticed that the shape in the Right View does not line up with the 
object it is associated with. This is because the Right View is offset from the Left 
View to create the stereo effect. However, you can use the Stereo Align tool in 
conjunction with a layer to negate the offset between the Left and Right Views.

5 In the Object List, click on the layer that was created for the duplicated shape.

Clicking on the layer makes it the active layer and a check appears.

You are now ready to align the two views.
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6 Select the Stereo Align icon (Shift-4) above the Viewer.

When activated, Stereo Align uses a negative mode which inverts one of the 
views and mixes it with the other. This creates an embossed effect when similar 
image areas are not aligned.

7 To perform an automatic alignment, press Shift-Alt and click on the image feature 
that you would like to align. 

or

8 Click and drag the move cursor that appears to align the views in the area of your 
shape. You can also Ctrl/Cmd-drag for finer accuracy. When similar image 
features are perfectly aligned for the object you are rotoscoping, you will see a 
solid gray color.

Note: The amount you move the view in Stereo Align mode is stored in the Stereo 
Offset parameter of the active layer which is set to animate by default. 

If you need to align vertically (not common), you can either use the Up/Down 
Arrow keys or press the Shift key while clicking and dragging the move cursor 
in the Viewer.

Note: You can automatically align without being in align mode by pressing Shift-Alt 
and clicking on an image feature.

9 If needed, you can keyframe the Stereo Offset

10 Deactivate Stereo Align mode and the shape will be aligned in the Right View.

Not Aligned Aligned
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If the object you are rotoscoping moves through various depths, you will want 
to keyframe the Stereo Offset using the Stereo Align mode at various frames.

Note: If you are rotoscoping objects at different depths, place them in separate layers 
so that different Stereo Offsets can be set on a per layer basis.

11 Adjust the shape keyframes as needed for the shape in the Right View.

12 Select the Left/Right View (Shift-3).

In the Left/Right View, the Viewer displays both the left and right clips.

Note: When the Edit In Both Views icon is enabled, shapes are edited in both views 
simultaneously. When disabled, shapes in the left or right view are edited individually.

13 To change whether the Left and Right Views are arranged either horizontally or 
vertically in the Viewer, press the Stereo Split Mode icon.

In the Left/Right View, selecting one of the linked shapes in the Viewer selects 
the other as well, and you can edit both shapes at once. If you only want to work 
on one shape at a time in the Left/Right View, just make sure that only one of 
them is selected in the Object List.
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Linking Shapes
As an alternative to using Edit > Stereo > Duplicate or Edit > Stereo > Duplicate 
> New Layer as outlined in the previous exercise, shapes of the same type and 
the same number of control points can be linked together for stereo 
rotoscoping. Once linked, the two shapes can be simultaneously selected and 
edited in the Left/Right View.

1 Select the Left View (Shift-1) and create a shape.

2 Choose the Right View (Shift-2) and create a shape of the same type and number 
of control points as the one you just created in the Left View.

3 Press the Left/Right View icon (Shift-3) above the Viewer.

4 Select both shapes in either the Object List or directly in the Viewer.

5 From the Edit > Stereo menu, choose Link.

The two linked shapes can now be simultaneously selected and edited when in 
the Left/Right View.
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Stereo Paint
In general, painting on stereo images is the same as painting with single 
images.

1 Double-click the Paint node in the Trees window to view and edit it.

The stereo view mode determines whether you are painting on the Left View, 
Right View or both the Left and Right Views at the same time.

2 Select the Left View (Shift-1).

Paint is applied to the left view only.

3 Choose the Color brush (Shift-C).

4 Paint on the image in the Viewer by pressing and dragging with your pen or 
clicking and dragging with your mouse.

5 Select the Right View (Shift-2) and paint on the image.

Paint is applied to the right view only.
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6 Select the Left/Right View (Shift-3).

7 To change whether the Left and Right Views are arranged either horizontally or 
vertically in the Viewer, press the Stereo Split Mode icon.

8 Paint on the image.

Paint is applied to both the left and right views simultaneously when the Edit In 
Both Views icon is enabled. When disabled, the left or right view is painted 
individually.

When painting on both views simultaneously, the location of the paint in the 
Right View will be offset slightly from the Left View. To paint on both the Left and 
Right Views at the same time and in the same location, you will need to add a 
layer and then use the Stereo Align mode to line up the two views.

9 Click Add Layer in the Object List.
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Two layers are added since you are in the Left/Right View.

10 Delete one of the layers since you only need one of them.

11 Select the remaining layer.

Immediately after selecting the layer, a check appears which means that it is 
the active layer.

You are now ready to align the two views.

12 Select the Stereo Align icon (Shift-4) above the Viewer.

When activated, Stereo Align uses a negative mode which inverts one of the 
views and mixes it with the other. This creates an embossed effect when similar 
image areas are not aligned.

13 To perform an automatic alignment, press Shift-Alt and click on the image feature 
that you would like to align. 

or

14 Click and drag the move cursor that appears to align the views in the area where 
you will be painting. You can also Ctrl/Cmd-drag for finer accuracy. When similar 
image features are perfectly aligned for the object you are painting, you will see 
a solid gray color.

Note: The amount you move the view in Stereo Align mode is stored in the Stereo 
Offset parameter of the active layer which is set to animate by default.
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If you need to align vertically (not common), you can either use the Up/Down 
Arrow keys or press the Shift key while clicking and dragging the move cursor 
in the Viewer.

If the object you are painting moves through various depths, you will want to set 
the Stereo Align setting on each frame.

Note: You can automatically align without being in align mode by pressing Shift-Alt 
and clicking on an image feature.

15 Deactivate Stereo Align mode.

16 Paint on the image again.

Once aligned, painting with the Left/Right View activated will paint on the same 
location of the image in both views.

17 Paint some more frames in the clip.

As frames are painted, markers are shown in the Timebar to provide a visual 
display of which frames are painted. Red markers are displayed for painted 
frames in the Left View, blue markers for the Right View and green markers for 
frames painted in both the Left and Right View.

Not Aligned Aligned
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Duplicating Strokes from One Stereo View to Another
By default, strokes only get painted into their original view when they are played 
back. The Duplicate feature in the Auto Paint window will duplicate strokes from 
one view to another on the current frame.

1 In a stereo session, make sure that the Left View icon (Shift-1) is highlighted 
above the Viewer. 

2 Paint strokes in the Left View.

3 In the Auto Paint window, select the strokes to be duplicated.

4 Select Duplicate L>R in the Auto Paint window.

The paint strokes are duplicated from the Left to the Right View.

Note: If a layer with a stereo offset is selected prior to duplicating, the stereo offset is 
taken into account when duplicating the strokes.
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Stereo Morphing
1 Select the Left View (Shift-1).

2 Create a morph just as you would if working with mono images except make sure 
that all shapes are in layers. This will allow you to easily adjust the Stereo Offset 
later.

Once you have created shapes for the A and B rolls, specified shape 
correspondences and have animated the distortion and transparency, you can 
move onto to handling stereo specific issues. The first step is to duplicate all of 
your shapes and layers to the right side. You can do this by using the Edit > 
Stereo > Duplicate feature.

3 Select a layer and from the Edit > Stereo menu, choose Duplicate. Repeat this for 
each layer in the Left view as this operation can only be done one layer at a time.



Silhouette User Guide    

• • • •••

Tutorials  277 
• • • •••

Edit > Stereo > Duplicate copies the layers, its shapes and all of their keyframes 
from the Left View, duplicates them in the Right View and links them together. 
The newly duplicated layer and shapes have a R displayed for them in the 
Object List’s View icon signifying that it is associated with the Right View.

Note: Clicking on the View icon in the Object List toggles which view the object is 
located in.

4 Select the Right View (Shift-2).

You probably noticed that the shapes in the Right View do not line up with the 
objects associated with them. This is because the Right View is offset from the 
Left View to create the stereo effect. However, you can use the Stereo Align tool 
in conjunction with a layer to negate the offset between the Left and Right 
views.

5 In the Object List, click one of the Right view layers.

Clicking on the layer makes it the active layer and a check appears.

You are now ready to align the two views.

6 Select the Stereo Align icon (Shift-4) above the Viewer.

When activated, Stereo Align uses a negative mode which inverts one of the 
views and mixes it with the other. This creates an embossed effect when similar 
image areas are not aligned.
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7 To perform an automatic alignment, press Shift-Alt and click on the image feature 
that you would like to align. 

or

8 Click and drag the move cursor that appears to align the views in the area of your 
shape. You can also Ctrl/Cmd-drag for finer accuracy. When similar image 
features are perfectly aligned for the object, you will see a solid gray color.

Note: The amount you move the view in Stereo Align mode is stored in the Stereo 
Offset parameter of the active layer which is set to animate by default.

Note: You can automatically align without being in align mode by pressing Shift-Alt 
and clicking on an image feature.

If the object you are morphing moves through various depths, you will want to 
keyframe the Stereo Offset at various frames.

9 Keyframe the Stereo Offset if necessary.

10 Deactivate Stereo Align mode and the shapes will be aligned in the Right View.

Note: If you are morphing objects at different depths, place them in separate layers so 
that different Stereo Offsets can be set on a per layer basis.

11 Adjust the Stereo Offset for all of the Right View layers.

If you need to make shape adjustments in the Right View, viewing the A or B 
roll will give faster interaction than View > Output.

Not Aligned Aligned
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12 Adjust the shape keyframes as needed for both the A roll and B roll shapes in the 
Right View making sure to select View > A or View B as appropriate.

13 Select the Left/Right View (Shift-3).

In the Left/Right View, the Viewer displays both the left and right clips and their 
shapes.

14 To change whether the Left and Right Views are arranged either horizontally or 
vertically in the Viewer, press the Stereo Split Mode icon.

In the Left/Right View, selecting one of the linked shapes in the Viewer selects 
the other as well, and you can edit both shapes at once. If you only want to work 
on one shape at a time in the Left/Right View, just make sure that only one of 
them is selected in the Object List.
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15 Change the View to Output and press 0 to turn off the shape display. This will 
allow you to see the image better.

16 Press the Play button.

Silhouette will render each frame of the left and right clips. If you have enough 
RAM to fit the clip into memory, it will playback in real time once it is completed.

Start Middle End
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Using the 3D Preview
Silhouette provides a 3D Preview window for displaying the stereo image.

1 Click the 3D Preview icon or press Shift-6.

If you have multiple monitors, the 3D Preview opens full screen while on a 
single monitor system, it opens centered and smaller.

2 When the 3D Preview opens, right-click on it and select your display type.

3 On a single monitor system, right-click on the 3D Preview and select Fullscreen.
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Multiple Object Lists, Node Or Object Windows
Creating Additional Windows & Locking Them

Multiple Object Lists, Node or Object windows can be created and locked to 
any node in the tree regardless of which node is active. In each of these 
windows, there are Add Dock and Lock Node icons.

1 Click the Add Dock icon in either the Object List, Node or Object windows.

A new Object List, Node or Object window is added and incrementally 
numbered.

2 Press the Lock Node icon to enable it.

The Object List, Node or Object window is now locked to the current node. 
Clicking on another node has no effect on the locked window. This workkflow 
allows you to have multiple windows locked to different nodes.
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Multiple Filtered Object Lists
Multiple Objects Lists in conjunction with search filtering can be used to 
organize left or right stereo objects, A or B morph shapes or anything else for 
that matter.

1 Set up a stereo session with objects in the left and right views or a morph project 
with A and B shapes.

2 Click the Add Dock icon to create another Object List.

Each additional Object List is incrementally numbered and is displayed as a tab 
below the Object List.

The Object Lists are identical until you filter them with the Search icon. With two 
Object Lists open, for instance, you can filter one on /l (left view) and the other 
on /r (right view) for stereo projects or filter on /a (A side) in one and /b (B side) 
in the other for morphing. If you then switch an object’s view assignment from 
left to right or from A to B, it will cause it to jump between the two lists.
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3 Enable the Search icon in the original Object List.

4 In the Search field that appears, enter /l if you are working in a stereo project or 
/a if in a morph project.

The Object List now only displays left view objects for a stereo project or A side 
objects for a morph project.

5 Enable the Search icon in Object List 2.

6 In the Search field that appears, enter /r if you are working in a stereo project or 
/b if in a morph project.

Object List 2 now only displays right view objects for a stereo project or B side 
objects for a morph project.

You can now easily switch between the Object Lists.

Note: Closing one of the added docks will also delete it.

7 Disable the Search icon when done to return to the normal Object List window 
view.
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Video Fields and 3:2 Pulldown
When working with footage that contains video fields, you have the option of 
either deinterlacing or removing 3:2 Pulldown.

Working with Video Fields
1 Import some video media that contains fields and create a session.

2 Click on the imported clip in the Sources window.

3 In the Object window, select Deinterlace from the Field Handling pop-up menu.

4 Choose Even (NTSC) or Odd (PAL) deinterlacing from the Field Dominance pop-
up menu.

5 Press the F button in the Timebar located at the bottom right of the Viewer to 
expand the Timeline and increment in fields (half frames).

6 Edit whatever node you are working on in field mode.
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7 When it is time to render, select Field Handling > Interlace and Field Dominance 
> Even (NTSC) or Odd (PAL) in the Render Options window.

Working with 3:2 Pulldown
1 Import some 3:2 based media and create a session.

2 Step through the beginning of your clip and determine the first field blended 
frame using the 3:2 setting in the chart below.

3 Click on the imported clip in the Sources window.

4 In Object window, select the appropriate 3:2 setting from the Field Handling pop-
up menu.

First frame with field blending 3:2 Setting

1 BC

2 BB

3 AA

4 DD

5 CD
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5 Choose Even (NTSC) or Odd (PAL) deinterlacing from the Field Dominance pop-
up menu.

6 When you choose the 3:2 value, the length of your clip changes in the Sources 
window.

7 Change the Session > Settings to reflect the new clip length.
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ROI (Region of Interest)
ROI (Region of Interest) crops the image in the Viewer to a user defined size 
and can be animated. This is especially useful when you only need to work 
within a smaller region of a larger image as it will use less memory and process 
faster. If expanded, the ROI will display overscan pixels which can then be 
manipulated.

Using a Smaller ROI for Performance
The ROI can be made smaller than the session size to speed up processing 
and save memory. This is especially useful when working with larger images.

1 Load some source footage and create a session.

2 Single-click in the center of the source node in the Trees window to view and edit 
it.

3 Display the ROI controls by clicking the ROI icon above the Viewer.

Once the ROI icon is activated, the ROI controls appear above the Viewer.

4 Make sure the Enable button is active.

5 Drag one of the corner points to size the ROI.

Note: You can also Ctrl/Cmd-Shift-drag a square region in the Viewer to draw a ROI 
region. 

6 Move the ROI by clicking and dragging its bounding box.

7 Animate the ROI by enabling the Animate icon and adjust the ROI at various 
frames.

8 To avoid moving the ROI by mistake after it has been set, disable the Viewer > 
ROI icon.
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This hides the ROI controls, but it is still active.

Note: To temporarily turn off the ROI effect, toggle the Enable icon.

9 To render the ROI, make sure that Render ROI is enabled in the Render Options.

Using the ROI to Reveal Overscan Pixels
If the source’s DOD (Domain of Definition) is larger than the session, the ROI 
can expand to reveal overscan pixels which can then be manipulated.

1 Load some source footage whose DOD is larger than the session you are 
working in.

2 Single-click in the center of the source node in the Trees window to view and edit 
it.

3 Display the ROI controls by clicking the ROI icon above the Viewer.

Once the ROI icon is activated, the ROI controls appear above the Viewer.

4 Make sure the Enable button is active.

5 Click the Set ROI to DOD icon in the Viewer. 

The ROI will automatically be set to match the size of the source’s DOD and 
will reveal any overscan pixels.
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Rendering
When you have you completed your work in Silhouette, you will need to render 
the final result.

1 In the Trees window, add Output nodes after the nodes that you would like to 
render.

2 In the Output node, set the file format type.

The format setting allows you to select from various file formats. We currently 
can save to the following file formats: Cineon, DPX, IFF, JPG, OpenEXR, PNG, 
SGI/RGB, TIFF and TARGA.

3 Enter the path and file name for the rendered file in the File field. You can either 
type in the path and name in the File field or click the Browse icon on the right.

As far as filenaming is concerned, you only have to type in a name as periods, 
hash marks for padding and file extensions are not required unless you want to 
manually enter them. See below.

4 If you choose to manually enter the file padding and extension, the filename 
should have 3 things:

• The image name.

• # for the frame placeholder.

• An extension: .exr = exr files, .cin = Cineon files, .tif = Tiff files, etc.

Therefore, if you enter a name something like test.####.exr,. Silhouette will 
render out test.0001.exr, test.0002.exr, etc. You can confirm how the files will 
be formatted by looking in the Output node’s Sample field. The Sample field 
displays all of the files that will be produced by the node.

5 Choose the appropriate channels to render. You can choose from RGB, Alpha 
and Depth.

6 If you are rendering a stereo project, select whether you want to render the Left, 
Right or Both the Left and Right Views simultaneously using the Views pop-up 
menu.
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7 Press the Render button, Ctrl/Cmd-R or Select Session > Render Session.

The Render Options window opens.

8 Choose whether to render All Output Nodes or just the Selected Output Nodes. 

Note: Output nodes have to be selected for the Selected Output Nodes option to work.

9 Select the range of frames to render.

At this point, you could just hit the Render button to render to disk. Alternatively, 
you could open a Preview window that displays each rendered image as well 
as render statistics while rendering.
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10 Enable Preview and select Render.

The Preview window opens. Pressing the R, G, B, and A buttons toggles 
viewing of the respective channels while C displays the RGB channels.

Rendering the Automatic Data Window
The Automatic Data Window rendering option looks at the alpha channel and 
determines the data window from that. Then, it writes only the pixels in the data 
window to an EXR file. For SXR files, it writes the combined data window 
between the two views. This greatly speeds up loading these files into a 
compositing system.

1 To render the EXR data window based on the alpha channel, set OpenEXR as the 
file format in the Output node.

2 Enable the Automatic Data Window option.

Silhouette will now look at the alpha channel to determine the data window and 
render only the pixels in the data window to the file.
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Rendering EXR Multi-Part Files
The Output Multi-Part node renders EXR multi-part files.

1 From the Image tab, add an Output Multi-Part node to the Trees window.

2 Connect the output of different nodes into the Output Multi-Part node’s inputs. 

If you would like more than the 4 default inputs, more can be added.

3 Right-click on the Output Multi-Part node and select Add Input. Right-click on an 
input port to remove it. You can add as many inputs as you want, but the inputs 
will get smaller.

If there is more than one input, each output part name is appended with the 
upstream node's name.
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Command-Line
Silhouette on the command-line allows you to execute projects with a variety of 
commands to control the rendering process.

1 Open a Terminal window.

The Silhouette command-line program is named sfxcmd and is located in the 
following locations depending on your operating system:

• Linux: Location determined at installation

• Macintosh: 
/Applications/SilhouetteFX/Silhouette[version]/Silhouette.app/Contents/MacOS

• Windows: C:\Program Files\SilhouetteFX\Silhouette[version]

2 Use the cd command to navigate to the location of the sfxcmd command-line 
program.

3 Type the following command:

• Mac: ./sfxcmd

• Windows: .\sfxcmd.exe

• Linux: ./sfxcmd.sh

The Silhouette command-line options are displayed in the Terminal window. 

Command-line options are of the form: -option value, where value may be 
optional. Required arguments are in pointy brackets (< >) and optional 
arguments are in brackets([ ]). If the value must be from a list of possible 
values, the available values are separated by |. The basic form of the sfxcmd 
argument is: sfxcmd <projectname> [options]

4 To render a project called vfx-125-02.sfx located at D:\SFX\projects, type: 
.\sfxcmd.exe D:\SFX\projects\vfx-125-02.sfx

By default, the project is rendered using the settings in the project unless 
changed by command-line options.

5 To render every other frame, use the -step command as follows: .\sfxcmd.exe 
D:\SFX\projects\vfx-125-02.sfx -step 2

Use -range or -f to specify single or multiple ranges of frames to render and - 
-start to override the starting frame number of the rendered frames. 
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6 The vfx-125-02 project starts at frame 1 and has a duration of 78 frames, but you 
want the rendered files to start at 1001. To do this, type: .\sfxcmd.exe 
D:\SFX\projects\vfx-125-02.sfx –range 1-78 –start 1001

If your project has multiple sessions, you would need to target one of the 
sessions to render. If you are too lazy to open up the Silhouette user interface 
to determine the session name, you can use the -info command. 

7 To print information about the overall project, type: .\sfxcmd.exe 
D:\SFX\projects\vfx-125-02.sfx -info

When –info is used, rendering is disabled and the project information is 
displayed.

Project: D:/SFX/projects/vfx-125-02
FileSource: bg.[0001-0078].rgb
FileSource: engine.[0001-0078].rgb
FileSource: bg_big.rgb
FileSource: gas.[0001-0078].rgb
FileSource: lens.[0001-0078].rgb
FileSource: parts.[0001-0078].rgb
FileSource: ship.[0001-0098].rgb
Session: vfx-125-02-v1
        Size: (2048, 1556)
        Aspect: 1.0
        Duration: 78.0
        Start: 1
        Rate: 24.0
        Work Range: (1.0, 78.0)
        Node: zMatte
        Node: Roto - Garbage
        Node: Screen Smoother
        Node: Roto Holdout
        Node: engine.[0001-0078].rgb 2
        Node: Tracker
        Node: Math Composite 1
        Node: engine.[0001-0078].rgb 2
        Node: bg.[0001-0078].rgb
        Node: gas.[0001-0078].rgb 1
        Node: Math Composite 2
        Node: lens.[0001-0078].rgb
        Node: Math Composite 4
        Node: parts.[0001-0078].rgb
        Node: Composite
        Node: Output
        Node: ship.[0001-0098].rgb 2
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Session: vfx-125-02-v2
        Size: (2048, 1556)
        Aspect: 1.0
        Duration: 78.0
        Start: 1
        Rate: 24.0
        Work Range: (1.0, 78.0)
        Node: zMatte
        Node: Roto - Garbage
        Node: Screen Smoother
        Node: Roto Holdout
        Node: engine.[0001-0078].rgb 2
        Node: Tracker
        Node: Math Composite 1
        Node: engine.[0001-0078].rgb 2
        Node: bg.[0001-0078].rgb
        Node: gas.[0001-0078].rgb 1
        Node: Math Composite 2
        Node: lens.[0001-0078].rgb
        Node: Math Composite 4
        Node: parts.[0001-0078].rgb
        Node: Composite
        Node: Output
        Node: ship.[0001-0098].rgb 2

8 To render the vfx-125-02-v2 session from the vfx-125-02 project, type the 
following: .\sfxcmd D:\SFX\projects\vfx-125-02.sfx -session vfx-125-02-v2

There are lots of possibilities, so see the Command-Line chapter for a 
complete list of options and descriptions.
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Keyboard Customization
Keyboard shortcuts can be customized by using a text editor to modify a Python 
script located in the scripts folder of your Silhouette installation.

To modify your Silhouette keyboard shortcuts:
1 Go to the scripts folder of your Silhouette installation. 

2 For Windows, go to C:\Program 
Files\SilhouetteFX\Silhouette[version]\resources\scripts.

or

3 For Linux, go to /SilhouetteFX/silhouette[version]/resources/scripts.

or

4 For Macintosh, go to /Applications/Silhouette[version], right-click on Silhouette 
and select Show Package Contents.

A new Browser window opens.

5 In the new Browser window, go to Contents/Resources/scripts.

Inside the scripts folder, you will find a keybinds.py file. As a precaution, it would 
be a good idea to make a backup of this file.

6 Make a copy of the keybinds.py file and rename the copy keybinds.py.bak.

7 Using a text editor, open the keybinds.py file.

8 Scroll down and replace the existing shortcuts with those of your choosing.

9 Save the file.

10 Restart Silhouette for the new keyboard shortcuts to be active.
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 USER INTERFACE

Silhouette uses a combination of traditional pull-down menus, toolbars and 
pop-up menus. Quick keys are provided for most functions and are shown next 
to the pull-down menu equivalent. Pop-up tool tips describe the function of 
buttons when the cursor is dragged over them. Pop-up and floating windows 
are used where appropriate.

The Silhouette interface is comprised of Sources, Trees, Viewer, Toolbar, 
Timebar, Timeline/Curve Editor, Node and Object Parameters, Presets, Object 
Lists and Nodes windows.

Toolbar

Timebar

Object List
Timeline/Curve Editor

Parameters

Sources

Viewer

Trees
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Concepts
Projects

A project contains sessions, trees, nodes and source media.

Sessions
A session in Silhouette is where you composite, rotoscope and paint. It 
describes the resolution, bit depth, duration, frame rate and aspect ratio as well 
as what nodes you will be using. More on nodes below. Typically, you may have 
a job that requires you to work on multiple shots. A session would be created 
for each shot that you will work on. You can have as many sessions as you 
want, but can only work on one session at a time. 

Sources
Sources are sequential images--clips. The location, frame rate, raster type, 
image size, and other information about the sources is stored for your 
reference.
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Trees
Trees are the combination of sources and nodes that are used to create the 
desired effect.

Nodes
Individual nodes that perform image processing functions are connected 
together to form a tree.
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Objects
Objects are items such as shapes, layers, trackers and brushes that are used 
by the nodes.
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Projects
When you start Silhouette, you are required to create or open a project, after 
which the user interface opens. A project contains sessions, trees, nodes and 
source media. A session in Silhouette is where you composite, rotoscope and 
paint.
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New Project
When a new project is created, a folder is generated using the name of the 
project and contains the project file as well as paint data, autosave, and 
backups.

Open Project
Opens existing projects using a file browser.

Recent Projects
Quickly open one of the ten most recent projects.

Sources
At the bottom left of the user interface, you will find the Sources window. This 
is where you import footage and create sequences or sessions.

The clip name, resolution, bit depth and duration is displayed on the image 
thumbnail.



Silhouette User Guide    

• • • •••

User Interface  305 
• • • •••

Import
Opens a file browser to import footage.

New Session
Creates a new session based on the selected source.

New Sequence
Creates a new sequence in the Sequence Editor.

Search
Clips and sequences can be searched for by entering text in the Search field. 
Once text is entered, only matching items are shown. Clear the search text to 
return the Sources window to its normal state.

Rename
Right-click on a source or sequence to rename it.

Source Views
List View
Displays the source information as text only.

List View with Thumbnails
Displays the source information as a thumbnail and text.
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Thumbnail View
Displays the source information as a thumbnail only.

Import Media
Footage is imported by selecting File > Import > Media, by double-clicking on 
an open space in the Sources window or by pressing the Import icon at the 
bottom left of the Sources window.

When the File Browser opens, you can import a single frame, the entire clip or 
a range of frames.
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Import Options

We currently support the following file formats: Cineon, DPX, IFF, JPEG, 
OpenEXR, PNG, SGI/RGB, TIFF and TARGA.

Open
Loads the selected media into the Sources window.

Cancel
Cancels the import operation.

Go to the Importing Media tutorial to see how it works.

Source In and Out Points
Each clip in the Sources window can have a different in and out point which are 
used when creating a new session or editing in the Sequence Editor.

To set a clip’s in and out point:
1 Double-click on a clip in the Sources window. 

The clip is loaded into the Viewer and Mark IN and Mark OUT icons appear.

2 Set the Timebar to the in point.

3 Click the Mark IN icon or press the I key.

4 Set the Timebar to the out point.

5 Click the Mark OUT icon or press the O key.

When you are done setting the clip’s in and out points, change the Viewer back 
to the session.

Selection Action

Select the first frame in a clip Imports the entire clip

Select a range of frames Imports the selected range of frames

Select any single frame other than the first frame Imports only that frame
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6 Click on a node in the Trees window.

The result of the Trees window is now displayed in the Viewer.

Source Settings
Source media settings can be modified in the Object window. You can access 
these settings by clicking on the media in the Sources window.

Renaming Media
The source can be renamed using the name field.

Replacing Media
The File field is used to replace media.

If the media is moved from its location on disk after you have imported it, 
Silhouette will no longer be able to find it. However, you can easily relink the 
media so you can replace your existing clip with a new one. You can either 
manually type in the path or click the Browse icon at the far right of the File field.

Go to the Replacing Media tutorial to see how it works.

Managing Media Paths
You can virtualize media paths in order to improve asset sharing between 
users, asset management and render servers by specifying the file path with a 
SFX_MEDIA environment variable. 
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Go to the Managing Media Paths tutorial to see how it works.

Managing Media Paths - Scripting
System administrators are able to create their own content resolvers with 
Silhouette's scripting system. A content resolver can remap footage 
automatically on import and when it is used.

• A content resolver can remap the footage path when it is imported. For instance, 
our default resolver remaps anything under the $SFX_MEDIA variable to start with 
a “sfx:” scheme.

• A content resolver can remap the footage file path when it is used. For instance, 
our default resolver remaps anything starting with the sfx: scheme to a path 
starting with the directory $SFX_MEDIA points to.

Field Handling
You can choose from either Deinterlace or one of the 3:2 settings.

See the Appendix F - Video Fields chapter for a detailed explanation of video 
fields.

None
No field processing takes place.

Deinterlace
Deinterlaces the video frame into two separate fields.

3:2 AA
Removes 3:2 Pulldown based on the AA frame being the first frame.

3:2 BB
Removes 3:2 Pulldown based on the BB frame being the first frame.

3:2 BC
Removes 3:2 Pulldown based on the BC frame being the first frame.



Silhouette User Guide    

• • • •••

User Interface  310 
• • • •••

3:2 CD
Removes 3:2 Pulldown based on the CD frame being the first frame.

3:2 DD
Removes 3:2 Pulldown based on the DD frame being the first frame.

Field Dominance
Select either Even or Odd dominance depending on whether you are working 
with NTSC or PAL images.

Even
Use for NTSC images.

Odd
Use for PAL images.

Go to the Working with Video Fields and Working with 3:2 Pulldown 
tutorials to see how they work.

Interpretation
Interpretation is only displayed in the Object window when using DPX files. It 
detects and sets whether DPX files are Logarithmic or Linear. Sometimes the 
program used to create the DPX files writes the wrong header information into 
the file causing Silhouette to think it is Logarithmic when it is Linear and vice 
versa. The controls below allow you to explicitly set whether or not the file is 
Logarithmic or Linear.

Auto
Automatically figures out whether the DPX file is Logarithmic or Linear.

Log
Manually sets the DPX file to Logarithmic.

Lin
Manually sets the DPX file to Linear.

Note: To update the Viewer after changing the Interpretation, purge the RAM cache.
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Autosave and Backups
An autosave and backup system ensures that you will not lose any of your 
work. Autosaves and backups are stored in the project folder. 

Autosaves
The Auto Save > Interval (minutes) preference specifies how often to update 
the autosave file which is named autosave.sfx. If Silhouette crashes, you are 
given the choice to open the autosave file when re-opening the project. When 
projects are closed or saved normally, the autosave file is automatically 
deleted. 

Backups
The Auto Save > Maximum # of Backups preference controls how many 
backup files are created. Each time a project is saved, a backup copy is stored. 
The most recent backup is backup.sfx, the second most recent is backup.1.sfx, 
then the next is backup.2.sfx, etc., up to the maximum number of 5. As each 
new backup is added, the files are rotated upward.
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Sessions
A session in Silhouette is where composite, rotoscope and paint. Typically, you 
may have a job that requires you to work on multiple shots. A session would be 
created for each shot that you will work on. You can have as many sessions as 
you want, but can only work on one session at a time.

Go to the Creating Sessions tutorial to see how it works.

New Session
You must create a session before you can start working with your footage. It 
describes the resolution, bit depth, duration, frame rate and aspect ratio as well 
as what nodes you will be using. You can create a new session by:

1 Selecting a clip in the Sources window and pressing either Ctrl/Cmd-N, selecting 
Session > New Session or clicking the New Session icon at the bottom of the 
Sources window.

2 Dragging the clip thumbnail from the Sources window to the Trees window.

Note: If an in and out point has been marked for a source clip, the marked duration will 
be used for the session duration. For more information on source clip in and out points, 
see Source In and Out Points.
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Editing Sessions
Once you have created a session, you can change its settings at any time by 
either 1) Selecting Session > Session Settings or 2) Pressing Ctrl/Cmd-Shift-
S. In either case, the session window opens and you can change the settings.

Switching Sessions
To switch between sessions, select it from the pop-up at the top of the Trees 
window or from the Session > Current Session menu.

Deleting Sessions
Delete a session using the Session > Delete Session menu. Whatever is the 
currently selected session is deleted.

Session Window
The Session window has a variety of settings for format, image size, pixel type, 
and frame rate. You can choose one of the preset formats or create a custom 
format.

Name
Determines the name of the session.

Template
Templates are presets for automatically adding Roto and Paint nodes to the 
session and selecting a workspace.

Composite
Automatically adds an Output node to the Source and selects the Composite 
workspace.

Paint
Automatically adds Paint and Output nodes to the Source and selects the 
Streamlined workspace.

Roto
Automatically adds Roto and Output nodes to the Source and selects the 
Streamlined workspace.
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Roto+Paint
Automatically adds Roto, Paint and Output nodes to the Source, connects the 
Roto > Objects output to the Paint > Objects input and selects the Streamlined 
workspace.

Workspace
Selects a Silhouette workspace. A workspace is a snapshot of the user 
interface layout.

Format
A number of preset formats can be selected from the Format pop-up menu. 
When one of the options is selected, the session fields are preset with the 
appropriate data. See the Appendix C - Session Formats chapter for a 
complete listing of all format presets.

Format Presets
• Custom

• Film Full Aperture (4K: 4096x3112)

• Film Full Aperture (4K: 4096x3072)

• Film Full Aperture (2k: 2048x1556)

• Film Full Aperture (2k: 2048x1536)
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• Film Cinemascope Full (3656x2664)

• Film Cinemascope Half (1828x1556)

• Film Academy (1828x1332)

• HDTV 24p (1920x1080)

• HDTV 1080i (1920x1080)

• HDTV 1080, Anamorphic 1280x1080

• HDTV 720p (1280x720)

• NTSC (640x480)

• NTSC (648x486)

• NTSC DV 720x480)

• NTSC DV Widescreen (720x480)

• NTSC D1 (720x486)

• NTSC D1 Square Pixels (720x540)

• PAL D1/DV (720x576)

• PAL D1/DV Square Pixels (768x576)

• PAL D1/DV Widescreen (720x576)

Size
Width
Sets the width of the image.

Height
Sets the height of the image.

Pixel Aspect
Sets the pixel aspect ratio of the image.

Duration
Sets the length of the session.

FPS
Sets the frame rate of the session.
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Sets the start frame for the session. The Player, Timeline and Render Options 
incorporate this value into their numbering. 

Depth
Sets the bit depth of the session.

8 bit
Sets the bit depth to 8 bits per channel.

Float 16
Sets the bit depth to 16 bit floating point. Use for film sessions using OpenEXR, 
DPX and Kodak Cineon files. Float 16 will have slightly less precision than Float 
32 but will take up much less memory.

Float 32
Sets the bit depth to 32 bit floating point. Use for film sessions using OpenEXR, 
DPX and Kodak Cineon files. Float 32 will be higher precision than Float 16, but 
will take up much more memory.

OK
Creates a new session in the Trees window. When you click OK, the session is 
automatically created.
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Trees
The power of Silhouette lies in the Trees window where your effects are built. 
A tree is a series of clips and nodes, such as color correction, image processing 
and composite nodes, plugged together to create the desired effect. The tree 
is grown by adding clips and nodes in any order. The ability to view any node 
while editing another allows for very complex composites that can be set up 
and rendered in one pass.
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Session Selector
There is a Session Selector at the top of the Trees window where you can 
select the session to work on.

Overview
The Overview displays a miniature version of the entire Trees window at the 
bottom right.

Extract Nodes (E)
Click on a node and select the Extract icon at the top of the Trees window to extract 
it from the Tree.

Enable/Disable Nodes (D)
Click on a node and select the Toggle Enable State icon at the top of the Trees 
window to disable it. Click the icon again to enable it.

Load Nodes
Loads previously saved nodes.

Save Nodes
Saves selected nodes.

Note: The Paint node can’t be saved using Save Nodes.
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Delete Session
Deletes the current session.

Inside this Overview, a gray rectangle signifies the visible portion of the Tree 
which you click and drag to pan. If the gray rectangle is moved off screen, just 
click in the Overview and it will reappear.
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Nodes
Silhouette is a node based system and different nodes are used for various 
functions. Located in the Nodes window at the bottom of the screen, nodes are 
grouped into the following categories: Color, Composite, Diffusion, Filter, Film 
Lab, Image, Key, Light, Silhouette, Special Effects, Time, Tints, Transform and 
Warp.

Nodes can be dragged and dropped to the Trees window and then wired up to 
the appropriate inputs. Once active in the Trees window, the node’s controls 
appear in the Node parameters window and if required, the relevant tools show 
up in the Toolbar.

Favorites
Nodes can be tagged as a Favorite allowing them to be grouped separately in 
the Favorites tab of the Nodes window.

You can tag a node as a Favorite by selecting the node (single click) and 
pressing the Favorite icon located at the top left of the Nodes window.

If the node is already a favorite, the Favorite icon lights up when the node is 
selected and you can turn it off.
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Search
To search for nodes in the Nodes window, click the Search icon at the top left 
of the Nodes window. 

Enter the node into the search field and it will appear.

Disable the Search icon when done to return to the normal Nodes window view.

Note: With the mouse in the Nodes Window, you can press the Enter key to enter 
search mode, and the Esc key to leave it. 

Node Connections
Nodes can be configured for either vertical or horizontal layouts. Vertical layout 
sets the node’s input and output at the top and bottom of the node while 
horizontal layout sets the node’s input and output on the sides of the node. This 
is controlled by a User Interface > Tree Layout preference.

Vertical Layout
The different colored bars on the border of the nodes allow you to connect them 
together.

Output

Inputs

Obey Matte

Edit Node

View Node

Aux Outputs
Objects Output



Silhouette User Guide    

• • • •••

User Interface  322 
• • • •••

Inputs
The colored bars on top of a node are the inputs. Depending on the node, the 
type of input required may change. Green bars are foreground and background 
inputs, purple bars are auxiliary inputs, and yellow bars are transform inputs. 
Tool tips pop up when you hover over a node’s input or output to easily identify 
it.

Output
The colored bars on the bottom of a node are outputs. The gray colored bar is 
the main output, purple bars are auxiliary outputs, and yellow bars are object 
outputs--like layers. You use the output of a node to feed it into the input of other 
nodes.

Obey Matte
The blue colored bar at the far right is the obey matte input. Whatever is 
plugged in to the obey matte input will constrain or limit the effect of the node.

Horizontal Layout
The different colored bars on the border of the nodes allow you to connect them 
together.

Inputs
The colored bars on the left side and top of a node are the inputs with the 
primary input being on the left side. Depending on the node, the type of input 
required may change. Green bars are foreground and background inputs, 

OutputInput

Input Obey Matte

View Node
Aux Outputs

Objects Output

Edit Node
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purple bars are auxiliary inputs, and yellow bars are transform or obejcts inputs. 
Tool tips pop up when you hover over a node’s input or output to easily identify 
it.

Output
The gray colored bar at the right side of a node is the main output. The colored 
bars on the bottom of a node are outputs. Purple bars are auxiliary outputs and 
yellow bars are object outputs--like layers. You use the output of a node to feed 
it into the input of other nodes.

Obey Matte
The blue colored bar at the top right is the obey matte input. Whatever is 
plugged in to the obey matte input will constrain or limit the effect of the node.

View / Edit Node
You can view one node in the Viewer while editing the parameters of a different 
node. 

View Node
When enabled, the View Node icon on the left side of the node displays the 
result of that node in the Viewer.

Edit Node
When enabled, the Edit Node icon on the right side of the node displays its 
parameters in the Node parameters window.

Single-click the center of a node to simultaneously enable the View Node and 
Edit Node icons.

Adding Nodes
There are various ways to add nodes to a tree:
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1 Click and drag a node from a Nodes window onto the center of an existing node wire 
where it will be inserted.

2 Single-click a node in the Nodes window to add it after the selected node or place it 
in the center of the Trees window if nothing is selected.

3 Use the Backtick key or right-click in the Trees window to add a node from the pop-
up menu. It is added after the selected node or is placed near the cursor if nothing is 
selected.

4 Click and drag a node from the Nodes window on top of an existing node and a new 
branch is created.

Connecting Nodes
There are various ways to connect nodes in a tree:

1 Connect nodes together by dragging from the output of one node to the input of 
another node or vice-versa.

2 Select one or more nodes using Cmd(Win)-Ctrl(Mac)-click and then Shift-click on 
a target node. All selected nodes will wire up to the input bars on the target node 
in the order the source nodes were selected.

3 Drag an unconnected node over a wire, line it up with the input port you want to 
connect and then release once it automatically connects.

4 Touch input/output bars until they highlight, wait .3 seconds, the ports will 
connect, and then they will unhighlight as they can no longer connect again.

5 Swap inputs by dragging one of the wires and placing it on the other connected 
input.

6 Shift-clicking

• Node: If Shift-clicking on a node, the node becomes the target node. Any selected 
nodes become the source nodes that get wired to the inputs of the target node in 
selection order. 

• If the bar is an input bar then the behavior above applies, but instead of using the 
primary input, the clicked bar is used. This will only work with a single node since 
multiple nodes can't be wired to the same input bar.

• If the port is an output bar, then a wire is added from the output bar to the primary 
inputs of all selected nodes.

Note: You can’t use a Source clip’s node input, only its output.
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Grouping Nodes
Nodes in the Trees window can be grouped, collapsed or expanded.

Using Node Groups
• To group one or more nodes, right-click on one of the selected nodes and choose 

Group Nodes. A group window appears around the nodes.

• Ungroup nodes by right-clicking on the node group and select Ungroup.

• Rename the node group by right-clicking over the group and select Rename.

• Change the background color of the group by clicking on the color pot to the right 
of the title.

• Double-click on the group or click the collapse/expand icon to the left of the title 
to collapse/expand the group.

• Click-drag anywhere in the group (not on a node) to move the group.

Deleting Nodes/Wires
• Click on a node to select it and press the Delete key.

• Click on a wire to select it and press the Delete key.

Disconnecting Nodes
There are various ways to disconnect nodes from a tree:

Collapse/Expand Background Color
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• Click on a node and select the Extract icon at the top of the Trees window.

• Click on a node to select it and press E to extract it.

• Shake a node to the left and right to detach it.

Disabling Nodes
• Click on a node and select the Toggle Enable State icon at the top of the Trees 

window.

• Click on a node to select it and press D to disable it. If disabled, pressing D will 
enable the node.

or

• Click on a node’s Edit Node icon to edit its parameters.

• Press the lightning bolt icon at the top of the Node parameters.

Renaming Nodes
It is a good idea to rename your nodes, especially when you have a large tree, 
for organizational purposes. 

To rename a node:
1 Click on a node’s Edit Node icon to edit its parameters.

2 Type in a new name at the top left of the Node Parameters window.

Once renamed, a read-only field appears to the right of the node name, 
displaying the node type.
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Note: If the node's name is renamed to be different from its type, the tooltip displayed 
when hovering will show the node type in parenthesis.

Replacing Nodes
You can replace any node in the tree with another node within the Node 
Selector or with any other node in the Trees window.

To replace a node:
1 Alt-click and drag a node on top of another node and release.

Searching Nodes
You can search for nodes by using the Search field at the top right of the Trees 
window.

To search for nodes:
1 Enter the node’s name in the Search field at the top right of the Trees window and hit 

Enter.

The node is selected in the tree.

2 Hit Enter again to select the next node of the same name.

3 Click the X to the right of the Search field to clear the search.

Trees Window Pan/Zoom Shortcuts

Shortcut Action

Middle-mouse drag Pans the tree

Space Bar-drag Pans the tree

Scroll wheel Zooms the tree in and out

+ or = Zooms the tree in

- Zooms the tree out

Click and Drag in Overview Pans the Overview overlay
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Toolbar, Node and Object Parameters, Presets
Controls for selected objects such as nodes, shapes, layers, and trackers are 
set using the Toolbar, Node and Object windows. In addition, notes can be 
assigned to shapes, layers and trackers in the Notes window.

Note: When dragging numeric fields, press the Ctrl/Cmd key while dragging for finer 
control.

Toolbar
Along the left side of the Viewer is the Toolbar. It contains icons that select 
various tools. The contents of the Toolbar will change depending upon the node 
that is selected.

Transform

Reshape

X-Spline

Square

B-Spline

Magnetic Freehand

IK

Bézier

Tracker
Circle

MultiFrame
RotoOverlay
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Parameters
Node
When a node in the Trees window is edited, its controls appear in the Node 
parameters window.

Add Dock
Adds another Node parameters window.

Lock Node
Locks the Node parameters window to the current node.

Enable/Disable
Enables or disables the node.
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Object
All of the editable parameters of a shape, layer or tracker can be adjusted in the 
Object parameters window. When a shape is selected, you will see the controls 
listed below.

Add Dock
Adds another Object parameters window.

Lock Node
Locks the Object parameters window to the current node.
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Presets
The Presets window allows you to select from a set of pre-defined presets. 
When the Presets tab is selected, the Presets window is visible and displays 
the current node’s available presets. 

Presets for most nodes have been created so that you can easily click through 
the various choices.

Most nodes contain multiple preset groups which are selectable at the top of 
the window.
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Clicking once on a preset modifies the image in the Viewer. As you click on 
different presets, the image in the Viewer will update. This allows you to quickly 
try out several different presets.

Preset Searching
Presets can be searched for by entering text in the search field located at the 
top of the Presets window. Clear the search text to return the Presets window 
to its normal state.

To search for a preset:
1 Select a node, for instance Special Effects > Looks.

2 In the Presets window search field, type Warm.

All presets with Warm in the name are shown.

3 Click the X to the right of the search text to clear the search.

Create Preset
Creates a custom preset in the Presets window based on the current parameter 
settings.

To sort the Presets window by Custom presets, select Custom in the Presets 
pop-up menu.
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Favorites
Presets can be tagged as a Favorite allowing them to be sorted separately in 
the Presets window. You can tag a preset as a Favorite by selecting the preset 
and pressing the Favorite icon located at the top right of the Presets window.

Presets tagged as a favorite display a yellow star at the top right of the preset.

To sort the Presets window by Favorites, select Favorites in the Presets pop-
up menu.

Delete Preset
Deletes custom presets.

Rename Preset
Right-click on a custom preset, select Rename Preset and type in the new 
name.
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Notes
The Notes window allows you to type a note for selected objects.
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Object List
In nodes that contain shapes, the Object List is where you can select, lock, 
combine, rename or delete shapes, layers and trackers. Layers are containers 
for shapes and other objects and have their own individual transforms.

Add Dock
Adds another Object List.

Lock Node
Locks the Object List to the current node.

Search
Searches for shapes, layers or trackers in the Object List. 

Click the Search icon, enter an object name into the search field and it will 
appear.

• If you type /l or /r at the end of a query, it will filter only left or right stereo objects.

• If you type /a or /b at the end of a query, it will filter only A or B morph objects.

Layer

Objects

Layer Icons

Shape Icons
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For instance, to show all right side objects, just type /r. To show all left side 
objects starting with the word deer, type deer/l. Entering deer/rb would match 
all right side B objects that have the word deer in the name. 

Disable the Search icon when done to return to the normal Object List window 
view.

Add Layer
Located at the bottom of the Object List, this icon creates a new layer. Layers 
are used to organize shapes, trackers and other objects, but more importantly 
they are used to contain the motion information from trackers.

Note: Dragging objects onto the New Layer icon will create a new layer and move the 
objects into it in one operation.

Deleting
Select an object in the list and press Ctrl/Cmd-X, hit the Delete key or use the 
Delete icon at the bottom of the Object List.

Renaming
You can rename an object by either:

• Clicking on the object once to select it, hitting the Enter key, typing in the new 
name and pressing Enter again.

• Double-clicking the object, typing in a new name and hitting the Enter key.

• Right-clicking on the object, selecting Rename and typing in a new name.
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Selecting
Clicking the name of an object selects it. Multiple objects can be selected by 
Shift-clicking on them. Ctrl/Cmd-clicking will add to the selection of objects 
that are located at different levels of the Object List while Ctrl/Cmd-clicking an 
object after it is selected will deselect it. In addition, if you Shift-click a color pot 
in the Object List, you select all objects of the same type and color.

Note: In File > Preferences > Shape on Windows and Linux or Silhouette > 
Preferences > Shape on Mac, there is a Template Color setting that sets the color and 
opacity of unselected shapes. This feature is enabled by using Shift-W.

Moving
Objects can be moved by dragging and dropping them to a new position in the 
list or within another layer.

Expanding / Collapsing Layers
Expand All
Shift-clicking the +/- icon expands or collapses all nested layers inside that 
layer.

Expand or collapse multiple layers at once 
If expanding or collapsing a selected layer using +/- icon, then any other 
selected layers with the same parent will also expand or collapse. This can be 
combined with Shift to expand or collapse children as well.
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Icons
Shape Icons
There are number of icons directly to the right of a shape’s name that can be 
used to modify shapes. The Opacity, Blend Mode, Invert, Motion Blur and Color 
icons duplicate the functionality of the Shape parameters in the Object window 
and does so because it is often easier to change these settings in the Object 
List when multiple shapes are selected.

View
The View icon, which only shows up when using stereo sources, displays either 
a L for Left View or R for Right View and indicates which view the shape or layer 
is assigned to. Clicking on the View icon toggles which view the shape or layer 
is located in.

Roll
The Roll icon, which only appears when using the Morph node, determines 
whether the shape resides in the A-roll or B-roll. Morph Shapes create 
themselves in the proper “roll” when viewing A or B. If viewing any other View 
mode, creating a shape will default to A. The Object List shows the A/B state 
and clicking the A or B will toggle the shape to the other roll. Viewing A or B will 
only show A or B shapes, as appropriate. Creating a shape on the B-roll will 
automatically set the shape color to blue. Also, Select All in A or B will only 
select A or B shapes, respectively.

View

Blend Mode

Motion
Blur Color

Lock

Notes

InvertOpacity

VisibilityRoll
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Opacity
Indicates the opacity level of a shape. It is white when opacity is 100%, black 
when 0% and a shade of gray when somewhere in between. When keyframing 
is activated for Opacity in the Shape parameters, you can quickly keyframe the 
opacity of a shape from 100% to 0% by toggling this icon.

Note: In File > Preferences on Windows and Linux or Silhouette > Preferences on Mac, 
there is a Shape > Fade Outline with Opacity setting that draws unselected/inactive 
shape outlines using the Opacity value. This preference can be toggled using the V key 
so that you can easily see any shapes that are at 0% opacity.

Blend Mode
Controls how shapes are blended together. Each click of the icon cycles 
through the blend modes. See the Blend Mode section for information.

Invert
Inverts selected shapes.

Motion Blur
Turns Motion Blur on or off for selected shapes.

Outline Color
Sets the color of selected shape’s outlines.
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Left-clicking the color pot opens a standard color picker while right-clicking on 
the color pot opens a pop-up color menu with 16 primaries. 

Lock
Locks/Unlocks selected objects. A locked shape cannot be edited or changed 
and is italicized in the Timeline.

Visibility
Click the Visibility icon to hide or show selected objects. Only visible shapes are 
rendered. To solo an object, Alt-click on its Visibility icon. Alt-Ctrl/Cmd-click to 
force the visibility of all objects to the on position. 

Notes
Select an object and click the Notes icon to bring the Notes window forward 
above the Object List.

You can type a note for selected objects. Currently, shapes, trackers, depth 
objects, and layers are supported. Because you can type multiple paragraphs 
into the Notes window, you must press Apply to assign the note. The Notes icon 
changes once a note is applied to the object.

• Hovering over the Notes icon displays the note, if there is one, as a tool tip.
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• The Status Bar displays the object name and the note for the selected object.

Layer Icons
There are some icons directly to the right side of a layer’s name that can be 
used to modify layers.

The Layer’s View, Blend Mode, Invert, Color, Lock, Visibility and Notes icons 
have similar functionality to the ones used by other objects.

Active Layer
The Active Layer box displays a check mark when the layer is selected. 
Clicking the checkbox will toggle the state of the Active Layer.

Object List Shortcuts

Active Layer
Lock

Visibility
Blend Mode

Invert

View Notes

Color

Shortcut Action

Click on an object Selects the object

Shift-click an object Adds an object to the current selection

Ctrl/Cmd-click on an object Toggles the object selection

Shift-click color pot Selects shapes of same color

Alt-click the Visibility icon Solos an object

Alt-Ctrl/Cmd-click the Visibility icon Forces the visibility of all objects to the on position

Shift-click the +/- icon Expands or collapses all nested layers inside that layer

Double-click an object Selects the object so it can be renamed
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Timeline
The Timeline is an overall view of all animated parameters. Animation is the 
process of setting values at various frames, or keyframes as they are called. 
These keyframes transition from one to another over time. The Timeline 
provides you with the tools necessary to view, edit, move or delete keyframes 
as well as change their interpolation type.

The Timeline is divided in three parts:

• Parameter List: lists all animateable parameters for a particular process.

• Timeline: displays keyframes over time.

• Curve Editor: The Curve Editor is a view mode in the Timeline that allows you to 
work with keyframe animations expressed as curves on a graph. The Curve Editor 
is only displayed once the Curve Editor icon is enabled.

Go to the Using the Timeline tutorial to see how it works.
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Parameter List 
The Parameter list shows all objects in the current session. This list is arranged 
in a collection of shapes, filters, trackers and their associated parameters. Click 
the twirly to the left of the parameter to either show or hide parameters of a 
particular object.

Timeline 
The Timeline is an overview of your objects and their keyframes. In the 
Timeline, you can edit a keyframe's position in time, but not its value.

Work Range
The Timeline displays the full session range with the work range displayed 
using a gray bar at the top of the Timeline.

The work range can quickly be adjusted by: 

• Ctrl/Cmd-drag the ends of the work range bar to change the start and end.

• Ctrl/Cmd-drag the work range bar to slide it forward and back while maintaining 
the duration.

Current Time Indicator 
The vertical line in the Timeline is the current time that you are parked at. To 
move the Current Time Indicator, just click and drag the shuttle slider below the 
Viewer or in the top line of the Timeline.
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To center the timeline on the current frame, click the top left corner of the 
Timeline above the object labels.

Out of Bounds Indicator
The area before the first frame and after the last frame (the area between the 
actual session range and the work range, if extended) is shaded red in the 
timeline to show the usable, but out of bounds area.

Zooming and Panning the Timeline
The Timeline shows the duration specified for the current session. You can 
zoom in or out using the mouse scroll wheel to see the Timeline in more or less 
detail and can pan horizontally or vertically using the Spacebar while clicking 
and dragging.

Timeline Pop-up Menu
Right-click over a selected keyframe in the Timeline or point in the Curve Editor 
to open the Timeline pop-up menu.

Interpolation
Ease
Ease allows you to smoothly transition in or out of a keyframe.
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• Ease In

Eases in to the selected keyframe.

• Ease Out

Eases out of the selected keyframe.

• Ease In/Out

Eases in and out of a selected keyframe.

Hold
There is no interpolation and abrupt switches in value occur at keyframes.

Linear
When values change, a straight line with sharp, abrupt angles from one 
keyframe to the next is drawn.

Smooth (Catmull-Rom)
Smooth (Catmull-Rom) creates a smooth animation curve between keyframes.

Extrapolate
Extends the path of the curve beyond the first or last points.

Note: When the Shape > Interpolation Engine preference is set to Spatial (Nuke-
compatible), shape keyframes can only be set to Smooth (Catmull-Rom), Hold and 
Extrapolate. This ensures that shapes using Smooth (Catmull-Rom) interpolation in 
Silhouette exactly match the result in Nuke when exported.

Add Key
Right-click over the property you are interested in at the desired frame in the 
Timeline and select Add Key. Keyframes will be added to that property for all 
selected objects.

Note: You can also Alt-click in the Timeline to add a keyframe.

Cut
Deletes the currently selected keyframe or keyframes.

Copy
Copies the currently selected keyframe or keyframes.

Paste
Pastes the currently selected keyframe or keyframes.
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Delete
Deletes the currently selected keyframe or keyframes.

Note: Individual shape points can be copied and pasted between keyframes using 
Ctrl/Cmd-Alt-C to copy and Ctrl/Cmd-Alt-V to paste.

Select All Keys
When hovering over a track, it will select all keyframes for that track. If not over 
a track (empty area), it will select all keyframes in the timeline.

Marker
Marker allows for the creation, editing or deletion of markers. Markers are a 
handy way of placing notes at specific points in time and are displayed as light 
blue squares at the top of the Timeline.

Hovering the cursor over the marker will display the marker’s text as a tool tip.

Create/Edit
A dialog box opens where you can enter, change, or clear text for the marker. 
When you enter text and click OK, a marker is displayed.

Delete
Deletes the marker at the current frame.

Delete All
Deletes all markers.

Show Work Range
When enabled, the Timeline displays only the start and end frames of the Work 
Range.

Moving One Keyframe in Time
A single keyframe can be moved by selecting it and then dragging it to a new 
location.
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Moving a Selection of Keyframes in Time
Multiple keyframes can be moved by first selecting a range using the Shift key 
and then dragging on them to a new location.

Selecting Objects
Objects can be selected within the Timeline. Clicking the name of an object 
selects it. Multiple objects can be selected by Shift-clicking on them. Ctrl/Cmd-
clicking an object after it is selected will deselect it.

Curve Editor
The Curve Editor is a view mode in the Timeline that allows you to work with 
keyframe animations expressed as curves on a graph. It allows you to visualize 
the interpolation of the animation.

The Curve Editor is only displayed once the Curve Editor icon, located to the 
right of the parameter in the Timeline, is enabled.
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Timeline Keyboard Shortcuts

Curve Editor Keyboard Shortcuts

Shortcut Action

Scroll wheel Zooms the Timeline in and out

Shift-Middle-mouse drag Zooms the Timeline in and out

Space Bar-move mouse Pans the Timeline

Middle-mouse drag Pans the Timeline

Single-click keyframe Selects one keyframe

Ctrl/Cmd-click keyframe Toggle the keyframe selection

Shift-click keyframes Selects a range of keyframes

Alt-click Inserts a keyframe

Right-click keyframe Opens Timeline pop-up menu

Click-drag keyframe Moves the keyframe

Ctrl/Cmd-drag the ends of work range bar Changes the start and end of the work range

Ctrl/Cmd-drag the work range bar Slides the work range forward and back

Click top left corner of the Timeline Centers the timeline on the current frame

Shortcut Action

Alt-click on curve Inserts a point on the curve

Click-drag curve point Moves the curve point

+ or = Zooms the Curve Editor in

- Zooms the Curve Editor out

Space Bar-move mouse Pans the Curve Editor

Hover cursor over curve Displays the current curve value

Right-click curve point Opens Curve pop-up menu
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Viewer
Silhouette uses a Viewer for image editing as well as for clip playback. Some 
features include: viewing individual color channels, the simultaneous display of 
RGB and alpha channels, the selection of stereo views as well as the 
superimposition of shapes over images. 

Node Selector
Selects the node displayed in the Viewer.

Alt-] cycles to next node in the menu, while Alt-[ cycles to the previous node.
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New Viewer
The New Viewer icon opens additional Viewers that can be set to any node or 
view.

Note: Multiple viewers from the same node have the option of being synchronized in 
terms of zoom and pan using the Use Viewer > Synchronize Viewers preference.

View
Offers various View options for the selected node. The View choices will 
depend on the node.

Update
Determines when processing takes place. The ~ key cycles through the Update 
modes.

Drag
Tries to process at the current resolution as fast possible.

Adaptive
Tries to process as fast possible by first processing a 4:1 proxy and then full 
resolution.

Release
Processes once the mouse or pen is released. This the default setting.
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Manual
Silhouette does not process. If you place the cursor within the Viewer window 
and hit the Enter key, Silhouette will manually process any changes.

Stereo View Modes
The stereo view modes, which only show up when using stereo sources, 
determine whether you are working on the Left View, Right View or both the Left 
and Right Views at the same time.

Left View (Shift-1)
Left View displays the left clip in the Viewer.

Right View (Shift-2)
Right View displays the right clip in the Viewer.

Left/Right View (Shift-3)
Left/Right View displays both the left and right clips in the Viewer at the same 
time.

Edit In Both Views
Controls editing in the Left/Right View.

Paint
When enabled, paint is added to both views simultaneously. When disabled, 
the left or right view is painted individually.



Silhouette User Guide    

• • • •••

User Interface  352 
• • • •••

Roto
When enabled, shapes are edited in both views simultaneously. When 
disabled, shapes in the left or right view are edited individually. 

Depth (D)
Displays the Depth channel.

Stereo Split Mode
Only available once the Left/Right View is active, Stereo Split Mode determines 
whether or not the Left and Right Views are arranged horizontally or vertically.

Horizontal
Arranges the Left and Right Views horizontally.

Vertical
Arranges the Left and Right Views vertically.

Stereo Align (Shift-4)
Stereo Align utilizes layers to line up two stereo clips which will effectively 
negate the offset between them. Aligning the clips in this manner allows 
painting on the same location of the Left and Right Views simultaneously, while 
for rotoscoping, it means shapes created for the Left View can be easily 
duplicated to the Right View in the proper position.

Note: Stereo Align can only be selected and used once a layer is selected.
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When activated, Stereo Align uses a negative mode which inverts one of the 
views and mixes it with the other. This creates an embossed effect when similar 
image areas are not aligned.

Automatic Alignment
With a layer selected, stereo sources can be aligned automatically by pressing 
Shift-Alt and clicking on the image feature that you would like to align. Shift-
Alt will function whether or not the Stereo Align view mode is enabled.

Note: Shift-Alt can only be used once a layer is selected.

Manual Alignment
Enable Stereo Align and drag on the Viewer to align the views.

When similar image features are perfectly aligned, you will see a solid gray 
color. The amount you move the view in Stereo Align mode is stored in the 
Stereo Offset parameter of the active layer which is set to animate by default. 
Animation of this parameter is needed for clips that contain depth changes.

Stereo Align Keyboard Shortcuts

Shortcut Action

Shift-Alt and click Automatically sets the Stereo Offset horizontally

Ctrl/Cmd-Shift-Alt and click Automatically sets the Stereo Offset horizontally and vertically

Click and drag in Viewer Moves the Stereo Offset horizontally

Ctrl/Cmd-drag in Viewer Moves the Stereo Offset horizontally in finer increments

Shift-click and drag in Viewer Moves the Stereo Offset horizontally and vertically

Alt-click in Viewer Resets the Stereo Offset

Arrow keys Moves the Stereo Offset by 1 pixel

Shift-Arrow keys Moves the Stereo Offset by 10 pixels

Ctrl/Cmd-Arrow keys Moves the Stereo Offset by one tenth of a pixel

Hold down Arrow keys Moves the Stereo Offset continuously
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Anaglyph Preview (Shift-5)
Activates Anaglyph Preview mode so that you can check your stereo image in 
3D using red-blue glasses.

There are four anaglyph viewing modes that you can choose from. The default 
mode is set using the Viewer > Anaglyph Mode preference.

3D Preview (Shift-6)
Opens a 3D Preview window for displaying the stereo image. If you have 
multiple monitors, the 3D Preview opens full screen while on a single monitor 
system, it opens centered and smaller.

The 3D Preview has a pop-up menu containing zooming controls and display 
selection choices. The pop-up menu is accessed by right-clicking in the 3D 
Preview window.

Zoom > Fit
Zooms the image to fit into the 3D Preview.

Zoom > 1:1
Sets the image to a 100% zoom level and centers it in the 3D Preview.

Fullscreen
Sets the 3D Preview to full screen.

Note: On a single monitor system, the Esc key will minimize the 3D Preview.

Display Type
A list of displays are available to choose from.

Anaglyph (Color)
Preserves most of the color but causes retinal rivalry.

Anaglyph (Gray)
Creates a lighter image than a true anaglyph but results in more ghosting. No 
color is preserved.
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Anaglyph (Half-Color)
Preserves less of the color but reduces the retinal rivalry.

Anaglyph (Optimized)
Discards all of the red component from the original images and replaces it with 
a manufactured red channel derived from the green and blue components. The 
advantages are almost no retinal rivalry.

Hardware Interlaced Left First/Right First
Interlaced mode requires a 3D monitor that uses interlacing like the Zalman 
passive display. Select the Left or Right Hardware Interlaced mode to 
determine which eye comes first--Left or Right. This needs to match up with 
how the monitor does the 3D effect. 
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Stereo View Shortcuts

Proxy
Sets the viewer resolution. The higher the number, the lower the resolution.

The higher the proxy setting, the more frames you can play.

1:1
1:1 keeps the image quality at full resolution.

2:1
2:1 lowers the image resolution by 1/2. 

3:1
3:1 lowers the image resolution by 1/3.

4:1
4:1 lowers the image resolution by 1/4.

Shortcut Action

Shift-1 Selects the Left View

Shift-2 Selects the Right View

Shift-3 Selects the Left/Right View

Shift-4 Selects Stereo Align

Shift-5 Anaglyph Preview

Shift-6 3D Preview

D Displays the depth map
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Onion Skin
Onion Skin does a mix, as defined by the Mix value, between the current frame 
and either previous or later frames. This is useful for creating frame by frame, 
hand painted animations.

By default, Onion Skin is set up to display a mix to the previous frame.

Backward
Displays frames before the current frame.

Forward
Displays frames after the current frame.

Mix
Sets the Onion Skin mix value.

Snapshot
Captures the image in the Viewer so that it can be compared with other nodes 
or Viewer modes using Toggle Snapshot, Vertical Split, and Horizontal Split 
snapshot modes.

Toggle Snapshot
Cycles between the snapshot and the current image.
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Vertical Split
Compares the snapshot and the current image using a vertical split. Move your 
cursor into the image area over the split line and when the cursor changes to a 
double-arrow, click and drag to move the split. Depending on the image, the 
split line may not be obvious, so triangular sashes on the outside of the image 
help you find it.
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Horizontal Split
Compares the snapshot and the current image using a horizontal split. Move 
your cursor into the image area over the split line and when the cursor changes 
to a double-arrow, click and drag to move the split. Depending on the image, 
the split line may not be obvious, so triangular sashes on the outside of the 
image help you find it.

Blend Amount
Blend Amount, which is only available in the Depth and Morph nodes, appears 
when a blendable view mode is selected.



Silhouette User Guide    

• • • •••

User Interface  360 
• • • •••

In Morph, it appears when View A/B is selected and in the Depth node, it is 
displayed when the depth map is viewed. Clicking the Blend Amount icon pops 
up a slider that can be moved from 0 to 100. You can also click and slide on the 
icon instead of using the slider.

Display Options
The Display Options icon reveals the color management options which remain 
visible as long as it is enabled.

Silhouette uses the OpenColorIO standard originally developed by Sony 
Pictures Imageworks for its color management. You can load custom color 
configuration files and custom LUTs, apply color space conversions, as well as 
use other controls for fine tuning. Silhouette includes a set of preset color 
profiles, plus you can configure and use your own by specifying one in the Color 
Management > OCIO Configuration preference.

For a more detailed explanation of OpenColorIO, including generating LUT’s 
and suggested workflows, please visit http://opencolorio.org/.

Note: The color management functionality provided in the Display Options is for display 
purposes only. The color profiles, LUTs, and colorspace conversions applied in the 
Viewer do not affect the rendered image.

Color Management
Colorspace
Sets the input colorspace of the scene. The following colorspaces are provided: 
Linear, sRGB, rec709, Cineon, Gamma 1.8, Gamma 2.2, Panalog, REDlog, 
ViperLog, AlexaV3LogC, PLogLin, SLog, Raw.

Silhouette automatically tries to determine the colorspace based on the data in 
the file and other information from the header. If a colorspace can’t be detected, 
Linear will be selected. 

http://opencolorio.org/
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Display
If you are using a custom OCIO configuration with multiple Display options, the 
Display pop-up menu appears for you to choose the colorspace of the display. 
The default OCIO configuration only has one display option. Additional devices 
can be added in a custom configuration and will show up in this menu.

Note: When there is only one Display option, the Display pop-up menu is hidden.

View Xform (Transform)
Select a colorspace transform to apply to the scene. You can select from sRGB, 
rec709 or None.

LUT
Select a custom LUT to apply to the scene. 

Choose
A number of LUT formats are supported including: Flame, Lustre, Color 
Correction Collection, Color Correction, Cinespace, Houdini, Iridas itx, Iridas 
cube, Pandora mga, Pandora m3d, Sony Pictures Imageworks 1D, Sony 
Picture Imageworks 3D, Sony Picture Imageworks mtx, Truelight and Nuke vf.

Note: Selecting a LUT disables the Colorspace and View Xform controls.

Clear List
Clears the LUT list.

Gain
Adjusts the brightness of the image in F-stops. Gain is applied before the 
display transform.

Gamma
Adjusts the gamma of the image. Gamma is applied after the display transform.

Go to the Color Management tutorial to see how it works.
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ROI (Region of Interest)
ROI (Region of Interest) crops the image in the Viewer to a user defined size 
and can be animated. This is especially useful when you only need to work 
within a smaller region of a larger image as it will use less memory and process 
faster. If expanded, the ROI will display overscan pixels which can then be 
manipulated.

Go to the Region of Interest tutorial to see how it works.

ROI Controls
Once the ROI icon is activated, the ROI controls appear above the Viewer.

ROI Keyboard Shortcuts

Enable
You can toggle the ROI effect on and off by clicking on the Enable icon.

ROI Manual Input
If you click on the numeric field to the right of the ROI label, the fields become 
editable. Just click in the field you want to edit, type in a number and press the 
Set button.

Shortcut Action

Initial click-drag bounding box Sets the ROI

Click-drag bounding box points Scales the ROI

Click-drag bounding box Positions the ROI

Ctrl/Cmd-Shift-drag Draws a new ROI
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Animating the ROI
Enable the animate icon and change the position or size of the ROI at various 
frames.

Set ROI to Current DOD
The Set ROI to Current DOD icon automatically sets the ROI to match the size 
of the source’s DOD (Domain of Definition). If the source’s DOD is larger than 
the session, the ROI will expand revealing the overscan pixels which can then 
be manipulated.

Note: The Transform > DOD node can change the DOD of any source.

Reset
Resets the ROI to the session size.

ROI Notes
1 Rendering EXR Files

• The ROI becomes the data window and the session becomes the display window.

• The ROI window is rendered along with the ROI window’s coordinates. This will 
allow you to automatically composite the ROI window into its proper location. 

2 Rendering Non-EXR Files

For non-EXR file formats, the ROI window is cropped/padded to the session 
size by default.
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Magnifier
The Magnifier opens a magnification window at the bottom right corner of the 
Viewer and displays a zoomed area around the cursor location. It is useful for 
precise control point, tracker and paint placement. The Magnifier is available in 
the Reshape and Tracker tools as well as Paint.

Masks
Masks aid you in determining what will be projected on film or shown on 
television by adding reticles and or a variable opacity mask to the Viewer.
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The following aspect ratio’s are supported: 1:66, 1:78, 1:85, 2:35 as well as 
Safe Action for video. When an aspect ratio is selected from the Mask pull-
down menu, the mask settings defined in the Viewer Preferences are activated. 
See the Viewer Preferences section for more information.

Creating Custom Masks
In the Silhouette/resources folder of your installation, there are two files: 
formats.xml and masks.xml.

You can add your own custom masks to the masks.xml file. The rectangle 
values are multiplied by the image width/height to figure out where the mask 
should be placed. For example, Safe Action is a 90% rectangle, so the border 
is .1, .1, .9, .9 (i.e. 10%, 10%, 90% 90%) of the image size.

You associate certain masks with certain formats by adding a “Mask” entry to 
the formats in formats.xml. You can add any number of masks to each format. 
These masks will be available in the mask selector in the Viewer, depending on 
the session format.

Note: You can't associate masks with “custom” session formats. Instead, you should 
add a new format to your formats.xml file if you have an odd format you want to use 
with masks.
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Stabilize
The Viewer is stabilized based on the selected layer’s tracking data.

Rotate
Activates Viewer rotation mode. Shift-Ctrl/Cmd-R toggles the Viewer rotation 
mode. Rotating the Viewer can facilitate rotoscoping and painting. 
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Adjust Rotation
Once Rotate is enabled, the Adjust Rotation editing control becomes available. 

Adjust Rotation allows you to click and drag in the Viewer to set the angle. 
Shift-R toggles the rotation editing mode on/off.

Go to the Viewer Rotation tutorial to see how it works.

Overlay
Toggles the display of overlays which are lines, shapes or objects that 
Silhouette superimposes over the image. 0, the number zero, toggles the 
overlay.

RGBA
Displays various combinations of the red, green, blue and alpha channels.

Selecting Channels
Clicking on the Red, Green, Blue or Alpha buttons solo that channel as a gray 
scale image. The horizontal white bar above the RGBA buttons quickly toggles 
the display of the image back to full color mode.

Solo Channels
Alt-R/G/B/A toggles the red, green, blue and alpha channels on and off.
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Alpha Display
Cycle Alpha
Either press the Alpha button (to the right of the blue button) or the A key to 
cycle the state of the alpha display. Pressing once superimposes the alpha 
channel over the image. Pressing a second time displays the alpha channel 
over black. Hitting it again shows only the color image. 

Note: To view a shape’s alpha channel, you must first set the View to Output before 
pressing the Alpha button or the A key.

Display Alpha - No Overlay
Shift-A toggles the View to Output, superimposes the alpha channel over the 
image and deactivates the Overlay. Pressing Shift-A again returns the Viewer 
to its previous state.

Display Roto Node’s Output Alpha
Alt+O toggles the view mode to Output and displays the alpha. Pressing Alt-O 
again returns the Viewer to its previous state.

Alpha Mix
The numeric entry box next to the RGBA buttons controls the opacity of the 
alpha channel when it is superimposed over the image.

Premultiply
You can premultiply the image in the Viewer by using Shift-0.

Go to the Using the RGBA buttons in the Viewer tutorial to see how it works.

Aspect Ratio
Activates pixel aspect ratio correction in the Viewer as defined in the session 
settings. For instance, this lets you view Cinemascope ratio images as they 
would appear when projected.



Silhouette User Guide    

• • • •••

User Interface  369 
• • • •••

Zooming and Panning
Sets the zoom factor for the image.

25%-500%
Choose from one of the preset zoom percentages. 100% displays the image at 
its actual size at a ratio of one image pixel to one screen pixel.

You can also zoom the image using the scroll wheel on your mouse, the + or = 
keys to zoom in, and the - key to zoom out or press Space Bar-Shift and move 
the mouse up to zoom in or down to zoom out.

Fit
Either pressing the F keyboard shortcut or selecting Fit from the zoom pop-up 
window will display the image as large as possible within the Viewer window.

Home
You can either press the H keyboard shortcut or double-click the middle mouse 
button to set the image to a 100% zoom level and center it in the Viewer.

Center Selected Object
Press Ctrl/Cmd-F to center the select object in the Viewer.

Go to the Viewer Navigation tutorial to see how to zoom and pan the Viewer.
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Viewer Keyboard Shortcuts

Shortcut Action

F1 The composite workspace is displayed

F2 The Viewer is displayed full screen

F3 The Viewer and Timeline are displayed

F4 The Viewer and Trees window are displayed

F5 The dual monitor workspace is displayed

0 Toggles the display of overlays which are lines, shapes or objects

1-7 (Number Keys) Switches the Viewer > View menu

~ Cycles through the update modes

A Cycles the display between the full color image, the alpha channel 
superimposed over the image, and the alpha channel by itself

Shift-A Toggles the View to Output, superimposes the alpha channel over 
the image and deactivates the Overlay

Alt-R/G/B/A Toggles the red, green, blue and alpha channels on and off

Alt-O Toggles the Roto node’s view mode to Output and displays the 
alpha. Pressing Alt-O again returns the Viewer to its previous state.

Shift-Ctrl/Cmd-R Toggles the Viewer rotation mode on/off

Shift-R Toggles the Viewer rotation editing mode on/off

Shift-0 Premultiplies the image in the Viewer by the alpha

Alt-] Cycles to next node in the Node pop-up menu

Alt-[ Cycles to the previous node in the Node pop-up menu
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Viewer Pan/Zoom Keyboard Shortcuts

Shortcut Action

Middle-mouse drag Pans the image

Space Bar-move mouse Pans the image

+ or = Zooms the image in

- Zooms the image out

Shift-Middle-mouse drag Zooms the image in and out

Scroll wheel Zooms the image in and out

Space Bar-Shift-move mouse up/down Zooms the image in and out

F Fits the image in the Viewer

H or Middle-mouse double click Centers the image in the Viewer at 100%

Ctrl/Cmd-F Centers selected object in the Viewer

‘ Opens a context menu over pen/mouse location
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Timebar / Player Controls
The Timebar below the Viewer provides you with controls to play your clips as 
well as navigate your session.

Timebar
Keyframe Markers
Colored markers in the Timebar shuttle area signify where selected objects 
have keyframes. Objects that display keyframes in the Timebar are shapes, 
trackers and painted frames. Path keyframes are shown for shapes, position 
keyframes for trackers and painted frames when in the Paint node.

The color of the markers is determined by the object color. If multiple selected 
objects have a keyframe on the same frame, the most recently selected 
object's color has precedence. A white marker is used to signify the current 
frame and hovering over a marker displays a tool tip showing the keyframe 
time.

Shift-Alt-clicking and dragging a marker will move the keyframe in time.

Note: In the Paint node, selecting a paint tool ignores the object selection and displays 
paint keyframe markers instead. To see the keyframe markers of selected objects, 
select a non-paint tool like Reshape, Transform or Tracker.

First Frame
The numeric entry box on the left displays the first frame to be viewed. Enter a 
new number in the numeric entry box to change the start frame and hit Enter. 
Frame numbers located before the start frame, including negative numbers, 
can be entered. This is useful when adjusting motion blur at the start of a shot.

First Frame Last Frame

Frame Rate

Increment

Player Controls

Current Frame

FieldsPlay Menu

Current Frame

Keyframes

Shuttle Area

Duration
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Last Frame
The numeric entry box to the right of the shuttle slider displays the last frame to 
be viewed. Enter a new number in the numeric entry box to change the last 
frame and hit Enter. Frame numbers located beyond the end frame can be 
entered. This is useful when adjusting motion blur at the end of a shot.

Current Frame
The second numeric entry box to the right of the shuttle slider displays the 
currently viewed frame. Enter a new number in the numeric entry box and hit 
Enter to move directly to that frame.

Increment
The far right numeric entry box controls the amount of frames that the Viewer 
increments from frame to frame.

Fields
When selected, the Fields button changes the Timebar and Timeline to 
advance and display in half frame increments.

Play Menu
Changes the playback mode. The Play menu is located at the bottom-left of the 
Viewer.

Once
Plays the clip once when you press the Play button.

Loop
Plays the clip in a continuous loop when you press the Play button.

Bounce
Plays the clip continuously, alternately forwards, then backwards when you 
press the Play button.
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Playback Controls
These controls affect playback.

Shuttle
Clicking and dragging in the shuttle area shuttles through the clip.

Previous Key
Moves to the previous keyframe.

Next Key
Moves to the next keyframe.

Home
Moves to the first frame.

Previous Frame
Step backward 1 frame.

Play Backward
Plays backward.
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Stop
Stops playback.

Play
Plays forward.

Next Frame
Step forward 1 frame.

End
Moves to the last frame.
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Playback Controls Keyboard Shortcuts

Frame Rate
Sets the frame rate for the clip in the Viewer. Enter the desired frame rate, for 
instance: 24 fps (film), 25 fps (PAL), 29.97 fps (NTSC DF) or 30 fps (NTSC 
NDF).

Duration
Displays the duration of the clip in the Viewer.

Shortcut Action

Z Step backward 1 frame

Shift-Z Moves to the previous keyframe

X Step forward 1 frame

Shift-X Moves to the next keyframe

J Plays backward

K Stops or starts playback

L Plays forward

Space Bar Stops playback

Home Moves to the first frame

End Moves to the last frame

Click and drag in the shuttle area Shuttles through the clip

Shift-Alt-click and drag a keyframe marker Moves the keyframe in time
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Real-Time Playback
RAM Cache
Silhouette can cache frames into RAM to guarantee real-time playback. When 
you hit the play button, each frame is cached into RAM. Once the clip is played 
through once, it will then play in real-time if enough RAM is available. At the 
bottom right corner of the interface, there is a numeric readout (Cache Display). 
It displays the length of your clip, the maximum frames that can be cached into 
RAM, the percentage of RAM currently being used as well as the session’s bit 
depth.

If your clip is longer than the maximum frames that can be cached into RAM, 
the clip will not play in real-time.

Hovering over the Cache Display will reveal a tool tip that shows the maximum 
cache size and total available physical memory in megabytes.

Preload Frames
Source frames are automatically cached in a background thread. The amount 
of preloaded frames is controlled by a Cache > Preload Frames preference with 
the default value being 10 frames.

Go to the Optimizing Playback tutorial to see how you can playback the 
maximum amount of frames.

Purge RAM Cache
The RAM cache can be purged by right-clicking on the Cache Display and 
selecting the Purge RAM Cache option or by selecting Session > Cache > 
Purge RAM Cache. If selected, currently cached frames are cleared from RAM.
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Sequence Editor
Silhouette can perform editing tasks such as cutting, joining, moving, copying, 
replacing, trimming, retiming and repeating clips in the Sequence Editor. The 
sequence can then be used as an element in the Trees window.

Go to the Sequence Editor tutorial to see how it works.

Creating a Sequence
A sequence is comprised of multiple clips edited together. To create a new 
sequence, select the New Sequence icon in the Sources window.

A sequence object is created in the Sources window and the Sequence Editor 
appears. Drag and drop clips from the Sources window into the Sequence 
Editor to build the sequence.

If you select one or more clips in the Sources window before pressing the New 
Sequence icon, the clips are assembled in selection order using in and out 
points, if they are set, into a new sequence.

Marking In and Out Points
Each clip in the Sources window can have a different in and out point. In and 
out points are also useful within the sequence to define a region to be moved, 
copied, replaced or deleted. Double-click on a clip in the Sources window to 
load it into the Viewer and Mark IN and Mark OUT icons appear.
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Mark IN (I)
Sets the in point.

Mark OUT(O)
Sets the out point.

Clear Both Marks
Clears both the in and out points.

Go to IN
Jumps to the in point.

Go to OUT
Jumps to the out point.

When setting in and out points for a clip, the clip takes over the Viewer. To 
return the Viewer to a sequence or a node, double-click the sequence in the 
Sources window or a node in the Trees window.

Selecting Clips / Frames
Once selected, the area is highlighted.

Clips
Click on a single clip to select it or Ctrl/Cmd-click on multiple clips to select 
more than one. You can also drag select clips to select them.

Note: Single-clicking on an open area of the Sequence Editor will clear the selection.
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Frames
To select an arbitrary range of frames, which possibly spans multiple clips in the 
sequence, select Mark IN and Mark OUT.

Moving, Copying, Replacing, Deleting
The highlighted selection can be moved, copied, replaced or deleted.

Moving
Click-drag somewhere in the highlighted region and then drop to a new 
location. The selection is moved.

Copying
Shift-drag somewhere in the highlighted region and then drop to a new 
location. The selection is copied.

Replacing
The Alt key is used to replace either a destination clip or a marked region while 
dragging and dropping.

Deleting
Press the Delete key. The selection is deleted.

Add Edit
Adds an edit in the sequence at the location of the current frame in the Timebar, 
splitting the clip into two.
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Segment Controls
At the bottom left of the Sequence Editor are segment related controls--a 
segment being a selection of one or more clips.

Segment Speed
Controls the selected clips speed and is specified as a percentage. A value of 
50 slows down by 50%, a value of 100 does nothing, and a value of 200 is twice 
as fast.

Segment Direction
Specifies the playback mode for selected clips.

Forward
Plays the selected clips forward.

Reverse
Plays the selected clips backward.

Bounce
Plays the selected clips forward and then backward.

Speed
Direction

Loop
Duration
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Loop Count
Repeats selected clips by the specified amount as well as creates freeze 
frames when using single frame clips.

Segment Duration
Displays the duration of the currently selected segment.

Trimming
The head and tail of a clip can be lengthened or shortened using the Trim 
controls.

Clicking on a cut enables trimming and displays both sides of the cut in the 
Viewer.

• Click the center of a cut and drag to trim both sides of the cut simultaneously. 

Trim Out Trim Both Trim In
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• Click and drag to the left of the cut and the out point is trimmed.

• Click and drag to the right of the cut and the in point is trimmed.

Note: After selecting the left, right or center of a cut, the left and right arrow keys can 
be used to trim frames one at a time.
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Sequence Editor Keyboard Shortcuts

Shortcut Action

Scroll wheel Zooms the Sequence Editor in and out

Shift-Scroll Wheel or Middle-mouse drag Zooms the Sequence Editor in and out 10x faster

Space Bar-move mouse Pans the Sequence Editor

Middle-mouse drag Pans the Sequence Editor

I Sets a Mark IN point

O Sets a Mark OUT point

Shift-Drag/Drop Selected Clips Copies the selected clips

Alt-Drag/Drop Selected Clips Replaces the destination clip or marked region

Delete Deletes the selection
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Console
The Console is located in a tab in the Timeline area. It displays the various 
modules loaded by Silhouette as well as information about your machine. The 
Console information can be cut, copied or pasted and we may ask you for its 
contents when providing customer support.

The console can also be used as an interactive Python interpreter. You can 
type basic python expressions, including loops, import custom Python modules 
and call custom functions, etc. The Tab key displays a completion list of 
available methods/attributes.
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Script Editor
Hidden by default, the Script Editor can be opened with View > Script Editor and 
is located at the bottom of the Sources window. When displayed, it allows a 
script to be edited and tested efficiently without having to type it in the Console 
each time. Scripts can also be loaded from a file by using the Load button.

To use the Script Editor, press the Execute button to run the script and the 
Console will display the results if the script prints anything. While the editor has 
focus, Alt-Enter will execute the script as well.
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Windows and Adjustments
The Silhouette interface contains multiple windows. Windows can be closed, 
torn off to be a floating window, or moved to a new location. The upper right 
portion of the window has two icons: a Minimize/Maximize and a Close icon.

Opening and Closing Windows:
• Click the Close icon to close a window. 
• Once a window has been closed, it can be reopened by selecting it from the 

Window pull-down menu.

Creating Floating Windows:
• Click the Minimize/Maximize icon to make the window a floating window.

Minimize/Maximize Close
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Moving Windows:
• Click and drag a window’s title bar and place it in a new location. This moves all 

of the tabs docked in the window as one unit.

• Click and drag a tab and place it in a new location. This moves only the single tab.

• If you drop the window in the center of an existing window, a tab will be created 
so that both windows will share the same space. This is the same as the Node, 
Object, Presets and Notes windows sharing the same location.

• Windows can be docked next to each other. For instance, you can put the Object 
List to the left of the Trees window with both being docked to the right of the 
Viewer.

Title Bar
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Sashes
By clicking and dragging the sashes, dividing lines between areas of the 
screen, you can customize the Silhouette interface.

Status Bar
The Status Bar is located at the bottom left of the user interface and displays 
various messages.

Cursor Position Color Values
The cursor position color values when in the Paint node are displayed in the 
Status Bar.

Tool Tips
Hovering the cursor over an icon will pop up a tool tip that displays its function.
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Twirly Icons
Effect groups in the Node and Object parameter windows can be expanded and 
collapsed using the Twirly icons located to the left of the group.

Animate Icons
Animateable parameters in the Parameters and Object windows have an 
Animate icon to the left of them. Keyframes are set when the Animate icon is 
enabled (highlighted).

Off        On
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Numeric Keyboard
Single clicking on a numeric field opens a numeric keyboard.

Numeric Fields
Drag on a numeric field to adjust the value. You can adjust any value with finer 
precision by pressing Ctrl/Cmd while dragging.

Note: When the cursor is hovering over a Numeric Field, the Arrow keys can adjust the 
value.

Reset Icons
Individual parameters as well as parameter groups can be reset to their default 
settings using the Reset icon.

Mouse Wheel Adjustments
Hover over a numeric field and use Alt-mouse wheel to adjust it. Use Alt-Shift 
for a 10 time larger change. Use Alt-Ctrl/Cmd for 10 time smaller change.



Silhouette User Guide    

• • • •••

User Interface  392 
• • • •••

Spin Box

Spin boxes change values according to the following key strokes:

• Click = change by 1 pixel.

• Shift-click = change by 10 pixels.

• Ctrl/Cmd-click = change by 0.1 pixel.

• Middle-Mouse button-click, hold and drag back and forth over spin box arrows 
adjusts the value.

Note: When the cursor is hovering over a Spin Box, the Arrow keys can adjust the 
value.
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Pull-Down Menus
File

New Project
Creates a new project.

Open Project
Opens projects.

Open Backup
Opens a browser that lists the available backups by date and time which can 
then be loaded.

Save Project and Save Project As
Projects can be saved by choosing Save and Save As.

Revert Project
You can revert to the last saved version by selecting Revert.

Lock Project
Locks a project so that it can’t be modified and displays LOCKED in the Title 
Bar. To retain the Lock Project state, enable it and save the project.

Close Project
Closes the current project.

Recent Projects
The last ten recently opened or saved projects can be selected and opened in 
Recent Projects.

Import
Media
Imports media into the project.

Shapes
Imports shapes into the project.
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Export
Exports selected shapes from the project.

Edit
Undo
Undo operations.

Redo
Redo operations.

Cut
Cuts the selected object.

Copy
Copies the selected object.

Paste
Pastes the selected object.

Duplicate
Duplicates the selected object.

Delete
Deletes the selected object.

Select All
Selects all shapes.

Deselect All
Deselects all shapes.

Stereo
This is where you can link, unlink and duplicate shapes for stereo rotoscoping. 

Link
Links two selected shapes of the same type and the same number of control 
points for stereo rotoscoping. Linking allows the two shapes to be 
simultaneously selected and edited in the Left/Right View.

Note: Linked shapes are bolded in the Object List when one or both of a linked pair is 
selected.
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Unlink
Unlinks selected shapes.

Duplicate
Duplicates a selected shape or a single layer containing shapes to the other 
view and automatically links it. When a layer is duplicated, all of its transform 
data is copied as well.

Duplicate > New Layer
Duplicates a selected shape to the other view, automatically links it and places 
it in a new layer.

Note: Duplicate > New Layer is not available if you are in the Left/Right View.

Session
New Session
Creates a new session.

Delete Session
Deletes the current session.

Current Session
Selects a session to edit.

Render Session
Opens the render settings.

Session Settings
Opens the session settings.

Cache
Caching speeds up image playback by pre-loading the frames into RAM or on 
disk. Frames are loaded into RAM when you play them back.

Purge RAM Cache
Purges the RAM cache. The RAM cache can also be purged by right-clicking 
on the Cache Display at the bottom right of the user interface and selecting 
Purge RAM Cache. If selected, currently cached frames are cleared from RAM.
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Window
The various Silhouette interface windows are displayed with checkboxes next 
to them. When the box is checked next to an item, that particular window is 
displayed in the user interface.

Workspace
A workspace is a snapshot of the user interface layout. Silhouette workspaces 
can be selected, saved or deleted.

Note: The stock workspaces can’t be deleted or modified.

Composite (F1)
The composite workspace is displayed.

Streamlined (F2)
Optimized for Roto and Paint projects, the size of the Trees window is reduced 
to make room for the Object List and Paint History immediately below.

Maximize Viewer (F3)
The Viewer is displayed full screen.

Viewer + Timeline (F4)
Only the Viewer and Timeline are displayed.

Viewer + Timeline (F5)
Only the Viewer and Trees are displayed.

Dual Monitor (F6)
The Silhouette user interface is spread across two monitors with the Trees 
window displayed full screen on the right monitor.

Save Workspace
Saves the current workspace.

Delete Workspace
Deletes the current workspace.
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Actions
The Actions menu executes various scripts located in 
Silhouette/resources/scripts/actions. For information on how to create custom 
scripts that show up in the Silhouette > Actions menu, see the Silhouette 
Customization Guide for more information.

Batch
Rename
Renames selected objects to match first selected object.

Create
Corner-Pin Layer
Creates a corner-pinned layer from four selected point trackers.

Tracked layer
Creates a tracked layer from one to three trackers.

Edit
Convert to Bézier
Converts the selected shapes to Bézier shapes.

Note: The original shape is hidden after the Action has been executed.

Copy Selection
Copies one or more selected shapes in a layer as well as the parent layer 
hierarchy and transforms. Put another way, this copies the parent layer and its 
shapes and then deletes all unselected shapes.

Duplicate
Duplicates a selected object at the same level in the Object List as opposed to 
Copy/Paste which places the pasted object at the top of the Object List.

Propagate Blend Mode
Sets the blend mode of shapes to their parent layer's blend mode if it is not Add.

https://documentation.borisfx.com/wiki/sfx/index.php?title=Main_Page
https://documentation.borisfx.com/wiki/sfx/index.php?title=Main_Page
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Keyframes
Add Weighted Key (Alt-K)
Creates a keyframe at the current position which changes the timing of the 
animation between two surrounding keyframes. Park between two keyframes, 
select a shape, choose this action or press Alt-K, and drag the slider to adjust 
the weight.

Select All
Selects all keyframes.

Select Layer
Selects all layer keyframes.

Select Shape
Selects all shape keyframes.

Select Tracker
Selects all tracker keyframes. 

Render
Layers to Separate Files
Renders layers to separate files.

Shapes to File Tree
Renders all shapes in the selected Roto node, each to its own file, organized 
by folders based on layer names.

Shapes to Separate Files
Renders shapes to separate files.

Select
Various selection actions are provided.

All
Selects all items.

Hidden Objects
Selects hidden objects.
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Layers
Selects all layers.

Siblings
Selects all siblings of a selected object in the current layer. For any selected 
objects, add all similar objects in that object's layer to the selection.

Single Point Shapes
Selects single point shapes.

Transparent Shapes
Selects all transparent shapes.

Time
Jump to Transparent
Looks at the selected shapes and jumps the Timebar to the first entirely 
transparent opacity keyframe it finds.

Shift Source Time
A clip can be shifted in time by inputing both the source frame and the 
destination session frame. This automatically calculates and sets the Source 
node’s Time Shift parameter.
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Help
About
Shows the Silhouette version.

User Guide
Opens the Silhouette User Guide.

What’s New
Opens the Silhouette What’s New document.

Customization Guide
Opens the Silhouette Scripting Guide.

Check for Update
Checks to see if a newer version of Silhouette is available.

License
Opens the license tool.
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 NODES

Node Groups
Silhouette is made up of a variety of image processing nodes. These nodes can 
be connected together within the Trees window to accomplish the desired 
effect. The nodes are organized into various groups according to their function:

Color
Black and White, Chromatic Aberration, Clamp, Color Correct, Defringe, 
Develop, High Contrast, Invert, Kelvin, Low Contrast, Match, Polarizer, Printer 
Points, Selective Color Correct, Shadows/Highlights, Telecine, Tone Adjust, 
Vignette.

Composite
Alpha to Color, Color Paste, Color to Alpha, Composite, Copy, Drop Shadow, 
Edge Composite, Fade Color, Grain Composite, Holdout Composite, Light 
Wrap, Math Composite, Mix, Non-Additive Mix, Optical Dissolve, Premultiply, 
Slap Comp, Swap Channels, Switch Matte, Unpremultiply.

Diffusion
Center Spot, Depth of Field, Diffusion, Double Fog, Fog, Frost, Mist, Net, Rack 
Focus, Silk, Split Field.

Filter
Blur, Bump Shade, Deartifact, Deband, Deblock, Deflicker, Defog, Degrain, 
Despeckle, Detail, Displace, Edge Detect, Extract Detail, Grain, Mosaic, 
Scatter, Scratch, Sharpen.

Film Lab
Bleach Bypass, Cross Processing, Film Stocks, Grunge, Overexpose, Three 
Strip, Two Strip.

Image
Checkerboard, Color, Color Bars, Depth, Fractal Noise, Grid, Linear Gradient, 
Merge Views, Null, Output, Output Multi-Part, Paint, Radial Gradient, Roto, 
Roto Blend, Split Views.
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Key
Color Suppress, Difference Matte, Matte Repair, Power Matte, Screen 
Smoother, zMatte.

Light
Glow, Glow Darks, Glow Edges, Lens Flare, Rays, Reflector, Relight, Star, 
Streaks.

Silhouette
Depth, Morph, Output, Output Multi-Part, Paint, Power Matte, Roto, Roto 
Blend, zMatte.

Special Effects
Cartoon, Color Infrared, Color Shadow, Day for Night, Harris Shutter, Infrared, 
Looks, Night Vision, Pastel, Pencil, Texture, X-Ray.

Time
Hold, Retime, Reverse, Time Blur.

Tints
Color Gradient, Color Spot, Colorize Channel, Colorize Gradient, Dual 
Gradient, ND Gradient, Photographic, Radial Tint, Split Tone, Sunset, Tint.

Transform
Camera Shake, Crop, DOD, Flip, Flop, Keystone, Resize, Tracker, Transform.

Warp
Bump Distort, Lens Distortion, Morph, Pin Warp, Turb Distort.

OFX
Third party OFX nodes.
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Common Node Controls
There are a number of common node controls that appear in Silhouette. For 
simplicity they are listed here.

Blur
Horizontal
The image is blurred by a quality blur along the X-axis.

Vertical
The image is blurred by a quality blur along the Y-axis.

Gang
The horizontal and vertical values can be ganged together.

Black and White
Selects the type of black and white filter to be applied to your color image.

Normal
Converts the color image to a monochrome image.

Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates an orange filter in black and white photography.
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Disabling Nodes
You can disable a selected node by clicking the lightning bolt icon at the top of 
the Node parameters. The node will dim in the Trees window when disabled.

This has the same effect as pressing the D key in the Trees window to toggle 
the enable/disable state of a selected node.

Grad
Grad is the gradient transition area between the filtered image and the original. 
Its direction, corners, size and angle can be adjusted.

Enable
Turns the grad on and off.

ND Brightness
Darkens the colored portion of the grad.

Type
Controls the direction of the grad.

Top-to-bottom
The direction of the grad is from top to bottom.

Bottom-to-top
The direction of the grad is from bottom to top.

Left-to-right
The direction of the grad is from left to right.

Right-to-left
The direction of the grad is from right to left.

Horizontal Strip
Horizontal strip grad.

Vertical Strip
Vertical strip grad.
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Size
The size of the grad.

Angle
The angle of the grad.

Matte
In some of the nodes, a matte is generated to create the desired effect. The 
Matte controls consist of Position, Range and Blur parameters, and they work 
the same in all of the nodes. The white areas of the matte are the areas that 
will be affected by the node, while the black areas remain unaffected. The 
matte is extracted based on luminance, in most cases, and is created using the 
Position and Range parameters.

Position
Selects the values to be included in the matte. A higher Position value shows 
more white values from the original image as white values in the matte. A lower 
Position value shows more black values from the original image as white values 
in the matte.

Range
Controls the range of values to be used for the matte. Once you’ve selected the 
“Position”, you can then add or subtract the “Range” of values to be included in 
the matte. A higher Range value includes more white values in the matte while 
a lower Range value includes less values in the matte. 

Blur
The matte is blurred by a quality blur.

Spot
A spot in the form of a radial gradient is used to limit the effect of the filter.

Position
There is an on-screen control in the center of the image. By clicking and 
dragging the on-screen control, the position of the spot can be adjusted.
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Position X
The horizontal position of the spot.

Position Y
The vertical position of the spot.

Aspect
The aspect ratio of the spot.

Radius
The un-blurred radius of the spot.

Falloff Radius
The blurred edge radius.

Falloff
Moves the falloff towards the spot center point.

Invert
Inverts the spot.

Obey Matte
In the Node parameters window for all nodes, there is an Obey Matte tab with 
controls that limit the effect of the node based on the node’s obey matte input.

Obey
When enabled, the effect of the node is limited by the alpha channel connected 
to the obey matte input of the node.

Invert
Inverts the obey matte input.

Opacity
Controls the opacity of the obey matte input.

Channel
Determines which channel to use as the obey matte source.
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Red
Uses the red channel.

Green
Uses the green channel.

Blue
Uses the blue channel.

Alpha
Uses the alpha channel.

Luminance
Uses the average luminance of the RGB channels.

Renaming Nodes
Nodes can be renamed by changing typing in a new name at the top of the 
Node parameters window.

Temperature
Color
Sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the warming or cooling.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 
warming or cooling.

Transform
In nodes that contain trackable items, the Transform pop-up selects available 
point trackers and tracked layers from the input Tracker node.



Silhouette User Guide    

• • • •••

Nodes  409 
• • • •••

View Menu
Offers various View options for the selected node. The View choices will 
depend on the node.

The numeric keys can quickly switch the view. For instance, for the Roto node: 
1 is Output, 2 is Foreground, 3 is Background, 4 is Color Comp, 5 is Composite 
and 6 is Channels.
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Description
Copies the alpha channel into the RGB channels as a color.

Node Group
Composite.

Controls
Color
The color can be set through the use of a standard color picker.
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Black and White
Description

Black and White converts color images to black and white simulating the look 
of Black and White photographic filters.

Node Group
Color.

Controls
Presets
To select a preset, choose one from the Presets tab.

Filter
The Filter pop-up selects the type of black and white filter to be applied to your 
color image. Go to the Black and White section of Common Node Controls to 
see how the Black and White controls work.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
lighten the midtones, negative values darken the midtones.
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Bleach Bypass
Description

Bleach Bypass is a film laboratory technique where, by skipping the bleach 
stage in the color processing sequence, silver is retained in the image along 
with the color dyes. The result is effectively a black and white image 
superimposed on a color image. Bleach Bypass images have increased 
contrast, reduced saturation, often giving a pastel effect.

Node Group
Film Lab.

Controls
Presets
To select a preset, choose one from the Presets tab.

Amount
Sets the intensity of the bleach effect.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Temperature
Sets the color temperature of the image. Dragging the numeric field to the right 
makes the image cooler (bluer) and dragging the numeric field to the left makes 
the image warmer (redder).
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Blur
Description

Blurs the image with individual horizontal and vertical controls. It’s fast, high 
quality and blurs outside the frame which removes the dark inward bleeding 
edges of most blurs.

Node Group
Filter.

Controls
Blur
Horizontal
The image is blurred by a fast, quality blur along the X-axis.

Vertical
The image is blurred by a fast, quality blur along the Y-axis.

Gang
The horizontal and vertical values can be ganged together.

Expand
Grows the DOD (Domain of Definition) to allow the image to expand outward 
and pull in transparent pixels. You would use this when blurring an image with 
an alpha channel and a small DOD, so the blur can spread outward without 
clipping against the edge of the DOD.
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Bump Distort
Description

Distorts an image based on the second input’s luminance values to create a 
glass effect. It is also useful for creating heat waves.

Node Group
Warp.

Controls
Amount
Sets the amount of distortion.

Angle
Changes the angle of the distortion.

Smoothing
Smooths out the distortion.
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Bump Shade
Description

Light and shadow are applied to the image according to the second input’s 
luminance values simulating a relief texture or embossing effect.

Node Group
Filter.

Controls
Depth
Sets the embossing effect to be appear inward or outward.

Width
Sets the width of the embossing effect.

Elevation
The position of the light above the plane.

Light Direction
Sets the direction of the light.

Light Color
The light color can be set through the use of a standard color picker.
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Camera Shake
Description

Simulates camera shake using random changes in amplitude, speed, scale, 
rotation, and motion blur.

Node Group
Transform.

Controls
Amplitude
Sets the size of the camera shake.

Speed
The speed of the camera shake.

Scale
Determines the camera shake fluctuation.

Rotate
Sets the rotation of the camera shake.

Randomize
Randomizes the camera shake.

Motion Blur
Enable
Turns Motion Blur on or off. The default is off.

Shutter Angle
Determines how long the camera shutter stays open when a picture is taken-- 
higher values create more motion blur. The range of the Shutter Angle is 0-720 
and defaults to 180. Measured in degrees, it simulates the exposure of a 
rotating camera shutter. The shutter angle uses the footage frame rate to 
determine the simulated exposure. For example, a shutter angle of 180 
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degrees (50% of 360 degrees) for 24fps footage creates an effective exposure 
of 1/48 of a second. Typing 1 degree applies almost no motion blur, and typing 
720 degrees applies a high degree of motion blur.

Shutter Phase
Offsets the point in time, either forward or reverse, when the shutter opens. The 
range of the Shutter Phase is -360 to 360 and defaults to -90.

Motion Samples
Renders intermediate frames equal to the Motion Samples value and 
accumulates them, one over the other, on a single frame. The higher the 
number, the smoother the motion. The Motion Samples range is from 1-256 
and defaults to 16.

Note: Normally, motion blur is calculated going forward, so if there is no motion beyond 
the end of a clip, there won’t be motion blur on the last frame. To work around this, add 
an extra frame or two to the end of the work range in the Timebar and move the last 
transform keyframes to be outside of the session range.
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Cartoon
Description

Converts the image into a cartoon.

Node Group
Special Effects.

Controls
Amount
Adjusts the amount of the cartoon effect.

Detail
Adjusts the detail. If the value is increased, you will see more detail while 
decreasing the value will have an overall smoothing effect.

Line
Adjusts the size of the cartoon’s outline.

Note: If you are working in a host application that supports proxy resolutions, it is 
important to view the line strength at full size to determine what the final output will look 
like.
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Center Spot
Description

Diffuses and blurs distracting backgrounds while keeping a center spot in 
focus. The center spot can be moved, sized, the amount of blur can be 
controlled, and a warming filter makes it ideal for portraits and skintones.

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab.

Blur
Sets how much the image is blurred.

Spot
A spot in the form of a radial gradient is used to control where blur is added to 
the image. Go to the Spot section of Common Node Controls to see how the 
Spot controls work.

Temperature
Applies a warming filter to the image. Go to the Temperature section of 
Common Node Controls to see how the Temperature controls work.
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Checkerboard
Description

Generates a checkerboard.

Node Group
Image.

Controls
Amount
Sets the amount of diagonal squares.
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Chromatic Aberration
Description

Chromatic aberration is caused by a lens having a different refractive index for 
different wavelengths of light and is seen as fringes of color around the edges 
of the image. This fringing is removed by un-distorting the individual color 
channels.

There are some new types of color fringes that are not chromatic aberration. 
These effects might be visible as purple or blue fringes and are visible around 
overexposed areas in most cases. If the following conditions apply, your image 
most likely has true chromatic aberration as opposed to color fringing caused 
by sensor overloading:

• Corners should show most color fringes whereas the center should show none.

• Color fringes should be not only at the edges of overexposed areas but at lower 
contrast edges, too.

• Color fringes should be of complementary color (red-cyan, green/magenta, and 
blue-yellow) on opposite sides of a dark or bright area.

• Color fringes should be in all corners with the same direction and pointing out 
from the center.

Node Group
Color.

Controls
Red/Cyan, Green/Magenta, Blue/Yellow
Use the appropriate color group to remove the chromatic aberration. For 
instance, if you see red/cyan fringing, use the Red/Cyan group. Start by 
adjusting the Distortion parameter.

Distortion
Pulls the corners of the image in or out. Negative values pull the corners of the 
image inward while positive values pull the corners of the image outward.

Anamorphic Squeeze
Anamorphic Squeeze corrects for the squeeze found in anamorphic motion 
picture lenses.
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Curvature X and Y
Curvature X and Y correct for non-radial, asymmetric distortions found in 
anamorphic motion picture lenses.

Note: Anamorphic Squeeze and Curvature X and Y only work once the Distortion 
parameter has been adjusted.

Center X and Y
Determines the center point for the distortion.
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Clamp
Description

Clamps out super-blacks and or super-whites by default.

Node Group
Color.

Controls
Min
Clamps out super-blacks.

Max
Clamps out super-whites.

Note: If Max < Min, then Max will internally be set to the maximum possible value. For 
instance, only super-whites would be clamped out.
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Color
Description

Generates a solid field of color.

Node Group
Image.

Controls
Color
The color can be set through the use of a standard color picker.
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Color Bars
Description

Generates a HD SMPTE color bars test pattern.

Node Group
Image.

Controls
Bar Intensity
Scales the bar intensity.

Output IRE
Maps the 16-235 range to 0-255.
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Color Correctors
Description

Silhouette includes a number of different color correctors that are handy for 
adjusting an image’s color. They include: Color Correct, Printer Points, and 
Telecine.

Color Correct
Color Correct manipulates hue, saturation, brightness, contrast, gamma, 
temperature, cyan/magenta, red, green and blue values of the overall image 
and separately in user definable shadow, midtone and highlight areas.

Printer Points
Printer Points manipulate the red, green and blue values of the overall image 
and separately in user definable shadow, midtone and highlight areas using 
motion picture laboratory printer points as the unit of measure. When creating 
color prints for motion pictures, a contact printer performs scene-to-scene color 
corrections. The most popular printing method is additive printing that uses 
three separate colored sources - red, green, and blue which are combined to 
form the light source that exposes the film. The red, green, and blue light valves 
in the printer are adjusted in values of 1, 2, 3... up to 60 for each primary color 
and are called printer points or printer lights. 

Telecine
Telecine emulates the method of color correction done in a telecine film to tape 
transfer suite. Hue, saturation, brightness, contrast, gamma and pedestal 
values of the overall image can be adjusted as well as separately in user 
definable shadow, midtone and highlight areas.

Node Group
Color.
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Master, Shadows, Midtones, Highlights
All of the color correctors can adjust an image by using its master, shadows, 
midtones and highlight groups. The Telecine filter uses the following 
terminology: Lift (shadows), Gamma (midtones) and Gain (highlights). The 
master settings affect the entire image while adjusting parameters within the 
shadows, midtones and highlights will only affect those specific areas.

If you are unsure about what values are included in the shadows, midtones and 
highlights, you can use the View pop-up menu. It will allow you to view the 
shadows, midtones and highlights as a black and white matte. The white areas 
are the areas that will be adjusted by that particular group. For instance, if you 
see white areas while viewing the midtones, then midtone color adjustments 
will affect only those white areas. If you want to change the default areas 
defined by the shadows, midtones and highlights, you would use the Position 
and Range parameters.

Position
Position pinpoints the values to be considered as shadows, midtones, or 
highlights. A low Position value uses the darkest image values, while a high 
Position value uses the brightest.

Range
Increases or decreases the range of values considered as shadows, midtones 
or highlights. A low Range value indicates a narrow range of values, while a 
high Range value indicates a large range of values.

Go to the Matte section of Common Node Controls to see how the Position and 
Range controls work.

Color Correct
Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.
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Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
lighten the midtones, negative values darken the midtones.

Temperature
Sets the color of the image to be either warmer or cooler. Dragging the numeric 
field to the right makes the image cooler (bluer) and dragging the numeric field 
to the left makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the numeric field to the 
right makes the image more magenta and dragging the numeric field to the left 
makes the image more cyan.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.
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Flashing
The Flash parameters mix a color into the image through the use of a standard 
color picker. The default color is white. What in the world is this for? It is a great 
way to add atmosphere to an element. Flash comes from the film term 
“flashing”, which describes the optical process of lowering the contrast of an 
image by flashing it with light.

Flash Amount 
Sets the opacity of the Flash Color. 

Flash Color
The Flash Color can be set through the use of a standard color picker.

Printer Points
The Red, Green and Blue Exposure are set to a value of 25 which represent no 
adjustment. Printer “lights” or points set to 25, 25, 25 are considered to be the 
normal or standard printer setup at most motion picture labs.

Input is Linear
Enable this if your image is in true linear color space. Gamma corrected images 
should have this parameter disabled by default.

Red Exposure
Adds or subtracts red from the image. As in motion picture printing, higher 
values subtract and lower values add.

Green Exposure
Adds or subtracts green from the image. As in motion picture printing, higher 
values subtract and lower values add.

Blue Exposure
Adds or subtracts blue from the image. As in motion picture printing, higher 
values subtract and lower values add.

Gang
The Red, Blue and Green Exposure values can be ganged together.
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Telecine
Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
lighten the midtones, negative values darken the midtones.

Pedestal
Adjusts the black level of the image.
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Color Gradient
Description

Color Gradient can transform an average sunrise or sunset into something 
spectacular or convert a dull, washed-out sky to a breathtaking blue. No other 
filter has done as much to improve landscape photography as the graduated 
filter. Add color selectively while leaving the rest of the scene unaffected by 
using a graduated transition for a smooth color blend between the colored 
portion and the original image. Presets for your favorite Color-Gradient filters 
are provided as well as the ability to create custom colors.

Node Group
Tints.

Controls
Presets
To select a preset, choose one from the Presets tab.

Color
Color
The Color parameter sets the color of the grad through the use of a standard 
color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Grad
Grad is the transition area that goes from the tinted image to the original image. 
Its direction, corners and size can be adjusted. Go to the Grad section of 
Common Node Controls to see how the Grad controls work.
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Color Infrared
Description

Color Infrared simulates infrared filters used in conjunction with infrared 
sensitive film or sensors to produce very interesting false-color images with a 
dreamlike or sometimes lurid appearance.

Node Group
Special Effects.

Controls
Presets
To select a preset, choose one from the Presets tab.

Magenta
Adjusts the amount of magenta.

Blue
Adjusts the amount of blue.

Hue
Adjusts the hue in any non-blue areas.

Contrast
Adjusts the contrast of the image.
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Color Paste
Description

Color Paste takes the red, green, blue, alpha or luminance values of the 
foreground image and pastes it as a color over the background.

Note: You can change Color Paste’s input order with the User Interface > Trees > Input 
Order preference. By default, FG, BG is selected, but you can change it to BG, FG if 
you’d like.

Node Group
Composite.

Controls
Opacity 
Sets the opacity of the foreground element.

Color
The Color parameter sets the color of the foreground image through the use of 
a standard eyedropper or color picker. The default color is white.

Channel
Determines which channel to use as the source for the Color Paste.

Red
Uses the red channel.

Green
Uses the green channel.

Blue
Uses the blue channel.

Alpha
Uses the alpha channel.

Luminance
Uses the average luminance of the RGB channels.
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Color Shadow
Description

Creates a high contrast image overlayed with a gradient.

Node Group
Special Effects

Controls
Presets
To select a preset, choose one from the Presets tab.

Threshold
Sets the amount of image detail.

Invert
Changes whether the gradient is in the background or foreground. 

Background Color
Sets the color of the background. Select the desired color using the color 
picker.

Color 1
Sets the color for the top half of the image. Select the desired color using the 
color picker.

Color 2
Sets the color for the bottom half of the image. Select the desired color using 
the color picker.

Grad 
Grad is the transition area between the two colors. Its direction, corners and 
size can be adjusted. Go to the Grad section of Common Node Controls to see 
how the Grad controls work.
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Color Spot
Description

Tints the image using presets for common photographic filters except for a 
center spot which retains normal color. The center spot can be moved, sized 
and the amount of blur can be controlled.

Node Group
Tints.

Controls
Presets
To select a preset, choose one from the Presets tab.

Color
Color
The Color parameter sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Spot
A spot in the form of a radial gradient is used to control where color is added to 
the image. Go to the Spot section of Common Node Controls to see how the 
Spot controls work.
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Color Suppress
Description

Removes either blue or green from an image. This is usually used to remove 
the blue or green light that commonly spills onto objects filmed in front of blue 
or green screens.

Node Group
Key.

Controls
Suppress
Blue
Suppresses blue.

Green
Suppresses green.

Color
Chooses the color to be suppressed and is automatically set based on the 
Suppress selection.

Note: You can alternatively select the Suppress Color with the eyedropper.

Amount
Suppresses the color chosen from the Suppress pop-up menu. The default 
value of 100 should be sufficient for most situations.

Range
Increases the range of areas that are color suppressed. If the color you want to 
suppress is still evident, increase this value.

Edge
When an alpha channel is present, Edge suppresses the color spill of the 
foreground edge to the color gray. This is very useful for edges that contain a 
lot of transparency like hair or reflections.
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Color To Alpha
Description

Composites each of the RGB channels together and places the result in the 
alpha. This is useful for working with shapes assigned to different RGB 
channels in Roto. Connect the Roto > Channels output to the Color to Alpha 
node and RGB mattes with corresponding alpha are created.

Node Group
Composite.
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Colorize Channel
Description

Colorize Channel converts the image to gray scale and then maps the gray 
values to the selected colors.

Node Group
Tints.

Controls
Channel
Red
Converts the image to gray scale using the red channel.

Green
Converts the image to gray scale using the green channel.

Blue
Converts the image to gray scale using the blue channel.

Alpha
Converts the image to gray scale using the alpha channel.

Luminance
Converts the image to gray scale using the luminance of the image.

Shadows
Enable
Determines whether or not the color contributes to the gradient.

Color
Picks the color that the image will be colorized with. Select the desired color 
using the color picker.

Position
Determines where the colorization is applied to the image. By default, Shadows 
are set to 0, which is the shadow areas. A value of 50 would be the midtones, 
while 100 would be highlights.
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Midtones
The Midtones controls are the same as the controls for the Shadows, except by 
default, the colorization is applied to the midtones of the image.

Highlights
The Highlights controls are the same as the controls for the Shadows, except 
by default, the colorization is applied to the highlights of the image.

Grad
You can optionally use a gradient that limits where the filter is applied. Grad is 
the transition area that goes from the colorized image to the original image. Its 
direction, corners and size can be adjusted. Go to the Grad section of Common 
Node Controls to see how the Grad controls work.



Silhouette User Guide    

• • • •••

Nodes  440 
• • • •••

Colorize Gradient
Description

Tints the image according to the image’s brightness values.

Node Group
Tints.

Controls
Presets
To select a preset, choose one from the Presets tab.

Opacity
Sets the overall opacity of the tint.

Shadows
Enable
Determines whether or not the color contributes to the gradient.

Color
Picks the color that the image will be tinted with. Select the desired color using 
the color picker.

Position
Determines where the tint is applied to the image. By default, Shadows are set 
to 0, which is the shadow areas. A value of 50 would be the midtones, while 
100 would be highlights.

Midtones
The Midtones controls are the same as the controls for the Shadows, except by 
default, the tint is applied to the midtones of the image.

Highlights
The Highlights controls are the same as the controls for the Shadows, except 
by default, the tint is applied to the highlights of the image.
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Grad
You can optionally use a gradient that limits where the filter is applied. Grad is 
the transition area that goes from the colorized image to the original image. Its 
direction, corners and size can be adjusted. Go to the Grad section of Common 
Node Controls to see how the Grad controls work.
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Composite
Description

Composites a foreground over a background using a matte. Either two or three 
inputs can be used.

• Two inputs: Foreground RGBA and Background

• Three inputs: Foreground, Background, Matte

Note: You can change Composite’s input order with the User Interface > Trees > Input 
Order preference. By default, FG, BG is selected, but you can change it to BG, FG if 
you’d like.

Silhouette is a straight, unmatted compositor and its composite nodes expect 
unpremultiplied images. In addition, it is best practice to unpremultiply before 
color correcting premultiplied images so as to avoid unexpected results. If you 
are working with premultiplied images, you have the following options:

• In the Source parameters, identify the alpha as Premultiplied. This will 
unpremultiply it.

• Unpremultiply the image within the Composite node.

• Use a Composite > Unpremultiply node before the premultiplied image hits the 
Composite node.

Node Group
Composite.

Controls
Amount
Sets the amount of the foreground.

Matte Input
Chooses which channel from the Matte input to use in the composite.

Red
The red channel is used for the matte in the composite.

Green
The green channel is used for the matte in the composite.
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Blue 
The blue channel is used for the matte in the composite.

Alpha
The alpha channel is used for the matte in the composite.

Luminance
The average luminance of the RGB channels is used for the matte in the 
composite.

Unpremulitply
Divides the RGB channels by the alpha channel.
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Copy
Description

Copies selected channels from input image 2 to input image 1.

Node Group
Composite.

Controls
Red
Original
Uses the original red channel.

Red
Copies the red channel from input image 2.

Green
Copies the green channel from input image 2.

Blue
Copies the blue channel from input image 2.

Alpha
Copies the alpha channel from input image 2.

Luminance
Copies the average luminance of the RGB channels from input image 2.

Black
Copies black into the red channel.

White
Copies white into the red channel.

Green, Blue and Alpha
The controls for the Green, Blue and Alpha pop-up menus work the same as 
the Red channel listed above.
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Crop
Description

Crops the image to a user defined size.

Node Group
Transform.

Controls
Top
Crops the image from the top down.

Bottom
Crops the image from the bottom up.

Left 
Crops the image from left to right.

Right
Crops the image from right to left.

Crop On-Screen Controls

Shortcut Action

Click and drag a corner Crops both horizontally and vertically

Click and drag horizontal boundary Crops vertically

Click and drag vertical boundary Crops horizontally

Click and drag within bounding box Moves the crop area
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Cross Processing
Description

Cross-processing is a photographic technique where print film (C41) is 
processed in the set of chemicals usually used to process slide film (E6) or vice 
versa. The final result yields images with oddly skewed colors and increased 
contrast and saturation. Different film stocks produce different results, so we 
have created what we feel is a representative look.

Node Group
Film Lab.

Controls
Presets
To select a preset, choose one from the Presets tab.

Amount
Sets the intensity of the cross process effect.

Mode
Print to Slide
Simulates the effect of print film (C41) being processed in slide (E6) chemicals.

Slide to Print
Simulates the effect of slide film (E6) being processed in print (C41) chemicals.
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Day for Night
Description

Day for Night simulates a technique used for shooting exteriors in daylight 
made to look like they were photographed at night. Typically, it involves 
underexposing by two to two-and-a-half stops and using a filter to provide a tint, 
that is often a lavender-blue, as it mimics twilight and appears to emulate the 
mood of moonlight.

Node Group
Special Effects.

Controls
Presets
To select a preset, choose one from the Presets tab.

Diffusion
Blur
Sets how much the image is diffused.

Opacity
Sets the amount of diffusion mixed into the original image. The higher the 
setting, the more the image is blurred.

Moonlight
Color
The Color parameter sets the color of the moonlight through the use of a 
standard color picker. The default color is blue.

Opacity
Sets the opacity of the moonlight color.

Preserve Highlights
Preserves the white areas of the image.
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Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the color 
application.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.
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Deartifact
Description

Deartifact is handy for cleaning up artifacts caused by DV and HD video 
footage. In fact, it is useful for cleaning up images that have aliased or jaggy 
edges. 

When activated, a RGB to YUV conversion takes place so that you can blur 
only the U and V color channels. Since this is where most of the artifacting 
shows up, this has the effect of cleaning up the ratty edges encountered when 
keying DV or HD video footage. It is usually best to blur mostly on the horizontal 
axis.

Note: The Deartifact parameters default to settings that are good for DV footage. If you 
are working at higher resolutions, you will want to increase the Blur settings.

Node Group
Filter.

Controls
Deartifact
Activates Deartifacting.

Blur-Horizontal
The U and V color channels are blurred by a fast, quality blur along the X-axis.

Blur-Vertical
The U and V color channels are blurred by a fast, quality blur along the Y-axis.

Gang
The horizontal and vertical values can be ganged together.
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Deband
Description

Deband removes banding artifacts from an image by smoothing pixels in 
banded areas while retaining detail.

Node Group
Filter.

Controls
Presets
To select a preset, choose one from the Presets tab.

Amount
Sets the amount of debanding.
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Deblock
Description

Blocking artifacts created as a result of high compression factors can be 
removed with the Deblock filter.

Node Group
Filter.

Controls
There are no controls for the Deblock filter since it automatically finds blocks 
and removes them.
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Deflicker
Description

Removes luminance flickering.

Node Group
Filter.

Controls
Mode
Determines the reference frame that all other frames will be matched to so the 
flickering can be removed.

Reference Image
The frame of the clip defined by the Set Reference Image button is used as the 
reference image.

First Frame
The first frame of the clip is used as the reference image.

Amount
Sets the amount of deflickering.

Set Reference Image
Sets the reference image at the frame the Timeline is parked on when this 
button is pressed.
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Defog
Description

Using advanced deweathering algorithms, Defog restores clear day contrasts 
and colors of a scene taken in bad weather such as fog and mist. It is also 
successful in removing the effects of optical Fog and Diffusion filters.

Node Group
Filter.

Controls
Presets
To select a preset, choose one from the Presets tab.

Defog
Color
The Color parameter sets the color of the fog to be removed through the use of 
a standard color picker. The default color is white.

Vanishing Point
A vanishing point along the direction of increasing distance in the image is used 
to remove fog. By default, the vanishing point is set to the center of the screen. 
Essentially, the fog is removed in a radial pattern emanating from the vanishing 
point. So at the default center position, fog is removed in a circular pattern with 
a greater amount of fog being removed from the center while falling off at the 
edges. For instance, if your fog moves in the direction of top right to bottom left, 
set your vanishing point towards the top right corner and the fog removal will 
be more intense at the upper right and fall off at the bottom left. However, in 
most cases, the vanishing point can be left in the center of the screen and you 
will obtain acceptable results.

There is an on-screen control in the center of the image. By clicking and 
dragging the on-screen control, the position of the vanishing point can be 
adjusted.

Position X
The horizontal position of the vanishing point.
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Position Y
The vertical position of the vanishing point.

Defog
Sets the amount of fog to be removed from the scene.

Min Depth
Controls how much fog is removed from the darker areas of the image.

Max Depth
Controls how much fog is removed from the brighter areas of the image.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.
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Defringe
Description

Purple or blue fringing around overexposed areas is a result of sensor 
overloading in video as well as digital still cameras. DeFringe isolates and 
removes the various types of color fringing.

Node Group
Filter.

Controls
Presets
To select a preset, choose one from the Presets tab.

Red
Red
Adjusts the saturation of red values in areas defined by the Position and Range 
controls. Positive values saturate, negative values desaturate.

Position
A matte is generated to isolate red fringing. The areas that are white in the red 
matte are the areas that will be defringed. Moving the Position numeric field will 
change the hue that is used for the red matte.

Range
Increases or decreases the range of values considered as red fringing. A low 
Range value indicates a narrow range of values, while a high Range value 
indicates a large range of values.

Go to the Matte section of Common Node Controls to see how the Position and 
Range controls work.

Green, Blue, Cyan, Magenta, and Yellow
The Green, Blue, Cyan, Magenta and Yellow groups work in a similar fashion 
to the Red group.
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Degrain
Description

Removes or extracts grain from images. If the grain is removed, edges can be 
protected. If the grain is extracted, it can be composited back into the image 
using the Grain Composite node.

Node Group
Filter.

Controls
Amount
Sets the amount of degraining.

Note: You may not see an accurate representation of the grain and noise removal in 
the viewer unless your timeline/composition is set to high quality and the viewer is set 
to a 1:1 pixel ratio.

Outputs
Output
Outputs the degrained image.

Grain
Outputs only the grain that is removed. Use this output in conjunction with the 
Grain Composite node.
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Depth
Description

The Depth node contains a dedicated toolset for creating depth channels.

All of the tools from Silhouette’s Roto node are included in the Depth node 
along with additional shape, gradient and depth tools.

Go to the Depth tutorials to see how it works.

Node Group
Image, Silhouette.

Depth Tools
There are a number of tools to create depth maps which include: Constant, 
Horizon, Ramp, Hall, Tunnel, Edges, and Alpha.

Before
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The level of depth corresponds to the shade of gray. White is nearest, black is 
farthest and 50% gray represents mid depth. Just select the appropriate depth 
tool and adjust the settings to fit the image. Several tools are provided, for 
instance, a tunnel module for corridor-like scenes or a horizon tool for 
landscapes.

Constant
Sets a constant depth for the entire frame. It is useful for setting the depth of 
objects that are completely flat. After selecting the Constant icon, click on the 
screen to create the object.

Go to the Constant tutorial to see how it works. 

Constant
Horizon

Tunnel

Hall

Alpha

Ramp

Edges

Depth Tools
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Depth
Sets the depth value. A value of 1 is nearest (white), 0 is farthest (black) and .5 
is a mid depth (50% gray). The depth can be set interactively by Ctrl/Cmd-
vertical dragging on the image in the Viewer.

Horizon
Creates a horizon line. After selecting the Horizon icon, click on the screen to 
create the object.

Go to the Horizon tutorial to see how it works. 

Position
Sets the position of the horizon. The position can be set interactively by 
dragging the center point.

Rotate
Rotates the horizon. The rotation can be set interactively by dragging the solid 
line.

Size
Sets the size of the horizon. The size can be set interactively by dragging the 
dashed line.
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Near/Far Depth
Sets the near and far depth. A value of 1 is nearest (white), 0 is farthest (black) 
and .5 is a mid depth (50% gray). The depth can be set interactively by:

• Near Depth: Ctrl/Cmd-vertical dragging on the dashed line. 

• Far Depth: Ctrl/Cmd-vertical dragging on the solid line.

Note: Ctrl/Cmd-Shift dragging modifies all depth values at once.

Ramp
Creates a horizontal or vertical ramp blending out from the center. After 
selecting the Ramp icon, click on the screen to create the object.

Go to the Ramp tutorial to see how it works. 

Position
Sets the position of the ramp. The position can be set interactively by dragging 
the center point.

Rotate
Rotates the ramp. The rotation can be set interactively by dragging the solid 
line.

Left/Right Size
Sets the left and right size. The size can be set interactively by dragging the 
dashed lines.
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Center/Left/Right Depth
A value of 1 is nearest (white), 0 is farthest (black) and .5 is a mid depth (50% 
gray). The depth can be set interactively by:

• Center Depth: Ctrl/Cmd-vertical dragging on the solid line. 

• Left Depth: Ctrl/Cmd-vertical dragging on the left dashed line.

• Right Depth: Ctrl/Cmd-vertical dragging on the right dashed line.

Note: Ctrl/Cmd-Shift dragging modifies all depth values at once.

Hall
Creates a perspective gradient as if you are looking down a hallway. After 
selecting the Hall icon, click on the screen to create the object.

Go to the Hall tutorial to see how it works. 

Position
Sets the position of the ramp. The position can be set interactively by dragging 
the center point.

Rotate
Rotates the hall. The rotation can be set interactively by dragging the corner of 
one of the squares.
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Offset
Offsets the outer square from the center position. The Offset can be set 
interactively by Alt-dragging the center point or outer square.

Inner/Outer Size
Sets the inner and outer size. The size can be set interactively by dragging the 
inner and outer squares. Use Shift while dragging an edge to proportionately 
size.

Roundness
Rounds the corners of the inner square.

Inner/Outer Depth
Sets the inner and outer depth. A value of 1 is nearest (white), 0 is farthest 
(black) and .5 is a mid depth (50% gray).The depth can be set interactively by:

• Inner Depth: Ctrl/Cmd-vertical dragging on the inner square. 

• Outer Depth: Ctrl/Cmd-vertical dragging on the outer square.

Tunnel
Creates a circular gradient as if you are looking down a tunnel. After selecting 
the Tunnel icon, click on the screen to create the object.

Go to the Tunnel tutorial to see how it works. 
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Position
Sets the position of the tunnel. The position can be set interactively by dragging 
the center point.

Offset
Offsets the outer circle from the center position. The Offset can be set 
interactively by Alt-dragging the center point or outer circle.

Inner/Outer Size
Sets the inner and outer size. The size can be set interactively by dragging the 
inner and outer circles.

Aspect Ratio
Sets the aspect ratio of the tunnel.The aspect ratio can be set interactively by 
dragging the point at the bottom of the outer circle.

Inner/Outer Depth
Sets the inner and outer depth. A value of 1 is nearest (white), 0 is farthest 
(black) and .5 is a mid depth (50% gray). The depth can be set interactively by:

• Inner Depth: Ctrl/Cmd-vertical dragging on the inner circle. 

• Outer Depth: Ctrl/Cmd-vertical dragging on the outer circle.

Note: Ctrl/Cmd-Shift dragging modifies all depth values at once.



Silhouette User Guide    

• • • •••

Nodes  464 
• • • •••

Edges
Runs an edge detection and objects with edges or a lot of structure are placed 
in front. After selecting the Edges icon, click on the screen to create the object.

Go to the Edges tutorial to see how it works. 

Invert
Inverts the depth channel.

Amount
Sets the edge brightness.

Threshold
Limits the amount of edges that are detected.

Depth
Sets the base depth. A value of 1 is nearest (white), 0 is farthest (black) and .5 
is a mid depth (50% gray). 

Before Edges
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Alpha
Converts the alpha channel hooked into the Depth node’s alpha inputs into a 
depth map. After selecting the Alpha icon, click on the screen to create the 
object.

In the above example, Power Matte was used with open shapes placed far 
apart which generates an organic looking gradient with edge detail.

Go to the Alpha tutorial to see how it works.

Source
Sets the node input source for the Alpha tool. You can choose from Input and 
Alpha 1-5.

Depth Type
Sets the depth type.

Constant
Sets a constant depth.

Linear
Creates a linear gradient with two depth values.

Radial
Creates a radial depth gradient.

Before
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Ramp
Creates a linear gradient with three depth values.

Depth Parameters
Sets the depth. A value of 1 is nearest (white), 0 is farthest (black) and .5 is a 
mid depth (50% gray). The depth can be set interactively by:

Constant
• Ctrl/Cmd-vertical dragging on the center point.

Linear
• Left Depth: Ctrl/Cmd-vertical dragging on the left dashed line.

• Right Depth: Ctrl/Cmd-vertical dragging on the right dashed line.

Radial
• Inner Depth: Ctrl/Cmd-vertical dragging on the center point. 

• Outer Depth: Ctrl/Cmd-vertical dragging on the dashed circle.

Ramp
• Center Depth: Ctrl/Cmd-vertical dragging on the solid line. 

• Left Depth: Ctrl/Cmd-vertical dragging on the left dashed line.

• Right Depth: Ctrl/Cmd-vertical dragging on the right dashed line.

Note: Ctrl/Cmd-Shift dragging modifies all depth values at once.

Position
Sets the position of the gradient. The position can be set interactively by 
dragging the center point.

Rotate
Sets the angle of the gradient. The angle can be set interactively by dragging 
the solid line for Linear/Ramp and Alt-dragging the point at the bottom of the 
circle for Radial.

Size
Sets the size of the Radial gradient. The size can be set interactively by 
dragging the dashed line.
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Left/Right Size
Sets the left and right size of Linear and Ramp. The size can be set interactively 
by dragging the dashed lines. Shift-dragging over one of the dashed lines will 
drag them both.

Aspect Ratio
Sets the aspect ratio of the Radial gradient. The aspect ratio can be set 
interactively by dragging the point at the bottom of the circle.

Blur
Blurs the depth map.

Wrap
Blurs the depth map inward without completely losing the edge.

Shapes / Layers and Depth
In addition to the same shape/layer parameters in the Roto node, there are a 
number of shape/layer depth controls in the Depth node.

Shape Depth Parameters
Type
Sets the shape’s depth type. 

Constant
Sets a constant depth for the entire shape.

Linear
The shape is filled with a linear gradient with two depth values.

Radial
The shape is filled with a radial depth gradient.

Ramp
The shape is filled with a linear gradient with three depth values.

Depth Parameters
Sets the depth. A value of 1 is nearest (white), 0 is farthest (black) and .5 is a 
mid depth (50% gray). The depth can be set interactively by:
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Constant
• Ctrl/Cmd-vertical dragging on the center point.

Linear
• Left Depth: Ctrl/Cmd-vertical dragging on the left dashed line.

• Right Depth: Ctrl/Cmd-vertical dragging on the right dashed line.

Radial
• Inner Depth: Ctrl/Cmd-vertical dragging on the center point. 

• Outer Depth: Ctrl/Cmd-vertical dragging on the dashed circle.

Ramp
• Center Depth: Ctrl/Cmd-vertical dragging on the solid line. 

• Left Depth: Ctrl/Cmd-vertical dragging on the left dashed line.

• Right Depth: Ctrl/Cmd-vertical dragging on the right dashed line.

Note: Ctrl/Cmd-Shift dragging modifies all depth values at once.

Position
Sets the position of the gradient. The position can be set interactively by 
dragging the center point.

Rotate
Sets the angle of the gradient. The angle can be set interactively by dragging 
the solid line for Linear/Ramp and Alt-dragging the point at the bottom of the 
circle for Radial.

Size
Sets the size of the Radial gradient. The size can be set interactively by 
dragging the dashed line.

Left/Right Size
Sets the left and right size of Linear and Ramp. The size can be set interactively 
by dragging the dashed lines. Shift-dragging over one of the dashed lines will 
drag them both.

Aspect Ratio
Sets the aspect ratio of the Radial gradient. The aspect ratio can be set 
interactively by dragging the point at the bottom of the circle.
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Blur
Blurs the shape.

Wrap
Blurs the shape inward without completely losing the edge.

Layer Depth Parameters
Obey Alpha
With Obey Alpha enabled, a depth map is only created within areas of the 
layer’s alpha channel.

Near Depth
Sets the Near Depth for all objects in the layer.

Far Depth
Sets the Far Depth for all objects in the layer.

Common Parameters
All of the editable parameters can be adjusted in the Object Parameters. The 
parameters listed below are common to many of the objects.

Invert
Inverts the values. The default is off.

Blend Mode
Controls how objects are blended together in the depth map.

Normal
Places the shape/layer over any objects below it.

Note: Normal is only available for shapes and layers.

Min
Looks at the luminance information for each object and selects the value—
whichever is darker—as the result. Lighter pixels are replaced while darker 
pixels do not change.
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Max
Looks at the luminance information for each object and selects the value—
whichever is brighter—as the result. Darker pixels are replaced while brighter 
pixels do not change.

Multiply
Produces a result where there is a union of pixels from two objects.

Screen
Looks at each object’s luminance information and multiplies the inverse of the 
two images. This looks kind of like an Add blend mode, but highlights are 
retained.

Motion Blur
Motion blur is the directional blurring of rapidly moving shapes. This parameter 
turns Motion Blur on or off for the selected object. The default is off.

Note: The Motion Blur parameters will not affect a shape unless Motion Blur is also 
enabled in the Node parameters. See Motion Blur in the Roto node for more 
information.

Outline Color
Sets the color of the object’s outline or on-screen controls. Left-clicking the 
color pot opens a standard color picker while right-clicking on the color pot 
opens a pop-up color menu with 16 primaries. 

Reset All
Resets all parameters to their default state.
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Depth Preview
The Depth Preview window displays a 3D view of the depth map and is located 
in a tab shared with the Sources window. It is very useful for visualizing the 
depth and placement of objects in 3D space.

Clicking and dragging will move the image around in a perspective view.

Note: OpenGL 3.0 is a required graphics card feature for the Depth Preview window to 
be available.
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Depth Preview Pan/Zoom Shortcuts

Node Parameters
When the Depth node is being edited in the Trees window, parameters specific 
to the Depth node can be adjusted in the Node parameters.

Motion Blur
Motion blur is the directional blurring of rapidly moving shapes. Enables Motion 
Blur for the Depth node.

Go to the Motion Blur tutorial to see how it works.

Near Depth
Sets the Near Depth for all objects in the node.

Far Depth
Sets the Far Depth for all objects in the node.

Render to Alpha
Renders the depth channel to the alpha channel.

Antialias
Controls whether depth shapes are antialiased on their edges.

Node Outputs
Output
Outputs the result of the Depth node.

Shortcut Action

Click and drag Rotates the image a perspective view

Scroll wheel Zooms the image in and out

Shift-Middle-mouse drag Zooms the image in and out

Space Bar-Shift-move mouse up/down Zooms the image in and out

Space Bar-move mouse Pans the image

Middle-mouse drag Pans the image

Middle-mouse double click Fits the image in the Viewer
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Objects
Outputs tracked layers and shapes for use in nodes with Transform or Objects 
inputs.
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Depth of Field
Description

Depth of Field can be added to a scene by isolating and blurring only a portion 
of the image. The amount of blurring is directly proportionate to the luminance 
of the matte settings, a gradient or an input image.

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab.

Depth
Selects the source for the selective blur effect.

Matte
Use a matte for the depth source.

Grad
Use a gradient for the depth source.

Input
Use an image as the depth source. This is useful for 3D programs which render 
out depth mattes.

Blur
Sets how much the image is blurred.

Grad 
Depth of Field can optionally use a gradient that limits where the filter is applied. 
Grad is the transition area that goes from the blurred portion to the original 
image. Its direction, corners and size can be adjusted. Go to the Grad section 
of Common Node Controls to see how the Grad controls work.
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Matte
A matte can be used to create the depth of field effect. Go to the Matte section 
of Common Node Controls to see how the Matte controls work.
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Despeckle
Description

The Despeckle filter is used to remove small single pixel defects.

Node Group
Filter.
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Detail
Description

Detail can perform selective sharpening, detail enhancement and edge aware 
smoothing. The image is separated into three detail layers: coarse, medium 
and fine. Each of the detail layers can be manipulated separately in various 
ways, for instance, sharpening or smoothing. Masking provides quick isolation 
of image features for selective filtering.

Node Group
Filter.

Controls
Detail
The image is separated into three detail layers: coarse, medium and fine. Each 
of the detail layers can be manipulated separately in various ways, for instance, 
sharpening or smoothing.

Coarse
Adjusts the Coarse detail layer. Increasing the value sharpens while decreasing 
the value smooths.

Medium
Adjusts the medium detail layer. Increasing the value sharpens while 
decreasing the value smooths.

Fine
Adjusts the fine detail layer. Increasing the value sharpens while decreasing the 
value smooths.

Gang
The Coarse, Medium and Fine values can be ganged together so that they all 
move simultaneously. This will generate an overall sharpening effect if the 
numeric fields are increased and an overall smoothing effect if decreased.

Shadows
Adjusts the amount of Detail in the shadow portions of the image.
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Midtones
Adjusts the amount of Detail in the midtone portions of the image.

Highlights
Adjusts the amount of Detail in the highlight portions of the image.
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Develop
Description

Provides useful developing controls for globally adjusting the color and tonal 
scale of your images.

Node Group
Color.

Controls
Temperature
Sets the color of the image to be either warmer or cooler. Dragging the numeric 
field to the right makes the image cooler (bluer) and dragging the numeric field 
to the left makes image warmer (redder).

Tint
Adds either Green or Magenta to the image. Dragging the numeric field to the 
right makes the image more magenta and dragging the numeric field to the left 
makes the image more green.

Exposure
Sets the overall image brightness, with a greater effect in the high values. 
Adjust the numeric field until the image looks good and the whites are at the 
right level. Use Recovery to bring highlight values down. Exposure values are 
in increments equivalent to f-stops. An adjustment of +1.00 is similar to 
increasing the aperture 1 stop. Similarly, an adjustment of –1.00 is similar to 
reducing the aperture 1 stop.

Recovery
Reduces the tones of extreme highlights and attempts to recover highlight 
detail lost because of overexposure.

Fill Light
Lightens shadows to reveal more detail while maintaining blacks. Take care not 
to over apply the setting and reveal image noise.
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Blacks
Specifies which image values map to black. Adjusting this value increases the 
areas that become black, sometimes creating the impression of increased 
image contrast. The greatest effect is in the shadows, with much less change 
in the midtones and highlights.

Brightness
Adjusts image brightness, mainly affecting midtones. Set the overall tonal scale 
by setting Exposure, Recovery, and Blacks. Then set the overall image 
brightness. Large brightness adjustments can affect shadow or highlight 
clipping, so you may want to readjust the Exposure, Recovery, or Blacks after 
adjusting brightness.

Contrast
Increases or decreases image contrast, mainly affecting midtones. When you 
increase contrast, the middle-to-dark image areas become darker, and the 
middle-to-light image areas become lighter. The image tones are inversely 
affected as you decrease contrast.

Vibrance
Adjusts the saturation so that clipping is minimized as colors approach full 
saturation, changing the saturation of all lower-saturated colors with less effect 
on the higher-saturated colors. Vibrance also prevents skin tones from 
becoming over saturated.

Saturation
Adjusts the saturation of all image colors equally.
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Difference Matte
Description

Extracts a matte based on the difference in color values between two images.

Node Group
Key.

Controls
Gain
Sets the gain of the matte.

Offset
Offsets the matte values either darker or lighter.
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Diffusion
Description

Diffusion creates atmosphere by reducing contrast while creating a glow 
around highlights or shadows using an extensive texture library.

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab.

Diffusion
Blend
Determines the blend mode to be used to create the diffusion effect.

Add
The diffusion is added to your image.

Screen
The diffusion is combined with the image using a Screen blend mode. This 
looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the diffusion.

Blur
Sets the softness of the diffusion.

Color
The Color parameter sets the color of the diffusion through the use of a 
standard color picker. The default color is white.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.
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Texture
Texture
Selects the texture which will be used to add diffusion to the image.

Blend
Textures can be used as the source of the diffusion as well as combined with a 
matte using a variety of Blend modes. Go to Blend Modes for explanations of 
the various modes.

I like the Multiply blend mode for combining textures with the matte because it 
only puts the texture within the areas of the generated matte.

Transform
The texture can be manipulated using a Transform. Go to the Transform node 
to see how it works.

Matte
A matte can be used to create the diffusion effect. Go to the Matte section of 
Common Node Controls to see how the Matte controls work.
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Displace
Description

Displaces the image by the luminance values of the second input.

Node Group
Filter.

Controls
Amount
Displaces the image by the luminance values of the second input.
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DOD
Description

The DOD (Domain of Definition) node defines the size of the DOD. The DOD 
can be expanded or reduced. A smaller DOD will speed up all image 
processes. Setting the DOD larger than the Session size will pad smaller 
images and the ROI (Region of Interest) can access the additional image area. 
This is useful for creating oversize plates.

Node Group
Transform.

Controls
On-Screen Controls
The on-screen controls automatically set the values for the DOD’s numeric 
values. Dragging any on-screen control handle with Shift held down will add 
the equivalent amount to the other side.

Size
Width
Sets the image width.

Height
Sets the image height.

DOD
Left
Sets the left image boundary.

Top
Sets the top image boundary.

Right
Sets the right image boundary.

Bottom
Sets the bottom image boundary.
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Double Fog
Description

The Double Fog filter creates a soft, misty atmosphere over the image by first 
applying fog using a vanishing point along the direction of increasing distance 
in the image. Then, a second pass blooms image highlights. 

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab.

Fog
Color
The Color parameter sets the color of the fog to be added through the use of a 
standard color picker. The default color is white.

Vanishing Point
A vanishing point along the direction of increasing distance in the image is used 
to add fog. By default, the vanishing point is set to the center of the screen. 
Essentially, the fog is added in a radial pattern emanating from the vanishing 
point. So at the default center position, fog is added in a circular pattern with a 
greater amount of fog being added in the center while falling off at the edges. 
For instance, if you would like your fog to move in the direction of top right to 
bottom left, set your vanishing point towards the top right corner and the fog will 
be more intense at the upper right and fall off at the bottom left. However, in 
most cases, the vanishing point can be left in the center of the screen and you 
will obtain acceptable results. 

There is an on-screen control in the center of the image. By clicking and 
dragging the on-screen control, the position of the vanishing point can be 
adjusted.

Position X
The horizontal position of the vanishing point.
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Position Y
The vertical position of the vanishing point.

Note: There is an on-screen control in the center of the image. By clicking and dragging 
the on-screen control, the position of the vanishing point can be adjusted.

Fog
Sets the amount of fog to be added to the scene.

Min Depth
Controls how much fog is added in the darker areas of the image.

Max Depth
Controls how much fog is added in the brighter areas of the image.

Glow
The Glow controls are used to add additional atmosphere and are useful in 
adding glow to highlights. By default, a wide matte of highlights are glowed in 
the image and blended with the Screen blend mode. This works well for adding 
additional fog. To add glow around highlights such as light sources, it is best to 
set the Blend mode to Add and lower the Matte > Range parameter to limit the 
areas of glow to only include the light sources.

Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.
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Color
The Color parameter sets the color of the glow through the use of a standard 
color picker. The default color is white.

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 
Node Controls to see how the Matte controls work.
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Drop Shadow
Drop shadows can be added to an image that has an alpha channel. The 
opacity, color, blur and transformation of the drop shadow can all be adjusted.

Node Group
Composite.

Controls
Color
The Color parameter sets the color of the drop shadow through the use of a 
standard eyedropper or color picker. The default color is black.

Opacity 
The opacity of the shadow.

Blur
The drop shadow is blurred by a fast, quality blur. Go to the Blur node to see 
how the Blur controls work.

Transform
The drop shadow can be manipulated using a Transform. Go to the Transform 
node to see how it works.
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Dual Gradient
Description

Dual Gradient applies two photographic filters to the image which are blended 
together with a gradient. Presets for your favorite Color Gradient filters are 
provided as well as the ability to create custom colors.

Node Group
Tints.

Controls
Presets
To select a preset, choose one from the Presets tab.

Color 1
Sets the color for the top half of the image. Select the desired color using the 
color picker or choose a filter preset.

Presets
Select one of the filters from the pop-up list.

Color
The Color parameter sets the color of the grad through the use of a standard 
color picker.

Opacity
Sets the opacity of the color filter.

Color 2
The Color 2 controls are the same as the controls for Color 1 except it is applied 
to the bottom half of the image.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.
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Grad 
Grad is the transition area between the two tints. Its direction, corners and size 
can be adjusted. Go to the Grad section of Common Node Controls to see how 
the Grad controls work.
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Edge Composite
Description

Edge Composite automatically generates an edge matte from an existing alpha 
channel and allows you to color correct or blur only the edge of the foreground. 
You can also mix the edge of the foreground with the background. This is very 
helpful for seamlessly integrating images as well as dealing with aliased 
mattes.

Node Group
Composite.

Controls
Size
Determines the size of the edge matte.

Color Correct
The edge of the foreground can be color corrected. Go to the Color Correct 
node to see how the Color Correct controls work.

Blur-Horizontal
The edge of the composite is blurred by a fast, quality blur along the X-axis, but 
only in areas of the edge matte.

Blur-Vertical
The edge of the composite is blurred by a fast, quality blur along the Y-axis, but 
only in areas of the edge matte.

Gang
The horizontal and vertical values can be ganged together.

Opacity
Mixes the foreground back to the background, but only in areas of the edge 
matte.
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Edge Detect
Description

Edges are generated from the values in the either the RGB or alpha channels.

Node Group
Filter.

Controls
Channels
Choose which channels to perform the edge detect on.

RGB
Performs the edge detect on the RGB channels.

Alpha
Performs the edge detect on the alpha channel.

Brightness
Sets the brightness of the edges.

Blur
Blurs the edges.
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Extract Detail
Description

Extract Detail decomposes the image into color and detail layers.The color and 
detail can later be composited together using the Grain Composite node.

Node Group
Filter.

Controls
Presets
To select a preset, choose one from the Presets tab.

Coarse
Extracts detail from the coarse layer.

Medium
Extracts detail from the medium layer.

Fine
Extracts detail from the fine layer. The fine layer typically includes details such 
as skin blemishes, pores, hair, and wrinkles.

Detail
Determines the detail layer to be used. 0 is coarse, .5 is medium and 1 is fine.

Outputs
Output
Outputs the color layer.

Detail
Outputs the detail layer. Use this output in conjunction with the Grain 
Composite node.
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Fade Color
Description

Fades an image into a color.

Node Group
Image.

Controls
Amount
Sets the amount of the color.

Color
The color can be set through the use of a standard color picker.

Direction
Forward
The Amount transitions from the input image to the color.

Reverse
The Amount transitions from the color to the input image.
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Film Stocks
Description

Film Stocks is a unique filter that simulates 294 different color and black and 
white still photographic film stocks, motion picture films stocks and historical 
photographic processes.

Node Group
Film Lab.

Controls
Presets
To select a preset, choose one from the Presets tab. If you would like to view 
presets from a different category, use the pop-up menu at the top left of the 
Presets tab.

Amount
Sets the amount of the selected preset.

Black and White
Red, Green and Blue controls allow you to determine the contribution of each 
color channel in the black and white conversion.

Enable
Enables the Black and White conversion.

Red
Sets the amount of the red channel that contributes to the black and white 
conversion.

Green
Sets the amount of the green channel that contributes to the black and white 
conversion.

Blue
Sets the amount of the blue channel that contributes to the black and white 
conversion.
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Film Response
To mimic the characteristics of a particular film stock, a combination of settings 
for the RGB channels have been set.

RGB
Controls the RGB film response curve. If you are using a black and white 
preset, the grayscale film response curve will be adjusted.

Red
Controls the Red film response curve.

Green
Controls the Green film response curve.

Blue
Controls the Blue film response curve.

Color Correct
Color Correct manipulates the Temperature, Cyan/Magenta, Brightness, 
Contrast, Shadow, Midtone, Highlight, and Saturation values of the image. Go 
to the Color Correct node to see how it works.

Filter
Adds a color filter to the image.

Presets
Select one of the filters from the pop-up list.

Color
Sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color filter.

Highlights
Preserves the white areas of the image.
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Sharpen
Amount
Determines how much contrast is added at the edges.

Radius
Controls the size of the edges you wish to sharpen.

Threshold
The threshold setting is used to sharpen more pronounced edges, while 
leaving more subtle edges untouched. Low values sharpen more image areas 
while higher threshold values sharpen less.

Diffusion
Blend
Determines the blend mode to be used to create the diffusion/glow effect.

Add
The diffusion/glow is added to your image.

Normal
The diffusion is mixed with the original image. In this mode, Amount only shows 
changes up to a value of 100.

Screen
The diffusion/glow is combined with the image using a Screen blend mode. 
This looks kind of like the Add blend mode, but highlights are retained.

Amount
Sets the amount of diffusion.

Blur
Sets the softness of the image.

Color
The Color parameter sets the color of the diffusion/glow through the use of a 
standard color picker or eyedropper. The default color is white.
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Position
When using the Add and Screen blend modes, Position selects the values used 
to create the glow effect. A higher Position value uses the brightest image 
values to create the glow. A lower Position value uses the darkest image values 
to create the glow.

Range
When using the Add and Screen blend modes, Range controls the range of 
values to be used for the glow. Once you’ve selected the “Position”, you can 
then add or subtract the “Range” of values to be used in the glow source. A 
higher Range value includes more values in the glow source while a lower 
Range value includes less values.

Vignette
A vignette is a popular photographic effect where the photo gradually fades into 
a color. Go to the Vignette filter to see how it works.

Grain
Grain simulates film grain with control of the size, softness and intensity. In 
addition, a Film Response parameter controls where you will see grain in the 
image. Go to the Grain filter to see how it works. 

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.
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Flip
Description

Flips the image vertically.

Node Group
Transform.
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Flop
Description

Flops the image horizontally.

Node Group
Transform.
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Fog
Description

The Fog filter creates a soft, misty atmosphere over the image and glows 
highlights.

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab.

Fog
Blend
Determines the blend mode to be used to create the fog effect.

Add
The fog is added to your image.

Screen
The fog is combined with the image using a Screen blend mode. This looks kind 
of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the fog.

Blur
Sets the softness of the fog.

Color
The Color parameter sets the color of the fog through the use of a standard 
color picker. The default color is white.

Matte
A matte is used to create the fog effect. Go to the Matte section of Common 
Node Controls to see how the Matte controls work.
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Fractal Noise
Description

Fractal Noise is a noise texture based on Perlin noise.

Node Group
Image.

Controls
Scale
Scales the noise.

X Bias
Moves the noise horizontally.

Y Bias
Moves the noise vertically.

Lancunarity
Lacunarity defines the gap between the various frequencies that are added 
together to form the texture. Higher Lacunarity values increase the complexity 
and detail in the texture. Lower values make the texture smoother with less 
detail.

Increment
Increment controls the ratio of noise in the texture. Higher values blend the light 
and dark areas together. Lower values create a more contrasty texture.

Octaves
Octaves controls the number of texture calculation iterations. Fractal textures 
work by running an algorithm iteratively. The longer it runs, the more detail it 
creates, but the slower it goes. Increase Octaves to make the texture more 
detailed. This is good to do if it will be seen up close in the final rendered image. 

Amplitude
Scales the final result.
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Frost
Description

Frost
Frost glows highlights and reduces contrast while softening facial blemishes 
and wrinkles.

Black Frost
Black Frost offers all the benefits of the Frost filter in a more subtle form. This 
filter subtly controls highlights, reduces contrast and provides a harder look 
than the Frost filter, while suppressing facial blemishes and wrinkles.

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab.

Detail
Smoothing
Fine image details, such as facial wrinkles and blemishes, are minimized using 
edge aware smoothing.

Mist
The Mist controls add a mild glow to image highlights.

Blend
Determines the blend mode to be used to create the mist effect.

Add
The mist is added to your image.

Screen
The mist is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.
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Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist.

Color
Sets the color of the mist.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.

Matte
A matte is used to create the mist effect. Go to the Matte section of Common 
Filter Controls to see how the Matte controls work.
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Glow
Description

The Glow filter creates glows around selected areas of the image.

Node Group
Light.

Controls
Presets
To select a preset, choose one from the Presets tab.

Glow
Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color
The Color parameter sets the color of the glow through the use of a standard 
color picker. The default color is white.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 
Node Controls to see how the Matte controls work.
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Glow Darks
Description

Glows and grows the darks areas of the image.

Node Group
Light.

Controls
Presets
To select a preset, choose one from the Presets tab.

Glow
Amount
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 
Node Controls to see how the Matte controls work.
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Glow Edges
Description

Edge Glow isolates lines and edges in an image and then adds glow only to 
these areas resulting in a stylized look.

Node Group
Light.

Controls
Presets
To select a preset, choose one from the Presets tab.

Glow
Blend
Determines the blend mode to be used to create the edge glow effect.

Add
The edge glow is added to your image.

Screen
The edge glow is combined with the image using a Screen blend mode. This 
looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the edge glow.

Blur
Sets the softness of the edge glow.

Color
The Color parameter sets the color of the edge glow through the use of a 
standard color picker. The default color is white.

Edge
An edge matte is created to produce the edge glow effect.

Brightness
Determines the brightness of the edge matte.
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Blur
Blurs the edge matte.
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Grain
Description

Grain simulates film grain with control of size, intensity and softness. In 
addition, a Film Response parameter controls where you will see grain in the 
image. Popular film stock presets are provided as a starting point to adding 
grain.

Node Group
Filter.

Controls
Presets
To select a preset, choose one from the Presets tab.

Monochrome
When enabled, the grain is monochrome. In this mode, parameters that have 
no effect are grayed out.

Size
The Size parameter controls the size of the grain. The larger the Size setting, 
the larger the grain will be.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

Amount
The Amount parameters set the red, green and blue intensities of the grain. 
Film stocks generally have varying amounts of red, green and blue intensities 
with the blue intensity generally higher than the rest. If you set the red, green 
and blue amount to a value of 0, the grain will disappear.

Red Amount
Controls the intensity of the red grain.

Green Amount
Controls the intensity of the green grain.
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Blue Amount
Controls the intensity of the blue grain.

Softness
The Softness parameter controls the softness of the grain. Normally, only minor 
softness adjustments are necessary, usually between a value of 0-1.

Film Response
The Film Response parameter allows the adjustment of where you will see 
grain in the image. In most cases, film grain is apparent over the entire image 
except the brightest whites with the black areas being the most affected.

Position
Position defines the portions of the image where grain will be added. A low 
Position value places grain in the darkest image values, while a high Position 
value places grain in the brightest areas.

Range
Increases or decreases the area where grain is added to the image based on 
the Position value. A low Range value indicates a narrow range of values, while 
a high Range value indicates a large range of values.

Minimum
Sets the minimum level of grain that is always added to the image.

Note: A Position value of 0 and a Range of 80 is typical of standard film, with grain 
applied to the entire range except the brightest whites with black being the most 
affected.
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Grain Composite
Description

Composites grain or detail back into an image that was previously extracted 
using the DeGrain or Extract Detail nodes.

Node Group
Composite.

Controls
Opacity
Controls the amount of grain or detail added to the image.

Channels
Sets the mode for compositing grain or detail into the image.

Luminance
Composites detail extracted using the Extract Detail node.

RGB
Composites grain extracted using the DeGrain node.
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Grid
Description

Creates a grid of horizontal and vertical lines on top of the input image.

Node Group
Image.

Controls
Amount
Sets the number of squares in the grid.

Size
Determines the size of the grid lines.

Color
Sets the color of the grid through the use of a standard color picker.

Opacity
Controls the opacity of the grid.
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Grunge
Description

Adds film dirt, hair, scratches, stains, splotches, gate weave, flicker, vignetting 
and grain--all to make your pristine image look like damaged film.

Node Group
Film Lab.

Controls
Presets
To select a preset, choose one from the Presets tab.

Randomize
Randomizes the applied elements.

Dirt
Opacity
The opacity of the dirt.

Amount
The number of pieces of dirt.

Size
The size of the dirt.

Type
Positive
The dirt is black as it is in positive film.

Negative
The dirt is white as it is in negative film.

Hair
Opacity
The opacity of the hair.
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Amount
The number of hairs.

Size
The size of the hairs.

Type
Positive
The hair is black as it is in positive film.

Negative
The hair is white as it is in negative film.

Scratches
Opacity
The opacity of the scratches.

Amount
The number of scratches.

Width
The width of the scratches.

Length
Randomly changes the length of the scratches.

Variance
Determines how fast the scratches move from side to side.

Roughness
The roughness of the scratches.

Type
Positive
The scratches are black as they are in positive film.

Negative
The scratches are white as they are in negative film.
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Stains
Opacity
The opacity of the stains.

Amount
The number of stains.

Size
The size of the stains.

Type
Positive
The stains are black as they are in positive film.

Negative
The stains are white as they are in negative film.

Splotches
Opacity
The opacity of the splotches.

Amount
The number of splotches.

Size
The size of the splotches.

Type
Positive
The splotches are black as they are in positive film.

Negative
The splotches are white as they are in negative film.

Gate Weave
Amount
The amount of weave.
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Speed
The speed of the weave.

Flicker
Amount
The amount of flicker.

Speed
The speed of the flicker.

Vignette
A vignette is a popular photographic effect where the photo gradually fades into 
a color. Go to the Vignette node to see how it works.

Grain
Grain simulates film grain with control of the size, softness and intensity. In 
addition, a Film Response parameter controls where you will see grain in the 
image. Go to the Grain node to see how it works. 

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.
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Harris Shutter
Description

Invented by Robert S. “Bob” Harris of Kodak, the Harris Shutter was originally 
a strip device with three color filters used for making color photographs with the 
different primary color layers exposed in separate time intervals in succession. 
The same frame of film was re-exposed through red, green and blue filters in 
turn, while keeping the camera steady.

Our digital version of the Harris Shutter uses separate images for the red, green 
and blue channels. In the case of a time interval between images used for the 
red, green and blue channels, this will generate a rainbow of color around any 
object that moves within the frame. Some good candidates for subjects include 
waterfalls, clouds blowing over a landscape or people walking across a busy 
street.

Node Group
Special Effects.

Controls
Red / Green / Blue
Source
Sets the source image to be used as the Red, Green and Blue channels. If an 
image is not assigned using Source, the original image’s color channel will be 
used.

Offset
Allows you to offset the frames used for the Red, Green and Blue channels.

Amount
Controls how much of the Red, Green or Blue image is contributed to the 
composite image.
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High Contrast
Description

Creates an extreme high contrast image.

Node Group
Color.

Controls
Presets
To select a preset, choose one from the Presets tab.

Contrast
Sets the amount of contrast to be applied to the scene.

Amount
Sets the mix amount between the original and filtered version.
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Hold
Description

Repeats the specified frame for the duration of the session. This is useful, for 
instance, to hold a single painted frame from the Paint node.

Node Group
Time.

Controls
Frame
Selects the frame to be held for the duration of the session.
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Holdout Composite
Description

To add practical fire, explosions, smoke or other footage not containing an 
alpha channel is normally a challenge. A normal Math Composite Add function 
would cause areas of the background to get brighter. This is bad. Using a key 
of some type would most likely generate unwanted edge fringing. This is also 
bad. The Holdout Composite is a two-layer/track effect that effectively 
composites images such as fire, explosions and smoke. It creates a luminance 
matte of the foreground and pastes it as black (or other color) over the 
background. You then use one of the Blend Modes to place the foreground over 
the “held out background”.

Note: You can change Holdout Composite’s input order with the User Interface > Trees 
> Input Order preference. By default, FG, BG is selected, but you can change it to BG, 
FG if you’d like.

Node Group
Composite.

Controls
Blend
This selects the type of Blend mode to use for the foreground element.

Add
The pixels of the foreground are added to the background.

Screen
The foreground and background are combined using a Screen blend mode. 
This looks kind of like the Add blend mode, but highlights are retained.

Lighten
Compares the foreground and background and takes the pixels with the higher 
value.

Level
Sets the level of the foreground element.
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Black Clip
Blacks are made blacker by increasing this value. As the value increases, more 
values are clipped to black.

Note: Often times the black portion of an image is not entirely black. This becomes an 
issue if something like fire is shot against a black background. If the black is not entirely 
black, then these impure black areas will be added to the background image as part of 
the Holdout Composite causing the final result to have milky blacks. Black Clip will 
improve these milky blacks and make them darker.

Matte
The Holdout Composite first creates a luminance matte of the foreground and 
then pastes it as black (or other color) over the background. You can see the 
extracted matte with the View set to Matte.

Black Clip
Blacks in the matte are made blacker by increasing this value. As the value 
increases, more values are clipped to black. This is helpful for getting rid of 
unwanted gray areas in what should be the black part of the matte.

White Clip
Whites in the matte are made whiter by increasing this value. As the value 
increases, more values are clipped to white. This is helpful for getting rid of 
unwanted grey areas in what should be the white part of the matte.

Holdout
The Holdout Composite takes the luminance matte of the foreground and 
pastes it as black (or other color) over the background. You can see the matte 
pasted onto the background with the View set to Holdout.

Color
The Color parameter sets the color of the Holdout matte through the use of a 
standard eyedropper or color picker. The default color is black.

Note: There may be times when you want to select a color from the background as the 
Holdout color. This will appear to give the foreground some atmosphere.

Opacity 
The opacity of the color.
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Infrared
Description

Infrared simulates infrared filters used in conjunction with infrared sensitive film 
or sensors to produce very interesting black and white images with glow in 
highlight areas.

Node Group
Special Effects.

Controls
Presets
To select a preset, choose one from the Presets tab.

Black and White
Selects the type of black and white filter to be applied to your color image. Go 
to the Black and White section of Common Node Controls to see how the 
Black and White controls work.

Glow
Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.
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Matte
A matte is used to create the glow effect. Go to the Matte section of Common 
Node Controls to see how the Matte controls work.
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Invert
Description

Inverts the RGB or alpha channels.

Node Group
Color.

Controls
Channels
RGBA
Inverts the RGB channels.

RGB
Inverts the RGB channels.

Alpha
Inverts the alpha channel.
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Kelvin
Description

Degrees Kelvin is the standard unit of measure for color temperature which is 
a way to characterize the spectral properties of a light source. Low color 
temperature implies warmer (redder) light, while high color temperature implies 
a colder (bluer) light. Presets for a number of different light sources and 
conditions are provided in degrees Kelvin.

Node Group
Color.

Controls
Presets
To select a preset, choose one from the Presets tab.

Color Temperature
The Color Temperature of the image is determined by the difference of the 
Destination and Source Kelvin parameters. For instance, if your Source Kelvin 
is 3200 degrees Kelvin and you adjust the Destination Kelvin to 6500 degrees, 
your image would turn blue. This is the same as using tungsten indoor film 
meant to be used with lighting balanced for 3200 degrees Kelvin outside in 
daylight which is 6500 degrees Kelvin.

Destination Kelvin
Sets the destination color temperature of the image in degrees Kelvin.

Source Kelvin
Sets the source color temperature of the image in degrees Kelvin.

Opacity
Sets the opacity of the color temperature adjustment.

Preserve Highlights
Preserves the white areas of the image.
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Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the color 
temperature application.

Grad 
Kelvin can optionally use a gradient that limits where the filter is applied. Grad 
is the transition area between the colored portion and the original image. Its 
direction, corners and size can be adjusted. Go to the Grad section of Common 
Node Controls to see how the Grad controls work.
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Keystone
Description

Rotates the source image around the horizontal and vertical axis for minor 
corrections.

Node Group
Transform.

Controls
X
Rotates the source image around the vertical axis.

Y
Rotates the source image around the horizontal axis.
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Lens Distortion
Description

Lens Distortion corrects for pin-cushioning and barrel distortion of camera 
lenses. It is also useful for creating the look of a wide angle lens.

Node Group
Warp.

Controls
Distortion
Pulls the corners of the image in or out. Negative values pull the corners of the 
image outward while positive values pull the corners of the image inward.

Anamorphic Squeeze
Anamorphic Squeeze corrects for the squeeze found in anamorphic motion 
picture lenses.

Curvature X and Y
Curvature X and Y correct for non-radial, asymmetric distortions found in 
anamorphic motion picture lenses.

Note: Anamorphic Squeeze and Curvature X and Y only work once the Distortion 
parameter has been moved.

Center
Determines the center point for the distortion. There is an on-screen control in 
the center of the image. By clicking and dragging the on-screen control, the 
Center can be adjusted.
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Lens Flare
Description

Lens flares are produced by the scattering or flaring of light within a lens when 
pointed into a bright light. Although an image aberration, lens flares can be 
added for dramatic effect and are created by combining the following elements: 
Caustic, Chroma Bands, Chroma Ring, Circle, Circles, Disc, Edge Streak, 
Ellipse, Fan Rays, Hot Spot, Polygon, Polygons, Radial Streaks, Random 
Spikes, Ring, Spikes, Spiral Rays, Star, Star Caustic, and Stripe.

Node Group
Light.
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Elements
Caustic

Simulates an optical distortion created by the envelope of light rays reflected or 
refracted by a curved surface.

Chroma Bands
Creates rainbow diffraction patterns.
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Chroma Ring
Rainbow lines that emanate from the center of the light source.

Circle
An individual circle.
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Circles
Creates a specified number of random circles often seen in lens flares.

Disc
Generates a circular ramp with individual control of the inner, middle and outer 
areas.
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Ellipse
Ellipse is similar to Disc, but elliptical in shape.

Edge Streak
Caused by a light source at the edge of the frame reflecting off of the shiny lens 
aperture. It only appears when the light source is positioned outside of the 
frame.
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Fan Rays
Generates asymmetric fanned rays.

Hot Spot
Utilized in most lens flares, glow ball simulates the circular glow created when 
a light source interacts with a lens.
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Polygon
An individual polygon.

Polygons
Creates a specified number of random polygons. These are reflections caused 
by light interacting with the lens’s polygonal bladed aperture.
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Radial Streaks
Short radial streaks emanating from the center point.

Random Spikes
Generates asymmetric radial rays.
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Ring
A rainbow ring that fades as it is moved to the edges of the screen.

Spikes
Long radial rays emanating from the center point.
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Spiral Rays
Creates spiral rays.

Star
A star pattern is created when light reflects off the intersection of the lens’s 
aperture blades.
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Star Caustic
A star shaped caustic created by the envelope of light rays reflected or 
refracted by a lens’s reflective coatings.

Stripe
A tapered stripe that simulates anamorphic lens flares.
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Controls - Global
Presets

To select a preset, pick one from the Presets tab. 

Edit Flare
Click the Edit Flare button to edit the current preset or to create a custom lens 
flare. The Flare Editor interface consists of a Viewer, Parameters, Global, Flare 
(currently used flare elements) and Elements (all available elements). 

User Interface
Toolbar
The Toolbar contains Done, Cancel, Reset, and Show Image icons.
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Viewer
The Viewer displays the composite of all added flare elements.
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Parameters and Global
Parameters and Global share the same window space on the right side of the 
screen, with Global shown as the default. Either Parameters or Global are 
selectable in a tab at the top of the window.
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Elements
The Elements window displays lens flare building blocks to be used in the 
creation of a flare.

Flare
The Flare window displays all elements that make up the current lens flare.

Enable (E)
Enables and disables the element.

Solo (S)
Displays only the soloed element.
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Working With Elements
Select Elements
Select elements using the Shift or Ctrl/Cmd keys.

Add Elements
• Double-click an element in the Elements window and it is added to the end of the 

stack in the Flare window. If an element is selected in the Flare window prior to the 
double-click, the new element is added after the selection.

• Drag and drop from the Elements window to the Flare window or Viewer. Multiple 
selected elements can be dragged and dropped simultaneously.

Delete Elements
Delete selected elements.

• Press the Delete key.

or

• Click the Delete Element icon at the bottom of the Flare window.

Duplicate Elements
Duplicate selected elements using the Duplicate Element icon at the bottom of 
the Flare window.

Edit Elements
• Select an element in the Flare window and it’s controls are displayed in the 

Parameters window.

• When multiple elements are selected, the controls for all selected elements are 
displayed in the Parameters window.

• Click and drag the point controls in the viewer to move the flare around.

• Ctrl/Cmd-click and drag in the viewer to move the selected elements along the 
flare line.

Moving Elements In The Flare Window
Drag the icon of an element to a new position in the stack. Multiple elements 
can be moved at once.
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Rename Elements
Click in the element text box and type to rename it.

Flare
Input is Linear
Enable this if your image is in true linear color space. Gamma corrected images 
should have this parameter disabled.

Blend
Determines the blend mode used to composite the lens flare.

Add
The lens flare is added to your image.

Screen
The lens flare is combined with the image using a Screen blend mode. This 
looks kind of like the Add blend mode, but highlights are retained.

Color
Sets the color.

Brightness
Controls the brightness.

Transform
Selects point trackers and tracked layers from the input Tracker node and 
match moves the lens flare based on the input tracker data.

Position
Adjusts the origin of the lens flare.

Pivot
Changes the end position of the lens flare.

Scale
Determines the size.
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Aspect
Sets the aspect ratio.

Angle
Sets the angle.

Softness
Blurs the lens flare.

Occlusion
The Occlusion parameters allow you to block the lens flare. Using the 
Occlusion input, the brightness of the lens flare will automatically animate 
based on the source input channel.

Channel
Determines which channel to use for the occlusion source.

Invert
Inverts the source channels.

Threshold
Controls how much the occlusion source affects the flare.

Flicker
Flickers the lens flare.

Amount
The amount of flicker.

Speed
The speed of the flicker.

Edge Flare
Flares the frame as the lens flare enters or exists the frame.

Amount
Controls the amount of the edge flare.
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Size
Sets the size of the edge flare.

Noise
Adds noise to the lens flare elements. Noise can selectively be added to 
elements based on whether an element’s Lens Noise parameter is enabled. 
Alternatively, you can apply noise to all elements using the parameter below.

All Elements
Applies the noise pattern to all lens flare elements.

Amount
Sets the amount of the noise.

Scale
Determines the size of the noise.

X Offset
Moves the noise horizontally.

Y Offset
Moves the noise vertically.

Detail
Sets the detail of the noise.

Texture
Controls the complexity of the noise.

Randomize 
Randomizes the size and position of the noise.
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Controls - Elements
Each flare element uses a subset of the parameters below.

Angle
Sets the angle.

Aspect
Sets the aspect ratio.

Blur
Blurs the element.

Brightness
Controls the brightness.

Brightness Variance
Randomizes the brightness between multiple elements.

Center
Determines the center of the Chroma Ring along the flare.

Center Brightness
Sets the brightness of the stripe’s center.

Center Offset
Pushes all the Disc edges outwards.

Chroma
Changes the saturation of the Chroma Ring.

Color
Sets the color.

Color Variance
Randomizes the color between multiple elements.

Cycles
Determines the number of Chroma Bands.
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Density
Sets the amount of rays.

Edge Fade
Fades the element as it moves towards the edge of the screen.

Element Count
Sets the number of elements.

Hotspot
Sets the size of the Star’s center hotspot.

Inside Width
Changes the size of the inner ramp.

Jitter
Randomizes the angle.

Length
Sets the length of the stripe.

Lens Noise
Determines whether the Lens Noise controls affect the enabled element.

Lock To
X Axis
Locks the element to the X axis so it will only move vertically.

Y Axis
Locks the element to the Y axis so it will only move horizontally.

Match Flare Angle
Matches the Circle and Polygon element’s angle to the flare angle. This is 
especially useful when the Aspect parameter has been adjusted.

Middle Width
Adjusts the size of the middle ramp.
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Noise
Controls the amount of noise in an element.

Noise Density
The strength of the noise.

Offset
For most elements, Offset determines the element’s inner diameter. For Circles 
and Polygons, it shifts the shapes along the flare axis.

Outside Width
Sets the size of the outer ramp.

Position
Sets the position of the element along the flare.

Position Variance
Randomizes the position between multiple elements along the flare.

Ramp Gamma
Sets the Hot Spot’s black point.

Ramp Scale
Changes the Hot Spot’s size.

Randomize 
Randomizes size and position.

Ring Brightness
Sets the brightness of the Hot Spot’s ring.

Ring Size
Changes the size of the Hot Spot’s ring.

Ring Softness
Softens the Hot Spot’s ring.

Scale
Sets the size.
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Sides
Determines the number of sides.

Size Variance
Randomizes the size between multiple elements.

Softness
Blurs the element.

Softness Variance
Randomizes the softness between multiple elements.

Spread
Determines the distribution of an element.

Taper
Tapers the Chroma Band’s edges.

Total Scale
Sets the size of all elements.

Vertical Variance
Randomizes the vertical position between multiple elements.

Weight
Polygons and Circles can be weighted to either the beginning or end of the lens 
flare.

Warp
Enables the warping of the Ellipse and Ring elements as they exit the frame.

Width
Adjusts the width.

X Offset
Offsets the element horizontally.

Y Offset
Offsets the element vertically.
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Light Wrap
Description

Light Wrap helps blend the foreground into the background by making the color 
of the background wrap into the foreground edges without softening the edge.

This is accomplished by placing the background layer into a special matte and 
then combining it with the foreground. You can look at the Light Wrap element 
in the View menu.

Note: You can change Light Wrap’s input order with the User Interface > Trees > Input 
Order preference. By default, FG, BG is selected, but you can change it to BG, FG if 
you’d like.

Node Group
Composite

Controls
Brightness
Sets the intensity of the Light Wrap.

Wrap
Sets the size of the Light Wrap.
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Linear Gradient
Description

Creates a linear top to bottom or left to right gradient.

Node Group
Image.

Controls
Type
Top-to-bottom
The direction of the gradient is from top to bottom.

Bottom-to-top
The direction of the gradient is from bottom to top.

Left-to-right
The direction of the gradient is from left to right.

Right-to-left
The direction of the gradient is from right to left.

Horizontal Strip
The gradient is in the form of a horizontal strip.

Vertical Strip
The gradient is in the form of a vertical strip.

Size
The size of the gradient.

Angle
The angle of the gradient.

On-Screen Controls - Corner Points
There are four points around the four corners of the image. By clicking and 
dragging any of the four points, the gradient can be adjusted.
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Looks
Description

Looks is a unique filter meant to simulate a variety of color and black and white 
photographic/film looks, diffusion and color grad camera filters, colored tints, 
film stocks and optical lab processes. By selecting from the available presets, 
parameters in the various modules are automatically set to achieve a variety of 
different effects.

Node Group
Special Effects.

Controls
The Looks presets are made up of Color Correct, Diffusion, Color Gradient, 
Tint, Lab, Grain and Post Color Correct groups. Together, they simulate a 
variety of photographic and film looks. By selecting from the available presets, 
parameters in the various groups are automatically set to achieve a variety of 
different effects.

Presets
To select a preset, choose one from the Presets tab. If you would like to view 
presets from a different category, use the pop-up menu at the top left of the 
Presets tab.

Color Correct
Color Correct manipulates the Black and White, Hue, Saturation, Brightness, 
Contrast, Gamma, Red, Green and Blue values of the image. Go to the Color 
Correct node to see how it works.

Diffusion
Diffusion creates atmosphere by reducing contrast while creating a glow 
around highlights or shadows. It simulates diffusion and fog filters as well as 
glows. Go to the Diffusion section of the Film Stocks node to see how it works.
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Color Gradient
Color Gradient can transform an average sunrise or sunset into something 
spectacular or convert a dull, washed-out sky to a breathtaking blue. No other 
filter has done as much to improve landscape photography as the graduated 
filter. Add color selectively while leaving the rest of the scene unaffected by 
using a graduated transition for a smooth color blend between the colored 
portion and the original image. Presets for your favorite Color Gradient filters 
are provided as well as the ability to create custom colors. Go to the Color 
Gradient node to see how it works.

Tint
Tints the image with a color.

Lab
The Lab group simulates a variety of different optical lab processes including 
Bleach Bypass, Cross Processing, Flashing and Overexposure. Go to the 
Bleach Bypass, Cross Processing, Flashing and Overexpose nodes to see 
how they work.

Grain
Grain simulates film grain with individual control of red, green, and blue grain 
size, softness and intensity. In addition, a Film Response parameter controls 
where you will see grain in the image. Go to the Grain node to see how it works.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

Post Color Correct
Post Color Correct gives you further color correction after all other operations 
have been processed. This is often helpful as some of the operations affect the 
brightness, contrast and color of the image. In addition, Temperature controls 
allow you to make the scene warmer or cooler, and cyan or magenta. Go to the 
Color Correct node to see how it works.
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Low Contrast
Description

Low Contrast spreads highlights into darker areas, lowers contrast and keeps 
bright areas bright.

Node Group
Color.

Controls
Presets
To select a preset, choose one from the Presets tab.

Contrast
Light Brightness
Sets the intensity of the light that is spread into darker areas.

Light Spread
Sets how far light is spread from bright areas to darker areas.

Shadow Brightness
Adjusts the brightness of the shadow areas.

Matte
A matte is used to create the light spread effect. Go to the Matte section of 
Common Node Controls to see how the Matte controls work.
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Match
Description

Matches the color of one image to another.

Node Group
Color

Controls
Mode
Determines the frame to color match.

Reference Image
The frame of the source clip defined by the Set Reference Image button is 
matched.

First Frame
The first frame of the source clip is matched.

Every Frame
Every frame of the source clip is matched.

Brightness
Sets the amount of the brightness match.

Color
Sets the amount of the color match.

Set Reference Image
Matches the source clip at the frame the Timeline is parked on when this button 
is pressed.
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Math Composite
Description

Math Composite combines two clips using one of the Blend modes. You can 
choose from Add, Subtract, Multiply, Screen, Difference, Darken and Lighten.

Note: You can change Math Composite’s input order with the User Interface > Trees > 
Input Order preference. By default, FG, BG is selected, but you can change it to BG, 
FG if you’d like.

Node Group
Composite.

Controls
Blend
Selects the Blend mode that is used to combine the foreground and 
background.

Add
The pixels of one image are added to another image.

Subtract
The pixels of one image are subtracted from another image.

Background                  Foreground                        Result

Background                  Foreground                        Result
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Multiply
Produces a result where there is a union of pixels from two images.

Screen
Looks at each images color information and multiplies the inverse of the two 
images. This looks kind of like the Add blend mode, but highlights are retained.

Difference
Produces a result where a value exists in each image, but not in both.

Background                  Foreground                        Result

Background                  Foreground                        Result

Background                  Foreground                        Result
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Darken
Compares two images and takes the pixels with the lower value.

Lighten
Compares two images and takes the pixels with the higher value.

Level
Sets the level of the foreground element.

Black Clip
Blacks are made blacker by increasing this value. As the value increases, more 
values are clipped to black.

Note: Often times the black portion of the image is not entirely black. This becomes an 
issue if something like fire is shot against a black background. If the black is not entirely 
black, then these impure black areas will be added to the background image as part of 
the Math Composite causing the final result to have “milky” blacks. The Black Clip 
parameter has been added to easily adjust the foreground image’s black level.

Channels
RGB
The Blend modes affect the RGB channels.

RGBA
The Blend modes affect the RGBA channels.

Background                  Foreground                        Result

Background                  Foreground                        Result
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Alpha
The Blend modes affect the Alpha channel.
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Matte Repair
Description

Matte Repair grows, shrinks or blurs a matte. It also is handy for cleaning up 
impurities in the black or white areas.

Node Group
Key.

Controls
Use
Chooses the channel from the input image to use for the Matte Repair.

Alpha Channel
The alpha channel is used for the Matte Repair.

Red Channel
The red channel is used for the Matte Repair.

Green Channel
The green channel is used for the Matte Repair.

Blue Channel 
The blue channel is used for the Matte Repair.

Luminance
The average luminance of the RGB channels is used for the Matte Repair.

Opacity
Sets the opacity of the matte.

Black Clip
Blacks in the matte are made blacker by increasing this value. As the value 
increases, more values are clipped to black. This is helpful for getting rid of 
unwanted gray areas in what should be the black part of the matte. 
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White Clip
Whites in the matte are made whiter by increasing this value. As the value 
increases, more values are clipped to white. This is helpful for getting rid of 
unwanted gray areas in what should be the white part of the matte. 

Shrink/Grow
Shrinks or grows the matte. Negative values shrink and positive values grow 
the matte.

Blur
The matte is blurred by a fast, quality blur.

Wrap
Helps blend the foreground into the background by making the background 
“wrap” into the foreground edges without completely losing the edge. The edge 
of the foreground starts to become transparent.

Invert
Inverts the matte.
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Merge Views
Description

Merges the input images into a combined left, right and depth view.

Node Group
Image.
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Mist
Description

Mist
Creates atmosphere by reducing contrast while creating a glow around 
highlights.

Cool Mist
Same as Mist but combined with a cooling filter.

Warm Mist
Same as Mist but combined with a warming filter. It is useful in outdoor open 
shade situations where there is excessive blue in the image and when total 
control over lighting may not be possible.

Black Mist
A more subtle version of Mist, the Black Mist filter creates atmosphere by 
reducing contrast, but with minimal glow around highlights.

Warm Black Mist
Same as Black Mist but combined with a warming filter.

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab.

Mist
The Mist controls add a mild glow to image highlights.

Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.
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Screen
The glow is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color
Sets the color of the glow.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 
Node Controls to see how the Matte controls work.
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Mix
Description

Mixes two images together.

Node Group
Composite.

Controls
Amount
Sets the mix level between the two input images.

Direction
Forward
Mixes from input 1 to input 2.

Reverse
Mixes from input 2 to input 1.
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Mocha Pro
Description

Mocha Pro features GPU-accelerated tracking and object removal, advanced 
masking with edge-snapping, stabilization, lens calibration, 3D camera solver, 
stereo 360/VR support, and more. This purchasable option launches the 
Mocha Pro interface directly from within Silhouette.

Node Group
Silhouette.

For more information on Mocha, see the Mocha 2020 User Guide.

https://borisfx.com/support/documentation/mocha/7.0.0/
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Morph
Description

Understanding the concepts of warping and morphing will allow you to get the 
most out of the Silhouette software. Silhouette's morph node uses a “shape 
based” approach. Our company's founders include the inventors of this 
approach for which a Scientific and Technical Achievement Award was given 
by the Academy of Motion Picture Arts and Sciences.

Warping is a geometric or spatial distortion of an image. A morph is two or more 
synchronized warps composited together using location specific dissolve 
criteria specified by the artist.

As the term “shape based” implies, the artist creates shapes using the same 
tools as the Silhouette Roto node. In general, two shapes are paired together, 
one being the “source” and the other being the “target.” The exception to this 
can be an unpaired shape to be used as a “barrier.”

Silhouette warps source shapes to match target shapes (and in a morph, the 
target shapes simultaneously warp towards source shapes). As shapes warp, 
the image underneath the shapes (and surrounding areas) warp along as well 
as if the image were being stretched like a sheet of rubber.

Silhouette's warping technology provides a rich set of controls over the specific 
effect of the warp. These include the ability to precisely control correspondence 
between source and target shapes allowing the artist to specify not only that 
one shape should warp to another, but what part of the source shape to warp 
to what part of the target shape.

The Silhouette morph node also allows for the precise control over how shapes 
might fold over other shapes. Folding is a powerful feature which can best be 
understood by imagining pulling a blanket rather than a sheet of rubber. 
Snatching a piece of the blanket and pulling it can do one of three things. It can 
move the area of the blanket ahead of its motion out of the way. It can fold on 
top of the area in its way. Or, it can fold behind the area in its way.

All of these controls are necessary to create seamless, invisible effects.
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Warps
Image warping can take place on a still as well as moving images. Warping can 
be used to enhance or exaggerate features, adjust sizing of image elements, 
create talking animals, for example, or other types of image deformation.

Go to the Shape Based Warping tutorial to see how it works. 

Before After

Copyright © 2008--www.iofoto.com
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Morphs
Image morphing can take place on stills as well as moving image. Morphing 
has been traditionally used to transform one object or person into another and 
more recently to seamlessly transform a live action element into a CG 
(computer generated) object and vice versa.

Since shapes are required for warping and morphing, it has its own shape tools 
similar to those in the Roto node. See the Roto Node for more information.

Go to the Morphing tutorial to see how it works.

Node Group
Silhouette, Warp.

Node Parameters
When the Morph node is being edited in the Trees window, parameters specific 
to the Morph can be adjusted in the Node parameters.

Distortion
Controls the amount of deformation for joined shapes.

Start Middle

Copyright © 2008--www.iofoto.com

End
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Transparency
Controls how the A-roll and B-roll images are mixed together.

Precision
Sets the computing precision of the Morph node. There are Draft, Normal and 
Better choices.

Draft
Draft mode provides a fair representation of your work but has clearly visible 
defects. It is fast, interactive and very responsive, but is not intended for 
finished work.

Normal
Assuming you are using a reasonably modern machine, Normal can be used 
in most interactive situations and is sufficient for finished work.

Better
Better is slower than Normal, though still interactive on modern processors. It 
can be used for final renders although you should pre-check the final render 
before submitting it to a render farm. 

Note: Image areas immediately below shapes will be the same in all modes. Image 
areas which are pulled and pushed by nearby shapes will differ between the modes.

Use Input Alpha
Ignores the Transparency value and just warps the input alpha.

Motion Blur
Motion blur is the directional blurring of rapidly moving shapes. Enables Motion 
Blur for the Morph node.

Go to the Motion Blur tutorial to see how it works.

Parameters set on the Morph node provide the (potentially keyframed) default 
values for all shapes in the node. To allow shapes to have values different from 
those of the node, use the Morph Shape parameters. 

See the Inheritable Parameters section for more information.
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Shape Parameters
All of the roto tools contained in the Roto node are available in the Morph node 
and contain parameters specific to warping and morphing. This includes B-
Spline, Bézier or X-Spline shapes as well as point and planar tracking.

Note: When two shapes are joined, the controls indicated below are taken from the 
source shape only. Settings from Target shapes are not used.

Outline Color
Sets the color of selected shape’s outlines. Shapes created while viewing the 
A-roll will automatically have a different outline color than those created while 
viewing the B-roll.

Inheritable Parameters
By default, shapes and layers inherit their Distortion and Transparency from the 
Morph node settings. To “override” the value at the layer or shape, click the 
Override icon (dot) to the right of the numeric field and the parameter will 
override the parent.

Distortion
Controls the amount of deformation for joined shapes.

Transparency
Controls how the A-roll and B-roll images are mixed together.

Barrier Strength
Being shape to shape based, the Silhouette Morph node will always “hit its 
mark”. That is, pixels directly underneath a shape will arrive exactly underneath 
the shape to which it (the source shape) is joined. This also means that the 
influence of a warp stops dead at barriers (unjoined shapes).
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The Barrier Strength control, available only for unjoined shapes, lets barriers 
pass through a portion of a warp's influence. At a value of zero, the influence 
of the barrier shape is almost completely eliminated. At a value of 100 percent, 
the barrier is at 100 percent strength, and the influence of a warp stops dead. 
All unjoined shapes default to 100 percent.

Note: Be careful when using barriers in morphs. Since a barrier is unjoined, it can exist 
only in one of the warps, not on both. This means there is the potential to see unwanted 
artifacts since the two sides of the morph are no longer warping in concert.

See the Barrier Shapes section for more information.

Barrier Strength = 0 Barrier Strength = 100
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Edge Density
When rendering warps and morphs, Silhouette utilizes an edge density 
parameter which subdivides the shape between correspondence points. The 
higher the Edge Density, the closer the shape matches the curve that you 
originally created. Under normal circumstances, the default value of 100 should 
be fine.

If you adjust the Edge Density, don’t automatically set it to the highest setting 
as this is unnecessary and could lead to longer rendering time. Increasing edge 
density might be needed for shapes whose source or target are physically large 
relative to image size and have few correspondence points. 

For example, if a joined shape stretched from the left to right edges of your 
image and had a single correspondence point with an edge density of 100, the 
perimeter of the whole shape would be represented by 100 far apart vertices. 
You could add a second correspondence point to halve the distance between 
vertices or you could increase the edge density to accomplish the same result. 
One method can be preferable to the other, for instance when there is an image 
feature, it would be logical to join from source to target with an additional 
correspondence point. If there isn't an image feature, simply increasing edge 
density means there is potentially less to keyframe. 

Shapes whose source and target are physically very small relative to image 
size can actually benefit from reducing their edge density.

Note: Edge Density determines how closely the perimeter of the rendered shape 
matches the original B-spline, X-Spline or Bézier shape.

Shape Precision value = 10 Shape Precision value = 100



Silhouette User Guide    

• • • •••

Nodes  577 
• • • •••

Motion Blur
Motion blur is the directional blurring of rapidly moving shapes. This parameter 
turns Motion Blur on or off on a shape by shape basis. The default is off.

Go to the Motion Blur tutorial to see how it works.

Generate Alpha
Determines whether or not a shape contributes to the alpha channel. This is on 
by default.

A/B Shapes
Morph Shapes create themselves in the proper “roll” when viewing A or B. If 
viewing any other View mode, creating a shape will default to A. The Object List 
shows the A/B state and clicking the A or B will toggle the shape to the other 
roll. Viewing A or B will only show A or B shapes, as appropriate. Creating a 
shape on the B-roll will automatically set the shape color to blue. Also, Select 
All in A or B will only select A or B shapes, respectively.

Correspondence Tool (C)

Understanding Correspondence Points
Correspondence points are a critical part of achieving superior results in the 
Morph node. Imagine you have a bendable shower rod. The shape that you 
bend the shower rod into represents the shapes you use to outline features in 
your images. Now attach the shower curtain using rings that can slide 
anywhere along the shower rod. These rings are like correspondence points. 

Your image is printed on the shower curtain. The shower rod defines how the 
border of the image feature gets deformed in combination with how you line up 
the shower curtain using the sliding rings along the shower rod.
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The combination of shape and correspondence point (shower rod and shower 
curtain rings) makes a warper that is incredibly more precise than a warper 
without the combination of these features.

Correspondence Points Workflow
Shape correspondences determine how to transform the areas of the image 
defined by your source and target shapes. This is accomplished by selecting 
and joining shapes in a particular order.

Joining shapes specifies the direction of a warp. That is, which shape of a pair 
of joined shapes is considered to be the source and which is the target. When 
using a morph to transform one person’s face into another, it is necessary that 
you join the shapes from one image to another. For instance, the shapes for the 
eyes in the source image are joined to the shapes for the eyes in the target 
image, mouth shapes to mouth shapes, nose shapes to nose shapes--you get 
the idea. Without the joining process, Silhouette cannot know that shapes 
relate to each other.

Every joined shape has correspondence points which are only visible when 
using the Correspondence tool. Since barrier shapes are not joined, they do not 
show any correspondence points.

When two shapes are joined, correspondence points define how the perimeter 
of the source shape matches to the perimeter of the target shape.
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Using Correspondence Points
To illustrate the use of correspondence points, source and target shapes are 
created on two different images. The source shape is outlined in red and the 
target shape is outlined in blue.

Joining and Unjoining Shapes
Whether you are warping or morphing, you must join together two shapes to 
cause movement from the source to the target. 

Source Shape

Target Shape
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Joining Shapes
When you join shapes, a shape correspondence is established in the image 
areas defined by these shapes. To join shapes, select the Correspondence 
tool, click the source shape and drag a line to the target shape, and release the 
mouse button to join the shapes. Circles appear on each shape which indicate 
the actual correspondence points. The dotted lines which flow around the 
shapes are lines of correspondence which show how the entire perimeter of the 
source relates to the entire perimeter of the target.

• Two A-roll or B-roll shapes can be joined to create a warp.

• Join one A-roll shape to one B-roll shape to create a morph.

Note: Switching to A/B View mode allows you to see both the A-roll and B-roll shapes 
simultaneously. You can then join shapes from the A-roll to the B-roll and vice-versa.

When joined shapes are selected, a modified bounding box appears around 
both shapes. The source shape has long dashes in the bounding box, while the 
target shape’s bounding box has short dashes.

Unjoining Shapes
You can unjoin shapes at any time which allows them to be then joined to other 
shapes. To unjoin shapes, select the Correspondence tool, select the source or 
target shape, right-click on the shape and choose Unjoin from the pop-up 
menu.

Once unjoined, the shape’s bounding boxes revert to a solid line indicating that 
they are unjoined.

View > A/B
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Correspondence Point Positioning
When shapes are joined, Silhouette adds a single correspondence point on the 
shapes. It is best to add and position these points so that logically similar 
features are connected together. Correspondence points serve as guides that 
define the location of identifiable areas on a shape.

Note: Never assume that correspondence points automatically line up to the control 
point of a shape. They often have to be lined up to the desired image features.

Poor Correspondence Point Placement
Poorly placed correspondence points results in warping artifacts. You can see 
the correspondence lines wrap around the outlines of each eye. The 
correspondence point pair is not specifying a correspondence relationship that 
is going to produce a good result.

View > A/B



Silhouette User Guide    

• • • •••

Nodes  582 
• • • •••

Performing a morph preview with these poorly aligned correspondence points 
produces a poorly aligned result.

As a general rule, for which there are many exceptions, you want to align like 
features. Multiple correspondence points may be specified as shown below. 
This precisely pins down the relationship between the shapes exactly where 
you need finer control.

View > Output

Multiple Correspondence Points
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Getting Good Results
Let’s break down a complex use of correspondence points that gives the best 
possible results. Sophisticated correspondence point placement is especially 
necessary when there are multiple shapes in a small space, for instance where 
the eye outline is in close proximity to outlines for the iris and pupil.

You will note that the eye outline has nine correspondence points!

The choice of these two sets of correspondence points is straight forward. They 
join the left-most eye points together and the right-most eye points together.

The next example shows how the correspondence points are used to maintain 
the relationship between source and target features. In this case, 
correspondence points were placed in such a way as to bisect both pupils. 

Multiple Shapes in Small Space



Silhouette User Guide    

• • • •••

Nodes  584 
• • • •••

Even though these correspondence points are not left-most or right-most or 
even the same distance around each eye surround, they represent logically 
connected features between the source and target.

The last example shows how the relationship between the outline of each iris 
is maintained relative to the eye surround. These correspondence points are 
extremely important. The outline of each iris ends before it touches the eye 
surround. This is because the position of the iris outline is going to slide 
relatively against the eye surround. By not overlapping the iris outline and the 
eye surround, you are giving the image a little room to stretch without folding.
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You will be able to visualize where this type of sliding of two shapes against 
each other may present a problem using the wireframe preview.

The arrows show where on the eye surround shape the iris shape connects. 
You can see how from frame 1 to frame 10, the place where iris meets the eye 
surround slides relative to the eye surround (compare to the position of the iris, 
for example).

Swapping Source and Target Shapes
When shapes are joined in the wrong order, they can be swapped using the 
Swap Joined option. To swap source and target shapes, select the 
Correspondence tool, select the source or target shape, right-click on the 
shape and choose Swap Joined from the pop-up menu.

Reverse Shape Orientation
Reverses the order of all control points on all keyframes. Similar to the Reverse 
option in the Reshape tool pop-up menu, Reverse Shape Orientation is useful 
when you are trying to join two shapes where the control points go clockwise in 
one and counter-clockwise in the other. In this case, the correspondence points 
would iterate in different directions and the lines would cross each other. 
Reversing the points of one of the shapes would make them go in the same 
direction and the correspondence would be correct.

Inserting Correspondence Points
To increase the precision of a complex shape, increase the number of 
correspondence points. To add a correspondence point, select the 
Correspondence tool and Alt-click on a selected shape.

Frame 1 Frame 10
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The edge density at the insertion point is effectively doubled by the addition of 
a new correspondence point. By dragging the new correspondence point, you 
move it to the desired location.

Deleting Correspondence Points
Correspondence points can be deleted at any time, but remember that you 
need a minimum of four correspondence points. To delete a correspondence 
point, select the Correspondence tool, select the correspondence point and 1) 
press the Delete key or 2) right-click on the correspondence point and select 
Delete from the pop-up menu.

Note: Correspondence points can only be removed one at a time.

Selecting Correspondence Points
Before a correspondence point can be adjusted, you must first activate the 
Correspondence tool in the Toolbar and select a joined shape. 
Correspondence points are colored yellow. Click on a correspondence point to 
select it.

Adjusting Correspondence Points
Once selected, correspondence points are moved by simply dragging them to 
the desired location.

Barrier Shapes
Besides creating shapes to define areas that warp and morph, you can also use 
shapes as ways of restricting movement beyond certain parts of the image. 
These shapes are called barriers and tack down an area and keep it stationary 
relative to the warping caused by other shapes. Any unjoined shape will serve 
as a barrier.

Barrier
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In the example above, the barrier shape will prevent any movement outside of 
the shape. Compare the results below.

The barrier shape has successfully pinned down the image outside of its 
boundaries. Notice in the image on the right, the model's lips have clearly 
extended over her coat and the coat did not move.

Folding
Sometimes the warping of a pair of joined shapes can overtake other shapes 
(joined or barrier). The overtaking shapes will necessarily fold over or under the 
shapes they overtake. For instance, you can warp eye lids over a pupil without 
distorting the pupil, as seen below.

No Barrier With Barrier
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The images below show how folding can affect an image.

The choice of folding over or under is determined by the order of shapes in the 
Object List. In the above example, the source shape for the eye lid appears 
above the barrier shape for the pupil in the Object List. Therefore, the eye lid 
folds over the pupil.

Go to the Folding tutorial to see how it works.

Node Outputs
Output
Outputs the result of the morph or warp transformation.

Source Warp
Outputs the source warp.

Target Warp
Outputs the target warp.

Objects
Outputs tracked layers and shapes for use in nodes with Transform or Objects 
inputs.

Source

Target Barrier

Original

Warp w/out folding Warp with folding

Shapes
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Mosaic
Description

Divides the picture up into square tiles.

Node Group
Filter.

Controls
Size
Controls the size of the square tiles. A small size value will create many square 
tiles.



Silhouette User Guide    

• • • •••

Nodes  590 
• • • •••

ND Gradient
Description

The ND or Neutral Density Gradient darkens only a portion of the image using 
a graduated transition between the darkened portion and the original image. It 
selectively adjusts brightness without affecting color balance. The most likely 
use for the ND Gradient would be to balance the difference between the sky 
and the ground. 

Node Group
Tints.

Controls
Presets
To select a preset, choose one from the Presets tab.

F-Stop
Presets
Select one of the ND Gradient presets from the pop-up list.

Exposure
Darkens the image using F-Stops as the unit of measure.

Preserve Highlights
Preserves the white areas of the image.

Grad
Grad is the transition area between the darkened portion and the original 
image. Its direction, corners and size can be adjusted. Go to the Grad section 
of Common Node Controls to see how the Grad controls work.
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Net
Description

Net
Softens and minimizes facial imperfections while retaining overall image clarity. 
This is an ideal portrait filter.

Warm Net
Combines all of the benefits of Net with a warming filter.

Node Group
Diffusion.

Presets
To select a preset, choose one from the Presets tab. If you would like to view 
presets from a different category, use the pop-up menu at the top left of the 
Presets tab.

Blur
Sets the softness of the image.

Opacity
Sets the amount of diffusion mixed into the original image. The higher the 
setting, the more the image is blurred.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.
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Night Vision
Description

The Night Vision filter creates the effect of a Night Vision lens--that green, 
glowy, grainy look.

Node Group
Special Effects.

Controls
Presets
To select a preset, choose one from the Presets tab.

Black and White
Selects the type of black and white filter to be applied to your color image. Go 
to the Black and White section of Common Node Controls to see how the 
Black and White controls work.

Tint
Color
Sets the color that the image will be tinted with. The color is preset to a night 
vision green, but feel free change it by using the color picker.

Opacity
Sets the opacity of the tint color.

Glow
Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.
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Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Additional Controls
Grain
Grain Size
Controls the size of the grain.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

Grain Amount
Controls the intensity of the grain.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 
Node Controls to see how the Matte controls work.
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Non-Additive Mix
Description

Known as a NAM, the non-additive mix combines two pictures by controlling 
their luminance level relative to each other as well as a set mix percentage. 
This popular video switcher effect has been included to satisfy those die-hard 
online video editors.

Note: You can change Non-Additive Mix’s input order with the User Interface > Trees 
> Input Order preference. By default, FG, BG is selected, but you can change it to BG, 
FG if you’d like.

Node Group
Composite.

Controls
Mix
Sets the mix level of the foreground element.

Black Clip
Blacks are made blacker by increasing this value. As the value increases, more 
values are clipped to black.

Note: Often times the black portion of an image is not entirely black. This becomes an 
issue if something like fire is shot against a black background. If the black is not entirely 
black, then these impure black areas will be added to the background image as part of 
the Non-Additive Mix causing the final result to have “milky” blacks. The Black Clip 
parameter has been added to easily adjust the foreground image’s black level.
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Null
Description

The Null node does nothing other than pass the input image through to the next 
node.

Node Group
Image.
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Optical Dissolve
Description

Optical Dissolve uses a power function to simulate an optical film dissolve. You 
see the bright areas of the B side of the dissolve sooner than the darker areas.

Note: You can change Optical Dissolve’s input order with the User Interface > Trees > 
Input Order preference. By default, FG, BG is selected, but you can change it to BG, 
FG if you’d like.

Node Group
Composite.

Controls
Opacity
Sets the mix level.
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Output / Output Multi-Part
Description

Output
The Output node determines the file format, file name, disk storage location, 
and channels to be rendered. Every session has at least one Output node.

Output Multi-Part
The Output Multi-Part node is the same as the Output node, but has multiple 
inputs and renders EXR multi-part files. If there is more than one input, each 
output part name is appended with the upstream node's name.

The Output Multi-Part node can have multiple additional inputs. Right-click on 
the Output Multi-Part node and select Add Input. Right-click on an input port 
to remove it. You can add as many inputs as you want, but the inputs will get 
smaller.

Node Group
Image, Silhouette.

Format
The format setting allows you to select from various file formats. We currently 
can save to the following file formats: Cineon, DPX, IFF, JPG, OpenEXR, PNG, 
SGI/RGB, TIFF and TARGA.

Note: Format is missing from the Output Multi-Part node since it only renders EXR files.

Options
Adjusts options for the selected file format, the majority of which are 
compression related.

Automatic Data Window
The Automatic Data Window rendering option looks at the alpha channel and 
determines the data window from that. Then, it writes only the pixels in the data 
window to an EXR file. For SXR files, it writes the combined data window 
between the two views. This greatly speeds up loading these files into a 
compositing system.

Go to the Automatic Data Window tutorial to see how it works.



Silhouette User Guide    

• • • •••

Nodes  598 
• • • •••

File
Determines the directory and filename of the rendered files.

You can either type in the path and name in the File field or click the Browse 
icon on the right. 

As far as filenaming is concerned, you only have to type in a name as periods, 
hash marks for padding and file extensions are not required unless you want to 
manually enter them. Silhouette uses the Render Preferences to determine 
the default suffixes appended to the filename as well as file padding.

If you choose to manually enter the file padding and extension, the filename 
should have 3 things:

• The image name (duh).

• # for the frame placeholder.

• An extension: .exr = exr files, .cin = Cineon files, .tif = Tiff files, etc.

Therefore, if you enter a name something like test.####.exr,. Silhouette will 
render out test.0001.exr, test.0002.exr, etc.

Filename Customization
You can add environment variables to the filename using the sfx $(VARNAME) 
format. Two internal variables are defined for rendering, VIEW and ALPHA. 
$(ALPHA) expands to _alpha, but only when it is needed for naming external 
alpha. $(VIEW) expands to L or R, when appropriate.

The default filename expansion, when $(VIEW) and $(ALPHA) are not typed 
manually (i.e. by default), is this:

$(FILENAME_TYPED_BY_USER)_$(VIEW)$(ALPHA)

If not doing multiple view stereo rendering, it is:

$(FILENAME_TYPED_BY_USER)$(ALPHA)
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Remember that $(ALPHA) expands to nothing when not needed.

Note: Make sure you type in the full path and base filename into the Output node File 
field and then Silhouette will do all the substitutions based on the environment 
variables.

Metadata
The Metadata field takes whatever you type and adds it to the comments 
metadata field in EXR files. The format for this field should be a comma-
separated list of name=value pairs. For instance, shot=sc125, version=5.

Metadata Notes
• Metadata contained in EXR files is passed through to the rendered file.

• The metadata for the output node is built from the first input of any upstream 
nodes.

• All EXR string, int, and float attributes are passed through.

• The Output > Metadata property now gets broken down into distinct metadata 
attributes instead of going into the EXR comment field.

• Silhouette adds the following attributes for each output part: the output node 
name, the session name, the project name, the project bundle path and the current 
user.

Channels
RGB
Renders the RGB color channels.

Alpha
Renders the alpha channel.

Depth
Renders the depth channel.

Views
The Views pop-up menu allows you to control whether you render the Left, 
Right or both the Left and Right stereo views simultaneously when working in 
stereo sessions.



Silhouette User Guide    

• • • •••

Nodes  600 
• • • •••

Both
Renders both the Left and Right stereo views with a _L and _R appended to 
the filenames. 

Left
Renders only the Left stereo view with a _L appended to the filename.

Right
Renders only the Right stereo view with a _R appended to the filename.

Go to the Render Preferences to see how to modify the default suffixes 
appended to the filename. 

Premultiply
Premultiplies the RGB channels by the alpha channel. This option is only valid 
if Channels > RGB and Alpha are selected.

Crop/Pad
When enabled, the output is cropped/padded to the session size. This 
becomes relevant when using a ROI (Region of Interest).

Note: Crop/Pad is missing from the Output Multi-Part node since EXR files save the 
ROI (Region of Interest) as an output EXR data window.

Sample
The Sample field displays all of the files that will be produced by the node.

Render
Opens the Render Options window where rendering is initiated.

 See the Render section for more information.



Silhouette User Guide    

• • • •••

Nodes  601 
• • • •••

Overexpose
Description

Overexpose simulates the overexposure that occurs when a film camera is 
stopped.

Node Group
Film Lab.

Controls
Presets
To select a preset, choose one from the Presets tab.

Amount
Controls the amount of overexposure.

Intensity
Sets the intensity of the overexposure.

Blur
Sets the softness of the overexposure.
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Paint
Description

Paint is a high dynamic range, non-destructive, 2D raster based paint system 
designed from the ground up to handle the demands of feature film and 
television production. Whether it’s image restoration, dustbusting, wire and rig 
removal or just plain paint, Silhouette provides simple and sensible tools to get 
the job done.

Black & White, Blemish, Blur, Burn, Clone, Color, Color Correct, Cutout, Detail, 
Dodge, Drag, Eraser, Grain, Mosaic, Repair and Scatter brushes are available 
for any task. As you paint, every action you make is recorded as events. These 
events can be selectively played back on the same frame, different frames, 
multiple frames and with or without tracking data applied. This makes for a very 
powerful and versatile Auto Paint feature that provides the flexibility of vector 
paint with the speed of a raster paint system.

Warning: To store painted frames to disk, you must change frames in the Timebar. The 
current frame’s paint is also saved with a save operation or an autosave.

Go to the Using Paint tutorial to see how it works.

Node Group
Image, Silhouette.

Paint Tools
When the Paint node is selected, various non-animateable controls appear in 
a Paint window located at the bottom portion of the screen. Silhouette provides 
a wide variety of paint tools that are organized into Presets, Brush, Profile and 
Paint tabs.
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Presets
A Presets tab contains 1, 2, 3, 4, 5, 6, 7, 8, 9, 0 and Save buttons on the left 
side of the Paint window and allows you to save all of the brush parameters as 
a preset.

To save a preset, select a brush and adjust its controls, click Save and then 
choose one of the numbered presets. Shift-Save will save to the currently 
selected preset without having to hit the number too. Once saved, you can use 
the Alt-0 through Alt-9 keyboard shortcuts to quickly select one of the presets.

Note: Saved presets are highlighted blue. Clicking a blue preset after selecting Save 
will overwrite it.

Clear a paint preset by pressing Save, then Alt-clicking on the preset.
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Brushes
A number of different brushes are selectable from the Paint toolbar to the left 
of the Viewer.

Black & White

Blemish
Blur

Cutout

Drag

Mosaic

Repair

Color

Clone

Scatter

Stroke

Color Correct

Eraser

Detail

Dodge

Burn

Grain
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Once a brush is selected, its controls appear on the left side of the Paint 
window.

To paint with a mouse, click and drag on the screen. To paint with a pen and 
tablet, just press and drag.

Drawing Straight Lines
If you press Alt, click and then click in a different location, a straight line is 
drawn. This will work with any brush type. If you keep Alt depressed while 
clicking, you will create interconnected straight lines.

Black & White (B)
The Black & White brush converts color images to black and white simulating 
the look of black and white photographic filters.

Mode
Selects the method by which the color image is converted to a monochrome 
image.

Luminance
Creates a monochrome image using the brightness of the image.

Average
Creates a monochrome image using the average of the red, green and blue 
channels.
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Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates a orange filter in black and white photography.

Blemish (Shift-B)
The Blemish brush is useful for removing facial blemishes on film originated 
footage. It combines the Blur and Grain brushes.

Blur (Ctrl/Cmd-B)
Blurs the image.

Radius
Sets the amount of blur to be applied.

Burn (Alt-Shift-B)
Darkens areas in the image.

Exposure
Sets the brightness of the brush.



Silhouette User Guide    

• • • •••

Nodes  607 
• • • •••

Range
Shadows, Midtones, Highlights, Full
Targets the Burn operation to either shadows, midtones or highlights as well as 
the entire range when set to Full.

Clone (C)
Paints with sampled pixels from an image with the ability to grade (color 
correct), blur, sharpen or warp the clone source.

Go to the Clone Brush tutorial to see how it works.

The controls for the Clone brush are split into three tabs: Clone, Grade/Filter 
and Warp. The Clone tab deals with the selection, timing and transformation of 
the clone source. The Grade/Filter tab contains color correction (grade), blur 
and sharpening parameters. Last, the Warp tab has warp related controls.

Clone
Setting the Clone offset on the same image:

1 Press and hold down the Shift key and then click, drag and release the mouse 
and then the Shift key. The first click sets the clone source and where you drag 
and release is the Clone target.

or

2 Press and hold down the Shift key. Click once to set the clone source and click 
once again in a different location to set the Clone target.
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To reset the Clone offset, press Shift and without moving the cursor, click your 
mouse or tap your pen on the screen once.

Setting the Clone offset on different images:
Oftentimes, you need to align the same feature in two different images of a clip 
when painting with the Clone brush.

1 In the Clone controls, select Output, Foreground or Input 1-5 in the Source pop-
up menu and then set the Frame parameter to choose which source frame to 
paint from.

2 Press the ‘ key (located to the left of 1 key).

The clone source image automatically appears in the Viewer.

3 Set the Onion Skin mix to 100.

4 Click on the clone source feature that you want to paint from.

The Clone target image automatically appears in the Viewer.

5 Click on the Clone target feature that you want to paint on.

The Clone offset is set.

Source
Picks which image will be used as the clone source.

Output
Clones from the previously painted areas.

Foreground
Clones from the foreground image.

Input 1-5
Clones from the clips assigned to the Paint node’s Input 1-5 auxiliary inputs.
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View
The View pop-up menu, which only appears when using stereo sources, 
determines which view the clone source will come from.

Auto
The clone source is determined by the stereo view mode that has been 
selected at the top of the Viewer.

For instance, if the Left View is selected above the Viewer, the clone source 
comes from the Left View. If the Right View is selected, the clone source comes 
from the Right View. If the Left/Right View is selected, the clone source comes 
from both the Left and Right Views so you can simultaneously Clone on both 
views at the same time.

Left
The clone source comes from the Left View.

Right
The clone source comes from the Right View.

Frame
Choose which frame number of the clone source to paint from. By default, the 
Frame field displays the actual frame number that you are cloning from. 
Alternatively, a frame offset can be displayed instead. This behavior is 
controlled with the Paint > Clone > Absolute Frame Numbers preference.

Relative
When the Relative box is checked, the clone source Frame value remains 
relative to the current frame. So, if the Frame value is different than the current 
frame, the offset between the two is maintained.
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When Relative is unchecked, the clone source is painting from a single frame 
defined by the value entered in the Frame field.

Transform Controls
The Transform Controls allow you to position, scale, rotate, skew and corner-
pin the clone source.

Source Match Move
Source Match Move allows you to apply the selected tracked layer to the clone 
source. This is useful for when you have a single frame, clean plate that needs 
to be tracked to match the motion of the clip you are painting on. 

Note: To Match Move the clone source during event playback, you will need to:
1) Hook a Tracker node or other node that contains trackers into the Paint node’s 
Objects input.
2) Select a tracked layer in the Paint tab’s Transform pop-up menu.
3) Enable Clone > Source Match Move prior to painting.
For more information on playing back paint strokes, go to the Auto Paint tutorial.

Offset
Sets the horizontal and vertical position of the clone source.

Scale
Sets the horizontal and vertical scale of the clone source. Typing in negative 
values will flip or flop the clone source.

Corner-Pin
• TL

Sets the horizontal and vertical position of the top left corner point.

• TR

Sets the horizontal and vertical position of the top right corner point.

• BL

Sets the horizontal and vertical position of the bottom left corner point.

• BR
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Sets the horizontal and vertical position of the bottom right corner point.

Rotate
Sets the rotation of the clone source.

Nudging the Clone Source
The clone source can be nudged using the Arrow keys. One press of the Arrow 
key moves the clone source 1 pixel. Using the Shift key in conjunction with the 
Arrow keys moves the clone source 10 pixels. Ctrl plus the Arrow keys moves 
the clone source one tenth of a pixel. These nudge values can be changed in 
the Preferences menu located in File > Preferences > Nudging on Windows 
and Linux or Silhouette > Preferences > Nudging on Mac. Holding an Arrow key 
down slides the clone source.

Q (Translate), W (Rotate), E (Scale)
Pressing Q, W or E and then clicking and dragging will translate, rotate or scale 
the clone source. Pressing Q, W or E a second time deactivates the mode. 
Also, the position of the cursor when W or E is pressed sets the anchor point 
for the rotation or scale operation.

Note: Onion Skin mode is automatically activated once the Q, W or E keys are pressed.

Corner-Pin
When Interactive mode is enabled, you can corner-pin the clone source by 
dragging the handles on the corners of the image. Alternatively, you can select 
and move the corner points without being in Interactive mode by using 
Ctrl/Cmd-1,2,3 or 4 to select the top left, top right, bottom right and bottom left 
corner points. Then, use the mouse, pen/tablet or Arrow keys to move the 
points. Pressing Ctrl/Cmd-1,2,3 or 4 a second time deactivates the mode.
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 Clone Transform Nudging Keyboard Shortcuts

 Clone Transform Keyboard Shortcuts

Shortcut Action

Arrow keys Moves the clone source by 1 pixel

Shift-Arrow keys Moves the clone source by 10 pixels

Ctrl/Cmd-Arrow keys Moves the clone source by one tenth of a pixel

Hold down Arrow keys Moves the clone source continuously

Q, W, E then Arrow keys Translates, Rotates or Scales by 1 pixel

Q, W, E then Shift-Arrow keys Translates, Rotates or Scales by 10 pixels

Q, W, E then Ctrl/Cmd-Arrow keys Translates, Rotates or Scales by 1/10 of a pixel

Ctrl/Cmd-1 then Arrow Keys Nudges the top left corner point

Ctrl/Cmd-2 then Arrow Keys Nudges the top right corner point

Ctrl/Cmd-3 then Arrow Keys Nudges the bottom right corner point

Ctrl/Cmd-4 then Arrow Keys Nudges the bottom left corner point

Shortcut Action

Q Activates / Deactivates translation of the clone source

W Activates / Deactivates rotation of the clone source

E Activates / Deactivates scaling of the clone source

Q, W, E then Ctrl/Cmd Translates, Rotates or Scales in finer increments

Ctrl/Cmd-W Rotates without setting the anchor point

Ctrl/Cmd-E Scales without setting the anchor point

Ctrl/Cmd-1-4 Selects the top left, top right, bottom right and bottom left 
corner points so they can be moved

. (Period key) Sets the anchor point
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Interactive
Activates the on-screen controls.

Turn off Interactive mode when you want to Paint. When Interactive is selected, 
you can position, scale, rotate, corner-pin and skew the clone source using the 
on-screen controls.

 Clone Transform On-Screen Controls

Shortcut Action

Drag within large center circle Moves the clone source

Shift-drag within large center circle Constrain clone source movement horizontally or vertically

Drag the center square horizontal and 
vertical halfway points

Scales the clone source horizontally or vertically

Drag a center square corner Proportionally scale the clone source

Drag large center circle Rotate the clone source

Ctrl/Cmd-drag large center circle Rotates the clone source with finer control

Drag handles on corners of image Corner-pins the clone source

Drag dash above large circle Skews the clone source horizontally

Drag dash to the right of large circle Skews the clone source vertically
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Region
Changes the position and size of the on-screen control rectangle which allows 
the effect of the corner-pin to be controlled from a specific area. The center of 
the new region also becomes the anchor point for scale and rotation.

Using a Region
1 Press Region.

2 Click and drag around an area of interest.

A region appears.

3 Turn on Interactive and adjust the Clone transform.

Now, when you adjust the Clone transform, the region is used.

 Region Shortcuts

Shortcut Action

Click and drag Creates a region

Alt-click and drag Creates new region when one already exists

Click and drag inside a region Moves the region

Drag the region handles Resizes the region

Tap outside a region box without dragging Resets the region to full screen
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 Clone Transform On-Screen Controls With Region Set

Shortcut Action

Drag within region Moves the clone source

Shift-drag region Constrains the clone source movement horizontally or vertically

Drag edge handle Scales the clone source horizontally or vertically

Shift-drag corner or edge handle Proportionally scale the clone source

Ctrl/Cmd-drag on corner handle Rotate the clone source / Continue holding Ctrl to adjust with 
finer control

Drag on a corner handle Corner-pins the clone source

Ctrl/Cmd-drag on edge handle Skews the clone source
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Filter
Chooses the filtering method when transforming the clone source. Mitchell is 
the default.

Triangle
The Triangle filter is not the highest quality, but fine for scaled images.

Quadratic
Quadratic is like triangle, but more blur with fewer artifacts. It offers a good 
compromise between speed and quality.

Cubic
Cubic is the default filter in Photoshop. It produces better results with 
continuous tone images, but is slower than Quadratic. If the image contains fine 
details, the result may be blurrier than desired.

Catmull-Rom
This produces good results with continuous tone images which are scaled 
down, producing sharp results with fine detailed images.

Gaussian
Gaussian lacks in sharpness, but is good with ringing and aliasing.

Mitchell
A good balance between sharpness and ringing, Mitchell is a good choice when 
scaling up.

Sinc
Keeps small details when scaling down with good aliasing.

Subpixel
When activated, subpixel positioning is used when moving the clone source.
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Grade/Filter
The clone source can be color corrected (graded), blurred or sharpened.

The parameters are ganged together by default. To deactivate Gang, press the 
Lock icon located to the right of each parameter group.

Auto Grade
Auto Grade automatically grades the clone source to match the location you 
are painting.

Note: The Gain, Gamma, Lift, Hue and Saturation controls are disabled when using 
Auto Grade.

Gain
Red
Multiplies red values.

Green
Multiplies green values.

Blue
Multiplies blue values.
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Gamma
Red
Adjusts red gamma values.

Green
Adjusts green gamma values.

Blue
Adjusts blue gamma values.

Lift
Red
Adds red values.

Green
Adds green values.

Blue
Adds blue values.

Hue
Rotates the hue.

Saturation
Adjusts saturation. Positive values saturate, negative values desaturate.

Blur
Blurs the clone source.

Sharpen
Sharpens the clone source.

Reset Grade/Filter
Resets all Grade/Filter controls.

Note: Once a Grade/Filter parameter has been adjusted, a green dot appears to the 
right of the tab to indicate that a change was made.
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Warp
Warp allows you to warp specific image areas using pins, while leaving other 
areas untouched. Adjustments can range from subtle nip and tucks to 
something more obvious like repositioning an arm or leg.

Enable
Enables/disables warping. This is useful to turn the warping effect on and off.

Pin 1 - 20
A total of 20 pins can be added to an image. To create a pin, click-drag on the 
image. Pins have a source (green circle) and target (red circle). The farther the 
target is dragged from the source, the more the image warps. Click-releasing 
on the image sets a tack which constrains the warp.

Pin and Tack Radius
Each pin and tack has a radius which determines its strength. Hover over a pin 
to display the radius. Shift-drag the radius to adjust it.

Transform
Selects point trackers and tracked layers from the input Tracker node and 
match moves the pins based on the input tracker data.

Note: Once a Warp parameter has been adjusted, a green dot appears to the right of 
the tab to indicate that a change was made.
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 Clone > Warp Keyboard Shortcuts

Shortcut Action

Click-drag on image Creates a pin

Click-release on image Creates a tack

Click-drag pin (source or target) Moves the pin (source or target)

Shift-drag pin (source or target) Moves both pins (source and target)

Ctrl/Cmd-drag pin radius Adjusts pin radius with all radii displayed

Hover over pin, Shift-drag pin radius Adjusts pin radius with only selected pin radius displayed

Alt-drag on a tack Converts a tack to a pin

Right-click > Remove Pin Deletes the pin

Right-click > Make Tack Converts a pin to a tack
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Dual Clone
Dual Cloning allows you to paint from two different frames simultaneously, 
using separate Transform, Grade/Filter and Warp settings. To Dual Clone, 
create two Clone presets using the 1 and 2 button presets on the left side of the 
Clone tab.

To save a preset, click on one of the numbered presets and adjust the Clone 
controls. This includes the Clone Source, Frame Offset, Transform, 
Grade/Filter, and Warp settings. Once you have different settings for the two 
presets, press the Dual button to enable both presets simultaneously.

When you do so, a Mix control appears to the right of the Clone controls. Mix 
sets the relative opacity of the two clone sources.

When you paint, both Clone presets will contribute to the painted result.

Note: You can use the Shift-Alt-1 and Shift-Alt-2 keyboard shortcuts to quickly select 
one of the Clone presets.

Reset
Resets all Clone brush transform controls.
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Color (Shift-C)
Paints the image with the current color.

Picking Colors from the Screen
Colors can be picked off of the screen using a couple of different techniques.

1 Hover over an area in the Viewer and press the . (period key). The area inside the 
brush diameter is sampled and averaged when choosing the color.

2 Right-click picks a color from a single pixel.

3 Right-click-drag and drawing a box averages the colors within it.

Color Palette
Colors can be selected using the Color Palette.

The Hue, Sat, Value and Sliders tabs provide you with four different methods 
for selecting a color.

Hue
The hue is selected from the hue picker while the saturation and value are 
chosen from the large square color palette.

Hue, Sat or Value Picker

Color Palette

Alpha

Paint Pots

Current Color

Mode
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Sat
The saturation is selected from the saturation picker while the hue and value 
are chosen from the large square color palette.

Value
The value is selected from the value picker while the hue and saturation are 
chosen from the large square color palette.

Sliders
Use the Red, Green, Blue, Hue, Sat, Value and Alpha sliders to set a color.

Hue, Sat or Value Picker
Depending on which tab is selected in the Color Palette, the vertical color bar 
to the right of the Color Palette controls the hue, saturation or value of the 
selected color.

Alpha
The second vertical color bar slider to the right of the Color Palette controls the 
level of the painted alpha when Paint > A (alpha) is selected. An alpha value of 
0 paints black, a value of 100 paints white, while a value in between paints a 
level of gray.

Current Color
Displays the currently selected color.

Mode
Selects how color is applied to the image.

Normal
The Current Color is added to the image.

Tint
The Current Color is used to tint the image by replacing hue and saturation.

Hue
The Current Color is used to tint the image by only replacing hue.

Luminance
Replaces the luminance of the image while leaving hue and saturation 
unaffected.
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Lighten
Pixels darker than the paint color are replaced, and pixels lighter than the paint 
color do not change.

Darken
Pixels lighter than the paint color are replaced, and pixels darker than the paint 
color do not change.

Paint Pots
Favorite colors can be stored in the paint pots by dragging and dropping from 
the Current Color. Click on one of the paint pots to make it the current color.

Color Correct (Alt-C)
The image is painted using color adjustments.

Hue
Rotates the hue.

Saturation
Adjusts saturation. Positive values saturate, negative values desaturate.

Brightness
Adjusts brightness. Positive values brighten, negative values darken.

Contrast
Adjusts contrast. Positive values increase contrast, negative values decrease 
contrast.

Center
Adjusts the contrast curve to weigh it more towards shadows or highlights. A 
lower value means a brighter range.

Gamma 
Adjusts gamma. The gamma adjustment leaves the white and black points the 
same and only modifies the values in-between. Positive values darken the 
midtones, negative values lighten the midtones.
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Red
Adds or subtracts red.

Green
Adds or subtracts green.

Blue
Adds or subtracts blue.

Cutout (Alt-Shift-C)
Cuts out a portion of the image based on a rectangular selection, taking into 
account alpha if it exists, and paints using the cutout.

If one is not defined, you can click-drag to create a source region. When a 
source region already exists, press Shift to display it and then optionally drag 
to create a new one. The source region can be reset by Shift-clicking or right- 
clicking without dragging.

Cutout Keyboard Shortcuts

Type
RGBA
Creates a cutout based on the RGBA channels.

RGB
Creates a cutout based on the RGB channels.

Shortcut Action

Click-drag Creates a source region when none exists

Shift-drag or Right-click-drag Creates a new source region

Shift Displays source region

Shift-click or Right-click Resets source region

Ctrl/Cmd-drag boundary Scales the cutout

Ctrl/Cmd-Shift-drag boundary Rotates the cutout
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Scale
Scales the cutout.

Rotation
Rotates the cutout.

Detail (Alt-D)
Sharpens or smooths by decomposing the image into coarse, medium and fine 
detail layers. This results in selective sharpening, detail enhancement and 
edge aware smoothing.

Coarse
Adjusts the coarse detail layer. Increasing the value sharpens while decreasing 
the value smooths.

Medium
Adjusts the medium detail layer. Increasing the value sharpens while 
decreasing the value smooths.
Fine
Adjusts the fine detail layer. Increasing the value sharpens while decreasing the 
value smooths.
Gang
The Coarse, Medium and Fine values can be ganged together. When ganged, 
adjust the Coarse slider to affect all values simultaneously. This will generate 
an overall sharpening effect if the numeric fields are increased and an overall 
smoothing effect if decreased.

Range
Shadows, Midtones, Highlights, Full
Targets the Detail operation to either shadows, midtones or highlights as well 
as the entire range when set to Full.
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Dodge (Alt-Shift-D)
Lighten areas in the image.

Exposure
Sets the brightness of the brush.

Range
Shadows, Midtones, Highlights, Full
Targets the Dodge operation to either shadows, midtones or highlights as well 
as the entire range when set to Full.

Drag (D)
Smudge or smear an area of the image. When the brush first starts, it makes a 
copy of the area under the brush, then on subsequent samples it stamps that 
area down in the new location with a blend.

Mix
Mix is the initial blend amount of the smudged area.

Decay
Determines how much of the Mix to use on the next stamp and reduces the Mix 
percentage with each sample.

The defaults are Mix = 50% and Decay = 90%. So, the first stamp will be a 
50/50 mix of the brush start sample and the new sample, then the next will be 
50% * 90% of it, etc. until it eventually fades away entirely.

Eraser (Shift-E)
Erases previously painted brush strokes.
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Grain (G)
Paints grain onto the image.

Size
Sets the size of the grain.

Red Size
Controls the size of the red grain.

Green Size
Controls the size of the green grain.

Blue Size
Controls the size of the blue grain.

Amount
Sets the intensity of the grain.

Red Amount
Controls the intensity of the red grain.

Green Amount
Controls the intensity of the green grain.

Blue Amount
Controls the intensity of the blue grain.

Softness
Sets the softness of the grain.

Red Softness
Controls the softness of the red grain.

Green Softness
Controls the softness of the green grain.

Blue Softness
Controls the softness of the blue grain.
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Monochrome
When enabled, the grain is monochrome. In this mode, parameters that have 
no effect are grayed out.

Mosaic (M)
Divides the picture up into square tiles.

Size
Controls the size of the square tiles. A small size value will create many square 
tiles.

Repair (R)
Paints the image with the color level sampled at the beginning of each stroke.

Scatter (Shift-S)
Scatters pixels in a random fashion.

Radius
Sets the amount of scattering.
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Stroke (S)
Displays all strokes. Strokes can be selected by clicking or drag selecting in the 
Viewer. Hold Shift to add to the selection and Ctrl to toggle the selection. As 
strokes are selected, they are highlighted in the Viewer and the Paint History.
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Brush Compare Modes
Four brush compare modes preview brush settings prior to painting. You can 
choose from Onion Skin, Align, Vertical Split and Horizontal Split.

The Caps Lock key toggles the compare modes on and off.

Note: The compare modes are not available for the Drag, Repair, and Cutout brushes. 
Onion Skin and Align mode only work with the Clone brush.

Onion Skin
Onion Skin does a mix, as defined by the Mix value, between the brush preview 
and source image. When using the Clone brush, it is a mix between the clone 
source and target. A value of 100 displays the clone source while a value of 0 
displays the clone target.

Align
Align inverts the clone source and mixes it with the foreground, creating an 
embossed effect when similar images are not aligned. When perfectly aligned, 
the Viewer appears gray or black depending on the state of the Paint > Clone 
> Alignment Type preference.

Not Aligned Aligned
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Vertical Split
Compares the brush preview and source image using a Vertical Split. Move 
your cursor into the image area over the split line and when the cursor changes 
to a double-arrow, click and drag to move the split line. The split line may not 
be obvious, so white triangles on the edges of the Viewer will help you find it.

The split is useful for determining the brush settings prior to painting.

Note: The | key (vertical bar) keyboard shortcut snaps the vertical split position to the 
cursor position.

Horizontal Split
Compares the brush preview and source image using a Horizontal Split. Move 
your cursor into the image area over the split line and when the cursor changes 
to a double-arrow, click and drag to move the split line. The split line may not 
be obvious, so white triangles on the edges of the Viewer will help you find it.

The split is useful for determining the brush settings prior to painting.

Note: The | key (vertical bar) keyboard shortcut snaps the horizontal split position to 
the cursor position.
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Profile
You can customize your brush settings in the Profile tab.

Profile
A circle or square brush can be selected from the pop-up menu.

Circle
The brush profile is set to a circle.

Square
The brush profile is set to a square.

Airbrush
When on, brush samples are generated at 30 samples/sec as long as the 
mouse button or pen is held down.

Buildup
Allows the opacity to accumulate so it doesn't get clamped by the Opacity 
parameter value.

Size
Sets the size of the brush. The brush can also be resized in the Viewer with the 
bracket keys, [ and ], or by holding Ctrl/Cmd and dragging the brush outline.

Opacity
Sets the opacity or transparency of the brush.
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Softness
Sets the brush softness. The brush softness can be changed in the Viewer by 
holding Ctrl/Cmd-Shift and dragging the brush outline.

Falloff
Controls the feather contour of the brush.

Flatness
Sets the flatness of the brush.

Angle
Sets the angle of the brush.

Spacing
Sets the brush spacing.

Paint
The Paint tab contains controls that affect how paint is applied to the image.

RGB
The selected brush paints on the RGB channels.

R
The selected brush paints on the red channel.

G
The selected brush paints on the green channel.
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B
The selected brush paints on the blue channel.

A
The selected brush paints on the alpha channel.

Detail Separation
Separates the image into color and detail layers. The color and detail layers can 
be painted separately or simultaneously. Painting on the color layer preserves 
detail while painting on the detail layer preserves color.

Note: With the exception of Cutout and Eraser, all brushes can be used in the Color 
and Detail modes.

Normal
Paints on the color and detail layers simultaneously.

Color
Paints on the color layer. The color layer can be viewed by selecting View > 
Color Layer or pressing the 8 keyboard shortcut.

Detail
Paints the detail layer. The detail layer can be viewed by selecting View > Detail 
Layer or pressing the 9 keyboard shortcut.

Detail Level
Determines the detail layer to be used. 0 is coarse, .5 is medium and 1 is fine.
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Detail Preset
The pop-up menu to the right of Detail Level provides coarse, medium and fine 
detail presets.

Coarse
Presets the detail to the coarse layer.

Medium
Presets the detail to the medium layer.

Fine
Presets the detail to the fine layer. The fine layer typically includes details such 
as skin blemishes, pores, hair, and wrinkles.

Original Coarse

Medium Fine



Silhouette User Guide    

• • • •••

Nodes  637 
• • • •••

Alpha
Obey Alpha
When enabled, the intensity of the alpha channel controls how much the image 
will be affected by a particular paint operation. At any given pixel in the image, 
the more transparent the value in the alpha channel, the more transparent the 
application of the paint operation. 

Invert Alpha
Inverts the alpha channel used for the Obey operation.

Opaque
Enabled once the A button is turned on, the Opaque control ensures that a solid 
paint stroke is created when painting into the alpha channel. When Opaque is 
off, the brush will also affect the alpha channel. So, it's possible to blur and drag 
the alpha channel, for instance.

Alpha Source
Selects which input source to use when Obey is enabled.

Foreground, Input 1-5
Foreground uses the alpha from the Foreground input as the obey alpha 
source. For instance, you can use the Roto node plugged into the Foreground 
input to control where you paint in the RGB channels.

Output
Uses the Paint node’s output alpha as the obey alpha source. This option is 
handy for painting temporary alpha to control where you paint in the RGB 
channels.

Paint Source
Selects either Foreground or Output as the paint source. Alt-P toggles between 
Foreground and Output.

Foreground
The brush paints from the Foreground. For instance, this is useful for painting 
multiple strokes to perform a constant color correction or blur adjustment.
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Output
The brush paints from the Output, with each new stroke affecting what was 
previously painted.

Note: Paint Source is not available for the following brushes: Clone, Cutout, Mosaic, 
Repair and Scatter.

Transform
Selects point trackers and tracked layers from the input Tracker node, or other 
nodes that contain trackers, for use in match moving paint strokes or the clone 
source during event playback.

Show Shapes
Shape outlines from a Roto node can be displayed in a Paint node. To do so, 
connect a Roto node’s Objects output into a Paint node’s Objects input and 
enable Show Shapes.

Delete
Delete all paint strokes and restores the original unpainted frames.

Current Frame
Sets the range to the current frame.

Work Range
Sets the range to the in and out points in the Timebar.
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All Frames
Sets the range to the entire frame range.

Paint Preferences
Seldom adjusted Paint controls can be accessed by clicking the Paint 
Preferences icon.

Auto Paint
Auto Paint is a highly unique automated paint feature that records all paint 
activity with tight integration of both point and planar trackers. Paint strokes can 
be match moved or stabilized giving Silhouette the speed of raster paint with 
the repeatability of vector paint. The beauty of the system lies in the automatic 
recording of the paint strokes and brush settings. Individual paint strokes can 
be selected and repeated over many frames, as well as deleted. If the original 
footage changes, the entire paint history can be used to rebuild the painted shot 
automatically. Go to the Auto Paint tutorial to see how it works.

Paint History
The Paint History contains all of the “events” for the current session. Events are 
things like paint strokes, brush profile changes, brush parameter changes, 
other paint states, etc. A selection of events essentially becomes a macro and 
can be played back over a range of frames.
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Groups are created each time painting is started on a frame and are recorded 
with the current time stamp. So the first time you begin painting on frame 1, for 
instance, a renameable “event group” containing a current time stamp is 
created. Then, events are created for the current paint state: channels/flags, 
brush, brush profile, and brush parameters. And finally, a new stroke event is 
created for the new stroke. After the first stroke, state changes are stored in 
their own events (ie. brush size, opacity, etc).

Add Group
Manually adds a paint event group. Manually creating groups is useful for 
organizing your painted strokes so that they can easily be identified at a later 
time.

Note: Normally, one paint group is created while painting on a frame. If you leave the 
frame and come back to it later, another group will be created automatically.

Show Strokes
When you make a selection in the Paint History, the strokes are highlighted 
green in the Viewer when Show Strokes is enabled--the default.

Delete
Press the Delete icon or the Delete key to delete selected events.

Groups and Events
• A date and time stamp is an automatically created group that contains the events 

for frame 1. Later, if you leave and come back to frame 1, there will be a new group 
created with a new time stamp. This will keep track of what changes were made 
and when.

• Groups can be renamed by double-clicking, typing a new name and hitting Enter.
• The first time you do something on a frame, events that snapshot the current paint 

state are recorded. This is so that if you need to rebuild the frame, everything that 
is needed is in the Paint History for each frame.
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• Groups that have + icons indicate you can expand them to see their contents.

Event Playback
Frame Range
Defines the frame range for Event Playback and Rebuild operations.

Current
Sets the range to the current frame.

Work
Sets the range to the in and out points in the Timebar.

All Frames
Sets the range to the entire frame range.

Custom
Sets a custom range as defined by the numeric entry fields. To quickly set 
custom in/out points, press the arrows in the numeric fields to enter the 
currently parked frame.

Start>Current
Sets the range to the start frame ending at the current frame.

Current>End
Sets the range to the current frame ending at the end frame.

Play Selected Events Forward/Backward
Plays selected events in the Paint History either forward or backward.

In the Paint History window, select the paint event group or a sub set of the 
paint events you want to play back. You will see the strokes highlight green in 
the Viewer. Then, select the desired frame range and press either the Play 
Selected Events Forward or Backward icon.



Silhouette User Guide    

• • • •••

Nodes  642 
• • • •••

The number to the right of the Play Selected Events icons represents the 
number of selected items in the Paint History.

If a layer with tracking data applied is selected and Match Move is enabled, the 
selected strokes will be match moved when played back. 

Note: To Match Move the clone source during playback, you will need to select the 
layer and enable Clone > Match Move prior to painting.

Match Move
Match Move allows you to apply the selected tracked layer while playing back 
paint events.

Duplicate
Duplicates strokes from one view to another for the current frame. If a layer with 
a stereo offset is selected prior to duplicating, the stereo offset is taken into 
account when duplicating the strokes.

Note: Duplicate only appears when in a stereo project.

Replay (Ctrl/Cmd-Alt-R)
Replays the last stroke. This can be used to apply the last stroke with changed 
settings and/or on a different frame.

Rebuild
Rebuilds the paint events for all frames defined in the Frame Range in the order 
in which they were painted. This is useful if you replace your footage with a 
different color correction than the original and want the result of painting with 
the Clone brush to match the new footage.

Stereo Paint
In general, painting on stereo images is the same as painting with mono 
images. The stereo view mode determines whether you are painting on the Left 
View, Right View or both the Left and Right Views at the same time.
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In the Timebar, red markers are displayed for painted frames in the Left View, 
blue markers for the Right View and green markers for frames painted in both 
the Left and Right View.

Go to the Stereo Paint tutorial to see how it works.

 Paint Brush Shortcuts

Shortcut Action

B Selects the Black and White brush

Shift-B Selects the Blemish brush

Ctrl/Cmd-B Selects the Blur brush

Alt-Shift-B Selects the Burn brush

C Selects the Clone brush

Shift-C Selects the Color brush

Alt-C Selects the Color Correct brush

Alt-Shift-C Selects the Cutout brush

Alt-D Selects the Detail brush

Alt-Shift-D Selects the Dodge brush

D Selects the Drag brush

Shift-E Selects the Eraser brush

G Selects the Grain brush

M Selects the Mosaic brush

R Selects the Repair brush

Shift-S Selects the Scatter brush

S Selects the Stroke tool
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 Paint Settings Shortcuts

Shortcut Action

Ctrl/Cmd-drag left/right Sizes the brush

[ and ] Sizes the brush

Ctrl/Cmd-Shift-drag Sets the brush softness

Shift-Alt-1 and Shift-Alt-2 Selects the Dual Clone brush setups

Shift+Ctrl+1 Toggle Dual Clone mode on/off

‘ (located to the left of 1 key) Displays the Clone source and then the Clone 
target so that you can click on each to set the Clone 
offset

Caps Lock Toggles Onion Skin mode on and off

. (period key) Picks colors off of the screen

Right-click Picks a color off of the screen from a single pixel

Right-click-drag Picks a color off of the screen by drawing a box and 
averages the colors within it

Alt-click-click Draws a straight line

Alt-P Toggles between Paint Source > Foreground or 
Output

| key (vertical bar) Snaps the vertical or horizontal split compare 
position to the cursor position
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Paint View Menu

Node Parameters
When the Paint node is being edited in the Trees window, parameters specific 
to the Paint node can be adjusted in the Paint > Node parameters.

Paint Only Alpha
Selects either a hard or soft edged alpha channel when using the Paint Only 
output.

Hard
Creates a hard edge alpha channel around brush strokes.

Soft
Creates a soft edge alpha channel around brush strokes.

Node Outputs
Output
Outputs the result of the paint node.

Paint Only
Outputs only the painted portions of the frame along with an automatically 
generated alpha channel (where the brush painted). This will allow you to 
seamlessly composite the painted areas in a Composite node without having 
to do a difference matte.

Shortcut Action

1 View the Output

2 View the Foreground

3-7 View Input’s 1-5

8 View Color Layer

9 View Detail Layer

P View Paint Only
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Pastel
Description

Converts the image into pastel artwork.

Node Group
Special Effects.

Controls
Presets
To select a preset, choose one from the Presets tab.

Amount
Adjusts the amount of the pastel effect.

Detail
Adjusts the detail. If the value is increased, you will see more detail while 
decreasing the value will have an overall smoothing effect.
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Pencil
Description

Pencil converts your image to a pencil sketch.

Node Group
Special Effects.

Controls
Presets
To select a preset, choose one from the Presets tab.

Amount
Sets the intensity of the pencil effect.

Color
The Color parameter sets the color of the pencil effect through the use of a 
standard color picker.

Background
Mixes in the original image.
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Photographic
Description

The most complete line of Kodak® filters for photographic uses is available in 
the form of gelatin films and are known as Wratten® Gelatin filters. Our 
Photographic filter is a digital equivalent of the Wratten set and were created 
using the spectral transmission curves for each optical filter. The Color 
Conversion, Light Balancing and Color Compensating preset groups are 
subsets of the Photographic filters. 

Photographic
Digital versions of the complete line of Kodak® Wratten® Gelatin filters.

Color Conversion
Color Conversion filters correct for significant differences in color temperature 
between your light source and recording media.

Light Balancing
Light Balancing filters correct for minor differences in color temperature 
between your light source and recording media.

Color Compensating
Color Compensating filters control color by attenuating specific parts of the 
spectrum. They can be used to make changes in color balance or compensate 
for deficiencies in the image’s spectral quality.

Node Group
Tints.

Controls
Presets
To select a preset, choose one from the Presets tab. If you would like to view 
presets from a different category, use the pop-up menu at the top left of the 
Presets tab.
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Color
Color
The Color parameter sets the color of the filter through the use of a standard 
color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Grad 
These filters can optionally use a gradient that limits where the filter is applied. 
Grad is the transition area between the colored portion and the original image. 
Its direction, corners and size can be adjusted. Go to the Grad section of 
Common Node Controls to see how the Grad controls work.
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Pin Warp
Description

Pin Warp allows you to warp specific image areas using pins, while leaving 
other areas untouched. Adjustments can range from subtle nip and tucks to 
something more obvious like repositioning an arm or leg.

Go to the Pin Based Warping tutorial to see how it works.

Node Group
Warp.

Controls
Transform
Selects point trackers and tracked layers from the input Tracker node and 
match moves the pins based on the input tracker data.

Before

Photo by Tim Easley on Unsplash

After
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Pin 1 - 20
A total of 20 pins can be added to an image. To create a pin, click-drag on the 
image. Pins have a source (green circle) and target (red circle). The farther the 
target is dragged from the source, the more the image warps. Click-releasing 
on the image sets a tack which constrains the warp.

Pin and Tack Radius
Each pin and tack has a radius which determines its strength. Hover over a pin 
to display the radius. Shift-drag the radius to adjust it.

Source

Target

Tack
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 Pin Warp Keyboard Shortcuts

Shortcut Action

Click-drag on image Creates a pin

Click-release on image Creates a tack

Click-drag pin source or target Moves the pin source or target

Shift-drag pin source or target Moves both the pin source and target

Ctrl/Cmd-drag pin radius Adjusts pin radius with all radii displayed

Hover over pin, Shift-drag pin radius Adjusts pin radius with only selected pin radius displayed

Alt-drag on a tack Converts a tack to a pin

Right-click > Remove Pin Deletes the pin

Right-click > Make Tack Converts a pin to a tack
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Polarizer
Description

Polarizer
The greatest use of polarizing filters is to achieve a darkened, deep blue sky. 
Our digital version of the Polarizer is designed to do just that. Through the use 
of a matte and an adjustable gradient, the color of the sky can be adjusted.

Warm Polarizer
Combines the benefits of the Polarizer with a warming filter making it ideal for 
portraits and scenics.

Node Group
Color.

Controls
Presets
To select a preset, choose one from the Presets tab. If you would like to view 
presets from a different category, use the pop-up menu at the top left of the 
Presets tab.

Sky
Color Correct controls are provided to adjust the sky.

Hue
Rotates the hue of the sky.

Saturation
Adjusts the saturation of the sky. Positive values saturate, negative values 
desaturate.

Brightness
Adjusts the brightness of the sky. Positive values brighten, negative values 
darken.
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Contrast
Adjusts the contrast of the sky. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the sky. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
lighten the midtones, negative values darken the midtones.

Red
Adds or subtracts red from the sky.

Green
Adds or subtracts green from the sky.

Blue
Adds or subtracts blue from the sky.

Temperature
Sets the color temperature of the sky. Dragging the numeric field to the right 
makes the sky cooler (bluer) and dragging the numeric field to the left makes 
the sky warmer (redder).

Temperature
Applies a warming filter to the image. Go to the Temperature section of 
Common Node Controls to see how the Temperature controls work.

Grad
The Polarizer can optionally use a gradient that limits where the filter is applied. 
For instance, if the polarization is affecting areas other than the sky, enable the 
Grad and adjust it to limit the areas of polarization. Go to the Grad section of 
Common Node Controls to see how the Grad controls work.

Matte
Hue
The Polarizer isolates the sky using a matte based on a blue hue. Use the Hue 
eyedropper to select the exact color of the sky if you are not seeing enough 
polarization.
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Range
Increases or decreases the range of values in the hue matte. A low Range 
value indicates a narrow range of values. A high Range value indicates a large 
range of values included in the matte.

Blur
Sets the softness of the matte by using a quality blur.

Go to the Matte parameters to see how they work.
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Power Matte
Description

Power Matte is an easy to use interactive image matting tool capable of 
extracting almost any object in an image--even if you are dealing with fine hair 
detail, smoke, or reflections.

To work this magic, Power Matte iteratively estimates the transparency value 
for every pixel in the image, based on a small sample of foreground (what you 
want to cut out) and background (what you want to get rid of) pixels marked by 
defining simple shapes on the image. Results show that compared with 
previous approaches, our method is more efficient and requires minimal effort 
to extract high quality mattes for foregrounds with significant semi-transparent 
regions. In addition, the foreground edge colors can be estimated in the semi-
transparent areas to create a seamless composite.

Go to the Power Matte tutorial to see how it works.

Before After

Matte Shapes
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Since shapes are required for Power Matte, it has its own shape tools similar 
to those in the Roto node. See the Roto Node for more information.

Node Group
Key, Silhouette.

Matte Creation
Power Matte uses open or closed shapes to define the object you would like to 
isolate or extract. The shapes can be loose--they don’t need to follow exactly 
around the edges. Areas not defined by shapes are considered unknown areas 
and are automatically computed by Power Matte.

Trimaps
Power Matte creates mattes by using a trimap--a pre-segmented image 
consisting of three regions of foreground (what you want to cut out), 
background (what you want to get rid of) and unknown. Partial opacity values 
are then computed only for pixels inside the unknown region. Two trimap 
methods can be used: Open Shape or Closed Shape. When creating mattes, 
start with the Open Shape Method and move on to the Closed Shape Method 
if the results are not satisfying.
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Open Shape Method
Power Matte only requires a few open shapes to define foreground and 
background areas of the image when using the Open Shape Method. Areas not 
defined by shapes are considered unknown areas with partial opacity values 
being computed between the areas marked by foreground and background 
shapes.

Using the shapes, Power Matte generates an intermediate matte result called 
a Trimap. White signifies solid foreground, black is complete background and 
gray is unknown area where Power Matte will compute partial opacity.

The Open Shape Method requires little user input, but when color ambiguity 
exists between the foreground and background, the Closed Shape Method 
may create a more accurate matte. In addition, the Open Shape Method will 
also take slightly longer to render as it requires an extra calculation step.

Shapes Matte

Trimap
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Open Shape Method Tips & Tricks
• Make sure you draw enough foreground (what you want to cut out) and 

background (what you want to get rid of) shapes. A good technique is to draw an 
open inner shape within the object you are extracting and an outer, open shape 
outside the object.

• The shapes should be near the boundary of the object, but not right up against the 
edge. 

• If the foreground or background has varying colors, the shapes should cover 
these colors.

• When viewing the matte, if you see gray areas in the foreground object that should 
be completely white, make additional foreground shapes in those areas. If you see 
gray matte areas in the background that should be completely black, make 
additional background shapes.

• The general rule is to not put different foreground and background shapes too 
close together unless you need to.

Warning: If you only provide a few sparse shapes, the Open Shape Method will take 
longer to process with a less accurate result than the Closed Shape Method.

Good Shape Example Bad Shape Example
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Closed Shape Method
The Closed Shape Method uses closed shapes to mark definite foreground and 
background areas of the image. Any unmarked areas are considered unknown 
and partial opacity values are then computed for the pixels inside the unknown 
region. So, make sure that any hair detail, transparent or blurry portions fall 
within the unknown areas.

Closed Shape trimaps process slightly faster than Open Shape trimaps and 
can result in extracting a more accurate matte, most notably when color 
ambiguity exists between the foreground and background. However, they can 
be tedious to create and tend to fail for images with large portions of semi-
transparent foreground where the trimap is difficult to create manually. The 
Closed Shape method does not handle a foreground object with background 
holes in it, and therefore the Open Shape method would be a better choice 
when extracting an object with holes

Shapes Matte

Trimap
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Closed Shape Method Tips & Tricks
• First, define foreground areas by drawing a closed shape around the inside edges 

of the foreground (what you want to cut out).
• Next, define background areas (what you want to get rid of) by drawing a closed 

shape around the background areas. 
• If your foreground object is completely surrounded by background, a quick way 

to define the background area is to first draw a closed shape around the outside 
of the foreground and then invert the shape in the Object Parameters. 

• Ideally, the unknown region, the regions not defined with foreground or 
background shapes, should only cover transparent pixels whose actual values are 
not completely foreground or background. In other words, the unknown region 
should include hair detail, transparent or blurry portions of the image.

Note: Large foreground objects take longer to process than small ones.

Shape Parameters
Type
Foreground
Assigns the shape to be used as foreground (what you want to cut out).

Background
Assigns the shape to be used as background (what you want to get rid of).

Filled
Determines whether or not the shape is filled.

Invert
Inverts a filled shape. This option is only available if Filled is enabled.

Node Parameters
When the Power Matte node is being edited in the Trees window, parameters 
specific to Power Matte node can be adjusted in the Node parameters.

Source Alpha
Controls how the incoming alpha channel is blended with the Power Matte 
alpha channel.

Ignore
The incoming alpha channel is not used.
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Add
Adds the incoming alpha channel to the Power Matte alpha channel.

Subtract
Subtracts the incoming alpha channel from the Power Matte alpha channel.

Multiply
Produces a result where there is a union of pixels from the incoming alpha 
channel and Power Matte alpha channel.

Difference
Produces a result where a value exists in the incoming alpha channel and 
Power Matte alpha channel, but not in both.

Color Estimation
Estimates the color of the foreground in unknown and semi-transparent areas. 
Color Estimation is off by default and when activated, prevents fringing to 
create a seamless composite. When disabled, a foreground object with 
transparent edges against a bright or dark background will have bright or dark 
edges in the composite.

Note: Color Estimation can cause color flickering in edge areas of partial opacity if your 
shape position is not constant from frame to frame or if your source footage is grainy. 
Disable Color Estimation if you see flickering in the edge areas after a preview or 
rendering.

Sensitivity
Sets the sensitivity of the Unknown areas. The higher the value, the more 
details are brought out.

Off On
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Deartifact
Blurry artifacts can be generated while attempting to extract objects that have 
drop shadows, similar colors to the background or out of focus edges. 
Deartifact can be used to limit these artifacts.

Accuracy
The accuracy of the generated matte can be increased with this control. When 
foreground and background shapes are close together, setting the Accuracy to 
Higher or Full will result in a more accurate matte. 

Note: It is best to work with Power Matte at the Accuracy setting that you will be 
rendering at.

Normal
Normal will work for most images and will render faster than the other settings.

Higher
Higher results in better accuracy than the Normal setting, but not quite as good 
as Full.

Full
Full will result in the most accurate matte, but will take longer to render.
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Color Suppression
When a foreground object has been photographed against a solid blue or green 
backdrop, the blue or green color can have a tendency to spill onto the 
foreground object. When extracting an object photographed against one of 
these colors, you may find it necessary to remove the blue or green spill. This 
is a process called Color Suppression.

Type
Selects whether blue or green is suppressed from the foreground image.

Foreground
Suppresses color spill in the foreground.The default value of 100 should be 
sufficient for most situations.

Range
Increases the range of areas that are color suppressed. If color spill is still 
evident, increase this value.

Edge
Suppresses the color spill of the unknown edge areas to the color gray. This is 
useful for edges that contain a lot of neutral transparency like glass reflections.

Reset All
Resets all parameters to their default state.

Off On
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Node Outputs
Output
Outputs the foreground input and generated matte.

Composite
Outputs a composite of the foreground over the background based on the 
generated matte.

Trimap
Outputs the generated trimap.
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Premultiply
Description

Multiplies the RGB channels by the alpha channel.

Node Group
Composite.
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Rack Focus
Description

Rack Focus replicates a true camera defocus by introducing lens Bokeh 
effects. Bokeh is the Japanese term that describes the quality of out-of-focus 
points of light. In defocused areas, each point of light becomes a shape--either 
a circle or a polygon. The shape grows in size as the amount of defocusing is 
increased.

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab.

Blur
The image is blurred by using a quality blur.

Aperture
Blend
Determines the blend mode to be used when adding Bokeh.

Add
Bokeh’s are added to your image.

Screen
The Bokeh are combined with the image using a Screen blend mode. This 
looks kind of like the Add blend mode, but highlights are retained.

Brightness
Brightens the Bokeh.

Facets
Set the number of Bokeh facets when the Curvature parameter is set to 0.
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Curvature
Controls the curvature of the Bokeh. When set to 100, the Bokeh are 
completely round. Set to a value of 0 to see a polygonal shape.

Angle
Rotates the Bokeh.

Color
Sets the Bokeh color.

Blur
Sets the softness of the Bokeh. This can be useful when using high threshold 
values.

Matte
A matte is used to create the Bokeh effect. Go to the Matte section of Common 
Node Controls to see how the Matte controls work.
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Radial Gradient
Description

Creates a radial gradient.

Node Group
Image.

Controls
Aspect
The aspect ratio of the spot.

Radius
The un-blurred radius of the spot.

Falloff Radius
The blurred edge of the spot.

Aspect
The aspect ratio of the spot.

Falloff
Moves the falloff towards the spot centerpoint.

Invert
Inverts the spot.
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Radial Tint
Description

Tints the image using multi-color, radially graduated filters.

Node Group
Tints.

Controls
Presets
To select a preset, choose one from the Presets tab.

Tint Mode
Selects how color is applied to the image.

Normal
Tints the image while retaining highlights.

Tint
The image is tinted by replacing hue and saturation.

Hue
The image is tinted by only replacing hue.

Lighten
Pixels darker than the color are replaced, and pixels lighter than the color do 
not change.

Darken
Pixels lighter than the color are replaced, and pixels darker than the color do 
not change.

Color 1
Sets the color for the top left quadrant of the image.

Color
Sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color.
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Color 2
The Color 2 controls are the same as the controls for Color 1 except it is applied 
to the top right quadrant of the image.

Color 3
The Color 3 controls are the same as the controls for Color 1 except it is applied 
to the bottom right quadrant of the image.

Color 4
The Color 4controls are the same as the controls for Color 1 except it is applied 
to the bottom left quadrant of the image.

Radial Grad
Sets the position, rotation and aspect ratio of the radial gradient.

Position
There is an on-screen control in the center of the image. By clicking and 
dragging the on-screen control, the position of the grad can be adjusted.

Position X
The horizontal position of the grad.

Position Y
The vertical position of the grad.

Size
The size of the grad.

Rotation
The rotation of the grad.

Aspect
The aspect ratio of the grad.

Highlights
Preserve Highlights
Preserves the white areas of the image.
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Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Spot
A spot in the form of a radial gradient can optionally be used to control where 
color is added to the image. Go to the Spot section of Common Node Controls 
to see how the Spot controls work.
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Rays
Description

Create stunning and realistic light ray effects quickly and easily. Known as 
volumetric lighting in computer graphics or crepuscular rays in atmospheric 
optics, this dramatic effect adds polish and style. Since the rays are only added 
to highlight areas, they have the effect of passing through objects and add a 
third dimensional quality. Add shafts of light streaming through clouds, rays 
filtering through a forest canopy, beams of light on a foggy night or rays 
shooting out from text. Rays adds a striking and dramatic quality to any image.

Node Group
Light.

Controls
Rays
Length
Sets the ray length.

Threshold
Controls the amount of rays based on a brightness threshold. Fewer rays with 
more definition are generated at higher threshold values.

Position
Move the point control in the center of the screen to change the source point 
from which the rays will emanate.

Color
Brightness
Sets the brightness of the rays.

Color
Sets the color of the rays.

Shimmer
Randomizes the rays.
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Amount
Sets the amount of shimmering.

Phase
Sets the randomness of the shimmering.

Opacity
Rays
Sets the opacity of the rays.

Source
Sets the opacity of your image.
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Reflector
Description

One of the oldest and still most popular means of lighting an exterior set is by 
taking a reflective surface and redirecting sunlight or artificial light exactly 
where it is needed. Unfortunately, it is nearly impossible for actors to keep their 
eyes open when looking into a reflector, resulting in squinting eyes. Our silver 
and gold reflectors allow you to add white or gold light into shadow areas 
without the squinting.

Node Group
Light.

Controls
Presets
To select a preset, choose one from the Presets tab. If you would like to view 
presets from a different category, use the pop-up menu at the top left of the 
Presets tab.

Brightness
Sets the intensity of the reflector.

Color
The Color parameter sets the color of the reflector through the use of a 
standard color picker. The default color is gold for Gold Reflector and white for 
Silver Reflector.

Position
Selects the shadow values that will be adjusted.

Range
Controls the range of shadow values that will be adjusted.

Go to the Matte section of Common Node Controls to see how the Position and 
Range controls work.
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ReLight
Description

Using ReLight, an image can be relit by with either a directional or point light. 
The result looks natural even though the relighting is done without computing 
any scene geometry.

Node Group
Light.

Controls
Type
Parallel
A directional light source.

Point
A point light where the light either emanates from or fades into a vanishing 
point. Move the point control in the center of the screen to change the Point light 
location.

Strength
Sets the strength of the light.

Angle
Used in conjunction with Parallel, Angle sets the direction of the light source.

Invert
Used in conjunction with Point, Invert determines whether the light source 
emanates from or fades into a vanishing point.
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Resize
Description

Changes the size of the image.

Node Group
Transform.

Controls
Size
X Axis
The horizontal size of the image.

Y Axis
The vertical size of the image.

Gang
The X Axis and Y Axis values can be ganged together.

Filter
Chooses the filtering method when transforming the image. Mitchell is the 
default.

Triangle
The Triangle filter is not the highest quality, but fine for scaled images.

Quadratic
Quadratic is like triangle, but more blur with fewer artifacts. It offers a good 
compromise between speed and quality.

Cubic
Cubic is the default filter in Photoshop. It produces better results with 
continuous tone images, but is slower than Quadratic. If the image contains fine 
details, the result may be blurrier than desired.

Catmull-Rom
This produces good results with continuous tone images which are scaled 
down, producing sharp results with fine detailed images.
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Gaussian
Gaussian lacks in sharpness, but is good with ringing and aliasing.

Mitchell
A good balance between sharpness and ringing, Mitchell is a good choice when 
scaling up.

Sinc
Keeps small details when scaling down with good aliasing.
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Retime
Description

Expands or contracts the timing of a selected range of frames.

Node Group
Time.

Controls
You can enter values in any of the parameters below to set a new timing.

Start Frame
Selects the first frame to be used.

End Frame
Selects the end frame to be used.

Duration
Shows the retimed duration in frames.

Speed
Shows the retimed duration as a percentage. A value of 50 slows down by 50%, 
a value of 100 does nothing, and a value of 200 is twice as fast. 

Strobe
Strobe creates a stuttering effect. The frame is frozen for the amount of frames 
specified in the Strobe parameter and then displays a new frame in sequence.

Blend
Determines how frames are blended together when new frames are created to 
produce a longer clip.

None
Frames are not blended.

Average
Frames are mixed together when the clip is slowed down.
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Reverse
Description

Reverses the clip.

Node Group
Time.
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Roto
Description

Rotoscoping or “Roto” for short has become a generic term for drawing shapes 
to extract, isolate or affect a portion of an image. It is tedious work, but it’s one 
of the most important parts of the visual effects process. Within the Roto node, 
there are all the tools needed to make quick work of any roto job.

Go to the Roto tutorials to see how it works.

Node Group
Image, Silhouette.

Toolbar
When the Roto node is selected, a number of different tools are selectable from 
the Toolbar to the left of the Viewer.

Transform

Reshape

X-Spline

Square

B-Spline

Magnetic Freehand

IK

Bézier

Tracker
Circle

MultiFrame
RotoOverlay
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 Toolbar Keyboard Shortcuts

Stereo Shape Creation
When in the Left or Right View of a stereo project, adding a shape creates it in 
either the Left or Right View. In the Left/Right View, a shape is created in both 
the Left and Right Views.

Go to the Stereo Roto tutorial to see how stereo rotoscoping works.

Shortcut Action

T Selects Transform Shape Mode

TT Selects Transform Points Mode

R Selects Reshape Normal Mode

RR Selects Reshape Magnet Mode

Y Selects IK (Inverse Kinematics)

B Selects B-Spline

S Selects X-Spline

Shift-B Selects Bézier

Shift-F Selects Magnetic Freehand

Shift-S Selects Square

Shift-C Selects Circle

Shift-T Selects Tracker

M Selects MultiFrame

Shift-O Selects RotoOverlay

Alt-F Toggles the shape feather handle on/off

Alt-K Adds weighted keyframe
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Bézier (Shift-B)
Creates a Bézier spline.

Go to the Bézier tutorial to see how it works.

To draw a Bézier spline, click on the image to place the first control point and 
drag the cursor while keeping the mouse pressed to extend the control point’s 
tangents. Click on the screen to add more control points and when finished 
adding points, click the first control point that you added to close the shape. 

To create an open shape, add points and press the Esc key or switch to a 
different tool to finish the shape. Then in the Reshape tool, select the open 
shape, adjust the Stroke Width to set its thickness and choose either a flat or 
round Cap Style in the Object Parameters.

Originally developed by Pierre Bézier in the 1970's for CAD/CAM operations, 
Bézier splines became the foundation of the entire Adobe drawing model. If 
you're a user of Adobe products, you've probably used Bézier’s. Bézier splines 
are defined by control points and tangents. The position of the two tangent 
handles control the amount of a point's curvature.
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A shape is created by drawing a Bézier curve path. This path contains control 
points and tangents that define the form of the curve.

Control Points
Control points are locations on the curve that determine its shape. When a 
control point is selected, two tangents extend from the control point. These 
tangents guide the shape of the curve.

Joins
The area of the curve at the control point is called the curve join.

Joins can either be corner or cardinal (smooth) joins. When control point 
tangents are positioned in opposite directions, the join is cardinal. In contrast, 
corner joins have their tangents positioned at an angle to each other.

Control Point

Tangent Handle

Tangent

Curve Join

Cardinal Join Corner Join
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Adjusting Bézier Curves
The length and direction of a control point’s tangents direct the curve through 
that control point.

Control points have two tangents that can extend from it. The path of the curve 
through the control point is determined by the length and orientation of the 
tangents. When you drag one tangent’s handle, the adjacent tangent moves as 
well. Using keyboard shortcuts while dragging allows you to control how the 
curve passes through a control point.

Tangent Handle

Tangent

Curve Join

Control Point
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 Bézier Keyboard Shortcuts

Extending Short Tangents
Sometimes a control point’s tangents are so close together that trying to modify 
the tangent results in movement of the control point. If this is the case, you can 
force the tangents to move without affecting the control point by pressing the 
Alt key while dragging the tangent. Only the tangent will move, leaving the 
control point unaffected.

Shortcut Action Curve

No key needed Adjust the length of one tangent while retaining 
a fixed angle between two tangents

Ctrl/Cmd Adjust both tangents simultaneously while 
retaining a fixed angle between two tangents

Alt Adjusts only one tangent to create corners

Shift Adjusts only the length of one tangent (similar to 
the “No key needed” shortcut)

Ctrl/Cmd-Alt-1 Sets the point tension to Corner

Ctrl/Cmd-Alt-2 Sets the point tension to Cardinal
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Moving Curve Segments
Normally, you move control points to adjust the form of a shape, but you can 
also move the portion of the curve between control points. To move a curve 
segment, deselect all control points by clicking somewhere off the shape and 
then Ctrl/Cmd-drag a curve segment between control points.

Once you start dragging, the Ctrl/Cmd key can be released.

Note: The surrounding tangents remain smooth, but if you want to keep adjacent 
tangents from moving, hold down the Alt key while dragging.
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B-Spline (B)
Creates a B-Spline shape.

Go to the B-Spline tutorial to see how it works. 

To create a B-Spline, click on the screen to create a control point and add as 
many points as you like. When you are finished adding points, click the first 
control point that you added to close the shape. 

To create an open shape, add points and press the Esc key or switch to a 
different tool to finish the shape. Then in the Reshape tool, select the open 
shape, adjust the Stroke Width to set its thickness and choose either a flat or 
round Cap Style in the Object Parameters.

In contrast to Béziers, B-Splines don’t use tangents and are created by only 
using control points. The position of the points, their tension settings as well as 
their proximity to each other determine the curvature of the shape. B-Splines 
are somewhat similar to NURBS (non-uniform rational B-Splines) that are used 
in many 3D modeling packages.

The images below show how the same shape can be created with either 
Béziers or B-Splines.

Because the two spline types of have significant strengths and differences, 
artists are religiously loyal to one or the other. B-Splines create natural curves 
but are terribly inefficient at defining square corners and require more points to 
define than a similar Bézier shape. On the other hand, Béziers can easily 
create corners and use fewer points, but can have an unnatural curved path 

B-SplineBézier
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caused by overly malleable “split” handles. Depending upon your expertise, 
you may find Bézier splines are more appropriate for square and angular 
shapes while B-Splines will work better for objects with a lot of curves like a 
person’s face. Just to upset the status quo, there is a new kid on the block 
called X-Splines which is explained in the next section. This spline type brings 
together the best of both B-Splines and Béziers.

Adjusting B-Splines
In contrast to Béziers, B-Splines don’t use tangents and are created by only 
using control points and are simple to adjust. The position of the points, their 
weight settings as well as their proximity to each other determine the curvature 
of the shape. The weight (amount of pull on a point) decides how sharp or 
smooth it is. Silhouette employs variable weight intensities on a point by point 
basis. The weight can be adjusted by hovering over a point and Alt-dragging to 
the right to create a corner point or Alt-dragging to the left to create a smooth 
point. Alternatively, you can Alt-click on one of the selected points to cycle 
through the preset weight settings.

Note: Do not use extreme, variable weight adjustments if you are planning on 
converting the B-Spline to a Bézier Spline.

 B-Spline Keyboard Shortcuts

Note: The Alt-click and pop-up menu preset weight settings for Corner and B-Spline 
can’t be animated.

Shortcut Action

Alt-drag control point right Creates a corner point

Alt-drag control point left Creates a smooth point

Alt-clicking control point Cycles through the preset weight settings of the point

Ctrl/Cmd-Alt-1 Sets the point tension to Corner

Ctrl/Cmd-Alt-3 Sets the point tension to B-Spline
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X-Spline (S)
Creates a X-Spline shape.

Go to the X-Spline tutorial to see how it works.

To create a X-Spline, click on the screen to create a control point and add as 
many points as you like. When you are finished adding points, click the first 
control point that you added to close the shape. 

To create an open shape, add points and press the Esc key or switch to a 
different tool to finish the shape. Then in the Reshape tool, select the open 
shape, adjust the Stroke Width to set its thickness and choose either a flat or 
round Cap Style in the Object Parameters.

A X-Spline is an intuitive and easily editable spline format whereby its points 
can be of three different types: Cardinal, Corner or B-Spline.

• Cardinal creates a path that passes smoothly through each point.

• Corner makes a path that consists of angular corner points.

• B-Spline creates a smooth path that is determined by the surrounding points.

Look at how the same set of points can yield entirely different shapes based on 
the point type setting.

The point type can be changed at anytime as well as animated from one type 
to another. You’ll find that the beauty of X-Splines is that the shape’s points can 
be a mix of Cardinal, Corner or B-Splines.

Cardinal Corner B-Spline
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The images below show how the same shape can be created with either Bézier 
splines, B-Splines or X-Splines.

Adjusting X-Splines
X-Splines are created by using control points and then adjusting their weight to 
coincide with one of the point types: Cardinal, Corner or B-Spline. The point 
type can even be somewhere in between one point type and another. The 
weight can be adjusted by hovering over a selected point and Alt-dragging to 
the right. The weight of the point goes from Cardinal to Corner to B-Spline. 
Alternatively, you can Alt-click to cycle through the different point types.

Edge Snapping
You can snap the control points of an X-Spline to edges of an object by using 
the Edge Snapping tool. Select the points you want to move and press the Alt-
S key.

Alternatively, start dragging the points, hold the Alt-S key down and they will 
snap to the nearest detectable edge. In some cases, the points may not snap 
to where you want them to. If this happens, adjust the points manually.

Bézier X-SplineB-Spline
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 X-Spline Keyboard Shortcuts

Shortcut Action

Alt-drag control point right Adjusts the weight of the point from Cardinal to Corner to B-Spline

Alt-drag control point left When the weight is set to B-Spline, it adjusts the weight of the point 
from B-Spline to Corner to Cardinal

Alt-clicking control point Cycles through preset weight settings of the point

Ctrl/Cmd-Alt-1 Sets the point tension to Corner

Ctrl/Cmd-Alt-2 Sets the point tension to Cardinal

Ctrl/Cmd-Alt-3 Sets the point tension to B-Spline

Alt-S Snap selected control points to the nearest detectable edge

Drag Points-Hold Alt-S Snap selected control points to the nearest detectable edge
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Magnetic Freehand (Shift-F)
Creates freehand shapes with or without magnetic properties. A magnetic 
freehand shape snaps the shape boundary to the nearest object edge.

Go to the Magnetic Freehand tutorial to see how it works.

Magnetic Shape
Creates a freehand shape with magnetic properties. There are two methods of 
creating a magnetic shape: Tracing or Strokes.

Tracing
Click once near the edge you want to start with and move your cursor along the 
edge you want to follow. The shape boundary snaps to the nearest edge to 
where the cursor lies, tracing the shortest path from any previous click. When 
you are done tracing, click the first control point that you added to close the 
shape.

Magnetic Tracing Shortcuts

Shortcut Action

Click while tracing Anchors the currently drawn path by adding a shape point

Shift-click Draws a straight line between the new and previous shape points
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Strokes
Temporary foreground (inside the shape) and background (outside the shape) 
strokes are drawn for the object you want to create a shape around. Shift-click 
and drag to create foreground strokes. With each click and drag of the mouse, 
a green line is drawn. Alt-click and drag to create background strokes. With 
each click and drag of the mouse, a red line is drawn.

As soon as the first background stroke is drawn, an X- Spline is created around 
the object.

Add additional foreground and background strokes as needed so that the 
shape properly surrounds the object.

BG

FG

X-Spline
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Press Esc to clear the foreground and background strokes as well as deselect 
the current shape. You can now create a new magnetic shape or new 
foreground/background strokes.

Magnetic Stroke Marking Shortcuts

Freehand Shape
Click and drag to create a freehand shape. A freehand shape is exactly like a 
magnetic shape, minus the magnetic properties. When you are done drawing, 
click the first control point that you added to close the shape.

Note: Anytime you press and hold the mouse down, a freehand shape is drawn.

Finalizing Magnetic and Freehand Shapes
When a magnetic or freehand shape is completed, an X-Spline that follows the 
originally drawn line is created.

Shortcut Action

Shift-click-drag Creates a foreground stroke

Alt-click-drag Creates a background stroke

Esc Clears foreground and background strokes / Deselects current shape
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Adjusting Detail
X-Splines generated by the Magnetic Freehand tool have a fairly high point 
count to match the subtle changes in the line.To reduce the number of points, 
select an X- Spline in the Object List while in the Magnetic Freehand tool and 
adjust the Detail parameter directly above the Viewer.

Adjusting the Detail reduces points for X-Splines created with the Magnetic 
Freehand tool, while increasing points for normal X-Splines.

Square (Shift-S)
Creates a square or rectangular spline.

To create a Square, click and drag in the shape of a square and release the 
mouse.

Go to the Square tutorial to see how it works. 

Circle (Shift-C)
Creates a circular spline.

To create a Circle, click and drag in the shape of a circle and release the mouse.

Go to the Circle tutorial to see how it works. 
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Shape and Layer Parameters
Shape Parameters
All of the editable parameters of a shape can be adjusted in the Object 
Parameters. When a shape is selected, you will see the parameters listed 
below.

Blend Mode
Controls how objects are blended together.

Add
Adds the object to other objects.

Subtract
Subtracts the object from other objects.

Multiply
Produces a result where there is a union of pixels from two objects.

Difference
Produces a result where a value exists in each object, but not in both.
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Max
Looks at the luminance information for each object and selects the value—
whichever is brighter—as the result. Darker pixels are replaced while brighter 
pixels do not change.

Inside
Places the object inside the alpha generated by the objects below it.

Blur
Sets the blur level of the selected shape or shapes. The Blur range is from 0-
100 and defaults to 0.

Blur Type
Determines the type of blur.

• Centered

The blur is centered on the edge of the shape, equally blurring inward and 
outward.

• Inner

The shape is blurred inward from the edge of the shape.

• Outer

The shape is blurred outward from the edge of the shape.

Shrink/Grow
Shrinks or grows the shape’s alpha channel. Negative values shrink and 
positive values grow.

Opacity
Sets the opacity of the selected shape. The opacity range is from 0-100 and 
defaults to 100. The interpolation type is set to Hold by default making it easy 
to turn shapes on and off at particular frames.

Note: You can change the Opacity interpolation type from Hold to Linear at any time. 
To do so, select the shape’s Opacity keyframes in the Timeline, right-click and select 
Interpolation > Linear.

Invert
Inverts the shape values. The default is off.
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Motion Blur
Motion blur is the directional blurring of rapidly moving shapes. This parameter 
turns motion blur on or off for the selected shape or shapes. The default is off. 
To affect a shape, Motion Blur also needs to be enabled in the Node window. 
See the Motion Blur section of the Roto Node parameters for more 
information.

Note: Normally, motion blur is calculated going forward, so if there is no shape motion 
beyond the end of a clip, there won’t be motion blur on the last frame. To work around 
this, add an extra frame or two to the end of the work range in the Timebar and move 
the shape’s last keyframe to be outside of the session range.

Color
Sets the color of the shape outline. Left-clicking the color pot opens a standard 
color picker while right-clicking on the color pot opens a pop-up color menu with 
16 primaries.

When the Roto node’s Color > Enable parameter is on, this sets the color of the 
filled shape.

Stroke Width
Sets the thickness of an open shape. When used on a closed shape, an outline 
is created.

Cap Style
Sets the end cap style for open shapes. You can choose from Flat or Round 
styles.

Channel
Determines what channel the shape is rendered into. You can set each shape 
to Red, Green, Blue, or Alpha. To visualize the results prior to rendering, use 
View > Channels in conjunction with the Alt-R, G, B and A shortcut keys. When 
ready, render shapes into the assigned channels with the Actions > Render 
Shapes to Channels action.
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Go to the Rendering Shapes to Channels tutorial to see how it works. 

Reset All
Resets all parameters to their default state.

Layer Parameters
Layers are used to organize shapes, but more importantly they are used to 
contain the motion information from trackers. All of the editable parameters of 
a layer can be adjusted in the Object Parameters. When a layer is selected, you 
will see the parameters listed below. The Transform, Stereo Offset, Blend 
Mode, Blur and Invert state of a layer can be adjusted.

Note: When in the Left or Right View of a stereo project, adding a layer creates it in 
either the Left or Right View. In the Left/Right View, a layer is created in both the Left 
and Right Views.
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Transform
The Position, Scale, Rotation, Corner-Pin and Anchor Point can be adjusted 
and animated.

Anchor
Sets the anchor point for the layer transformation. Scaling and rotation 
operations center around the anchor point.

Position
Sets the horizontal and vertical position of the layer. 

Scale
Sets the horizontal and vertical scale of the layer. Typing in a negative value will 
flip or flop the shapes in the layer.

Rotate
Sets the rotation of the layer.

Corner-Pin
The layer can be corner pinned by adjusting the Corner-Pin values.

Upper-Left
Controls the X and Y position of the Upper Left Point.

Upper-Right
Controls the X and Y position of the Upper Right Point.

Lower-Right
Controls the X and Y position of the Lower Right Point.

Lower-Left
Controls the X and Y position of the Lower Left Point.

Matrix
When tracking data is applied to a layer, the Matrix parameter is used to store 
the tracker keyframes.

Stereo Offset
Stereo Offset, which only shows up when using stereo sources, is used to align 
the offset between Left and Right Views of stereo clips and is set to animate by 
default. This value is automatically set when using the Viewer’s Stereo Align 
mode’s on-screen control.
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Blend Mode
Controls how layers are blended together. See the Blend Mode section for 
more information.

Blur
Sets the blur level of all shapes within the layer. The Blur range is from 0-100 
and defaults to 0.

Blur Type
Determines the type of blur.

• Centered

All shapes in the layer are blurred equally inward and outward centered on the 
edge of the shapes.
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• Inner

All shapes in the layer are blurred inward from the edge of the shapes.

• Outer

All shapes in the layer are blurred outward from the edge of the shapes.

Invert
Inverts all shapes within the layer. The default is off.

Channel
Determines which channel the shapes in the layer are rendered into. You can 
set a layer to Red, Green, Blue, or Alpha. To visualize the results prior to 
rendering, use View > Channels in conjunction with the Alt-R, G, B and A 
shortcut keys. When ready to render into the assigned channels, use the 
Actions > Render Shapes to Channels action.

Note: This overrides the Shape > Channel setting, except when set to Alpha, in which 
case the shape’s Channel setting is obeyed instead.

Go to the Rendering Shapes to Channels tutorial to see how it works. 

Reset All
Resets all parameters to their default state.

Transform
Once you draw a shape, there are various ways to modify it. As the object that 
you are attempting to Roto changes over time, you will need to adjust the shape 
so that it exactly matches the object. While the Transform tool affects an entire 
shape or a group of shapes, you can use Reshape to modify individual points 
on a shape. See Reshape for more information.

Go to the Transform tutorial to see how it works.
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Transform - Shape Mode (T)
Transform Shape Mode allows you to position, move, scale, rotate, shear or 
corner-pin a shape or selection of shapes using the on-screen controls. To 
enter this mode, press either Transform in the Toolbar or the T key once. Then, 
select a shape and use the on-screen controls to modify it.
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 Transform On-Screen Controls

If there are any selected layers while in the Transform tool, pressing Q, W or E 
and then clicking and dragging will translate, rotate or scale the selected layers. 
If there are no selected layers, you must select a shape or group of shapes 
before clicking and dragging. Also, the position of the cursor when W or E is 
pressed sets the anchor point for the rotation or scale operation.

Shortcut Action

Drag shape Moves the shape

Shift-drag shape Constrain shape movement horizontally or 
vertically

Drag bounding box corner or edge handle Scales a shape

Shift-drag bounding box corner or edge handle Proportionally scale a shape

Ctrl/Cmd-drag on a bounding box corner handle Rotate a shape

Alt-drag on a bounding box corner handle Corner-pin a shape

Alt-Shift-drag on a bounding box corner handle Constrains the corner-pin movement to one axis

Ctrl/Cmd-drag on a bounding box edge handle Shear a shape

. (period key) Turns the Anchor Point on or off

Drag on Anchor Point Moves the Anchor Point

Shift-. (period key) Moves the Anchor Point to the mouse location

Q Activates / Deactivates translation of selected 
shapes or layers

W Activates / Deactivates rotation of selected 
shapes or layers

E Activates / Deactivates scaling of selected 
shapes or layers

Q, W, E then Ctrl/Cmd Translates, Rotates or Scales in finer increments

Ctrl/Cmd-W Rotates without setting the anchor point

Ctrl/Cmd-E Scales without setting the anchor point
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Transform - Points Mode (TT)
Transform Points Mode allows you to position, move, scale, rotate, shear or 
corner-pin a selection of points using the on-screen controls. To utilize this 
mode, use Reshape to first select some points

and then press either Transform twice in the Toolbar or the T key twice. 

Instead of a bounding box with on-screen controls around the shape, the 
bounding box is around the selected points.

Moving Shapes
Selected shapes are moved using one of three methods: 

1 Drag on the outline of a shape.

2 Nudge the shapes using the arrow keys. See Nudging for more information.

3 Press the Q key to activate translation mode and click and drag to move the 
selected shapes. You must press the Q key a second time to deactivate 
translation mode.
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In either case, you can constrain movement along an axis by pressing the Shift 
key while dragging the outline of a shape. The movement is constrained by the 
first direction (horizontal or vertical) that you drag in.

Scaling Shapes
Scaling changes the size of the shapes. Selected shapes are scaled using one 
of two methods: 1) Drag any of the points on the shape bounding box or 2) 
Press the E key to activate scaling mode and click and drag to scale the 
selected shapes. You must press the E key a second time to deactivate scaling 
mode.

Note: The position of the cursor when E is pressed sets the anchor point for the scaling.

To proportionately scale, hold down the Shift key when resizing.

Rotating Shapes
Rotating changes the angle of the shapes. Selected shapes are rotated using 
one of two methods: 1) Ctrl/Cmd-drag on a shape bounding box corner handle 
or 2) Press the W key to activate rotation mode and click and drag to rotate the 
selected shapes. You must press the W key a second time to deactivate 
rotation mode.

Note: The position of the cursor when W is pressed sets the anchor point for the 
rotation.
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Corner-Pinning Shapes
The corner points of a shape’s bounding box can be corner-pinned. For 
instance, you could fit the corners of a shape into the corners of a billboard. Alt-
drag the corners of the shape’s bounding box to corner-pin the shape.

Shearing Shapes
Shapes can be sheared resulting in the shape being skewed horizontally or 
vertically. To shear a shape, Ctrl/Cmd-drag on the midpoints of a shape 
bounding box on either the horizontal or vertical axis.

Anchor Point
A shape rotates around its center point, but scales from the opposite handle. 
Moving the anchor point changes the center of rotation and scaling when using 
the on-screen controls. To position the Anchor Point, press the . (period key) 
and the Anchor Point is displayed on the screen. Then, click and drag the 
Anchor Point to the desired location.
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Now, when you rotate or scale the shape, notice how the shape rotates and 
scales around the Anchor Point.

Note: If more than one shape is selected, they will both rotate and scale around the 
Anchor Point.

Cutting, Copying and Pasting Shapes
Shapes can be cut(Ctrl/Cmd-X), copied(Ctrl/Cmd-C) and pasted(Ctrl/Cmd-
V).

Deleting Shapes
A shape or selection of shapes can be easily deleted using none other than the 
Delete key.

Selecting Shapes

Stereo Shape Selection
• When in the Left/Right View, selecting a shape also selects its linked shape.

• While in the Left/Right View, in the Transform and Reshape tools, changing the 
selection state of a stereo linked shape will do the same to the linked shape.

• It is possible to only select one of the two linked objects:
1. In the Left/Right View by using the Object List.
2. In the Transform tool by Alt-clicking a shape. 
3. In the Reshape tool by Alt-clicking an unselected shape.

• An Alert icon appears over the Left or Right View icons if there is a selected shape 
in the other view.

Shortcut Action

Click on a shape Selects the shape

Shift-click a shape or drag select multiple shapes Selects multiple shapes

Ctrl/Cmd-click on a shape Toggles the shape selection

Click anywhere off the shape Deselects all shapes

Shift-click color pot in the Object List Selects shapes of same color
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Transform - Layers
When a layer is selected and the Transform tool is active, you can set the 
Position, Scale, Rotation, Corner-Pin and Anchor Point of the layer using the 
on-screen controls.
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 Layer Transform On-Screen Controls

You can also use the arrow keys to nudge the layer. See Nudging for more 
information.

Shortcut Action

Drag within large center circle Moves the layer

Shift-drag within large center circle Constrain layer movement horizontally or vertically

Drag the intersection of the center square 
and the horizontal and vertical lines

Scales the layer horizontally or vertically

Drag the center square corner Proportionally scale the layer

Drag large center circle Rotate the layer

Ctrl/Cmd-drag large center circle Rotates the layer with finer control

Drag handles on corners of image Corner-pins the layer

Drag small center circle Moves the Anchor point

Q Activates / Deactivates translation of selected layers

W Activates / Deactivates rotation of selected layers

E Activates / Deactivates scaling of selected layers

Q, W, E then Ctrl/Cmd Translates, Rotates or Scales in finer increments
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Reshape
Reshape modifies shapes by adjusting their control points and tangents. In this 
mode, the shape’s control points and tangents are visible. You must first select 
a control point before it can be modified.

Reshape - Normal Mode (R)
Selected points all move the same amount.

Reshape - Magnet Mode (RR)
Points near the cursor move more than points farther away.

While in Magnet mode with multiple selected control points, you can Shift-Alt 
click in the Viewer, not on any control points or shapes, and that becomes the 
magnet pull position instead of using a point.

Note: If you prefer, use the Shape > Default Reshape Tool preference to set Magnet 
mode as the default mode.
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Selecting Control Points
Click on a single point to select it, Shift-click to add to the selection or 
Ctrl/Cmd-click to toggle the point selection.

Rectangular Selection
Click and drag a rectangle over the control points to be selected. This is the 
default behavior.

Freehand Selection
Control points can be selected by drawing a freehand polygon. Ctrl/Cmd-drag 
in the Viewer to begin the selection. Once the selection is started, release 
Ctrl/Cmd and complete the selection.

Note: A Shape > Freehand Point Selection preference controls whether freehand 
selection is used by default. Pressing Ctrl/Cmd and dragging uses the non-default 
method of selection. See the Shape Preferences for more information.

 Control Point Selection Keyboard Shortcuts 

Note: When in the Left/Right View of a stereo project, changing point selection on one 
shape will match the point selection on the linked shape.

Go to the Reshape tutorial to see how it works.

Shortcut Action

Click on a control point. If the control point is part of a 
Bézier curve, its tangents appear

Selects the control point

Shift-click the control points or drag select multiple 
control points

Selects multiple control points

Ctrl/Cmd-drag in the Viewer to begin the selection. Once 
the selection is started, release Ctrl/Cmd- and complete 
the selection

Freehand select multiple control points

Ctrl/Cmd-Alt-I Inverts the point selection

Alt-Shift-A Selects all control points

Alt-Ctrl/Cmd-A Deselects all control points

Ctrl/Cmd-click on a control point Toggles the point selection

Click anywhere off the shape Deselects all control points
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Adding Control Points
Adding control points assists in tracing more detailed images. To add a control 
point, Alt-click on the selected shape. Don’t click on an existing control point 
because it will move it instead.

Note: In a stereo project, adding points is only allowed when in the Left/Right View 
when both shapes are selected.

Deleting Control Points
You can delete control points in one of two ways. Select the control point and 
press the Delete key or right-click on the control point and select Delete from 
the Reshape pop-up menu.

Note: In a stereo project, deleting points is only allowed when in the Left/Right View 
when both shapes are selected and when both shapes have the same selected control 
points.

Moving Control Points
Control points are easily moved. Just select one or more control points and 
drag one of the selected points to a new location. You can also use the arrow 
keys to nudge the points. See Nudging for more information.

Numbering Points
All points or a selection of points can be numbered. To number one point or a 
selection of points, right-click on a selected control point and select Tag. To see 
all points numbered, go to File > Preferences > Shape on Windows and Linux 
or Silhouette > Preferences > Shape on Mac and set the Number Points 
preference to All.
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Feather
A shape’s points can be feathered to create variable edged blurs on a point by 
point basis.

Closed Shapes
In the Reshape tool, selected points display a red, outward feather handle. 
Dragging this handle outward will pull the feather out.

After the initial drag, the outer feather point can be dragged around 
independently.

To drag shape and feather points simultaneously, press Shift while dragging 
the shape point.

The display of the feather handles can be hidden using Alt-F.
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Feather Shortcuts

Open Shapes
In the Reshape tool, select an open shape, adjust the Stroke Width to set its 
thickness and choose either a flat or round Cap Style in the Parameters 
window. Once you've done this, additional per-point feather handles appear--a 
red one for the Stroke Width and a green one for the Feather.

Just drag on the handles to make adjustments.

Multiple selected points can be dragged simultaneously and by a proportionate 
amount. To move the shape and feather points simultaneously, press Shift 
while moving the shape point.

Go to the Feather tutorial to see how it works.

Shortcut Action

Alt-F Toggles the shape feather handle on/off

Shift-Drag Shape Point Moves shape and feather points simultaneously
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Shape Pop-up Menu
Right-click over a control point to open the Reshape pop-up menu and select 
one of the options. The options will change depending on the type of shape that 
is selected.

To modify multiple selected points simultaneously, do not right-click on one of 
the selected points. Right-click on an open area of the Viewer instead.

Invert Selection
Inverts control point selection state.

Delete
Deletes the selected control point.

Break
Breaks the shape at the selected control point.

Close
Closes an open shape.

Reset
Resets the attributes of the selected control point.
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Bézier Options
Linear
Both tangents are adjusted to one quarter the distance and in the direction of 
their adjoining control points.

Corner
Creates a corner point.

Cardinal
Creates a smooth point where the curve passes smoothly through it.

B-Spline Options
Corner
Creates a corner point.

B-Spline
Creates a smooth point that is determined by the surrounding points.

X-Spline Options
Corner
Creates a corner point.

Cardinal
Creates a smooth point where the curve passes smoothly through it.

B-Spline
Creates a smooth point that is determined by the surrounding points.

Center
Centers the control point between its adjoining control points.

Tag
Tags control points for point numbering. For point numbers to be displayed, the 
Shape > Number Points preference must be set to Tagged.

Tween
Takes the point and “re-tweens” it using the surrounding keyframes, and puts 
them where they would be if you hadn't moved them on that frame. Useful for 
simulating an “unkey” of selected points (the shape remains keyed of course).
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Reverse
Reverses the order of all control points on all keyframes. Useful for warping and 
morphing, Reverse is used when you are trying to join two shapes where the 
control points go clockwise in one and counter-clockwise in the other. In this 
case, the correspondence points would iterate in different directions and the 
lines would cross each other. Reversing the points of one of the shapes would 
make them go in the same direction and the correspondence would be correct.

Combine Shapes
Copies selected points from a source shape between the selected points of a 
target shape.

Combining Shapes
• Select the points from a source shape to be copied into a target shape.

• Ctrl/Cmd-click the target shape in the Object List.

• Select two adjacent selected points in the target shape.

• Right-click and choose Combine Shapes.

Extract Shape
Extracts the selected points of a shape into a new closed shape.

Breaking Shapes
In the Reshape tool, closed shapes can be opened using the Break option from 
the control point pop-up menu. To break a shape, select a point and right-click 
on it to open the pop-up menu. Choose Break and the shape opens at the 
selected control point.

Note: Feather information will be removed once you break a shape.

Closing and Extending Shapes
Shapes can be closed or extended with just a few mouse clicks. It is necessary 
to use the Reshape tool to perform the following actions.

Closing Open Shapes
Select one of the control points at the end of the shape and Alt-click on the 
other end point to close the shape.
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Extending Shapes
Select a control point at either end of the shape and Alt-click somewhere off 
the shape.

Joining Open Shapes
In the Reshape tool, open shapes can be joined together. To join open shapes, 
select one of the end points of the source shape by clicking on it. Next, make 
sure both shapes are selected in the Object window. Finally, Alt-click on one of 
the end points of the target shape. The two shapes are now joined together as 
one.

Note: The target shape inherits the attributes of the source shape.

Converting B-Splines or X-Splines to Bézier Splines
You may convert your B-Splines or X-Splines to Bézier splines at any time. To 
convert a B-Spline to a Bézier spline, select a B-Spline or X-Spline and choose 
the Edit > Spline > Convert to Bézier menu item.

Once you select Convert to Bézier, a couple of things happen. The visibility of 
the B-Spline or X-Spline is toggled to off. A new Bézier spline is created and is 
named the same as the B-Spline or X-Spline but has an * at the end of the 
name.

Note: The Bézier conversion of B-Splines that use extreme, variable weight 
adjustments will not exactly match the original B-Spline. Do not use extreme, variable 
weight adjustments if you are planning on converting the B-Spline to a Bézier.

Nudging
Shapes, control points and layers can be nudged using the Arrow keys. One 
press of the Arrow key moves 1 pixel. Using the Shift key in conjunction with 
the Arrow keys moves 10 pixels. Ctrl plus the Arrow keys moves one tenth of 
a pixel. These nudge values can be changed in the Preferences menu located 
in File > Preferences > Nudging on Windows and Linux or Silhouette > 
Preferences > Nudging on Mac. Holding the Arrow keys down moves the 
selection continuously.
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 Nudging Keyboard Shortcuts

Note: Nudging of the layer transform is only available if one layer is selected, and no 
shapes are selected. This is to avoid confusion in case nested layers or objects in them 
are also selected.

IK-Inverse Kinematics (Y)
In computer graphics, inverse kinematics (IK) is a technique that provides 
automatic movement of objects. It allows elements of an object to be linked, 
such as the parts of an arm or leg, and causes them to move in a prescribed, 
realistic manner. IK simplifies the process of rotoscoping jointed, segmented 
figures by making the motion of each part related to the motion of the linked 
parts. That way, you simply have to animate the starting and ending joints, and 
the ones in between will adjust themselves and create more natural looking 
movement.

Go to the IK tutorial to see how it works.

Shortcut Action

Arrow keys Moves by 1 pixel

Shift-Arrow keys Moves by 10 pixels

Ctrl/Cmd-Arrow keys Moves by one tenth of a pixel

Hold down Arrow keys Moves continuously

Q, W, E then Ctrl/Cmd-drag Translates, Rotates or Scales in finer increments

Q, W, E then Arrow keys Translates, Rotates or Scales by 1 pixel

Q, W, E then Shift-Arrow keys Translates, Rotates or Scales by 10 pixels

Q, W, E then Ctrl/Cmd-Arrow keys Translates, Rotates or Scales by 1/10 of a pixel
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Silhouette implements IK within its existing infrastructure by using layers to 
model joints with one or more shapes in each layer to represent the pieces of 
the object. To do an arm, you would have this layout:

Arm, Elbow and Wrist are layers while Upper Arm, Forearm and Hand are 
shapes located in the appropriate layer.

Once the layers and shapes have been setup, the joints need to be placed by 
positioning the Anchor Point of each layer using the Transform tool.

Arm

Elbow

Wrist

Joints
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With the IK tool selected, select the shapes and an IK chain is built on the fly 
that flows up the shape's layer tree to the top-most layer. Each layer’s Anchor 
Point becomes a joint in the IK chain. The “bones” are just the connections 
between the layer anchors.

Click-drag a bone or shape to rotate the shape around the parent’s anchor 
point. Click-dragging a joint uses IK to rotate all joints up the chain. Alt-click-
drag a joint to move the joint while attempting to keep other joints in place. 

When animated, keyframes are automatically set for each layer’s rotation 
parameter. However, you can explicitly set the layer rotation keyframes by right-
clicking on a selected bone and choosing Add Key.

Note: To quickly jump between the Reshape, Transform, and IK tools while editing a 
shape, use the shortcut keys: R for Reshape, T for Transform and Y for IK. R, T and Y 
are very convenient since they are right next to each other.
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 IK Editing

Tracker
Tracking is a technique that involves analyzing the motion of an image over 
time. In Silhouette, images can be tracked using an automatic image tracking 
system called Planar Tracking or Point Tracking which utilizes either one, two 
or four track points. Silhouette includes two Planar Trackers: Silhouette’s 
Planar Tracker and the Mocha Planar Tracker.

Go to the Tracker node to see how it works.

Action Result

Click-drag bone or shape Rotates the shape around the parent’s anchor point

Click-drag joint Uses IK to rotate all joints up the chain

Alt-click-drag joint Moves the joint but tries to keep other joints in place

Right-click bone-Add Key Sets keyframes for the selected bones
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MultiFrame (M)
Normally, adjusting a shape or points on a shape are keyframed only on that 
particular frame. When MultiFrame is activated, it modifies the Transform and 
Reshape tools to allow you to make adjustments across all previously set 
keyframes or a selection of keyframes. A red outline is drawn around the 
Viewer to let you know that MultiFrame is active.

To use MultiFrame, select it in the Toolbar. Then, drag the red ends of the 
MultiFrame range bar at the top of the Timeline to limit the keyframes affected 
by MultiFrame.

Note: The MultiFrame range is displayed in the status bar while it is being edited.

The Transform or Reshape tools will now only affect keyframes within the 
MultiFrame selection.

Go to the MultiFrame tutorial to see how it works.

Note: When using MultiFrame, attempts to edit a shape outside the MultiFrame work 
range will be ignored. If you try to, for example, transform a shape and nothing 
happens, check to see if the MultiFrame range is active at that particular point in time.

Add Weighted Key (Alt-K)
Add Weighted Key creates a keyframe at the current position which changes 
the timing of the animation between two surrounding keyframes. Park between 
two keyframes, select a shape, press Alt-K, and drag the slider to adjust the 
weight.



Silhouette User Guide    

• • • •••

Nodes  726 
• • • •••

RotoOverlay (Shift-O)
The RotoOverlay tool provides three options to visualize the selected shape’s 
animation and motion blur: Motion Path, Motion Blur and Onion Skin.

Once selected, a Roto Overlay window opens allowing you to select or deselect 
various options.

Motion Path
Displays the shape’s motion path with visual indicators for frames and 
keyframes.

Hold Alt over a motion path marker and the frame number is displayed in the 
status bar. Click on the marker and the Timebar will jump to that frame.
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Motion Blur
Displays a dashed line to show the width of the motion blur.

Note: When the Viewer is set to Foreground, this option allows you to visualize the 
motion blur without rendering it. This provides a significant speed increase when using 
many shapes with motion blur.

Onion Skin
Shows the shape outline on previous and future frames.

Hold Alt over an onion skin shape and the frame number is displayed in the 
status bar. Click on the shape and the Timebar will jump to that frame.
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Onion Skin Frame Range
Determines the amount of frames used in the onion skin.

Backward
The Onion Skin Frame Range Backward numeric field (the first one) displays 
the frames before the current frame.

Forward
The Onion Skin Frame Range Forward numeric field (the second one) displays 
the frames after the current frame.

Note: By default, the Backward and Forward numeric fields are ganged together. Click 
the lock icon to decouple them.

Use Shape Color
As an alternative to using the pre-defined colors for the Motion Path, Motion 
Blur and Onion Skin, you can use the default shape colors.

Shape Import and Export
Importing Shapes
Silhouette, Mocha Pro, Commotion, Elastic Reality and Shake 4.x SSF shapes 
can all be imported into Silhouette using the File > Import > Shapes menu.

Note: Mocha Pro shapes and layers are imported into Silhouette using the Silhouette 
Shapes format. If Copy to Clipboard was used in Mocha Pro instead of saving to a file, 
the shapes and layers are copied to the system clipboard and can then be pasted into 
a Silhouette Roto node.

Go to the Import tutorial to see how it works.

Exporting Shapes
Silhouette, Fusion, gMask (Combustion, Flint, Flame, Inferno), Nuke and 
Shake 4.x SSF shapes can all be exported using the File > Export > Shapes 
menu.

Go to the Export tutorial to see how it works.
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After Effects
Importing Silhouette Shapes into After Effects
The Silhouette Shape Import/Export Plug-in for After Effects is required to 
convert Silhouette Shapes into After Effects masks. When importing Silhouette 
Shapes, the following shape parameters transfer into After Effects: opacity, 
blur, shape color, shape name, invert and locked states, transfer mode and per-
shape motion blur state.

Go to the After Effects section of the Import tutorial to see how it works.

Exporting After Effects Masks to Silhouette Shapes
The Silhouette Shape Import/Export Plug-in for After Effects is required to 
convert After Effects masks to Silhouette Shapes. When exporting After Effects 
masks, the following shape parameters transfer into Silhouette: opacity, blur, 
shape color, shape name, invert and locked states, transfer mode and per-
shape motion blur state.

Go to the After Effects section of the Export tutorial to see how it works.

Notes
1 When importing and exporting Silhouette Shapes using the Silhouette Shape 

Import/Export Plug-in for After Effects, the general rule is that the After Effects 
composition size must match the Silhouette session size for shapes to import 
and export properly. However, as long as the ratio of the sizes between the After 
Effects composition and the Silhouette session match, you can successfully 
import and export shapes between them. For instance, you could import or 
export shapes from a 2000x1000 Silhouette session to a 1000x500 After Effects 
composition with no problems, as long as the pixel aspects were the same.

2 When After Effects has the Preserve Constant Vertex Count in the General 
Preferences dialog deactivated, it is possible for a differing number of control 
points to occur on different keyframes. These type of shapes can’t be imported 
into Silhouette.
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Commotion
Importing Shapes
When importing Commotion shapes into Silhouette, the following shape 
parameters transfer into Silhouette: shape visibility, shape locked state, shape 
motion blur on/off state. If the shape is invisible in Commotion, it will start out 
invisible in Silhouette, so it might not look like it was imported unless you have 
the Object List open.

Note: You can’t import Commotion B-Splines made with just 3 points.

Nuke
Exporting Shapes
There are three Nuke shape export options--Nuke 5 Shapes, Nuke 6.2+ 
Shapes and Nuke 9+ Shapes.

Nuke 5 Shapes
Nuke 5 Shapes (for Nuke 5.1v3 and above), Silhouette shapes and their blend 
modes are exported. Silhouette will also export Hold and Linear key frames for 
Opacity. When exported, tracker and shape data are baked together.

Nuke 6.2+ Shapes
Nuke 6.2+ Shapes will export the shape opacity, blend mode, invert, motion 
blur, outline color, shape blur (inner and outer blur only) as well as the layer and 
node blur and motion blur.

Nuke 9+ Shapes
Nuke 9+ Shapes will export open/closed shapes, the shape feather, opacity, 
blend mode, invert, motion blur, outline color, fill color, shape blur (inner and 
outer blur only), and visibility. The layer’s blur, visibility and motion blur are also 
exported in addition to the node blur. You can optionally fully bake shape and 
transform data, convert opacity to Nuke Lifetime, and export the Silhouette 
project name as determined by the Nuke 9+ Shapes preferences.

Notes
1 X-Splines and B-Splines are converted to Bezier's in Nuke.

2 Only Blurs set to Inside and Outside will transfer to Nuke.

3 Blend Modes
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• Multiply is not supported as Nuke and Silhouette’s notion of Multiply are different. 

• Inside is not supported as Nuke has no equivalent.

4 Layer blend modes are not implemented as Nuke does not support them.

5 Nested transformations are exported fully baked because Nuke does not actually 
nest transformations in its layers. If a layer contains only shapes or only layers, 
nested transforms are exported. This is the preferred case. If a layer contains 
layers and shapes, transforms are baked into the shape transform--not the shape 
points.

Shake
Import
Shake 4.x shapes are imported into Silhouette, but attributes such as 
feathering, color and opacity are ignored.

Export
Silhouette will export the shape name, locked/unlocked state, opacity, visibility, 
motion blur on/off, shutter angle, and shutter phase. In addition, subtractive 
shapes import into Shake as black in the RGB channels with a white alpha 
channel.

Node Parameters
When the Roto node is being edited in the Trees window, parameters specific 
to the Roto node, such as Motion Blur, can be adjusted in the Node parameters.

Alpha
Invert
Inverts the alpha channel.

Blur
Blurs the alpha Channel. The blur range is from 0-100 and defaults to 0.

Color
Renders shapes as outlines or filled with color in the RGB output. The color is 
set using the Shape > Color parameter.

Enable
Activates the color parameters.
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Outline Size
Sets the thickness of the shape outline.

Fill Opacity
Sets the opacity of the color fill. You can also change the opacity of each shape 
separately using the Shape > Opacity control.

Motion Blur
Motion blur is the directional blurring of rapidly moving shapes. Enables Motion 
Blur for the Roto node. 

Go to the Motion Blur tutorial to see how it works.

Enable
Turns Motion Blur on or off. The default is off. Leave this turned off for faster 
interaction while editing shapes.

Note: The Motion Blur parameters will not affect shapes unless you first activate Motion 
Blur for each shape in the Object Parameters. See the Motion Blur section in the 
Shape Parameters for more information.

Shutter Angle
Determines how long the camera shutter stays open when a picture is taken-- 
higher values create more motion blur. The range of the Shutter Angle is 0-720 
and defaults to 180. Measured in degrees, it simulates the exposure of a 
rotating camera shutter. The shutter angle uses the footage frame rate to 
determine the simulated exposure. For example, a shutter angle of 180 
degrees (50% of 360 degrees) for 24fps footage creates an effective exposure 
of 1/48 of a second. Typing 1 degree applies almost no motion blur, and typing 
720 degrees applies a high degree of motion blur.

Shutter Phase
Offsets the point in time, either forward or reverse, when the shutter opens. The 
range of the Shutter Phase is -360 to 360 and defaults to -90.
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Motion Samples
Renders intermediate frames equal to the Motion Samples value and 
accumulates them, one over the other, on a single frame. The higher the 
number, the smoother the motion. The Motion Samples range is from 1-256 
and defaults to 16.

Note: Normally, motion blur is calculated going forward, so if there is no shape motion 
beyond the end of a clip, there won’t be motion blur on the last frame. To work around 
this, add an extra frame or two to the end of the work range in the Timebar and move 
the shape’s last keyframe to be outside of the session range.

Antialias
Controls whether roto shapes are antialiased on their edges.

Node Outputs
Output
Outputs the foreground input and generated matte.

Color Composite
Outputs a composite of the foreground over a solid color based on the Roto > 
Composite Color preference. The default color is gray.

Composite
Outputs a composite of the foreground over the background based on the 
generated matte.

Channels
Renders shapes to different channels of an RGBA image as defined by the 
Shape > Channel parameter.

Objects
Outputs tracked layers and shapes for use in nodes with Transform or Objects 
inputs.
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Roto Blend
Description

Smoothly blends the opacity of shapes together which can then be further 
manipulated in the Depth node.

Since shapes are required for the Roto Blend node, it has its own shape tools 
similar to those in the Roto node. See the Roto Node for more information.

Go to the Roto Blend tutorial to see how it works.

Node Group
Image, Silhouette.

Node Parameters
When the Roto Blend node is being edited in the Trees window, parameters 
specific to the Roto Blend node can be adjusted in the Node parameters.

Precision
Sets the computing precision of the Roto Blend node. There are Draft, Normal 
and Better choices.

Draft
Draft mode provides a fair representation of your work but has clearly visible 
defects. It is fast, interactive and very responsive, but is not intended for 
finished work.

Before

Copyright © 2008--www.iofoto.com

After
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Normal
Assuming you are using a reasonably modern machine, Normal can be used 
in most interactive situations and is sufficient for finished work.

Better
Better is slower than Normal, though still interactive on modern processors. It 
can be used for final renders although you should pre-check the final render 
before submitting it to a render farm.

Shape Parameters
Most of the roto tools contained in the Roto node are available in the Roto 
Blend node as well as parameters specific to shape blending. This includes B-
Spline, Bézier or X-Spline shapes in addition to point and planar tracking.

Opacity
Controls the opacity of shapes.
Color
Sets the color of shape outlines.
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Scatter
Description

Scatters pixels in a random fashion.

Node Group
Filter.

Controls
Radius
Sets the amount of scattering.
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Scratch
Description

Removes vertical scratches by averaging in the surrounding pixels. Uses the 
second input’s alpha to define the scratch area, or alternatively, the alpha of a 
single RGBA input.

Node Group
Filter.

Controls
Width
Controls the width of the Scratch filter.

Opacity
Sets the opacity of the Scratch filter.
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Screen Smoother
Description

Smooths out unevenly lit blue and green screens. By default, darker screen 
areas are brightened. 

When working with poorly lit blue and green screens, it is useful to apply the 
Screen Smoother prior to using zMatte. This will result in a better key.

Node Group
Key.

Controls
Color Correct
The Color Correct parameters allow you to adjust the color of the blue or green 
screen based on an extracted matte.

Hue
Rotates the hue of the blue or green screen.

Saturation
Adjusts the saturation of the blue or green screen. Positive values saturate, 
negative values desaturate.

Brightness
Adjusts the luminance of the blue or green screen. Positive values brighten, 
negative values darken.

Contrast
Adjusts the contrast of the blue or green screen. Positive values increase 
contrast, negative values decrease contrast.

Gamma 
Adjusts the gamma of the blue or green screen. The gamma adjustment leaves 
the white and black points the same and only modifies the values in-between. 
Positive values darken the image, negative values lighten the image.

Red
Adds or subtracts red from the blue or green screen.
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Green
Adds or subtracts green from the blue or green screen.

Blue
Adds or subtracts blue from the blue or green screen.

Matte
Extract On
Extract On selects the type of matte extraction.

Blue Screen
Choose blue screen if you have a blue screen.

Green Screen
Choose green screen if you have a green screen.

Position
The Position value pinpoints the blue or green screen values to be used in the 
matte. White values in the matte are the areas that will be adjusted by the color 
correction.

Range
Increases or decreases the range of values in the matte. A high Range value 
indicates a large range of values included in the matte.

Blur-Horizontal
The matte is blurred by a fast, quality blur along the X-axis resulting in a 
smoother, more even color correction.

Blur-Vertical
The matte is blurred by a fast, quality blur along the Y-axis resulting in a 
smoother, more even color correction.

Gang
The horizontal and vertical values can be ganged together.
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Selective Color Correct
Description

Colors can be selectively isolated through the use of a matte and adjusted 
using hue, saturation, brightness, gamma, contrast, temperature, 
cyan/magenta, red, green, and blue controls.

Node Group
Color.

Color Correct
Certain parts of the image are isolated by the creation of a matte. Whatever is 
shown as white in the matte can be adjusted by the color controls below. 

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
lighten the midtones, negative values darken the midtones.
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Temperature
Sets the color of the image to be either warmer or cooler. Dragging the numeric 
field to the right makes the image cooler (bluer) and dragging the numeric field 
to the left makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the numeric field to the 
right makes the image more magenta and dragging the numeric field to the left 
makes the image more cyan.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.

Matte
A matte is created to isolate areas to be color corrected. Using advanced image 
slicing algorithms, mattes are created using luminance, hue, saturation, 
average, red, green, blue, cyan, magenta, and yellow values.

Extract On
Extract On selects the type of matte. Select whichever type isolates the desired 
values.

A matte is created based on one of the following:

Luminance
A matte is created based on the luminance of the image.

Hue
A matte is created based on the hue of the image. When adjusting the Position 
parameter, you are selecting different hues.
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Saturation
A matte is created based on the saturation of the image.

Average
A matte is created based on the average of the image’s RGB values.

Red
A matte is created based on the image’s red values.

Green
A matte is created based on the image’s green values.

Blue
A matte is created based on the image’s blue values.

Cyan
A matte is created based on the image’s cyan values.

Magenta
A matte is created based on the image’s magenta values.

Yellow
A matte is created based on the image’s yellow values.

Position
The Position value pinpoints the color values to be used in the matte. For a 
luminance matte, a Position value of 100 would make a white matte of the 
highlights and a value of 0 would make a white matte of the shadows. In the 
flower image below, look at how the matte varies for different Position values in 
a red extraction. When the Position is at a value of 100, the red flowers are 
shown as white in the matte.

When the Position is moved to 50, the red flowers turn black.

Range
Increases or decreases the range of values in the matte. A low Range value 
indicates a narrow range of values. A high Range value indicates a large range 
of values included in the matte.
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Black Clip
Blacks in the matte are made blacker by increasing this value. As the value 
increases, more values are clipped to black. This is helpful for getting rid of 
unwanted gray areas in what should be the black part of the matte. 

White Clip
Whites in the matte are made whiter by increasing this value. As the value 
increases, more values are clipped to white. This is helpful for getting rid of 
unwanted gray areas in what should be the white part of the matte. 

Shrink/Grow
Shrinks or grows the matte. Negative values shrink and positive values grow 
the matte.

Blur
Blurs the matte.

Invert
• Off

Does nothing to the matte.

• On

Inverts the luminance values of the matte.
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Shadows/Highlights
Description

Shadows/Highlights lowers contrast evenly throughout the image by 
brightening shadow areas and darkening highlights. It is useful for correcting 
dark foreground subjects due to strong backlighting as well as highlights that 
are slightly washed out.

Node Group
Color.

Controls
Presets
To select a preset, choose one from the Presets tab.

Shadows
Shadows
Raises the brightness of the shadows.

Position
Selects the shadow values to be adjusted.

Range
Controls the range of values to be used for the shadows. A higher Range value 
considers more values as shadows. 

Highlights
Highlights
Lowers the brightness of the highlights.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 
considers more values as highlights. 

Go to the Matte section of Common Node Controls to see how the Position and 
Range controls work.
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Sharpen
Description

Enhances the sharpness or focus by selectively increasing the contrast 
between adjacent pixels along edges in an image.

Node Group
Filter.

Controls
Presets
To select a preset, pick one from the Presets tab.

Amount
Determines how much contrast is added at the edges.

Radius
Controls the size of the edges you wish to sharpen.

Threshold
The threshold setting is used to sharpen more pronounced edges, while 
leaving more subtle edges untouched. Low values sharpen more image areas 
while higher threshold values sharpen less.
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Silk
Description

Black Silk
Gives a silky-smooth look to textured surfaces, suppresses facial blemishes 
and wrinkles, while maintaining a clear, focused image. Creates a diffused 
image that doesn't look like it's been shot through a filter.

Gold Silk
Offers all the benefits of the Black Silk filter, but also infuses special warmth by 
adding a soft, golden tint to shadows.

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab. If you would like to view 
presets from a different category, use the pop-up menu at the top left of the 
Presets tab.

Detail
Smoothing
Fine image details, such as facial wrinkles and blemishes, are minimized using 
edge aware smoothing.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.

Matte
A matte can be used to limit the smoothing effect. Wherever there is white in 
the matte is where the smoothing will occur. Go to the Matte parameters to see 
how they work.
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Slap Comp
Description

Renders the alpha channel overlayed on the image as a color with opacity. This 
is especially useful for rendering Roto node shapes as a color over an image.

Node Group
Composite.

Controls
Color
The color can be set through the use of a standard color picker.

Opacity
Sets the amount of color.

Invert
Inverts the alpha channel.
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Source Nodes
Description

When media is imported into Silhouette, it becomes a Source node and is 
displayed in the Source window. Once a Source node is placed in the Trees 
window, the following parameters become available.

Alpha
Silhouette is a straight, unmatted compositor and its composite nodes expect 
unpremultiplied images. In addition, it is best practice to unpremultiply before 
color correcting premultiplied images so as to avoid unexpected results.

Type
Straight - Unmatted
Select this option if your source is Straight-Unmatted.

Premultiplied
Select this option if your source is Premultiplied. This will unpremultiply it.

Fill
None
No fill operation is performed.

Opaque
Makes the alpha channel opaque.

Transparent
Makes the alpha channel transparent.

Stream
The Stream parameters are where you identify which clips are used for the Left 
and Right Views when working with stereo images. The stereo tools in 
Silhouette only show up in the user interface when using a stereo EXR file, 
when left and right clips have been assigned in the Stream > Left and Right 
parameters, or when left and right clips are connected to the Merge Views 
node.

Note: Non-stereo sources only use the Left view.
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Left
Sets which clip is used for the Left View.

Right
Sets which clip is used for the Right View.

Note: Stereo EXR files which contain both the Left and Right Views within one file are 
automatically connected to the Left and Right views.

Depth
Sets which clip is used for the Depth map.

Time Shift
Shifts the source node in time.

Extend Duration
When enabled, the last frame of the clip will repeat if the session duration is 
longer.

Center
Centers the image when using a session that is smaller or larger than the 
source. 

• When the file’s Display Window is the same as the DOD, Center is enabled by 
default.

• When a file has overscan built in, Center is off by default.
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Split Field
Description

Split Field splits the image with a line that can be positioned, rotated and 
blurred. On one side of the line, the image is blurred and on the other, it is in 
focus.

Node Group
Diffusion.

Controls
Presets
To select a preset, choose one from the Presets tab.

Blur
Sets the softness of the split portion of the image.

Split
The Split controls manipulate the position, rotation and blur of the split line.

Position
There is an on-screen control in the center of the image. By clicking and 
dragging the on-screen control, the position of the split line can be adjusted.

Position X
The horizontal position of the split line.

Position Y
The vertical position of the split line.

Rotate
Rotates the split line.

Blur
Blurs the split line using a quality blur.
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Split Tone
Description

Shadows, midtones and highlights can be individually tinted with the Split tone 
filter.

Node Group
Tints.

Controls
Shadows
Opacity
Set the opacity of the tint color.

Color
The Color parameter sets the color of the shadow tint through the use of a 
standard color picker.

Position
Selects the shadow values to be adjusted.

Range
Controls the range of values to be used for the shadows. A higher Range value 
considers more values as shadows. 

Midtones
Opacity
Set the opacity of the tint color.

Color
The Color parameter sets the color of the midtone tint through the use of a standard 
color picker.

Position
Selects the midtone values to be adjusted.

Range
Controls the range of values to be used for the midtones. A higher Range value 
considers more values as midtones. 
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Highlights
Opacity
Set the opacity of the tint color.

Color
The Color parameter sets the color of the highlight tint through the use of a standard 
color picker.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 
considers more values as highlights.

Go to the Matte section of Common Node Controls to see how the Position and 
Range controls work.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 
tinting.
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Split Views
Description

Splits a combined left, right and depth clip into separate views.

Node Group
Image.
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Streaks
Description

The Streaks node creates horizontal or vertical streaks around highlights in the 
image.

Node Group
Light.

Controls
Presets
To select a preset, choose one from the Presets tab.

Streaks
Blend
Determines the blend mode to be used to create the streak effect.

Add
The streaks are added to your image.

Screen
The streaks are combined with the image using a Screen blend mode. This 
looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the streaks.

Streaks
Horizontal Streaks
Creates horizontal streaks.

Vertical Streaks
Creates vertical streaks.

Color
The Color parameter sets the color of the streaks through the use of a standard 
color picker. The default color is white.



Silhouette User Guide    

• • • •••

Nodes  755 
• • • •••

Matte
A matte is used to create the streak effect. Go to the Matte section of Common 
Node Controls to see how the Matte controls work.
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Sunset
Description

Sunset applies three photographic filters to the image which are blended 
together with a gradient. Presets for your favorite Color Gradient filters are 
provided as well as the ability to create custom colors.

Node Group
Tints.

Controls
Presets
To select a preset, choose one from the Presets tab.

Color 1
Sets the color for the top third of the image. Select the desired color using the 
color picker or choose a filter preset.

Presets
Select one of the filters from the pop-up list.

Color
The Color parameter sets the color of the grad through the use of a standard 
color picker.

Opacity
Sets the opacity of the color filter.

Color 2
The Color 2 controls are the same as the controls for Color 1 except it is applied 
to the middle third of the image.

Color 3
The Color 3 controls are the same as the controls for Color 1 except it is applied 
to the bottom third of the image.
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Highlights
Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Grad 
Grad is the combination of the three blended tints. Its direction, corners and 
size can be adjusted.Go to the Grad section of Common Node Controls to see 
how the Grad controls work.
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Swap Channels
Description

Swap Channels lets you shuffle channels.

Node Group
Composite.

Controls
Red
Red
Uses the red channel.

Green
Uses the green channel.

Blue
Uses the blue channel.

Alpha
Uses the alpha channel.

Luminance
Uses the average luminance of the RGB channels.

Black
Copies black into the red channel.

White
Copies white into the red channel.

Green, Blue and Alpha
The controls for the Green, Blue and Alpha pop-up menus work the same as 
the Red channel listed above.
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Switch Matte
Description

Similar to the Copy node, but is dedicated to copying a channel from input 
image 2 to the alpha channel of input image 1.

Node Group
Composite.

Controls
Source
Red
Copies the red channel from input image 2.

Green
Copies the green channel from input image 2.

Blue
Copies the blue channel from input image 2.

Alpha
Copies the alpha channel from input image 2.

Luminance
Uses the average luminance of the RGB channels from input image 2.

Black
Copies black into the red channel.

White
Copies white into the red channel.
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Texture
Description

Applies textures to an image for a stylized look.

Node Group
Special Effects.

Controls
Presets
To select a preset, choose one from the Presets tab.

Amount
Sets the amount of texture applied to the image.

Complexity
Generates a more detailed, repetitive texture.

Randomize
Randomizes the texture.

Transform
The texture can be manipulated using a Transform. Go to the Transform node 
to see how it works.



Silhouette User Guide    

• • • •••

Nodes  761 
• • • •••

Three Strip / Two Strip
Three Strip
Known and celebrated for it ultra-realistic, saturated levels of color, the 
Technicolor® Three Strip process was commonly used for musicals, costume 
pictures and animated films. It was created by photographing three black and 
white strips of film each passing through red, green and blue filters on the 
camera lens and then recombining them in the printing process. Our Three 
Strip filter was created under the direction of Academy Award Winning Visual 
Effects Supervisor Rob Legato.

Two Strip
The Technicolor® Two Strip process was the first stab at producing color 
motion pictures and consisted of simultaneously photographing two black and 
white images using red and green filters. This look creates an odd but pleasing 
hand-painted look where faces appear normal and green takes on a blue-green 
quality, while the sky and all things blue appear cyan. Our Two Strip filter was 
created under the direction of Academy Award Winning Visual Effects 
Supervisor Rob Legato.

Node Group
Film Lab.

Controls
Presets
To select a preset, choose one from the Presets tab.

Opacity
Sets the intensity of the of the effect.

Strips
Red Intensity
Intensifies red values in the image.



Silhouette User Guide    

• • • •••

Nodes  762 
• • • •••

Red Smooth
Blurs the red matte that is used to isolate the red values. Use this control to 
smooth out any noise that may appear if the Red Intensity is turned up to a high 
value.

Green Intensity
Intensifies green values in the image.

Green Smooth
Blurs the green matte that is used to isolate the green values. Use this control 
to smooth out any noise that may appear if the Green Intensity is turned up to 
a high value.

Blue Intensity
Intensifies blue values in the image when using the Three Strip filter, but 
darkens image areas that were blue in the source image when using the Two 
Strip filter.

Blue Smooth
Blurs the blue matte that is used to isolate the blue values. Use this control to 
smooth out any noise that may appear if the Blue Intensity is turned up to a high 
value.

Color Correct
Go to the Color Correct node to see how the Color Correct controls work.
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Time Blur
Description

Time Blur mixes frames together to create interesting motion effects. This node 
is also useful for smoothing out film grain and video noise which can cause 
problems when pulling a key or generating a matte.

Node Group
Time.

Controls
Frames
Sets the amount of frames to be blended.

Frame Window
Determines the positioning of the frame averaging window.

Past
The frame averaging window uses past frames.

Centered
Centers the frame averaging window around the current frame.

Future
The frame averaging window uses future frames.
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Tint
Description

Tints the entire image with a selected color using a variety of colorization 
modes.

Node Group
Tints.

Controls
Presets
To select a preset, choose one from the Presets tab.

Black and White
Enable
Converts the image to Black and White.

Filter
The Filter pop-up selects the type of black and white filter to be applied to your 
color image. Go to the Black and White section of Common Node Controls to 
see how the Black and White controls work.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
lighten the midtones, negative values darken the midtones.
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Tint
Color
Sets the color that the image will be colorized with. Select the desired color 
using the color picker.

Opacity
Sets the opacity of the color.

Mode
Selects how color is applied to the image.

Normal
Tints the image while retaining highlights.

Tint
The image is tinted by replacing hue and saturation.

Hue
The image is tinted by only replacing hue.

Lighten
Pixels darker than the color are replaced, and pixels lighter than the color do 
not change.

Darken
Pixels lighter than the color are replaced, and pixels darker than the color do 
not change.

Grad
Tint can optionally use a gradient that limits where the filter is applied. Grad is 
the transition area that goes from the tinted image to the original image. Its 
direction, corners and size can be adjusted. Go to the Grad section of Common 
Node Controls to see how the Grad controls work.
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Tone Adjust
Description

Tone Adjust approximates the appearance of high dynamic range images by 
adjusting the tonal values. Specifically, detail is recovered from the darker 
portions of the images and can optionally be denoised.

Node Group
Color.

Controls
Amount
Lightens shadows to reveal more detail. Take care not to over apply this setting 
and reveal image noise.

DeNoise
Removes film grain and noise in the shadow areas.

Position
Selects the shadow values to be adjusted.

Range
Controls the range of values to be used for the shadows. A higher Range value 
considers more values as shadows.
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Tracker
Description

Tracking is a technique that involves analyzing the motion of an image over 
time. Images can be tracked using an automatic image tracking system called 
planar tracking using either Silhouette’s Planar Tracker or the Mocha Planar 
Tracker. In addition, you can use a Point Tracker which utilizes either one, two 
or four track points. One point tracking obtains horizontal and vertical 
movement. Two point tracking analyzes scaling and rotation in addition to 
horizontal and vertical movement. Lastly, four point tracking evaluates and 
applies perspective movement using a corner-pin transformation.

However the tracking data is obtained, it can then be applied in one of two 
ways: match moving or stabilization. Match moving applies the motion of the 
trackers to an object so that it follows the motion of the clip. Stabilization inverts 
the tracking data so that the clip appears to be stable.

Selecting the Tracker (Shift-T) displays various tracking features and controls.

When the Tracker is selected, various non-animateable controls appear in a 
Tracker window located at the bottom portion of the screen. You have the 
choice of using either the Point Tracker, Planar Tracker or Mocha Tracker.
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Node Group
Transform.

Note: The Tracker is available as a separate node, but is also built into the Depth, 
Morph and Roto nodes. When the Objects output of these nodes is plugged into 
another node’s Transform input, the Tracker’s point trackers and transformed layers 
are available for use by selecting one of them in the input node’s Transform pop-up 
menu.

Planar Tracker
Silhouette’s Planar Tracker tracks several points (corners, edges and ridges) 
on the image while automatically handling partial occlusions of the tracked 
object, producing excellent results even with textureless objects.
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Using the Planar Trackers
The key to getting the most out of the Planar and Mocha trackers is to learn to 
find planes of movement in your shot which coincide with the object that you 
want to track. Sometimes it will be obvious--other times you may have to break 
your object into different planes of movement. For instance, if you were tracking 
a tabletop, you would want to draw the spline to avoid a flower arrangement in 
the center of the table, since it is not on the same plane and will make your track 
less accurate.

Planar Trackers Setup
Both the Planar and Mocha trackers require a selected layer with at least one 
shape in it to drive the tracker.

Note: If shapes are selected and not in a layer, clicking the Track Forward/Backward 
buttons will create a new layer, make it active and begin tracking.

If shapes are selected in an unselected layer, clicking the Track Forward/Backward 
buttons will make the layer active and begin tracking.

The shape should surround the object you are tracking, but it does not have to 
be exact and it is best to leave a little extra room around it. In addition, you can 
use more than one shape as long as they are on the same geometric plane.

Handling Occlusions
In some cases, there are parts of an image that can interfere with the 
effectiveness of the Planar and Mocha trackers. To handle this, you can create 
an exclusion zone in the area you are tracking. For instance, a computer screen 
with strong reflections could cause the track to jump. To exclude an area while 
tracking, create a subtractive shape above the primary tracking shape. Then, 
select both the shapes prior to tracking.

Go to the Planar Trackers tutorial to see how it works.
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Tracker Direction
The Tracker Direction buttons are used to track backwards and forwards and 
are enabled when a layer has been selected.

Note: In a Stereo project, the Tracker Direction buttons are grayed out in the Left/Right 
View. You must be in either the Left or Right View to track. In the Morph node, the 
Tracker Direction buttons are grayed out in View Output. You must be in either View A 
or View B to track.

Track Backward One Frame
Tracks backward one frame at a time.

Track Backward
Tracks backward to the beginning of the Timebar.

Track Forward
Tracks forward to the end of the Timebar.

Track Forward One Frame
Tracks forward one frame at a time.

As you track, the tracker’s transform data is automatically applied to the 
selected layer.

Note: When a layer is selected prior to tracking, the per-shape blend mode, invert 
state, on/off state and opacity are all obeyed. This allows you to use multiple shapes 
while tracking.

Channel
Determines which image channel the tracker uses to analyze the image.
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Luminance
The tracker analyzes the luminance or brightness of the image.

Red
The tracker analyzes the image’s red channel.

Green
The tracker analyzes the image’s green channel.

Blue
The tracker analyzes the image’s blue channel.

Reset
Resets the tracking points.

Tracking Features
Auto
Tracks corners, edges and ridges and automatically selects the best result.

Corners
Tracks corners, crosses or points.

Edges
Tracks edges of a solid object.

Ridges
Tracks lines appearing as a strips or bands.

Motion Model
Perspective
Tracks perspective changes. Good for large shapes.

Affine
Tracks translation, rotation, scale, and skew. Good for medium shapes.

Translation
Tracks the XY offset. Good for small shapes.
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Min Features
The minimum number of trackers to generate.

Max Features
The maximum number of trackers to generate.

Min Dist
The minimum distance between trackers.

Max Age
The maximum number of frames a specific tracker will live until it is removed 
and a new tracker is generated.

Note: If you have really good tracks, you can increase the Max Age to cover the entire 
sequence and the trackers will live for the entire time and will result in a smoother 
transform. However, this value has to remain low to handle automatic occlusion 
handling.

Valid Tracks
The number next to Valid Tracks is a running total of the number of trackers that 
are viable as the tracker progresses.

Reference Frame
Displays the reference frame number. The reference frame is the frame you 
first started tracking on and it locks in the picked set of track points at that 
frame.

Jump to Reference Frame
When clicked, the Timebar is positioned at the reference frame.
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Group Tracking
Multiple layers containing non-overlapping shapes are tracked as separate 
planar surfaces.

Part Tracking
With multiple layers containing overlapping shapes, there is an interaction 
between them whereby they share coarse motion, but have individual motion 
at the fine scale. This is helpful when tracking non-planar surfaces.
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Mocha Planar Tracker
The Mocha Planar Tracker provides 2D transformation data by tracking planes 
rather than points.

Go to the Planar Trackers tutorial to see how it works.

As with Silhouette’s Planar Tracker, the Mocha Planar Tracker requires that you 
create a layer in the Object List and have at least one shape within it to drive 
the tracker. The shape should surround the object you are tracking, but it does 
not have to be exact and it is best to leave a little extra room around it. In 
addition, you can use more than one shape as long as they are on the same 
geometric plane.

Tracker Direction
The Tracker Direction buttons are used to track backwards and forwards and 
are enabled when a layer has been selected.

Note: In a Stereo project, the Tracker Direction buttons are grayed out in the Left/Right 
View. You must be in either the Left or Right View to track. In the Morph node, the 
Tracker Direction buttons are grayed out in View Output. You must be in either View A 
or View B to track.

Track Backward One Frame
Tracks backward one frame at a time.



Silhouette User Guide    

• • • •••

Nodes  775 
• • • •••

Track Backward
Tracks backward to the beginning of the Timebar.

Track Forward
Tracks forward to the end of the Timebar.

Track Forward One Frame
Tracks forward one frame at a time.

As you track, the tracker’s transform data is automatically applied to the 
selected layer.

Note: When a layer is selected prior to tracking, the per-shape blend mode, invert 
state, on/off state and opacity are all obeyed. This allows you to use multiple shapes 
while tracking.

Channel
Determines which image channel the tracker uses to analyze the image.

Luminance
The tracker analyzes the luminance or brightness of the image.

Red
The tracker analyzes the image’s red channel.

Green
The tracker analyzes the image’s green channel.

Blue
The tracker analyzes the image’s blue channel.

Min % Pixels Used
Min % is one of the most important parameters to look at for tracking. By 
default, the minimum percentage of pixels used is dynamic. When you draw a 
shape, the Mocha Planar Tracker tries to determine the optimal amount of 
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pixels to look for in order to speed up tracking. If you draw a very large shape, 
the percentage will be low. If you draw a small shape, the percentage will be 
high.

In many cases, the cause of a drifting or slipping track is a low percentage of 
pixels. If you want a more solid and accurate track, try setting the Min % Pixels 
Used value to a higher amount. Keep in mind, however, that a larger 
percentage of pixels can mean a slower track.

Min % Pixels Used is set to Auto by default.

Motion
These Motion parameters control what motion you are looking for when you 
track.

Translation
The position of the object.

Scale
Whether the object gets larger or smaller.

Rotation
The angle of rotation of the object.

Shear
How the object is skewing relative to the camera.

Perspective
How the object is moving in perspective relative to the camera.

The main difference between shear and perspective is the relative motion. 
Shear is defined as the object warping in only two corners, whereas 
perspective is most often needed where the object is rotating away from the 
viewer significantly in space.

As an example, if someone is walking towards you, their torso would be 
showing shear as it rotates slightly back and forth from your point of view.

The front of a truck turning a corner in front of you would be showing significant 
perspective change.
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Large Motion
This is the default. It searches for motion and optimizes the track as it goes. 
Small Motion is also applied when you choose Large Motion.

Small Motion
Small Motion only optimizes. You would use Small Motion if there were very 
subtle changes in the movement of the object you are tracking.

Search Area
The Search Area defines ranges for the tracker to search within.

Horizontal/Vertical
Determines the distance in pixels within the footage to search for the next 
object position. This is set to Auto by default.

Angle
If you have a fast rotating object, like a wheel, you can set an angle of rotation 
to help the tracker to lock onto the detail correctly. The tracker will handle a 
small amount of rotation, less than 10º per frame, with Angle set to zero.

Zoom %
If you have a fast zoom, you can add a percentage value here to help the 
tracker. Again, the tracker will still handle a small amount of zoom with this set 
to zero.
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Point Tracker
The Point Tracker uses trackers which are placed on distinguishable image 
features.

Go to the Point Tracker tutorial to see how it works.

Tracker Components
Each tracker has a Match Area, Search Region, and Track Point.

Match Area
The inner box is the Match Area. It defines a pattern that will be searched for 
from frame to frame. It's a good idea to choose a region with good contrast and 
detail. Corners with sharp contrast are usually good areas to track as 
movement can easily be detected in any direction. The Match Area can be 
scaled to the desired size.

Search Region
Match Area

Track Point
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Search Region
The outer, dashed box is the Search Region, which should be the maximum 
amount your tracking point will move between frames. The larger the size, the 
slower the processing. The trick is to make the Search Region as small as 
possible, yet still large enough to cover the area the tracker will move from 
frame to frame. The Search Region can be sized in the same fashion as the 
Match Area. 

Track Point
The center cross is the track point. It represents the position of the motion track. 
Normally, the Track Point is at the center of the tracker, but can be offset if the 
Match Area becomes obscured.

Tracker Direction
The tracker can track both forward and backward one frame at a time or for the 
entire duration. The controls are enabled once a tracker has been selected.

Note: In a Stereo project, the Tracker Direction buttons are grayed out in the Left/Right 
View. You must be in either the Left or Right View to track. In the Morph node, the 
Tracker Direction buttons are grayed out in View Output. You must be in either View A 
or View B to track.

Track Backward One Frame
Tracks backward one frame at a time.

Track Backward
Tracks backward to the beginning of the Timebar.

Track Forward
Tracks forward to the end of the Timebar.
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Track Forward One Frame
Tracks forward one frame at a time.

Behavior
Behavior decides what frame should be used as the reference to check the 
accuracy of the Match Area. By default, the reference is the first frame at which 
you started the track.

Start Frame
At each frame, the Match Area is compared to the first frame at which you 
started tracking. If you stop tracking halfway through your clip, and start up 
again at a later frame, the later frame will be used as the reference.

Every Frame
The Match Area is compared to the previous frame. This method will cause 
inherent drift in your track, but is useful for clips that have drastic changes in 
perspective and scale.

Key Frames
For difficult shots, it is helpful to pre-set keyframes for the tracker at various 
points in the clip. The Match Area will use these keyframes as a reference while 
tracking.
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Tolerance
Describes the level of accuracy between the Match Area that the Tracker is 
searching for and the area it actually finds when searching from frame to frame. 
A prefect match would be a value of 100. If the error that is calculated is below 
the Tolerance value, no keyframe will be set on that particular frame. The 
Tolerance is preset to a value of 75.

Create
Clicking on the Create button places a new tracker in the center of the screen. 
You can also add a new tracker at any time by Alt-clicking the image when the 
Tracker is activated.

Apply
Selecting the Apply button opens the Match Move window where you 
determine how the tracking data will be applied.

When OK is clicked, the tracking data is transferred to the Layer’s > Transform 
> Matrix parameter.

Note: With only trackers selected, clicking Apply creates a new layer and the tracking 
data is applied to that layer.

If a layer is selected along with the trackers, the tracking data will be applied to the 
selected layer.

Go to the Applying Trackers tutorial to see how it works.
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Position
Applies X/Y position data to the layer.

Scaling
Applies X/Y scaling data to the layer. Requires two trackers.

Rotation
Applies rotation data to the layer. Requires two trackers.

Average
Averages multiple tracks into a new destination track. A common technique is 
to track forwards from the first frame to the last, and then create a second track, 
tracking backwards from the last frame to the first. These two trackers are then 
averaged together to derive a more accurate track.

To average trackers, select more than one tracker and click the Average button. 
A new averaged tracker is created.

Go to the Averaging Trackers tutorial to see how it works.

Merge
If you have multiple trackers that cover different frame ranges, they can be 
merged into one tracker, automatically compensating for the different offsets.

Ideally, the trackers should overlap in time by at least one keyframe. 

Go to the Merging Trackers tutorial to see how it works.

Tracker Parameters
Most tracker parameters are interactively set while moving the tracker in the 
Viewer. When a point tracker is selected, its parameters are displayed in the 
Object Parameters.
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Magnify Window

A magnified version of the Match Area is displayed to aid in the placement of a 
tracker. It is activated when you click the Create button or when you move an 
existing tracker. The magnified area is displayed in the color space selected 
from the Mode pop-up menu.

Position
Sets the position of the Track Point. This parameter is automatically set when 
using the on-screen tracker controls.

Nudging Trackers
Trackers can be nudged using the Arrow keys. One press of the Arrow key 
moves the tracker 1 pixel. Using the Shift key in conjunction with the Arrow 
keys moves the tracker 10 pixels. Ctrl plus the Arrow keys moves the tracker 
one tenth of a pixel. These nudge values can be changed in the Preferences 
menu located in File > Preferences > Nudging on Windows and Linux or 
Silhouette > Preferences > Nudging on Mac. Holding the Arrow keys down 
slides the tracker.
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 Tracker Nudging Keyboard Shortcuts

Channel
Determines which image channel the tracker uses to analyze the image.

RGB
The tracker analyzes the red, green and blue channels of the image.

Luminance
The tracker analyzes the luminance or brightness of the image.

Red
The tracker analyzes the image’s red channel.

Green
The tracker analyzes the image’s green channel.

Blue
The tracker analyzes the image’s blue channel.

Match Offset
Offsets the Match Area from the tracker. This parameter is automatically set 
when using the on-screen tracker controls.

Search Offset
Offsets the Search Region from the tracker. This parameter is automatically set 
when using the on-screen tracker controls.

Match Size
Sets the size of the Match Area. This parameter is automatically set when using 
the on-screen tracker controls.

Shortcut Action

Arrow keys Moves the tracker by 1 pixel

Shift-Arrow keys Moves the tracker by 10 pixels

Ctrl/Cmd-Arrow keys Moves the tracker by one tenth of a pixel

Hold down Arrow keys Moves the tracker continuously
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Search Size
Sets the size of the Search Region. This parameter is automatically set when 
using the on-screen tracker controls.

Path Color
Sets the color of the tracker’s path. Left-clicking the color pot opens a standard 
color picker while right-clicking on the color pot opens a pop-up color menu with 
16 primaries. 

Tracker Pop-Up Menu
Point Tracker
With the Tracker tool enabled, right-click over a shape or a selected control 
point to open the Tracker pop-up menu.

Trackers can be created based on a shape’s points, the center point of a shape 
or the shape’s bounding box. Trackers created in this manner are a 
concatenation of the shape and layer transformation data. So, why do this? 
Because, it is a handy way of creating trackers with all of this combined data 
for use in other programs.

Create Corner Trackers from Shape Bounds
Creates four trackers around the four corners of the shape bounding box.

Create Tracker from Shape Center
Creates one tracker in the center of the shape.

Create Tracker from Points
Creates trackers from selected points.
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Planar Tracker
Create Point Tracker
Planar Tracker track points can be converted to point trackers which can then 
be treated like any other point tracker; they can be merged, smoothed, 
averaged, and applied to layers. Right-click on a planar track point, choose 
Create Point Tracker and a new point tracker is created.

Pre-Processing
Images that contain film grain or video noise, lack contrast or sharpness as well 
as images that have flicker can be tracked more accurately by applying certain 
filters during the tracking process. Filters such as Blur, Sharpen, Contrast, 
Gamma, De-Noise and Remove Flicker will increase tracker accuracy for 
problematic images.

Blur
Applies a blur to the image features.

Sharpen
Sharpens image features.

Contrast
Increases contrast.

Gamma
Increases brightness by leaving the white and black points the same and only 
modifies the values in-between.

De-Noise
Applies a de-noise algorithm to smooth out noise while retaining detail.

Remove Flicker
Corrects image flicker or brightness variation over time, which has a habit of 
interfering with tracker accuracy.

Preview
Shows the effect of the Pre-Processing parameters on the entire image in the 
Viewer.
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Smooth
Smooths out inaccuracies in the tracking data.

To smooth, select a point tracker or planar tracked layer and click the Smooth 
button. Adjust the slider when it pops-up and adjust it to the desired level of 
smoothing.

Go to the Smoothing Point Trackers or the Smoothing Planar Tracked 
Layers tutorials to see how it works.

I/0
Importing and exporting tracking data takes place in the I/0 section of the 
Tracker tab.

Import
After Effects Corner-Pin, Nuke, Shake or Simple Format formatted trackers can 
be imported into Silhouette. If you would like to import trackers from non-
supported applications, simply export a Silhouette tracker in Simple Format to 
see how it should be formatted.

Go to the Importing Tracking Data tutorial to see how it works.

Export
Trackers can be exported to the After Effects, Autodesk, Nuke and Shake 
tracker formats. In addition, the tracking data applied to a layer, either by the 
Point Tracker or Planar Tracker, can be exported as a four point corner-pin 
track.

To create trackers for export that are a concatenation of the shape and layer 
transformation data, see the Tracker Pop-Up Menu section for more 
information.

Go to the Exporting Tracking Data tutorial to see how it works.

View
 Shapes, points or tracker vectors can be toggled on or off.
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Shapes
Toggles the display of shapes in the Viewer.

Points
Toggles the display of Planar Tracker track points in the Viewer.

Vectors
Toggles the display of tracking vectors in the Viewer. This option is not available 
for use with the Planar Tracker.

Preferences
Seldom adjusted tracker controls can be accessed by clicking the Tracker 
Preferences icon.

See the Tracker Preferences for information on their use.

Using the Tracker’s Transform Data
However the tracking data is obtained, it ultimately needs to be applied to a 
layer. The Tracker node then outputs the point trackers and tracked layers for 
use in other nodes. For instance, the Transform node has a Transform input as 
do other nodes that contain point controls. When the output of a Tracker node 
is plugged into another node’s Transform input, the Tracker’s point trackers and 
transformed layers are available for use by selecting one of them in the node’s 
Transform pop-up menu.

Note: Other nodes that contain trackers, like Depth, Morph and Roto, have an Objects 
output that can be plugged into another node’s Transform input.

Go to the Match Move or Stabilize Images tutorial to see how it works
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Transform
Description

Transform your image using Position, Scale, Rotation, Corner-Pin, Shear and 
Crop controls. Match Move and Stabilization can also be applied to the image 
when a Tracker node is plugged into the node’s Transform input.

Node Group
Transform.

Controls
Transform
Transform
Selects point trackers and tracked layers from the input Tracker node.

Mode
Match Move
Match moves the image based on the input tracker data.

Stabilize
Stabilizes the image based on the input tracker data.

Crop
Top
Crops the image from the top down.

Bottom
Crops the image from the bottom up.

Left 
Crops the image from left to right.

Right
Crops the image from right to left.

Corner-Pin
The image can be corner pinned by adjusting the Corner-Pin values as well as 
dragging the four points on the corners of the screen.
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Upper-Left
Controls the X and Y position of the Upper Left Point.

Upper-Right
Controls the X and Y position of the Upper Right Point.

Lower-Right
Controls the X and Y position of the Lower Right Point.

Lower-Left
Controls the X and Y position of the Lower Left Point.

Position
X Axis
The horizontal pSosition of the image.

Y Axis
The vertical position of the image.

Scale
X Axis
The horizontal scale of the image.

Y Axis
The vertical scale of the image.

Gang
The X Axis and Y Axis values can be ganged together.

Rotate
In addition to the standard position and scale controls, the image can be 
rotated. Positive values rotate clockwise and negative values rotate counter-
clockwise.

Shear
X Axis
Skews the image left and right.
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Y Axis
Skews the image up and down.

Gang
The X Axis and Y Axis values can be ganged together.

Anchor
X Axis
Defines the point on the X axis where the image will be positioned, rotated, 
scaled or sheared.

Y Axis
Defines the point on the Y axis where the image will be positioned, rotated, 
scaled or sheared.

Gang
The X Axis and Y Axis values can be ganged together.

Filter
Chooses the filtering method when transforming the image. Mitchell is the 
default.

Triangle
The Triangle filter is not the highest quality, but fine for scaled images.

Quadratic
Quadratic is like triangle, but more blur with fewer artifacts. It offers a good 
compromise between speed and quality.

Cubic
Cubic is the default filter in Photoshop. It produces better results with 
continuous tone images, but is slower than Quadratic. If the image contains fine 
details, the result may be blurrier than desired.

Catmull-Rom
This produces good results with continuous tone images which are scaled 
down, producing sharp results with fine detailed images.
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Gaussian
Gaussian lacks in sharpness, but is good with ringing and aliasing.

Mitchell
A good balance between sharpness and ringing, Mitchell is a good choice when 
scaling up.

Sinc
Keeps small details when scaling down with good aliasing.
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 Transform On-Screen Controls

Motion Blur
Enable
Turns Motion Blur on or off. The default is off.

Corner Pin Shear X

Shear Y Rotate

Scale Y

Scale X

Scale X/Y

Position X/Y

Shortcut Action

Drag small center cross Moves the image’s X/Y Position

Drag on the large cross’s horizontal and 
vertical lines

Scales the image horizontally or vertically

Drag large center circle Proportionally scales the image

Drag small circle at 3 o’clock position Rotates the image

Drag crosses on corners of image Corner-pins the image

Drag bars at 9 and 12 o’clock positions Shears the image

Alt-click-drag Moves the anchor point to a different area of the image
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Shutter Angle
Determines how long the camera shutter stays open when a picture is taken-- 
higher values create more motion blur. The range of the Shutter Angle is 0-720 
and defaults to 180. Measured in degrees, it simulates the exposure of a 
rotating camera shutter. The shutter angle uses the footage frame rate to 
determine the simulated exposure. For example, a shutter angle of 180 
degrees (50% of 360 degrees) for 24fps footage creates an effective exposure 
of 1/48 of a second. Typing 1 degree applies almost no motion blur, and typing 
720 degrees applies a high degree of motion blur.

Shutter Phase
Offsets the point in time, either forward or reverse, when the shutter opens. The 
range of the Shutter Phase is -360 to 360 and defaults to -90.

Motion Samples
Renders intermediate frames equal to the Motion Samples value and 
accumulates them, one over the other, on a single frame. The higher the 
number, the smoother the motion. The Motion Samples range is from 1-256 
and defaults to 16.

Note: Normally, motion blur is calculated going forward, so if there is no motion beyond 
the end of a clip, there won’t be motion blur on the last frame. To work around this, add 
an extra frame or two to the end of the work range in the Timebar and move the last 
transform keyframes to be outside of the session range.
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Turb Distort
Description

Distorts the image by pulling it in a random manner.

Node Group
Warp.

Controls
Scale
Sets the size of the distortion.

Stretch
Stretches the distortion horizontally.

Angle
Rotates the distortion.

Amount
Sets the amount of distortion.

Speed
Automatically animates the distortion by multiplying it with Silhouette's frame 
number. So, if you set speed to 100, it uses the frame number as the time value 
directly. A speed of 200 makes it animate twice as fast, etc.

Time
Shifts the distortion animation by shifting it in time. 
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Unpremultiply
Description

Divides the RGB channels by the alpha channel.

Node Group
Composite.
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Vignette
Description

A vignette, or soft fade, is a popular photographic effect where the photo 
gradually fades into the background, usually in a circular or rectangular shape. 
The vignette can be any color as well as thrown out of focus.

Node Group
Color.

Controls
Presets
To select a preset, choose one from the Presets tab.

Vignette
Color
The Color parameter sets the color of the vignette through the use of a standard 
color picker. The default color is black.

Opacity
Sets the opacity of the colored vignette. For defocused vignettes, you may want 
to turn down the Opacity so you can see the defocused effect.

Blur
Sets the softness of the image in the area of the vignette.

Shape
Roundness
Sets the roundness of the vignette. The vignette can either be circular or square 
or anywhere in between.

Size
Sets the size of the vignette.

Aspect Ratio
Changes the aspect ratio of the vignette. A value of -100 would be wider, and 
100 would be taller.
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Rotation
Rotates the vignette.

Distortion
Distorts the edge of the vignette.

Distortion Size
Sets the size of the distortion.

Randomize
Randomizes the distortion.

Softness
The Softness parameters control the softness of the vignette edge.
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X-Ray
Description

Simulates the look of X-Ray images.

Node Group
Special Effects.

Controls
Presets
To select a preset, choose one from the Presets tab.

Black and White
Filter
The Filter pop-up selects the type of black and white filter to be applied to your 
color image. Go to the Black and White section of Common Node Controls to 
see how the Black and White controls work.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
lighten the midtones, negative values darken the midtones.

Color
Opacity
Sets the opacity of the color.
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Color
The Color parameter sets the color of the x-ray through the use of a standard 
color picker and defaults to blue.
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zMatte
Description

Using proprietary matte extraction techniques, zMatte quickly and simply 
creates mattes with minimal parameters even if you are dealing with fine hair 
detail, smoke, or reflections. It is easy to use, yet provides the needed tools 
when faced with good, bad, or ugly shots--tools such as multiple matte creation, 
automatic spill suppression, sophisticated matte and edge manipulation, and 
color correction.

Go to the zMatte tutorial to see how it works.

Node Group
Key, Silhouette.

Matte
Primary

Composite

FG BG

Matte
Secondary
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Deartifact
The Deartifact parameters are handy for cleaning up artifacts caused by DV 
and HD video footage. In fact, they are useful for cleaning up foregrounds that 
have aliased or jaggy edges. 

When activated, a RGB to YUV conversion takes place so that you can blur 
only the U and V color channels. Since this is where most of the artifacting 
shows up, this has the effect of cleaning up the ratty edges encountered when 
keying DV or HD video footage. It is usually best to blur mostly on the horizontal 
axis.

Note: The Deartifact parameters default to settings that are good for DV footage. If you 
are working at higher resolutions, you will want to increase the blur settings.

Enable
Activates Deartifacting.

Horizontal Blur
Prior to pulling the matte, the U and V color channels are blurred by a fast, 
quality blur along the X-axis.

Vertical Blur
Prior to pulling the matte, the U and V color channels are blurred by a fast, 
quality blur along the Y-axis.

Gang
The horizontal and vertical values can be ganged together.

Deartifact off Deartifact on 
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Primary Matte
zMatte can utilize up to two mattes in the creation of the final composite. If only 
one matte is needed, you would use the Primary Matte. When adjusting the 
Primary Matte, you should select Primary Matte in the View pop-up menu so 
you can see what you are doing.

Note: Keep in mind when creating your matte that wherever you see black in the matte, 
you will see background in the final composite. Wherever you see white in the matte, 
you will see foreground in the final composite--foreground being anything that is 
extracted from the blue or green screen.

Extract On
Extract On selects the type of matte extraction. Select whichever type isolates 
the desired values. A matte is extracted based on one of the following:

Blue Screen
Choose blue screen if you have a blue screen.

Green Screen
Choose green screen if you have a green screen.

Luminance
A matte is extracted based on the luminance of the image.

Hue
A matte is extracted based on the hue of the image. When adjusting the 
Position parameter, you are selecting different hues.

Saturation
A matte is extracted based on the saturation of the image.

Average
A matte is extracted based on the average of the image’s RGB values.

Red
A matte is extracted based on the image’s red values.

Green
A matte is extracted based on the image’s green values.
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Blue
A matte is extracted based on the image’s blue values.

Alpha
A matte is extracted based on the image’s alpha values.

Cyan
A matte is extracted based on the image’s cyan values.

Magenta
A matte is extracted based on the image’s magenta values.

Yellow
A matte is extracted based on the image’s yellow values.

Background/Foreground
When using the Extract On > Blue Screen or Green Screen settings, 
Background and Foreground are used while all other matte extraction methods 
use Position and Range.
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Background
Sets the background value. The lower the value, the harder or blacker the 
matte will become. 

It is best to set the Background value as high as possible, while at the same 
time making sure that the background is completely black.

Background = 40

Background = 80
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Foreground
Sets the foreground value. The higher the value, the harder or whiter the matte 
will become. 

It is best to set the Foreground value as low as possible, while at the same time 
making sure that the foreground is completely white for any areas that should 
be opaque in the final composite.

Position and Range
When using matte extraction methods other than the Extract On > Blue Screen 
or Green Screen settings, Position and Range are used instead of Foreground 
and Background.

Position
The Position value pinpoints the values to be used in the matte. For a 
Luminance extraction, a Position value of 100 would make a white matte of the 
highlights and a value of 0 would make a white matte of the shadows.

Foreground = 0

Foreground = 17
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Range
Increases or decreases the range of values in the matte. A low Range value 
indicates a narrow range of values. A high Range value indicates a large range 
of values included in the matte.

Black Clip
Blacks in the matte are made blacker by increasing this value. As the value 
increases, more values are clipped to black. This is helpful for getting rid of 
unwanted gray areas in what should be the black part of the matte. 

White Clip
Whites in the matte are made whiter by increasing this value. As the value 
increases, more values are clipped to white. This is helpful for getting rid of 
unwanted gray areas in what should be the white part of the matte. 

Shrink/Grow
Shrinks or grows the matte. Negative values shrink and positive values grow 
the matte.

Shrink/Grow = -5
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Blur
The matte is blurred by a fast, quality blur.

Wrap
Helps blend the foreground into the background by making the background 
“wrap” into the foreground edges without completely losing the edge. The edge 
of the foreground starts to become transparent.

Secondary Matte
Sometimes two mattes are needed to create a good key. zMatte allows you to 
create two different mattes and combine them with various Blend modes.

With the exception of those listed below, the remaining parameters for the 
Secondary Matte are the same as the Primary Matte: Extract On, Background, 
Foreground, Position, Range, Shrink/Grow, Blur, and Wrap.

Blur = 10

Wrap = 30
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Enable
Activates the Secondary Matte.

Note: You must first enable the Secondary Matte before it can be seen in the View pop-
up menu.

Blend
Once a blend mode is selected, the Secondary Matte is combined with the 
Primary Matte.

Add
The Secondary Matte is added to the Primary Matte.

Subtract
The Secondary Matte is subtracted from the Primary Matte.

Primary Matte            Secondary Matte                  Result

Primary Matte            Secondary Matte                  Result
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Multiply
Produces a result where there is a union of the Primary and Secondary Mattes.

Screen
This looks kind of like the Add blend mode, but highlights are retained as 
opposed to being burnt out.

Difference
Produces a result where a value exists in the Primary and Secondary Mattes, 
but not in both.

Primary Matte            Secondary Matte                  Result

Primary Matte            Secondary Matte                  Result

Primary Matte            Secondary Matte                  Result
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Darken
Compares the two mattes and takes pixels with the lower value.

Lighten
Compares the two mattes and takes pixels with the higher value.

Amount
Sets the opacity of the Secondary Matte.

Holdout Matte
A Holdout Matte defines foreground areas that should not be keyed out. The 
input can come from an existing source channel or a node like Roto, and the 
result is combined with the output matte.

Channel
Determines which channel to use as the Holdout Matte source.

Red
Uses the red channel.

Green
Uses the green channel.

Primary Matte            Secondary Matte                  Result

Primary Matte            Secondary Matte                  Result
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Blue
Uses the blue channel.

Alpha
Uses the alpha channel.

Luminance
Uses the average luminance of the RGB channels.

Blend
Sets the blend mode for combining the Holdout Matte with the Primary Matte. 
See the Blend Mode options for more information.

Amount
Sets the opacity of the Holdout Matte.

Garbage Matte
A Garbage Matte defines background areas that should be keyed out. The 
input can come from an existing source channel or a node like Roto, and the 
result is combined with the output matte.

Channel
Determines which channel to use as the Garbage Matte source.

Red
Uses the red channel.

Green
Uses the green channel.

Blue
Uses the blue channel.

Alpha
Uses the alpha channel.

Luminance
Uses the average luminance of the RGB channels.
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Blend
Sets the blend mode for combining the Garbage Matte with the Primary Matte. 
See the Blend Mode options for more information.

Amount
Sets the opacity of the Garbage Matte.

Color Suppress
Removes either blue or green spill from the foreground object.

Note: Color Suppress is only available when using Extract On > Blue or Green Screen 
in the Primary Matte.

Enable
Activates color suppression.

Foreground
Suppresses color spill in the foreground.The default value of 100 should be 
sufficient for most situations.

Range
Increases the range of areas that are color suppressed. If color spill is still 
evident, increase this value.

Edge
Suppresses the color spill of the foreground edge to the color gray. This is very 
useful for edges that contain a lot of transparency like hair or reflections.

Foreground = 0 Foreground = 100



Silhouette User Guide    

• • • •••

Nodes  814 
• • • •••

Color Correct
The Color Correct parameters allow you to adjust the foreground image so that 
it matches your background.

Hue
Rotates the hue of the foreground.

Saturation
Adjusts the saturation of the foreground. Positive values saturate, negative 
values desaturate.

Brightness
Adjusts the luminance of the foreground. Positive values brighten, negative 
values darken.

Contrast
Adjusts the contrast of the foreground. Positive values increase contrast, 
negative values decrease contrast.

Gamma 
Adjusts the gamma of the foreground. The gamma adjustment leaves the white 
and black points the same and only modifies the values in-between. Positive 
values brighten the image, negative values darken the image.

Temperature
Adjusts the color of the foreground to be either warmer or cooler. Dragging the 
numeric field to the right makes the foreground cooler (bluer) and dragging the 
numeric field to the left makes the foreground warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the foreground. Dragging the numeric field to 
the right makes the foreground more magenta and dragging the numeric field 
to the left makes the foreground more cyan.

Red
Adds or subtracts red from the foreground.
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Green
Adds or subtracts green from the foreground.

Blue
Adds or subtracts blue from the foreground.

Flash Amount 
Sets the opacity of the Flash Color. 

The Flash parameters mix a color into the foreground image through the use of 
a standard eyedropper or color picker. The default color is white. What in the 
world is this for? It is a great way to add atmosphere to an element. Flash 
comes from the film term "flashing", which describes the optical process of 
lowering the contrast of an image by flashing it with light. In terms of a 
composite, you would pick a color off of the background image and selectively 
add that color into the foreground image. This has the effect of making the 
foreground element look as if it is receding into the distance.

Flash Color
Sets the opacity of the Flash Color.

Eyedropper 
The eyedropper allows you to pick colors directly off of the screen.

Color Picker 
Colors can be selected using a standard color picker.
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Light Wrap
Helps blend the foreground into the background by making the color of the 
background “wrap” into the foreground edges without completely losing the 
edge. 

This is accomplished by placing the background layer into a special matte and 
then combining it with the foreground. You can look at the Light Wrap element 
in the View menu.

Brightness
Sets the brightness of the Light Wrap.

Wrap
Sets the size of the Light Wrap.

No Light Wrap With Light Wrap

Light Wrap Source
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Edge
The Edge parameters allow you to color correct or blur only the edge of the 
foreground. You can also mix the edge of the foreground with the background. 
Before using the Edge tools, it is a good idea to take a look at your Edge Matte 
in the View Menu so that you can see what your edge actually looks like.

Size
Determines the size of the edge matte.

Color Correct
The edge of the key can be color corrected. See the Color Correct controls for 
parameter descriptions.

Blur-Horizontal
The edge of the foreground is blurred by a fast, quality blur along the X-axis, 
but only in areas of the edge matte.

Blur-Vertical
The edge of the foreground is blurred by a fast, quality blur along the Y-axis, 
but only in areas of the edge matte.

Gang
The horizontal and vertical values can be ganged together.

Opacity
Mixes the foreground back to the background, but only in areas of the edge 
matte.

Edge = 1
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Transform
The keyed foreground/matte can be manipulated using a Transform. Go to the 
Transform node to see how it works.

Node Outputs
Output
Outputs the foreground input and generated matte. Use this option if you plan 
to do further work on the RGB and alpha channels downstream from zMatte.

Composite
Outputs a composite of the foreground over the background based on the 
generated matte.
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 RENDER

When you have you completed your work in Silhouette, you will want to render 
the final result. Rendering takes place in the Render Options window and is 
accessed by selecting Session > Render Session.

Go to the Rendering tutorial to see how it works.

Additional rendering options are available in the Actions menu such as: Render 
Active Node, Render Layer's Shapes in Folders, Render Layers to Separate 
Files, Render Shapes to Channels, and Render Shapes to Separate Files. See 
the Actions section for more information.



Silhouette User Guide    

• • • •••

Render  820 
• • • •••

Render Options
Render

All Output Nodes
Renders all output nodes.

Selected Output Nodes
Renders the current output node.

Output nodes determine the file format, file name, disk storage location, and 
channels to be rendered. The Output nodes should be edited to your 
specification before rendering.

Range
Range determines which frames will be rendered. The numeric entry fields to 
the right of the range pop-up display the frame range to be rendered, but can 
also be used to enter a specific frame range if Custom has been selected.

All
Renders the entire frame range.

Work Range
Renders the frame range in and out points in the Timebar.

Current Frame
Renders the current frame.

Custom
Renders a custom frame range as defined by the numeric entry fields.

Output Start Frame
The rendered frames will start with this number.

Field Handling
Enables field rendering.



Silhouette User Guide    

• • • •••

Render  821 
• • • •••

None
No field processing takes place.

Interlace
Interlaces the two separate fields within a single frame.

Field Dominance
Select either Even or Odd field dominance depending on whether you are 
working with NTSC or PAL images.

Even
Use for NTSC images.

Odd
Use for PAL images.

Resolution
Lowers the image resolution for faster rendering.

1:1
1:1 keeps the image quality at full resolution.

1:2
1:2 lowers the image resolution by 1/2.

1:3
1:3 lowers the image resolution by 1/3.

1:4
1:4 lowers the image resolution by 1/4.

Render ROI (Region of Interest)
Determines whether the ROI or the session size is rendered. Enable to render 
the ROI.

Note: Render ROI only appears when ROI is enabled.

When rendering EXR files:
• The ROI becomes the data window and the session becomes the display window.
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• The ROI window is rendered along with the ROI window’s coordinates. This will 
allow you to automatically composite the ROI window into its proper location. For 
all other file formats, the ROI window is padded out to the session size.

Preview
Opens a Preview window that displays each rendered image as well as render 
statistics. With the Preview window open, press the R, G, B, and A (alpha) keys 
to toggle viewing of the respective channels or C to view the RGB channels.
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Table 1: Render > Preview Shortcuts

Send to RV
If enabled, after rendering, the clip is loaded into Tweak Software’s RV 
playback tool--if installed. The “Send to RV” option appears when the RV > 
Command preference is set.

Render
Renders using the current settings.

Apply
Saves the current settings and closes the Render Options window without 
rendering.

Cancel
Closes the Render Options window.

Shortcut Action

R Displays the Red channel

G Displays the Green channel

B Displays the Blue channel

A Displays the Alpha channel

D Displays the Depth channel

C Displays the RGB channels
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 COMMAND-LINE

Silhouette on the command-line allows you to execute projects with a variety of 
commands to control the rendering process. Further customization is 
accomplished via scripting as much of the Silhouette object model is exposed 
to the Python scripting language.

The Silhouette command-line program is named sfxcmd and is located in the 
following locations depending on your operating system.

• Linux: Location determined at installation

• Macintosh: 
/Applications/SilhouetteFX/Silhouette[version]/Silhouette.app/Contents/MacOS

• Windows: C:\Program Files\SilhouetteFX\Silhouette[version]

To run the Silhouette command-line program, use the following commands in a 
shell window:

• Mac: ./sfxcmd

• Windows: .\sfxcmd.exe

• Linux: ./sfxcmd.sh

Go to the Command-Line tutorial to see how it works.

General Options
Command-line options are of the form: –option value, where value may be 
optional. Required arguments are in pointy brackets (< >) and optional 
arguments are in brackets ([ ]). If the value must be from a list of possible 
values, the available values are separated by |.

The basic form of the sfxcmd argument is: sfxcmd <projectname> [options]

where options are from the list below. By default, the project is rendered using 
the settings in the project unless changed by command-line options. Rendering 
can be disabled with the –render 0 option (see below). Certain options, such 
as format conversion, will implicitly disable rendering as well.
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-action <actionName>
Run the specified Action after the project is loaded, where actionName is an 
action class name for one of the actions found in 
Silhouette/resources/scripts/actions. When –action is used, rendering is 
implicitly disabled, unless the –render 1 option is also used. Any rendering 
done by the action itself is not disabled.

-info[project|session|node|outputs]
Print information about the overall project, the active session, active node or 
active session rendering information. Enabling this option loads the info.py 
script in the Silhouette scripts directory, and calls the appropriate function to 
dump basic information. This file can be modified by the user to alter how the 
information is presented. If just –info is used, the default is to display project 
information. Multiple options can be supplied, separated by commas, to print 
multiple types of information. For instance, –info session,outputs will print 
session and rendering information. When –info is used, rendering is implicitly 
disabled, unless the –render 1 option is also used. 

The information displayed by –info can be customized by editing the info.py 
Python script located in Silhouette/resources/scripts.

-log
Enable log messages. For example, use –log to display module load 
messages and other non-critical informational messages.

-node <name>
Target the specified node in the active session for output. By default, the first 
Output node is used. When specifying a particular node, the node label must 
be used and not the node type (i.e. RotoNode), because there may be more 
than one. To print a list of nodes in the active session, use the –info session 
option.

-no_launcher
Prevents the launcher from appearing when Silhouette starts up without a 
project.
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-no_modules
Modules are prevented from loading.

-no_splash
Prevents the splash screen from appearing when Silhouette starts up.

-open_project 
Opens the project browser on launch.

-options <options file>
Load the options file and treat each line of the file as a command-line option. 
For instance, instead of writing this:

sfxcmd project.sfx –log –info project

You can write this:

sfxcmd project.sfx –options options.txt

Where options.txt contains:

–log

–info project

Note: Lines that start with # in the options file will be ignored, so you can use # to add 
comments.

-render <0|1>
Rendering can be disabled by using –render 0. Use this if you only want to print 
information about the project or run a script that does other things with the 
project. Rendering is enabled by default if a project is specified.

Note that when –info or –action are used, –render 0 is implicitly set unless the 
–render 1 option is also set.
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-script <scriptfile>
Run the specified Python script after the project is loaded. The script has 
access to the active project, session, and node, as specified by the –session 
and –node options. Scripts can walk the object model, manipulate the object 
state such as visibility, and print information, limited only by the Silhouette 
scripting API. 

-session <name>
Make the specified session active in the project. This is only useful if the project 
contains more than one session. To print a list of sessions in the project, use 
the –info option.

-version
Print the sfxcmd version.

Rendering options
-write <0|1>
Disable frame writing by using –write 0. This is useful for doing test runs to 
verify that options are set properly.

-range <all|work|start#-end#x#>
Specifies the range of frames to render. A specific range is set by passing two 
numbers. A step factor can be introduced by using x# after the range. Some 
examples are:

• –range 1-10 renders frames 1, 2, 3, 4, 5, 6, 7, 8, 9, and 10.

• –range 1-10x2 renders frames 1, 3, 5, 7, and 9.

• –range 3 renders frame 3.

Multiple –range arguments can be used to specify multiple ranges, for instance 
–range 1-50x1 –range 51-60x2 –range 60-100x3. You can also use commas 
to separate ranges in a single –range option.

Frames are in the range of the session, and do not necessarily start at 1. If your 
session starts at frame 4000, to render the first 50 frames of the session, use –
range 4000-4049.
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-f
Same as –range.

-step <number>
Specifies the number to add to get to the next frame. The default is 1. Note that 
–step will override whatever step factor is used in –range or –f.

-start <number>
Use –start to override the starting frame number of the output frames. For 
example, if your session starts at 4000 and you want to render 50 frames, but 
you want the generated frame files to start at 1, use –range 4000-4049 –start 
1.

-depth <8|float16|float32>
Sets the render depth.

-roi <0|1>
Determines whether the region set in the ROI (Region of Interest) is used.

-resolution <full|half|third|quarter>
Override the output resolution to full resolution, half resolution, third resolution, 
quarter resolution. 

Note: Half resolution is width/2*height/2, third resolution is width/3*height/3, and 
quarter resolution is width/4*height/4.

-fields <none|interlace>
Sets the field handling to one of the supported options. The two letter options 
assume 3:2 handling.

-dominance <even|odd>
Sets the field dominance when field handling is enabled.

-nogui
For Linux systems without X-Windows installed, –nogui allows Silhouette to 
not use X-Windows. However, scripts that do drawing, for example Slate, will 
not work. 
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-threads
You can override the number of multi-processing threads Silhouette uses with 
–threads <n>. 
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 APPENDIX A - PREFERENCES

Preferences allow you to customize default settings and can be accessed by 
selecting File > Preferences on Windows and Linux or Silhouette > Preferences 
on Macintosh.
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Autosave
Interval (minutes)

Sets the default time for autosaving the project. Set interval to 0 to disable 
autosave.

Maximum # of Backups
Controls how many backup files are created. Each time a project is saved, a 
copy is stored in the project folder.
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Cache
% ROI Overscan

Sets the amount of extra pixels to save around the ROI in the Cache.

% Total Physical RAM
Sets the amount of RAM to be used for playback. The default is 50% and the 
range is 10-90%.

Note: A program restart is needed to enable % Total Physical RAM changes.

Preload Frames
Controls how many source frames are preloaded into the cache.

Purge Cache on Project Load
When selected, the cache is purged when a Project is loaded.
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Color Management
Cineon/DPX Working Colorspace

Controls whether or not Cineon and DPX images are converted to scene linear.

Linear
Converts the Cineon/DPX images to scene linear.

Log
Cineon/DPX images are kept in log space.

Note: After changing this preference, you must restart Silhouette for changes to take 
effect as the value is cached.

Warning: It is not a good idea to change this preference in the middle of a paint 
session, since when in Linear mode, it physically alters the pixels on import/export.

OCIO Configuration
This preference is a path to a global configuration file to use. The default is 
“$(OCIO)”. Silhouette will initially look for $SFX_OCIO and will use that first. 
Otherwise, it will use whatever the configuration preference is set to and finally 
it will check for $OCIO. If it still can't find a configuration, it will fall back to the 
embedded configuration in the resources/ocio folder.
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Environment
The Environments preference sets environment variables directly inside 
Silhouette without having doing so in the operating system. Once applied, 
variables are immediately available in Silhouette, sub-processes, and scripts.

+
Adds a new variable

-
Remove the selected variable.

Show Internal Variables
Display the internal variables used by Silhouette. These cannot be changed.

Note: Variables can contain references to other variables.

Note: Variables are changed when Apply is pressed. Reset has no effect for this page.
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GPU
The GPU preference determines whether or not GPU acceleration is enabled. 

Auto
Automatically chooses either GPU or CPU acceleration based on your graphics 
card.

GPU
Forces GPU acceleration on. If your graphics card is not capable of GPU 
acceleration, this setting will have no effect. 

CPU
Forces CPU acceleration on.

Note: The GPU preference doesn’t actually change until there is a frame or processing 
update.
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Input/Output
Silhouette Shapes

The Silhouette Shapes export format was changed in 5.0 so that settings 
normally stored in the Silhouette node can be accessed.

Export Format
5.0+
Exports Silhouette shapes in the 5.0 format.

4.5-
Exports Silhouette shapes in the 4.5 and below format.

Nuke 6.2+ Shapes
Connect Nodes When Embedding Layers Into Nodes
Connects layers together in Nuke using Merge nodes. However, if you set a 
layer in Silhouette to Subtract for example, you will have to manually adjust the 
corresponding Merge node in Nuke to Minus.

Note: Connecting of nodes with Merge nodes in Nuke is only supported in the layer 
based export modes: “Embed each layer in its own node” and “Embed each layer in its 
own node fully baked”.

Convert Opacity to Lifetime Preference
If checked, a Nuke lifetime is enabled ending at either the work range end or 
the first transition to zero Opacity. The start of the lifetime is either the work 
range start, if the starting value was 100% opacity, or the frame on which it went 
from zero to 100% opacity.

Note: 1) Only the first on to off Opacity range is converted to lifetime. 2) If the opacity 
is ever a fractional value other than 0 or 100 before the lifetime end, the lifetime feature 
is disabled. 3) At least one keyframe is required, otherwise Nuke sets zero Opacity.

Node Handling
Embed All Shapes In One Node
All selected shapes are exported into one Nuke Roto node.

Embed Each Shape In Its Own Node
Selected shapes are exported into separate, unconnected Nuke Roto nodes.
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Embed Each Layer In Its Own Node
Shapes are exported into their respective layers as separate, unconnected 
Nuke Roto nodes. Shapes not located in a layer will be combined into a Nuke 
node called Roto. If a layer has blur or invert settings applied to it, blur and 
invert nodes will be created in Nuke and connected to the layer’s node.

Silhouette may break shapes in a single layer into more than one Nuke Roto 
node if these shapes are interrupted by a Silhouette sub-layer. This is 
intentional so that the correct depth order can be maintained. For example, if 
the Silhouette Roto node contained Shape 1, Shape 2, Layer 1, Shape 3: The 
“Embed each layer in its own node” mode will break Shape 3 into its own Nuke 
Roto node so that the user has the option of ordering the contents of Layer 1 in 
between Shape 1, Shape 2 and Shape 3.

Embed Each Layer In Its Own Node Fully Baked
Shape control points are fully baked on every frame of the work range. While 
this creates larger files, it works around a known Nuke motion blur problem.

Nuke 9+ Shapes
Convert Opacity to Lifetime Preference
If checked, a Nuke lifetime is enabled ending at either the work range end or 
the first transition to zero Opacity. The start of the lifetime is either the work 
range start, if the starting value was 100% opacity, or the frame on which it went 
from zero to 100% opacity.

Copy Alpha to RGBA
Copies the alpha channel into the RGBA channels in the exported file.

Export Project Name
The Silhouette project name is exported and displayed in the Nuke node name.

File Size
Smaller (Hexadecimal)
Writes the export out in hexadecimal format resulting in a smaller file size.

Larger (Human Readable)
Writes the export out in human readable format resulting in a larger file size.
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Fully Baked
Shape and transform data are baked together.

Outline Width Multiplier
Nuke does not accurately import the width of open shapes, but we 
automatically account for this. If needed, use this multiplier to fine tune the 
width of open shapes when exported.
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Morph
Correspondence Lines

Sets the number of phantom lines between correspondence points. This is 
useful for visualizing how the various parts of the shapes are warping.

Correspondence Lines Color
Sets the correspondence lines’ color.

Correspondence Point Color
Sets the correspondence points’ color.

Correspondence Point Size
Sets the size of correspondence points.

Default Target Color
Sets the default color of target shapes.
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Nudging
Distance (pixels)

Sets how many pixels an object moves when the Arrow keys are used.

Extended (Shift) Distance (pixels)
Sets how many pixels an object moves when the Arrow keys are used in 
conjunction with the Shift key.

Precise (Ctrl/Cmd) Distance (pixels)
Sets how many fractional pixels an object moves when the Arrow keys are 
used in conjunction with the Ctrl/Cmd key.
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Paint
Brush Outline Color

Sets the color of the brush outline.

Crosshair Cursor
Controls the display of the cursor crosshair while painting.

Off
The cursor crosshair is not displayed.

On
The cursor crosshair is always displayed.

On/Off
The cursor crosshair disappears while painting a stroke, but is visible 
otherwise.

Hide Brush Outline While Painting
 Hides the brush outline while painting.

Output Unpainted Frames
Normally, when using the Paint Only output, only painted frames are rendered. 
This preference renders the blank, unpainted frames as well, so there is a 
complete sequence.

Pressure Threshold
Controls how hard the pen has to be pressed before opacity kicks in. The 
preference is from 0-1. When the threshold has been reached, the calculated 
pressure is scaled into the new range from threshold to 1.

Use Tablet Pressure
Turn tablet pressure sensitivity on or off.
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Clone
Absolute Frame Numbers
When activated (the default), displays the actual frame number in the Clone > 
Frame field. When turned off, it uses the old Silhouette v2.3 behavior where an 
offset in relation to the current frame was shown instead of the actual frame.

Alignment Type
Black
When in Align mode, the Viewer appears black when the Clone source and 
destination are perfectly aligned.

Gray
When in Align mode, the Viewer appears gray when the Clone source and 
destination are perfectly aligned.

Allow Adjustments to Auto Grade
Allows the other grade controls to be used in conjunction with Auto Grade. With 
this preference off, turning on Auto Grade will reset the other grade controls to 
their defaults and disable them.

Default Filter
Sets the default filter for new paint nodes.

Default Source
Sets the clone source default.

Incremental Clone Offset
Controls whether the Clone offset starts at last offset or at click location.

Overlay Color
Sets the color of the Clone transform on-screen controls.

Show Offset
Forces the Clone Offset connecting line to always be displayed.

Source Outline Color
Sets the color of the Clone brush outline.
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Source Outline Color (Secondary)
Sets the color of the secondary Clone brush outline. This is the color of the 
second Clone source activated by using Dual in the Clone presets.

Use Legacy Overlay Controls
Enables the Silhouette v6 and below Clone transform on-screen controls.

History
Lock Selection
If paint strokes are selected in the Paint History, they become un-selected when 
you change frames. If you enable Lock Selection, the strokes stay selected 
when changing frames.
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Project
Compress Project Data

Compress project data to save space.

Save Usage Analytics With Project
Saves a limited set of data analytics in the project file.

• All users who saved the project and how long they had it open.

• Creation date and usage time for each project, session, and node.
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Render
Filename

Sets the default suffixes that are appended to the Filename in the Render 
Options menu.

Alpha Suffix
 Sets the default alpha suffix to _alpha.

Depth Suffix
 Sets the default depth suffix to _depth.

Format
You can now override the output filename structure. The format for the output 
name is now defined by the Format preference.

The default is: $(NAME)$(SUFFIX)$(VIEW)$(PREFIX)$(FRAME).$(EXT) 
which matches the previous format.

• NAME substitutes the Filename field in Render Options

• SUFFIX substitutes the _alpha, _depth, or _paint suffix when saving External 
Alpha, or Depth

• VIEW substitutes the _L/_R suffix when saving a left/right view

• PREFIX substitutes the Prefix field in Render Options

• FRAME substitutes the frame number with padding

• EXT substitutes the output module default extension

Note: This Format preference is currently system wide and cannot be used on a per 
session basis.

Left View Suffix
Sets the default Left View suffix to _L.

Paint Suffix
 Sets the default Paint suffix to _paint.

Right View Suffix
Sets the default Right View suffix to _R.
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Roto
Composite Color

Sets the default color background when viewing Color Comp in the Roto node.
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RV
Command

Enter the path to Tweak Software RV’s “rvpush” command. For instance, 
depending on your OS and the RV version number, you would enter: 

• Macintosh: /Applications/RV64.app/Contents/MacOS/rvpush

• Windows: C:\Program Files\Tweak\RV-4.0.12-64\bin\rvpush.exe

• Linux: /opt/rv/rv.bin/rvpush 

Note: On Linux, rv can be installed anywhere. The above example is based on rv being 
installed in /opt/rv.

When a path is entered, a “Send to RV” option appears at the bottom right of 
the Render window. If that is enabled, after rendering, the rendered clip will be 
sent to the RV playback software--if installed.
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Shape
Active Point Color

Sets the default color of the active point (the point that the cursor is hovering 
over) through the use of a standard color picker.

Auto Switch to Reshape Tool
After closing a new shape, you will switch to the Reshape tool automatically.

Blur Type
Sets the default blur type: Center, Inner, Outer.

Bounding Box Color
Sets the default color of shape bounding boxes through the use of a standard 
color picker.

Control Handle Size
Sets the size of control point handles.

Control Point Color
Sets the default color of control points through the use of a standard color 
picker.

Default Interpolation
Sets the default keyframe interpolation type.

Hold
There is no interpolation and abrupt switches in value occur at keyframes.

Linear
When values change, a straight line with sharp, abrupt angles from one 
keyframe to the next is drawn.

Ease In
Eases in to the selected keyframe.

Ease Out
Eases out of the selected keyframe.



Silhouette User Guide    

• • • •••

Appendix A - Preferences  850 
• • • •••

Ease In/Out
Eases in and out of a selected keyframe.

Smooth (Catmull-Rom)
Smooth (Catmull-Rom) creates a smooth curve between keyframes.

Default Outline Color
Sets the default color of the shape outline through the use of a standard color 
picker.

Default Reshape Tool
Sets the default mode for the Reshape tool.

Normal
Selected points all move the same amount.

Magnetic
Points near the cursor move more than points farther away.

Enable Legacy Feathering
Enables the Silhouette v5 and below Feather tool. Once enabled, the Feather 
tool appears in the user interface.

Go to Appendix E - Legacy Feather to see how it works.

Fade Outline with Opacity
Draws unselected/inactive shape outlines using the shape opacity value. The 
V key toggles this preference so that you can easily see any shapes that are at 
0% opacity.

Freehand Point Selection
When enabled, point selection is done by freehand selection. Press Ctrl while 
dragging for rectangular selection.

When disabled, point selection is done by rectangular selection. Press Ctrl 
while dragging for freehand selection.

Hide Hulls During Edit
When activated, tangents/hulls hide when editing.
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Hide Outlines During Edit
When activated, the shape outline is hidden when editing.

Hull Color
Sets the default color of the hull (lines that connect tangents) through the use 
of a standard color picker.

Interpolation Engine
Temporal
Enables all interpolation types except for Smooth (Catmull-Rom).

Spatial (Nuke-compatible)
Interpolation types are limited to Smooth (Catmull-Rom), Hold and Extrapolate. 
This ensures that shapes using Smooth (Catmull-Rom) interpolation in 
Silhouette exactly match the result in Nuke when exported.

Number Points
None
Control points are not numbered.

Tagged
Only control points that have been tagged using the Reshape tool > control 
point pop-up menu are numbered.

All
All control points are numbered.

Primitive Type
Sets what shape type is used when circles and squares are created.

Bézier
Bézier shapes are used for circle and square creation.

B-Spline
B-Splines are used for circle and square creation.
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X-Spline
X-Splines are used for circle and square creation.

Recursive Subdivide
Drastically improves the curvature of shapes and reduces artifacts when using 
feathering. You can return to the previous behavior of v4.0.4 and below which 
used a fixed-step iterator by turning this preference off, if for some reason it 
causes shape artifacts.

Rotate from Center of Selection Bounding Box
Controls whether the automatic anchor point is set to the center of the collective 
bounding box or to the opposite handle.

Selected Point Color
Sets the default color of selected points through the use of a standard color 
picker.

Show Feather Handles
Displays feather handles on shape points. Shift-F toggles this setting.

Show Shape Name 
Displays the shape name in the center of the shape.

Show Tangent Vectors
Turns Bézier tangents on or off. Turns B-Spline and X-Spline hull drawing on or 
off.

Template Color
Sets the color and opacity of unselected shapes. This Viewer Template feature 
is enabled by using Shift-W.

Transform from Center of Selection Bounding Box
Controls whether the automatic anchor point is set to the center of the collective 
bounding box or to the opposite handle.

X-Spline Point Type
Controls the default weighting of X-Spline points when they are created.
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B-Spline
X-Spline points have B-Spline weighting.

Cardinal
X-Spline points have Cardinal weighting.

Corner
X-Spline points have Corner weighting.

X-Spline Tension Factor
This is a weight from -10 to 10 that is multiplied by the mouse delta when 
manipulating the X-Spline point tension. You can reverse the sense of the 
weight by making this value negative. Also, you can boost the amount the 
tension is adjusted based on mouse movement by making the value larger, for 
example closer to -10 or 10.
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Stereo
Enable NVIDIA 3D Vision Preview Support

When enabled, the 3D Preview window supports NVIDIA 3D Vision glasses. 
After enabling this preference, the 3D Preview window will open full screen.

Note: This works even on non-Quadro cards as long as the 3D Preview window 
is full screen.
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Tracker
Create Point Trackers in Root

When enabled, point trackers are placed in the root of the Object list, rather 
than the selected layer.

Default Path Color
Sets the default color of the tracker path.

Default Point Track Tolerance
Sets the default tracker tolerance. Describes the level of accuracy between the 
Match Area that the Tracker is searching for and the area it actually finds when 
searching from frame to frame.

Point Tracking Behavior
Sets the default tracker behavior. Behavior decides what frame should be used 
as the reference to check the accuracy of the Match Area. 

Show Path Points
Displays tracker points along the path of the track.

mocha
Drift Compensation
Enables mocha’s Drift Compensation feature where surrounding frames are 
used to decrease tracker drift.

Use GPU If Available
Enables GPU acceleration if a compatible graphics card is found.

Planar Tracker
Drift Compensation
Enables Silhouette’s Drift Compensation feature where surrounding frames are 
used to decrease tracker drift.
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Undo
Max Undo Events

Sets the maximum number of undos.
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User Interface
Allow Nested Docks

Allows all nested docks to be moved at the same time. Disabling this 
preference moves individual docks only.

Automatically Raise Dock Preference
Added a User Interface > Automatically Raise Dock Views On Selection 
Change preference. For instance, when the Paint node is selected, relevant 
tabs like the Paint History automatically appear. 

Check for New Versions
Checks for new versions and displays an alert on startup.

Colored Timeline Tracks 
Colors the timeline tracks the same as the Roto node’s shape colors.

Font Size
Changes the size of text in the user interface. This aids in making the text more 
readable on high dpi monitors. 

Note: Setting a larger font size could cause the text to be cut off in certain menus.

Invert Mouse Wheel in Editors
Inverts the numerical direction when adjusting sliders with the mouse wheel.

Show Sources Last in Node List
When enabled (the default), Source nodes are displayed last in the Node List.

Show Object Properties on Selection
When you select an item in the Object List, the controls for that item are 
automatically shown in the Parameters window. If you select an item in the 
Node List, the controls for that item are automatically shown in the Node 
window. This behavior can be disabled with this preference.

Show What’s New After Installing A New Version
On startup, if this is the first time launching a new version of Silhouette, it will 
open the What's New. It will only do this once.
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Trees
Connections
Curved
Displays node connections as curved lines.

Straight
Displays node connections as straight lines.

Input Order
BG, FG
The input order of composite nodes is background and then foreground.

FG, BG
The input order of composite nodes is foreground and then background.

Note: If there are existing nodes in the Trees window, you will need to reload the 
session for this to take effect.

Layout
Horizontal
The node input and output are configured on the sides of the node to 
accommodate horizontal trees.

Vertical
The node input and output are configured on the top and bottom of the node to 
accommodate vertical trees.
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Viewer
Alpha Overlay Color

Sets the color of the alpha overlay.

Anaglyph Mode
Sets the anaglyph mode when using the Anaglyph Preview in the Viewer. 
Anaglyphs do not portray saturated colors very well and due to color leaking 
between left and right images results in discomfort caused by retinal-rivalry. 
Four anaglyph modes are provided to choose from with Optimized set as the 
default.

Color
Preserves most of the color but causes retinal rivalry.

Gray
Creates a lighter image than a true anaglyph but results in more ghosting. No 
color is preserved.

Half-Color
Preserves less of the color but reduces the retinal rivalry

Optimized
Discards all of the red component from the original images and replaces it with 
a manufactured red channel derived from the green and blue components. The 
advantages are almost no retinal rivalry.

Anchor Color
Sets the color of the Transform tool anchor point.

Anti-Alias Overlay Controls
Anti-aliases lines and overlay controls.

Auto-Show Overlay
If Overlay is turned off, Auto-Show Overlay automatically turns Overlay back on 
when clicking in the Viewer.
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Background Color
Sets the border color in the Viewer.

Display ROI Outline
Displays the ROI outline.

Handle Mode
Controls how handles are drawn.

Blend
Uses a normal blend mode to display layer and shape handles.

XOR
Uses an XOR blend mode to display layer and shape handles.

Layer Transform Color
Sets the color of the layer’s on-screen controls.

Line Width
Sets the thickness of overlay lines.

Mask Fill Color
Color
Sets the color of the mask.

Opacity
Set the opacity of the Mask Fill Color by clicking on the percentage field (to the 
right of the color picker) and typing in a new number.

Mask Outline Color
Color
Sets the color of the mask outline.

Opacity
Set the opacity of the Mask Outline Color by clicking on the percentage field (to 
the right of the color picker) and typing in a new number.
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Picking Tolerance
Sets the radius of the threshold for picking points.

Premultiply Background Color
Sets the background color for premultiplied display modes. You can premultiply 
the image in the Viewer by using Shift-0.

Restore Focus After Editing preference
Restores focus to the viewer after editing parameters. This ensures that the 
arrow keys, for instance, continue to work for nudging objects.

Stereo Alignment Type
Selects either Gray or Black for the Stereo Alignment.

Synchronize Viewers
Synchronizes the zoom and pan of multiple viewers from the same node. 
Synchronization is one way from the main viewer to the additional viewers.

Template Mode
Turns template mode on or off. See Template Color for more information.

Zoom Factor
Controls the I/O zoom factor keyboard shortcuts. Default is 2. Range is 1.05 > 
2.0.

Zoom Filter
Linear
Interpolates pixels when zoomed into the image. This results in a smoother, but 
softer image.

Nearest
Replicates pixels when zoomed into the image. This results in a sharper, but 
chunkier image.
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 APPENDIX B - KEYBOARD SHORTCUTS

Nodes
Crop > On-Screen Controls

Depth > Preview Pan/Zoom

Nodes Window

Shortcut Action

Click and drag a corner Crops both horizontally and vertically

Click and drag horizontal boundary Crops vertically

Click and drag vertical boundary Crops horizontally

Click and drag within bounding box Moves the crop area

Shortcut Action

Click and drag Rotates the image a perspective view

Scroll wheel Zooms the image in and out

Shift-Middle-mouse drag Zooms the image in and out

Space Bar-Shift-move mouse up/down Zooms the image in and out

Space Bar-move mouse Pans the image

Middle-mouse drag Pans the image

Middle-mouse double click Fits the image in the Viewer

Shortcut Action

Enter with mouse in Nodes Window Enters search mode 

Esc with mouse in Nodes Window Exits search mode
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Paint 
Brushes
Shortcut Action

B Selects the Black and White brush

Shift-B Selects the Blemish brush

Ctrl/Cmd-B Selects the Blur brush

Alt-Shift-B Selects the Burn brush

C Selects the Clone brush

Shift-C Selects the Color brush

Alt-C Selects the Color Correct brush

Alt-Shift-C Selects the Cutout brush

Alt-D Selects the Detail brush

Alt-Shift-D Selects the Dodge brush

D Selects the Drag brush

Shift-E Selects the Eraser brush

G Selects the Grain brush

M Selects the Mosaic brush

R Selects the Repair brush

Shift-S Selects the Scatter brush

S Selects the Stroke tool
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Clone > Pin Warp

Clone > Region

Shortcut Action

Click-drag on image Creates a pin

Click-release on image Creates a tack

Click-drag pin (source or target) Moves the pin (source or target)

Shift-drag pin (source or target) Moves both pins (source and target)

Ctrl/Cmd-drag pin radius Adjusts pin radius with all radii displayed

Hover over pin, Shift-drag pin radius Adjusts pin radius with only selected pin radius displayed

Alt-drag on a tack Converts a tack to a pin

Right-click > Remove Pin Deletes the pin

Right-click > Make Tack Converts a pin to a tack

Shortcut Action

Click and drag Creates a region

Alt-click and drag Creates new region when one already exists

Click and drag inside a region Moves the region

Drag the region handles Resizes the region

Tap outside a region box without dragging Resets the region to full screen
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Clone Transform Keyboard Shortcuts

Clone Transform Nudging

Shortcut Action

Q Activates / Deactivates translation of the clone source

W Activates / Deactivates rotation of the clone source

E Activates / Deactivates scaling of the clone source

Q, W, E then Ctrl/Cmd Translates, Rotates or Scales in finer increments

Ctrl/Cmd-W Rotates without setting the anchor point

Ctrl/Cmd-E Scales without setting the anchor point

Ctrl/Cmd-1-4 Selects the top left, top right, bottom right and bottom left 
corner points so they can be moved

. (Period key) Sets the anchor point

Shortcut Action

Arrow keys Moves the clone source by 1 pixel

Shift-Arrow keys Moves the clone source by 10 pixels

Ctrl/Cmd-Arrow keys Moves the clone source by one tenth of a pixel

Hold down Arrow keys Moves the clone source continuously

Q, W, E then Arrow keys Translates, Rotates or Scales by 1 pixel

Q, W, E then Shift-Arrow keys Translates, Rotates or Scales by 10 pixels

Q, W, E then Ctrl/Cmd-Arrow keys Translates, Rotates or Scales by 1/10 of a pixel

Ctrl/Cmd-1 then Arrow Keys Nudges the top left corner point

Ctrl/Cmd-2 then Arrow Keys Nudges the top right corner point

Ctrl/Cmd-3 then Arrow Keys Nudges the bottom right corner point

Ctrl/Cmd-4 then Arrow Keys Nudges the bottom left corner point
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Clone Transform On-Screen Controls

Clone Transform On-Screen Controls With Region Set

Shortcut Action

Drag within large center circle Moves the clone source

Shift-drag within large center circle Constrain clone source movement horizontally or vertically

Drag the center square horizontal and 
vertical halfway points

Scales the clone source horizontally or vertically

Drag a center square corner Proportionally scale the clone source

Drag large center circle Rotate the clone source

Ctrl/Cmd-drag large center circle Rotates the clone source with finer control

Drag handles on corners of image Corner-pins the clone source

Drag dash above large circle Skews the clone source horizontally

Drag dash to the right of large circle Skews the clone source vertically

Shortcut Action

Drag within region Moves the clone source

Shift-drag region Constrains the clone source movement horizontally or vertically

Drag edge handle Scales the clone source horizontally or vertically

Shift-drag corner or edge handle Proportionally scale the clone source

Ctrl/Cmd-drag on corner handle Rotate the clone source / Continue holding Ctrl to adjust with 
finer control

Drag on a corner handle Corner-pins the clone source

Ctrl/Cmd-drag on edge handle Skews the clone source
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Cutout Brush

Settings

Shortcut Action

Click-drag Creates a source region when none exists

Shift-drag or Right-click-drag Creates a new source region

Shift Displays source region

Shift-click or Right-click Resets source region

Ctrl/Cmd-drag boundary Scales the cutout

Ctrl/Cmd-Shift-drag boundary Rotates the cutout

Shortcut Action

Ctrl/Cmd-drag left/right Sizes the brush

[ and ] Sizes the brush

Ctrl/Cmd-Shift-drag Sets the brush softness

Shift-Alt-1 and Shift-Alt-2 Selects the Dual Clone brush setups

Shift+Ctrl+1 Toggle Dual Clone mode on/off

‘ (located to the left of 1 key) Displays the Clone source and then the Clone 
target so that you can click on each to set the Clone 
offset

Caps Lock Toggles Onion Skin mode on and off

. (period key) Picks colors off of the screen

Right-click Picks a color off of the screen from a single pixel

Right-click-drag Picks a color off of the screen by drawing a box and 
averages the colors within it

Alt-click-click Draws a straight line

Alt-P Toggles between Paint Source > Foreground or 
Output

| key (vertical bar) Snaps the vertical or horizontal split compare 
position to the cursor position
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View Menu
Shortcut Action

1 View the Output

2 View the Foreground

3-7 View Input’s 1-5

8 View Color Layer

9 View Detail Layer

P View Paint Only
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Render
Preview
Shortcut Action

R Displays the Red channel

G Displays the Green channel

B Displays the Blue channel

A Displays the Alpha channel

D Displays the Depth channel

C Displays the RGB channels
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Roto
Tools
Shortcut Action

T Selects Transform Shape Mode

TT Selects Transform Points Mode

R Selects Reshape Normal Mode

RR Selects Reshape Magnet Mode

Y Selects IK (Inverse Kinematics)

B Selects B-Spline

S Selects X-Spline

Shift-B Selects Bézier

Shift-F Selects Magnetic Freehand

Shift-S Selects Square

Shift-C Selects Circle

Shift-T Selects Tracker

M Selects MultiFrame

Shift-O Selects RotoOverlay

Alt-F Toggles the shape feather handle on/off

Alt-K Adds weighted keyframe
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Bézier Splines

B-Spline Shapes

Shortcut Action Curve

No key needed Adjust the length of one tangent while 
retaining a fixed angle between two 
tangents

Ctrl/Cmd Adjust both tangents simultaneously while 
retaining a fixed angle between two 
tangents

Alt Adjusts only one tangent to create corners

Shift Adjusts only the length of one tangent 
(similar to the “No key needed” shortcut)

Ctrl/Cmd-Alt-1 Sets the point tension to Corner

Ctrl/Cmd-Alt-2 Sets the point tension to Cardinal

Shortcut Action

Alt-drag control point right Creates a corner point

Alt-drag control point left Creates a smooth point

Alt-clicking control point Cycles through the preset weight settings of the point

Ctrl/Cmd-Alt-1 Sets the point tension to Corner

Ctrl/Cmd-Alt-3 Sets the point tension to B-Spline
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Cut / Copy / Paste

Feather

IK (Inverse Kinematics) Tool

Shortcut Action

Ctrl/Cmd-X Cuts an object

Ctrl/Cmd-C Copies an object

Ctrl/Cmd-V Pastes an object

Shortcut Action

Alt-F Toggles the shape feather handle on/off

Shift-Drag Shape Point Moves shape and feather points simultaneously

Action Result

Click-drag bone or shape Rotates the shape around the parent’s anchor point

Click-drag joint Uses IK to rotate all joints up the chain

Alt-click-drag joint Moves the joint but tries to keep other joints in place

Right-click bone-Add Key Sets keyframes for the selected bones
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Layer Transform On-Screen Controls

Magnetic Freehand Shapes
Tracing

Stroke Marking

Shortcut Action

Drag within large center circle Moves the layer

Shift-drag within large center circle Constrain layer movement horizontally or vertically

Drag the intersection of the center square 
and the horizontal and vertical lines

Scales the layer horizontally or vertically

Drag the center square corner Proportionally scale the layer

Drag large center circle Rotate the layer

Ctrl/Cmd-drag large center circle Rotates the layer with finer control

Drag handles on corners of image Corner-pins the layer

Drag small center circle Moves the Anchor point

Q Activates / Deactivates translation of selected layers

W Activates / Deactivates rotation of selected layers

E Activates / Deactivates scaling of selected layers

Q, W, E then Ctrl/Cmd Translates, Rotates or Scales in finer increments

Shortcut Action

Click while tracing Anchors the currently drawn path by adding a shape point

Shift-click Draws a straight line between the new and previous shape points

Shortcut Action

Shift-click-drag Creates a foreground stroke

Alt-click-drag Creates a background stroke

Esc Clears foreground and background strokes / Deselects current shape
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Nudging

Object List

Shortcut Action

Arrow keys Moves by 1 pixel

Shift-Arrow keys Moves by 10 pixels

Ctrl/Cmd-Arrow keys Moves by one tenth of a pixel

Hold down Arrow keys Moves continuously

Q, W, E then Ctrl/Cmd-drag Translates, Rotates or Scales in finer increments

Q, W, E then Arrow keys Translates, Rotates or Scales by 1 pixel

Q, W, E then Shift-Arrow keys Translates, Rotates or Scales by 10 pixels

Q, W, E then Ctrl/Cmd-Arrow keys Translates, Rotates or Scales by 1/10 of a pixel

Shortcut Action

Click on an object Selects the object

Shift-click an object Adds an object to the current selection

Ctrl/Cmd-click on an object Toggles the object selection

Shift-click color pot Selects shapes of same color

Alt-click the Visibility icon Solos an object

Alt-Ctrl/Cmd-click the Visibility icon Forces the visibility of all objects to the on position

Shift-click the +/- icon Expands or collapses all nested layers inside that layer

Double-click an object Selects the object so it can be renamed
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Selecting / Deselecting Control Points

Selecting / Deselecting Shapes

Tracker

Shortcut Action

Click on a control point. If the control point is part of a Bézier curve, 
its tangents appear

Selects the control point

Shift-click the control points or drag select multiple control points Selects multiple control points

Ctrl/Cmd-drag in the Viewer to begin the selection. Once the 
selection is started, release Ctrl/Cmd and complete the selection

Freehand select multiple 
control points

Ctrl/Cmd-Alt-I Inverts the point selection

Alt-Shift-A Selects all control points

Alt-Ctrl/Cmd-A Deselects all control points

Ctrl/Cmd-click on a control point Toggles the point selection

Click anywhere off the shape Deselects all control points

Shortcut Action

Click on a shape Selects the shape

Shift-click a shape or drag select multiple shapes Selects multiple shapes

Ctrl/Cmd-click on a shape Toggles the shape selection

Click anywhere off the shape Deselects all shapes

Shift-click color pot in the Object List Selects shapes of same color

Shortcut Action

Alt-click in Viewer Creates a new tracker



Silhouette User Guide    

• • • •••

Appendix B - Keyboard Shortcuts  876 
• • • •••

Transform Tool
Shortcut Action

Drag shape Moves the shape

Shift-drag shape Constrain shape movement horizontally or 
vertically

Drag bounding box corner or edge handle Scales a shape

Shift-drag bounding box corner or edge handle Proportionally scale a shape

Ctrl/Cmd-drag on a bounding box corner handle Rotate a shape

Alt-drag on a bounding box corner handle Corner-pin a shape

Alt-Shift-drag on a bounding box corner handle Constrains the corner-pin movement to one axis

Ctrl/Cmd-drag on a bounding box edge handle Shear a shape

. (period key) Turns the Anchor Point on or off

Drag on Anchor Point Moves the Anchor Point

Shift-. (period key) Moves the Anchor Point to the mouse location

Q Activates / Deactivates translation of selected 
shapes or layers

W Activates / Deactivates rotation of selected 
shapes or layers

E Activates / Deactivates scaling of selected 
shapes or layers

Q, W, E then Ctrl/Cmd Translates, Rotates or Scales in finer increments

Ctrl/Cmd-W Rotates without setting the anchor point

Ctrl/Cmd-E Scales without setting the anchor point
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Transform On-Screen Controls

Corner Pin Shear X

Shear Y Rotate

Scale Y

Scale X

Scale X/Y

Position X/Y

Shortcut Action

Drag small center cross Moves the image’s X/Y Position

Drag on the large cross’s horizontal and 
vertical lines

Scales the image horizontally or vertically

Drag large center circle Proportionally scales the image

Drag small circle at 3 o’clock position Rotates the image

Drag crosses on corners of image Corner-pins the image

Drag bars at 9 and 12 o’clock positions Shears the image

Alt-click-drag Moves the anchor point to a different area of the image



Silhouette User Guide    

• • • •••

Appendix B - Keyboard Shortcuts  878 
• • • •••

X-Spline Shapes

View Menu

Shortcut Action

Alt-drag control point right Adjusts the weight of the point from Cardinal to Corner to B-Spline

Alt-drag control point left When the weight is set to B-Spline, it adjusts the weight of the point 
from B-Spline to Corner to Cardinal

Alt-clicking control point Cycles through preset weight settings of the point

Ctrl/Cmd-Alt-1 Sets the point tension to Corner

Ctrl/Cmd-Alt-2 Sets the point tension to Cardinal

Ctrl/Cmd-Alt-3 Sets the point tension to B-Spline

Alt-S Snap selected control points to the nearest detectable edge

Drag Points-Hold Alt-S Snap selected control points to the nearest detectable edge

Shortcut Action

1 View the Output

2 View the Foreground

3 View the Background

4 View the Color Comp

5 View Composite

6 View Channels
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Timeline

Curve Editor

Shortcut Action

Scroll wheel Zooms the Timeline in and out

Shift-Middle-mouse drag Zooms the Timeline in and out

Space Bar-move mouse Pans the Timeline

Middle-mouse drag Pans the Timeline

Single-click keyframe Selects one keyframe

Ctrl/Cmd-click keyframe Toggle the keyframe selection

Shift-click keyframes Selects a range of keyframes

Alt-click Inserts a keyframe

Right-click keyframe Opens Timeline pop-up menu

Click-drag keyframe Moves the keyframe

Ctrl/Cmd-drag the ends of work range bar Changes the start and end of the work range

Ctrl/Cmd-drag the work range bar Slides the work range forward and back

Click top left corner of the Timeline Centers the timeline on the current frame

Shortcut Action

Alt-click on curve Inserts a point on the curve

Click-drag curve point Moves the curve point

+ or = Zooms the Curve Editor in

- Zooms the Curve Editor out

Space Bar-move mouse Pans the Curve Editor

Hover cursor over curve Displays the current curve value

Right-click curve point Opens Curve pop-up menu
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Viewer
Shortcut Action

F1 The composite workspace is displayed

F2 The Viewer is displayed full screen

F3 The Viewer and Timeline are displayed

F4 The Viewer and Trees window are displayed

F5 The dual monitor workspace is displayed

0 Toggles the display of overlays which are lines, shapes or objects

1-7 (Number Keys) Switches the Viewer > View menu

~ Cycles through the update modes

A Cycles the display between the full color image, the alpha channel 
superimposed over the image, and the alpha channel by itself

Shift-A Toggles the View to Output, superimposes the alpha channel over the 
image and deactivates the Overlay

Alt-R/G/B/A Toggles the red, green, blue and alpha channels on and off

Alt-O Toggles the Roto node’s view mode to Output and displays the alpha. 
Pressing Alt-O again returns the Viewer to its previous state.

Shift-Ctrl/Cmd-R Toggles the Viewer rotation mode on/off

Shift-R Toggles the Viewer rotation editing mode on/off

Shift-0 Premultiplies the image in the Viewer by the alpha

Alt-] Cycles to next node in the Node pop-up menu

Alt-[ Cycles to the previous node in the Node pop-up menu
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Pan/Zoom
Shortcut Action

Middle-mouse drag Pans the image

Space Bar-move mouse Pans the image

+ or = Zooms the image in

- Zooms the image out

Shift-Middle-mouse drag Zooms the image in and out

Scroll wheel Zooms the image in and out

Space Bar-Shift-move mouse up/down Zooms the image in and out

F Fits the image in the Viewer

H or Middle-mouse double click Centers the image in the Viewer at 100%

Ctrl/Cmd-F Centers selected object in the Viewer

‘ Opens a context menu over pen/mouse location
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Playback Controls

ROI

Shortcut Action

Z Step backward 1 frame

Shift-Z Moves to the previous keyframe

X Step forward 1 frame

Shift-X Moves to the next keyframe

J Plays backward

K Stops or starts playback

L Plays the forward

Space Bar Stops playback

Home Moves to the first frame

End Moves to the last frame

Click and drag in the shuttle area Shuttles through the clip

Shift-Alt-click and drag a keyframe marker Moves the keyframe in time

Shortcut Action

Initial click-drag bounding box Sets the ROI

Click-drag bounding box points Scales the ROI

Click-drag bounding box Positions the ROI

Ctrl/Cmd-Shift-drag Draws a new ROI
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Stereo
Align

View

Shortcut Action

Shift-Alt and click Automatically sets the Stereo Offset horizontally

Ctrl/Cmd-Shift-Alt and click Automatically sets the Stereo Offset horizontally and vertically

Click and drag in Viewer Moves the Stereo Offset horizontally

Ctrl/Cmd-drag in Viewer Moves the Stereo Offset horizontally in finer increments

Shift-click and drag in Viewer Moves the Stereo Offset horizontally and vertically

Alt-click in Viewer Resets the Stereo Offset

Arrow keys Moves the Stereo Offset by 1 pixel

Shift-Arrow keys Moves the Stereo Offset by 10 pixels

Ctrl/Cmd-Arrow keys Moves the Stereo Offset by one tenth of a pixel

Hold down Arrow keys Moves the Stereo Offset continuously

Shortcut Action

Shift-1 Selects the Left View

Shift-2 Selects the Right View

Shift-3 Selects the Left/Right View

Shift-4 Selects Stereo Align

Shift-5 Anaglyph Preview

Shift-6 3D Preview

D Displays the depth map



Silhouette User Guide    

• • • •••

Appendix B - Keyboard Shortcuts  884 
• • • •••

Sequence Editor
Shortcut Action

Scroll wheel Zooms the Sequence Editor in and out

Shift-Scroll Wheel or Middle-mouse drag Zooms the Sequence Editor in and out 10x faster

Space Bar-move mouse Pans the Sequence Editor

Middle-mouse drag Pans the Sequence Editor

I Sets a Mark IN point

O Sets a Mark OUT point

Shift-Drag/Drop Selected Clips Copies the selected clips

Alt-Drag/Drop Selected Clips Replaces the destination clip or marked region

Delete Deletes the selection
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 APPENDIX C - SESSION FORMATS

A number of preset formats can be selected from the Session Format pop-up 
menu. When one of the options is selected, the session fields are preset with 
the appropriate data.

Film Full Aperture (4K: 4096x3112)
Uses the following presets.

Width: 4096

Height: 3112

Pixel Aspect: 1

Frame Rate: 24

Film Full Aperture (4K: 4096x3072)
Uses the following presets.

Width: 4096

Height: 3072

Pixel Aspect: 1

Frame Rate: 24

Film Full Aperture (2k: 2048x1556)
Uses the following presets.

Width: 2048

Height: 1556

Pixel Aspect: 1

Frame Rate: 24

Film Full Aperture (2k: 2048x1536)
Uses the following presets.

Width: 2048

Height: 1536

Pixel Aspect: 1

Frame Rate: 24
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Film Cinemascope Full (3656x2664)
Uses the following presets.

Width: 3656

Height: 2664

Pixel Aspect: 2

Frame Rate: 24

Film Cinemascope Half (1828x1556)
Uses the following presets.

Width: 1828

Height: 1556

Pixel Aspect: 2

Frame Rate: 24

Film Academy (1828x1332)
Uses the following presets.

Width: 1828

Height: 1332

Pixel Aspect: 1

Frame Rate: 24

HDTV 24p (1920x1080)
Uses the following presets.

Width: 1920

Height: 1080

Pixel Aspect: 1

Frame Rate: 24
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HDTV 1080i, 1920x1080
Uses the following presets.

Width: 1920

Height: 1080

Pixel Aspect: 1

Frame Rate: 30

HDTV 1080, Anamorphic 1280x1080
Uses the following presets.

Width: 1280

Height: 1080

Pixel Aspect: 1.5

Frame Rate: 24

HDTV 720p, 1280x720
Uses the following presets.

Width: 1280

Height: 720

Pixel Aspect: 1

Frame Rate: 60

NTSC, 640x480
Uses the following presets.

Width: 640

Height: 480

Pixel Aspect: 1

Frame Rate: 29.97
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NTSC, 648x486
Uses the following presets.

Width: 648

Height: 486

Pixel Aspect: 1

Frame Rate: 29.97

NTSC DV, 720x480
Uses the following presets.

Width: 720

Height: 480

Pixel Aspect: .9

Frame Rate: 29.97

NTSC DV Widescreen (720x480)
Uses the following presets.

Width: 720

Height: 480

Pixel Aspect: 1.2

Frame Rate: 29.97

NTSC D1 (720x486)
Uses the following presets.

Width: 720

Height: 486

Pixel Aspect: .9

Frame Rate: 29.97
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NTSC D1 Square Pixels (720x540)
Uses the following presets.

Width: 720

Height: 540

Pixel Aspect: 1

Frame Rate: 29.97

PAL D1/DV (720x576)
Uses the following presets.

Width: 720

Height: 576

Pixel Aspect: 1.07

Frame Rate: 25

PAL D1/DV Square Pixels (768x576)
Uses the following presets.

Width: 768

Height: 576

Pixel Aspect: 1

Frame Rate: 25

PAL D1/DV Widescreen (720x576)
Uses the following presets.

Width: 720

Height: 576

Pixel Aspect: 1.42

Frame Rate: 25
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 APPENDIX D - ENVIRONMENT VARIABLES

Environment Variables
Environment variables can be used to customize certain aspects of Silhouette. 
See the Customization Guide for more information and a full list of 
environment variables and their descriptions.

Use the Environments preference to set environment variables directly inside 
Silhouette without having doing so in the operating system. Once applied, 
variables are immediately available in Silhouette, sub-processes, and scripts.

See the Environment Preference for more information.

https://documentation.borisfx.com/wiki/sfx/index.php?title=Main_Page
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 APPENDIX E - LEGACY FEATHER

Silhouette v6 and later use a new method for feathering that is compatible with 
other host programs like Nuke. However, the feathering method used in 
Silhouette v5 and below can still be used by enabling the Shape > Enable 
Legacy Feathering preference. Once enabled, the Feather tool appears in the 
Toolbar as it did in Silhouette v5 and below.

Feather creates variable edged blurs on a point by point basis.

 The Feather points can be placed either inside or outside the shape.

To use Feather, select it from the Toolbar and Alt-click on a selected shape and 
drag. Additional feather points are added by Alt-clicking on the original curve 
and dragging. Feather points are edited by clicking and dragging on one of the 
points.

Note: Feather points can only be added when the Feather tool is activated, but can be 
edited and manipulated using Reshape.
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 Feather Keyboard Shortcuts

Shortcut Action

Alt-drag on shape Adds and pulls out a feather point

Click-drag a feather point Changes the length and position of the feather point

Shift-drag a feather point Constrains the length of the point

Delete key Deletes the selected feather points

Right-click over point > Select All Selects all feather points

Right-click over point > Reset Sets the selected feather points’ offset to 0
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 APPENDIX F - VIDEO FIELDS

When working with footage that contains video fields, you have the option of 
either deinterlacing or removing 3:2 Pulldown. What are video fields and 3:2 
Pulldown, you ask? Well, a review of the mechanics of video frames and fields 
is in order, so listen up.

The resolution of video images is 525 lines for NTSC and 625 lines for PAL. 
NTSC video runs at 30 frames per second and PAL at 25 frames per second. 
Each video frame is made of two separate subframes called fields. Each of 
these fields is an individual snapshot in time. By using fields, the Viewer sees 
twice as many frames and smoother motion. Even though the fields represent 
different points in time, they occupy the same video frame. This is achieved 
through a process called interlacing.

Here comes the fun part. Interlacing weaves together the two fields by starting 
at the top of the image and taking one line from field 1 (the odd field) and 
another line from field 2 (the even field) until all 525 or 625 lines are interlaced 
together. Temporally, the fields always occur in the following order: field 1 and 
then field 2. Spatially, the ordering is different for NTSC and PAL. For NTSC, 
the spatial field order starts with field 2, or the even field. For PAL, it is the exact 
opposite with field 1, or the odd field, being the first spatial field.

Therefore, the interlace process produces two fields of half-height for every 
broadcast frame. When a television displays these images, it quickly shows the 
first field only, and then the second field only, and then proceeds to the next 
frame. Each field sacrifices vertical resolution for the benefit of temporal quality.

Deinterlacing
When deinterlacing is enabled, it strips out the two fields from each other, 
placing field 1 at frame 1, and field 2 at frame 1.5. Each field is then copied and 
moved into the empty spatial place of the removed field. This ensures that all 
spatial effects are properly handled when rendering fields. This strategy is 
clever because it doubles the number of frames you have, but keeps the frames 
within the same duration.
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3:2 Pullup / Pulldown
What in the world does 3:2 Pullup / Pulldown mean? This is a technique to 
temporally convert (resolution not being considered here) film footage to video 
footage and back again. Given that film uses solid frames and video uses 
interlaced fields, and that film runs at 24 fps and NTSC runs at 30 fps, you split 
the film footage into fields and double up 2 out of 5 frames to increase your 
frames to fill the 30 fps. Pullup is the conversion of film footage from 30fps to 
24fps while Pulldown is the conversion of 24fps film footage to 30fps.

Let's use the classic diagram: 

We see that the third and fourth video frames have field blending in them to 
stretch time out. It's therefore called 3:2 because you have three solid frames 
and two mixed frames.

3:2 Pullup
We can fully reconstruct our original four film frames by extracting the field data 
from the five video frames. Here comes the odd bit. When you receive your 
footage, it has probably been edited, so it is not necessarily the case that 
frames three and four are the mixed frames because all of the clips have been 
shifted around in the edit. We therefore need to figure out what the first frame 
is before we attempt to remove the extra fields. To do this, you would go to the 
first five frames in the clip. If the first frame to have field blending is frame three, 
you know your first frame should be set to AA. If the first frame to have field 
blending is frame two, then you know your first frame is BB. You would then set 
your 3:2 parameter accordingly. If your first frames are a solid color and you 
can't figure it out, you have to jump to a time range of frames that display the 
blending and start guessing what the first frame is until the fields go away. Very 
scientific, isn’t it?

Use the 3:2 setting in the chart below that corresponds to your first frame with 
field blending.

AA BB BC CD DD
5 Video Frames

A B C D
4 Film Frames
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 3:2 Pullup Frame Guide

First frame with field blending 3:2 Setting

1 BC if followed by a blended frame / CD if followed by a solid frame

2 BB

3 AA

4 DD
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 APPENDIX G - BLEND MODES

Blend modes are used to combine images in a variety of different ways.

Normal
Edits each pixel to make it the result color. This is the default mode. Changing 
the opacity results in a mix between two layers.

Darken
Looks at the color information in each channel and selects the base or blend 
color—whichever is darker—as the result color. Pixels lighter than the blend 
color are replaced, and pixels darker than the blend color do not change.

Multiply
Looks at the color information in each channel and multiplies the base color by 
the blend color. The result color is always a darker color. Multiplying any color 
with black produces black. Multiplying any color with white leaves the color 
unchanged.

Color Burn
Looks at the color information in each channel and darkens the base color to 
reflect the blend color by increasing the contrast between the two. Blending 
with white produces no change.

Linear Burn
Looks at the color information in each channel and darkens the base color to 
reflect the blend color by decreasing the brightness. Blending with white 
produces no change.

Darker Color
Compares the total of all channel values for the blend and base color and 
displays the lower value color. Darker Color does not produce a third color, 
which can result from the Darken blend, because it chooses the lowest channel 
values from both the base and the blend color to create the result color.
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Lighten
Looks at the color information in each channel and selects the base or blend 
color—whichever is lighter—as the result color. Pixels darker than the blend 
color are replaced, and pixels lighter than the blend color do not change.

Add
The pixels of one image are added to another image

Screen
Looks at each images color information and multiplies the inverse of the two 
images. This looks kind of like the Add blend mode, but highlights are retained.

Color Dodge
Looks at the color information in each channel and brightens the base color to 
reflect the blend color by decreasing contrast between the two. Blending with 
black produces no change.

Linear Dodge (Add)
Looks at the color information in each channel and brightens the base color to 
reflect the blend color by increasing the brightness. Blending with black 
produces no change.

Lighter Color
Compares the total of all channel values for the blend and base color and 
displays the higher value color. Lighter Color does not produce a third color, 
which can result from the Lighten blend, because it chooses the highest 
channel values from both the base and blend color to create the result color.

Overlay
Multiplies or screens the colors, depending on the base color. Patterns or colors 
overlay the existing pixels while preserving the highlights and shadows of the 
base color. The base color is not replaced, but mixed with the blend color to 
reflect the lightness or darkness of the original color.
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Soft Light
Darkens or lightens the colors, depending on the blend color. The effect is 
similar to shining a diffused spotlight on the image. If the blend color (light 
source) is lighter than 50% gray, the image is lightened as if it were dodged. If 
the blend color is darker than 50% gray, the image is darkened as if it were 
burned in.

Hard Light
Multiplies or screens the colors, depending on the blend color. The effect is 
similar to shining a harsh spotlight on the image. If the blend color (light source) 
is lighter than 50% gray, the image is lightened, as if it were screened. This is 
useful for adding highlights to an image. If the blend color is darker than 50% 
gray, the image is darkened, as if it were multiplied. This is useful for adding 
shadows to an image.

Vivid Light
Burns or dodges the colors by increasing or decreasing the contrast, 
depending on the blend color. If the blend color (light source) is lighter than 50% 
gray, the image is lightened by decreasing the contrast. If the blend color is 
darker than 50% gray, the image is darkened by increasing the contrast.

Linear Light
Burns or dodges the colors by decreasing or increasing the brightness, 
depending on the blend color. If the blend color (light source) is lighter than 50% 
gray, the image is lightened by increasing the brightness. If the blend color is 
darker than 50% gray, the image is darkened by decreasing the brightness.

Pin Light
Replaces the colors, depending on the blend color. If the blend color (light 
source) is lighter than 50% gray, pixels darker than the blend color are 
replaced, and pixels lighter than the blend color do not change. If the blend 
color is darker than 50% gray, pixels lighter than the blend color are replaced, 
and pixels darker than the blend color do not change. This is useful for adding 
special effects to an image.
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Difference
Looks at the color information in each channel and subtracts either the blend 
color from the base color or the base color from the blend color, depending on 
which has the greater brightness value. Blending with white inverts the base 
color values; blending with black produces no change.

Exclusion
Creates an effect similar to but lower in contrast than the Difference mode. 
Blending with white inverts the base color values. Blending with black produces 
no change.

Subtract
Looks at the color information in each channel and subtracts the blend color 
from the base color. In 8 and 16-bit images, any resulting negative values are 
clipped to zero.

Hue
Creates a result color with the luminance and saturation of the base color and 
the hue of the blend color.

Saturation
Creates a result color with the luminance and hue of the base color and the 
saturation of the blend color.

Color
Creates a result color with the luminance of the base color and the hue and 
saturation of the blend color. This preserves the gray levels in the image and is 
useful for coloring monochrome images and for tinting color images.
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 APPENDIX H - LICENSES USED BY SILHOUETTE

Silhouette uses the following third-party libraries and commercial licenses. Where 
relevant, full license text is listed under each heading.

GLEW (OpenGL Extension Wrangler Library)
License

The OpenGL Extension Wrangler Library

Copyright (C) 2008-2016, Nigel Stewart <nigels[]users sourceforge net>

Copyright (C) 2002-2008, Milan Ikits <milan ikits[]ieee org>

Copyright (C) 2002-2008, Marcelo E. Magallon <mmagallo[]debian org>

Copyright (C) 2002, Lev Povalahev

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

• The name of the author may be used to endorse or promote products derived from this 
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR  CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF  SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
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LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

libjpeg
This software is based in part on the work of the Independent JPEG Group.

libpng
License

This copy of the libpng notices is provided for your convenience. In case of any 
discrepancy between this copy and the notices in the file png.h that is included in the 
libpng distribution, the latter shall prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following this  
sentence.

This code is released under the libpng license.

libpng versions 1.0.7, July 1, 2000 through 1.6.35, July 15, 2018 are Copyright (c) 
2000-2002, 2004, 2006-2018 Glenn Randers-Pehrson, are derived from libpng-1.0.6, 
and are distributed according to the same disclaimer and license as libpng-1.0.6 with 
the following individuals added to the list of Contributing Authors:

Simon-Pierre Cadieux

Eric S. Raymond

Mans Rullgard

Cosmin Truta

Gilles Vollant

James Yu

Mandar Sahastrabuddhe

Google Inc.

Vadim Barkov

and with the following additions to the disclaimer:
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There is no warranty against interference with your enjoyment of the library or against 
infringement. There is no warranty that our efforts or the library will fulfill any of your 
particular purposes or needs. This library is provided with all faults, and the entire risk 
of satisfactory quality, performance, accuracy, and effort is with the user.

Some files in the "contrib" directory and some configure-generated files that are 
distributed with libpng have other copyright owners and are released under other open 
source licenses.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 
1998-2000 Glenn Randers-Pehrson, are derived from libpng-0.96, and are distributed 
according to the same disclaimer and license as libpng-0.96, with the following 
individuals added to the list of Contributing Authors:

Tom Lane

Glenn Randers-Pehrson

Willem van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996-1997 
Andreas Dilger, are derived from libpng-0.88, and are distributed according to the same 
disclaimer and license as libpng-0.88, with the following individuals added to the list of 
Contributing Authors:

John Bowler

Kevin Bracey

Sam Bushell

Magnus Holmgren

Greg Roelofs

Tom Tanner

Some files in the "scripts" directory have other copyright owners but are released under 
this license.

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995-
1996 Guy Eric Schalnat, Group 42, Inc.

For the purposes of this copyright and license, "Contributing Authors" is defined as the 
following set of individuals:

Andreas Dilger

Dave Martindale

Guy Eric Schalnat

Paul Schmidt
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Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 
42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the 
warranties of merchantability and of fitness for any purpose. The Contributing Authors 
and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, 
or consequential damages, which may result from the use of the PNG Reference 
Library, even if advised of the possibility of such damage. 

Permission is hereby granted to use, copy, modify, and distribute this source code, or 
portions hereof, for any purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.

2. Altered versions must be plainly marked as such and must not

be misrepresented as being the original source.

3. This Copyright notice may not be removed or altered from any source or altered 
source distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without fee, and 
encourage the use of this source code as a component to supporting the PNG file 
format in commercial products. If you use this source code in a product,  
acknowledgment is not required but would be appreciated.

END OF COPYRIGHT NOTICE, DISCLAIMER, and LICENSE.

TRADEMARK:

The name "libpng" has not been registered by the Copyright owner as a trademark in 
any jurisdiction. However, because libpng has been distributed and maintained world-
wide, continually since 1995, the Copyright owner claims "common-law trademark 
protection" in any jurisdiction where common-law trademark is recognized. 

OSI CERTIFICATION:

Libpng is OSI Certified Open Source Software. OSI Certified Open Source is a 
certification mark of the Open Source Initiative. OSI has not addressed the additional 
disclaimers inserted at version 1.0.7.

EXPORT CONTROL:

The Copyright owner believes that the Export Control Classification Number (ECCN) 
for libpng is EAR99, which means not subject to export controls or International Traffic 
in Arms Regulations (ITAR) because it is open source, publicly available software, that 
does not contain any encryption software. See the EAR, paragraphs 734.3(b)(3) and

734.7(b).

Glenn Randers-Pehrson
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glennrp at users.sourceforge.net

July 15, 2018

libtiff
License

Copyright (c) 1988-1997 Sam Leffler

Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation 
for any purpose is hereby granted without fee, provided that (i) the above copyright 
notices and this permission notice appear in all copies of the software and related 
documentation, and (ii) the names

of

Sam Leffler and Silicon Graphics may not be used in any advertising or publicity 
relating to the software without the specific, prior written permission of Sam Leffler and 
Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, 
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY 
SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY 
KIND,OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA 
OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, 
AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH 
THE USE OR PERFORMANCE OF THIS SOFTWARE.

libz
License

zlib.h -- interface of the 'zlib' general purpose compression library

version 1.2.11, January 15th, 2017

Copyright (C) 1995-2017 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event 
will the authors be held liable for any damages arising from the use of this software.
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Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the following 
restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you 
wrote the original software. If you use this software in a product, an acknowledgment 
in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software. 

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly

jloup@gzip.org 

Mark Adler

madler@alumni.caltech.edu

OpenColorIO
License

All code by Sony Pictures Imageworks except:

Pystring http://code.google.com/p/pystring/

TinyXML http://sourceforge.net/projects/tinyxml/

yaml-cpp http://code.google.com/p/yaml-cpp/

PTex (Mutex), courtesy of Brent Burley and Disney http://ptex.us/

Little CMS http://www.littlecms.com/

MD5, courtesy L. Peter Deutsch, Aladdin Enterprises. 
http://sourceforge.net/projects/libmd5-rfc/files/

argparse, courtesy OpenImageIO and Larry Gritz http://openimageio.org

Copyright (c) 2003-2010 Sony Pictures Imageworks Inc., et al. All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.



Silhouette User Guide    

• • • •••

Appendix H - Licenses Used by Silhouette  908 
• • • •••

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Sony Pictures Imageworks nor the names of its contributors may 
be used to endorse or promote products derived from this software without specific 
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

Pystring

Copyright (c) 2008-2010, Sony Pictures Imageworks Inc All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. Redistributions in binary form must reproduce 
the above copyright notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. Neither the name 
of the organization Sony Pictures Imageworks nor the names of its contributors may be 
used to endorse or promote products derived from this software without specific prior 
written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT 
HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
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LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

TinyXML is released under the zlib license:

This software is provided ‘as-is’, without any express or implied warranty. In no event 
will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the following 
restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you 
wrote the original software. If you use this software in a product, an acknowledgment 
in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

yaml-cpp

Copyright (c) 2008 Jesse Beder.

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the “Software”), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons 
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE.



Silhouette User Guide    

• • • •••

Appendix H - Licenses Used by Silhouette  910 
• • • •••

PTEX SOFTWARE Copyright 2009 Disney Enterprises, Inc. All rights reserved

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

The names “Disney”, “Walt Disney Pictures”, “Walt Disney Animation Studios” or the 
names of its contributors may NOT be used to endorse or promote products derived 
from this software without specific prior written permission from Walt Disney Pictures.

Disclaimer: THIS SOFTWARE IS PROVIDED BY WALT DISNEY PICTURES AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
NONINFRINGEMENT AND TITLE ARE DISCLAIMED. IN NO EVENT SHALL WALT 
DISNEY PICTURES, THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND BASED 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

Little CMS Copyright (c) 1998-2010 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the “Software”), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons 
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
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WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE.

MD5

Copyright (C) 1999, 2002 Aladdin Enterprises. All rights reserved.

This software is provided ‘as-is’, without any express or implied warranty. In no event 
will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the following 
restrictions:

The origin of this software must not be misrepresented; you must not claim that you 
wrote the original software. If you use this software in a product, an acknowledgment 
in the product documentation would be appreciated but is not required.

Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software.

This notice may not be removed or altered from any source distribution.

L. Peter Deutsch ghost@aladdin.com

argparse

Copyright 2008 Larry Gritz and the other authors and contributors. All Rights Reserved. 
Based on BSD-licensed software Copyright 2004 NVIDIA Corp.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: * Redistributions of source 
code must retain the above copyright notice, this list of conditions and the following 
disclaimer. * Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. * Neither the name of the software’s owners nor 
the names of its contributors may be used to endorse or promote products derived from 
this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 



Silhouette User Guide    

• • • •••

Appendix H - Licenses Used by Silhouette  912 
• • • •••

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

OpenCV (Open Source Computer Vision Library)
License

Copyright (C) 2000-2019, Intel Corporation, all rights reserved.

Copyright (C) 2009-2011, Willow Garage Inc., all rights reserved.

Copyright (C) 2009-2016, NVIDIA Corporation, all rights reserved.

Copyright (C) 2010-2013, Advanced Micro Devices, Inc., all rights reserved.

Copyright (C) 2015-2016, OpenCV Foundation, all rights reserved.

Copyright (C) 2015-2016, Itseez Inc., all rights reserved.

Third party copyrights are property of their respective owners.

• Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the names of the copyright holders nor the names of the contributors may be 
used to endorse or promote products derived from this software without specific prior 
written permission.

This software is provided by the copyright holders and contributors “as is” and any 
express or implied warranties, including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose are disclaimed. In no event shall 
copyright holders or contributors be liable for any direct, indirect, incidental, special, 
exemplary, or consequential damages (including, but not limited to, procurement of 
substitute goods or services; loss of use, data, or profits; or business interruption) 
however caused and on any theory of liability, whether in contract, strict liability, or tort 
(including negligence or otherwise) arising in any way out of the use of this software, 
even if advised of the possibility of such damage.
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 OpenEXR
OpenEXR uses a modified BSD license.

License
Copyright (c) 2002-2011, Industrial Light & Magic, a division of Lucasfilm

Entertainment Company Ltd. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Industrial Light & Magic nor the names of its contributors may be 
used to endorse or promote products derived from this software without specific prior 
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

Power Matte
Power Matte is based on unpublished research and technology by Jue Wang from the 
Department of Electrical Engineering at the University of Washington.



Silhouette User Guide    

• • • •••

Appendix H - Licenses Used by Silhouette  914 
• • • •••

PySide2
PySide2 uses Lesser General Public License (LGPL) version 2.1

License
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 

51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA

Everyone is permitted to copy and distribute verbatim copies of this license document, 
but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of 
the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and 
change it. By contrast, the GNU General Public Licenses are intended to guarantee 
your freedom to share and change free software--to make sure the software is free for 
all its users.

This license, the Lesser General Public License, applies to some specially designated 
software packages--typically libraries--of the Free Software Foundation and other 
authors who decide to use it. You can use it too, but we suggest you first think carefully 
about whether this license or the ordinary General Public License is the better strategy 
to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our 
General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you wish); that you 
receive source code or can get it if you want it; that you can change the software and 
use pieces of it in new free programs; and that you are informed that you can do these 
things.

To protect your rights, we need to make restrictions that forbid distributors to deny you 
these rights or to ask you to surrender these rights. These restrictions translate to 
certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must 
give the recipients all the rights that we gave you. You must make sure that they, too, 
receive or can get the source code. If you link other code with the library, you must 
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provide complete object files to the recipients, so that they can relink them with the 
library after making changes to the library and recompiling it. And you must show them 
these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we 
offer you this license, which gives you legal permission to copy, distribute and/or modify 
the library.

To protect each distributor, we want to make it very clear that there is no warranty for 
the free library. Also, if the library is modified by someone else and passed on, the 
recipients should know that what they have is not the original version, so that the 
original author's reputation will not be affected by problems that might be introduced by 
others.

Finally, software patents pose a constant threat to the existence of any free program. 
We wish to make sure that a company cannot effectively restrict the users of a free 
program by obtaining a restrictive license from a patent holder. Therefore, we insist that 
any patent license obtained for a version of the library must be consistent with the full 
freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General 
Public License. This license, the GNU Lesser General Public License, applies to 
certain designated libraries, and is quite different from the ordinary General Public 
License. We use this license for certain libraries in order to permit linking those libraries 
into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the 
combination of the two is legally speaking a combined work, a derivative of the original 
library. The ordinary General Public License therefore permits such linking only if the 
entire combination fits its criteria of freedom. The Lesser General Public License 
permits more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to 
protect the user's freedom than the ordinary General Public License. It also provides 
other free software developers Less of an advantage over competing non-free 
programs. These disadvantages are the reason we use the ordinary General Public 
License for many libraries. However, the Lesser license provides advantages in certain 
special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest 
possible use of a certain library, so that it becomes a de-facto standard. To achieve this, 
non-free programs must be allowed to use the library. A more frequent case is that a 
free library does the same job as widely used non-free libraries. In this case, there is 
little to gain by limiting the free library to free software only, so we use the Lesser 
General Public License.



Silhouette User Guide    

• • • •••

Appendix H - Licenses Used by Silhouette  916 
• • • •••

In other cases, permission to use a particular library in non-free programs enables a 
greater number of people to use a large body of free software. For example, permission 
to use the GNU C Library in non-free programs enables many more people to use the 
whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it 
does ensure that the user of a program that is linked with the Library has the freedom 
and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay 
close attention to the difference between a "work based on the library" and a "work that 
uses the library". The former contains code derived from the library, whereas the latter 
must be combined with the library in order to run.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which 
contains a notice placed by the copyright holder or other authorized party saying it may 
be distributed under the terms of this Lesser General Public License (also called "this 
License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be 
conveniently linked with application programs (which use some of those functions and 
data) to form executables.

The "Library", below, refers to any such software library or work which has been 
distributed under these terms. A "work based on the Library" means either the Library 
or any derivative work under copyright law: that is to say, a work containing the Library 
or a portion of it, either verbatim or with modifications and/or translated 
straightforwardly into another language. (Hereinafter, translation is included without 
limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications 
to it. For a library, complete source code means all the source code for all modules it 
contains, plus any associated interface definition files, plus the scripts used to control 
compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this 
License; they are outside its scope. The act of running a program using the Library is 
not restricted, and output from such a program is covered only if its contents constitute 
a work based on the Library (independent of the use of the Library in a tool for writing 
it). Whether that is true depends on what the Library does and what the program that 
uses the Library does.
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1. You may copy and distribute verbatim copies of the Library's complete source code 
as you receive it, in any medium, provided that you conspicuously and appropriately 
publish on each copy an appropriate copyright notice and disclaimer of warranty; keep 
intact all the notices that refer to this License and to the absence of any warranty; and 
distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your 
option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming 
a work based on the Library, and copy and distribute such modifications or work under 
the terms of Section 1 above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you 
changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third 
parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be 
supplied by an application program that uses the facility, other than as an argument 
passed when the facility is invoked, then you must make a good faith effort to 
ensure that, in the event an application does not supply such function or table, the 
facility still operates, and performs whatever part of its purpose remains 
meaningful.

(For example, a function in a library to compute square roots has a purpose that is 
entirely well-defined independent of the application. Therefore, Subsection 2d requires 
that any application-supplied function or table used by this function must be optional: if 
the application does not supply it, the square root function must still compute square 
roots.)

These requirements apply to the modified work as a whole. If identifiable sections of 
that work are not derived from the Library, and can be reasonably considered 
independent and separate works in themselves, then this License, and its terms, do not 
apply to those sections when you distribute them as separate works. But when you 
distribute the same sections as part of a whole which is a work based on the Library, 
the distribution of the whole must be on the terms of this License, whose permissions 
for other licensees extend to the entire whole, and thus to each and every part 
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work 
written entirely by you; rather, the intent is to exercise the right to control the distribution 
of derivative or collective works based on the Library.
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In addition, mere aggregation of another work not based on the Library with the Library 
(or with a work based on the Library) on a volume of a storage or distribution medium 
does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead 
of this License to a given copy of the Library. To do this, you must alter all the notices 
that refer to this License, so that they refer to the ordinary GNU General Public License, 
version 2, instead of to this License. (If a newer version than version 2 of the ordinary 
GNU General Public License has appeared, then you can specify that version instead 
if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary 
GNU General Public License applies to all subsequent copies and derivative works 
made from that copy.

This option is useful when you wish to copy part of the code of the Library into a 
program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 
2) in object code or executable form under the terms of Sections 1 and 2 above 
provided that you accompany it with the complete corresponding machine-readable 
source code, which must be distributed under the terms of Sections 1 and 2 above on 
a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place 
satisfies the requirement to distribute the source code, even though third parties are 
not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed 
to work with the Library by being compiled or linked with it, is called a "work that uses 
the Library". Such a work, in isolation, is not a derivative work of the Library, and 
therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable 
that is a derivative of the Library (because it contains portions of the Library), rather 
than a "work that uses the library". The executable is therefore covered by this License. 
Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the 
Library, the object code for the work may be a derivative work of the Library even 
though the source code is not. Whether this is true is especially significant if the work 
can be linked without the Library, or if the work is itself a library. The threshold for this 
to be true is not precisely defined by law.
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If such an object file uses only numerical parameters, data structure layouts and 
accessors, and small macros and small inline functions (ten lines or less in length), then 
the use of the object file is unrestricted, regardless of whether it is legally a derivative 
work. (Executables containing this object code plus portions of the Library will still fall 
under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code 
for the work under the terms of Section 6. Any executables containing that work also 
fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that 
uses the Library" with the Library to produce a work containing portions of the Library, 
and distribute that work under terms of your choice, provided that the terms permit 
modification of the work for the customer's own use and reverse engineering for 
debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it 
and that the Library and its use are covered by this License. You must supply a copy of 
this License. If the work during execution displays copyright notices, you must include 
the copyright notice for the Library among them, as well as a reference directing the 
user to the copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable 
source code for the Library including whatever changes were used in the work 
(which must be distributed under Sections 1 and 2 above); and, if the work is an 
executable linked with the Library, with the complete machine-readable "work that 
uses the Library", as object code and/or source code, so that the user can modify 
the Library and then relink to produce a modified executable containing the 
modified Library. (It is understood that the user who changes the contents of 
definitions files in the Library will not necessarily be able to recompile the 
application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable 
mechanism is one that (1) uses at run time a copy of the library already present on 
the user's computer system, rather than copying library functions into the 
executable, and (2) will operate properly with a modified version of the library, if the 
user installs one, as long as the modified version is interface-compatible with the 
version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the 
same user the materials specified in Subsection 6a, above, for a charge no more 
than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated 
place, offer equivalent access to copy the above specified materials from the same 
place.
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e) Verify that the user has already received a copy of these materials or that you 
have already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include 
any data and utility programs needed for reproducing the executable from it. However, 
as a special exception, the materials to be distributed need not include anything that is 
normally distributed (in either source or binary form) with the major components 
(compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other 
proprietary libraries that do not normally accompany the operating system. Such a 
contradiction means you cannot use both them and the Library together in an 
executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in 
a single library together with other library facilities not covered by this License, and 
distribute such a combined library, provided that the separate distribution of the work 
based on the Library and of the other library facilities is otherwise permitted, and 
provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the 
Library, uncombined with any other library facilities. This must be distributed under 
the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work 
based on the Library, and explaining where to find the accompanying uncombined 
form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as 
expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense, link with, or distribute the Library is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or rights, 
from you under this License will not have their licenses terminated so long as such 
parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, 
nothing else grants you permission to modify or distribute the Library or its derivative 
works. These actions are prohibited by law if you do not accept this License. Therefore, 
by modifying or distributing the Library (or any work based on the Library), you indicate 
your acceptance of this License to do so, and all its terms and conditions for copying, 
distributing or modifying the Library or works based on it.
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10. Each time you redistribute the Library (or any work based on the Library), the 
recipient automatically receives a license from the original licensor to copy, distribute, 
link with or modify the Library subject to these terms and conditions. You may not 
impose any further restrictions on the recipients' exercise of the rights granted herein. 
You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for 
any other reason (not limited to patent issues), conditions are imposed on you (whether 
by court order, agreement or otherwise) that contradict the conditions of this License, 
they do not excuse you from the conditions of this License. If you cannot distribute so 
as to satisfy simultaneously your obligations under this License and any other pertinent 
obligations, then as a consequence you may not distribute the Library at all. For 
example, if a patent license would not permit royalty-free redistribution of the Library by 
all those who receive copies directly or indirectly through you, then the only way you 
could satisfy both it and this License would be to refrain entirely from distribution of the 
Library.

If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply, and the section as a 
whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other 
property right claims or to contest validity of any such claims; this section has the sole 
purpose of protecting the integrity of the free software distribution system which is 
implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance 
on consistent application of that system; it is up to the author/donor to decide if he or 
she is willing to distribute software through any other system and a licensee cannot 
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence 
of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by 
patents or by copyrighted interfaces, the original copyright holder who places the 
Library under this License may add an explicit geographical distribution limitation 
excluding those countries, so that distribution is permitted only in or among countries 
not thus excluded. In such case, this License incorporates the limitation as if written in 
the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the 
Lesser General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or 
concerns.
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Each version is given a distinguishing version number. If the Library specifies a version 
number of this License which applies to it and "any later version", you have the option 
of following the terms and conditions either of that version or of any later version 
published by the Free Software Foundation. If the Library does not specify a license 
version number, you may choose any version ever published by the Free Software 
Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose 
distribution conditions are incompatible with these, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, write 
to the Free Software Foundation; we sometimes make exceptions for this. Our decision 
will be guided by the two goals of preserving the free status of all derivatives of our free 
software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE 
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT 
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF 
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY 
YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH 
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the 
public, we recommend making it free software that everyone can redistribute and 
change. You can do so by permitting redistribution under these terms (or, alternatively, 
under the terms of the ordinary General Public License).
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To apply these terms, attach the following notices to the library. It is safest to attach 
them to the start of each source file to most effectively convey the exclusion of 
warranty; and each file should have at least the "copyright" line and a pointer to where 
the full notice is found.

one line to give the library's name and an idea of what it does.
Copyright (C) year name of author

This library is free software; you can redistribute it and/or modify it under the terms of 
the GNU Lesser General Public License as published by the Free Software 
Foundation; either version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS 
FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for 
more details. 

You should have received a copy of the GNU Lesser General Public License along with 
this library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth 
Floor, Boston, MA  02110-1301  USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, 
to sign a "copyright disclaimer" for the library, if necessary. Here is a sample; alter the 
names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for 
tweaking knobs) written by James Random Hacker.

signature of Ty Coon, 1 April 1990

Ty Coon, President of Vice
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Python
The Python Software Foundation License (PSFL) is a BSD-style, permissive 
free software license which is compatible with the GNU General Public License 
(GPL).

License
1. This LICENSE AGREEMENT is between the Python Software Foundation ("PSF"), 
and the Individual or Organization ("Licensee") accessing and otherwise using Python 
3.7.4 software in source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, PSF hereby grants 
Licensee a nonexclusive, royalty-free, world-wide license to reproduce, analyze, test, 
perform and/or display publicly, prepare derivative works, distribute, and otherwise use 
Python 3.7.4 alone or in any derivative version, provided, however, that PSF's License 
Agreement and PSF's notice of copyright, i.e., "Copyright © 2001-2019 Python 
Software Foundation; All Rights Reserved" are retained in Python 3.7.4 alone or in any 
derivative version prepared by Licensee. 

3. In the event Licensee prepares a derivative work that is based on or incorporates 
Python 3.7.4 or any part thereof, and wants to make the derivative work available to 
others as provided herein, then Licensee hereby agrees to include in any such work a 
brief summary of the changes made to Python 3.7.4.

4. PSF is making Python 3.7.4 available to Licensee on an "AS IS" basis. PSF MAKES 
NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED BY WAY OF 
EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND DISCLAIMS ANY 
REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS FOR 
ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON 3.7.4 WILL NOT 
INFRINGE ANY THIRD PARTY RIGHTS.

5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF 
PYTHON 3.7.4 FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL 
DAMAGES OR LOSS AS A RESULT OF MODIFYING, DISTRIBUTING, OR 
OTHERWISE USING PYTHON 3.7.4, OR ANY DERIVATIVE THEREOF, EVEN IF 
ADVISED OF THE POSSIBILITY THEREOF.

6. This License Agreement will automatically terminate upon a material breach of its 
terms and conditions.

7. Nothing in this License Agreement shall be deemed to create any relationship of 
agency, partnership, or joint venture between PSF and Licensee. This License 
Agreement does not grant permission to use PSF trademarks or trade name in a   
trademark sense to endorse or promote products or services of Licensee, or any third 
party.
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8. By copying, installing or otherwise using Python 3.7.4, Licensee agrees to be bound 
by the terms and conditions of this License Agreement.

Qt
Qt is available under the GNU Lesser General Public License version 3.

The Qt Toolkit is Copyright (C) 2018 The Qt Company Ltd. and other contributors.

Contact: https://www.qt.io/licensing/

License
GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. http://fsf.org/

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and 
conditions of version 3 of the GNU General Public License, supplemented by the 
additional permissions listed below.

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public 
License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an 
Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but 
which is not otherwise based on the Library. Defining a subclass of a class defined by 
the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the 
Library.  The particular version of the Library with which the Combined Work was made 
is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding 
Source for the Combined Work, excluding any source code for portions of the 
Combined Work that, considered in isolation, are based on the Application, and not on 
the Linked Version.

https://www.qt.io/licensing/
http://fsf.org/
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The "Corresponding Application Code" for a Combined Work means the object code 
and/or source code for the Application, including any data and utility programs needed 
for reproducing the Combined Work from the Application, but excluding the System 
Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being 
bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a 
function or data to be supplied by an Application that uses the facility (other than as an 
argument passed when the facility is invoked), then you may convey a copy of the 
modified version:

a) under this License, provided that you make a good faith effort to ensure that, in the 
event an Application does not supply the function or data, the facility still operates, and 
performs whatever part of its purpose remains meaningful, or

b) under the GNU GPL, with none of the additional permissions of this License 
applicable to that copy.

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that 
is part of the Library.  You may convey such object code under terms of your choice, 
provided that, if the incorporated material is not limited to numerical parameters, data 
structure layouts and accessors, or small macros, inline functions and templates (ten 
or fewer lines in length), you do both of the following:

a) Give prominent notice with each copy of the object code that the Library is used in it 
and that the Library and its use are covered by this License.

b) Accompany the object code with a copy of the GNU GPL and this license document.

4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, 
effectively do not restrict modification of the portions of the Library contained in the 
Combined Work and reverse engineering for debugging such modifications, if you also 
do each of the following:

a) Give prominent notice with each copy of the Combined Work that the Library is used 
in it and that the Library and its use are covered by this License.

b) Accompany the Combined Work with a copy of the GNU GPL and this license 
document.
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c) For a Combined Work that displays copyright notices during execution, include the 
copyright notice for the Library among these notices, as well as a reference directing 
the user to the copies of the GNU GPL and this license document.

d) Do one of the following:

0) Convey the Minimal Corresponding Source under the terms of this License, and the 
Corresponding Application Code in a form suitable for, and under terms that permit, the 
user to recombine or relink the Application with a modified version of the Linked Version 
to produce a modified Combined Work, in the manner specified by section 6 of the GNU 
GPL for conveying Corresponding Source.

1) Use a suitable shared library mechanism for linking with the Library. A suitable 
mechanism is one that (a) uses at run time a copy of the Library already present on the 
user's computer system, and (b) will operate properly with a modified version of the 
Library that is interface-compatible with the Linked Version.

e) Provide Installation Information, but only if you would otherwise be required to 
provide such information under section 6 of the GNU GPL, and only to the extent that 
such information is necessary to install and execute a modified version of the 
Combined Work produced by recombining or relinking the Application with a modified 
version of the Linked Version. (If you use option 4d0, the Installation Information must 
accompany the Minimal Corresponding Source and Corresponding Application Code. 
If you use option 4d1, you must provide the Installation Information in the manner 
specified by section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a 
single library together with other library facilities that are not Applications and are not 
covered by this License, and convey such a combined library under terms of your 
choice, if you do both of the following: 

a) Accompany the combined library with a copy of the same work based on the Library, 
uncombined with any other library facilities, conveyed under the terms of this License.

b) Give prominent notice with the combined library that part of it is a work based on the 
Library, and explaining where to find the accompanying uncombined form of the same 
work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU 
Lesser General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or 
concerns.
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Each version is given a distinguishing version number. If the Library as you received it 
specifies that a certain numbered version of the GNU Lesser General Public License 
"or any later version" applies to it, you have the option of following the terms and 
conditions either of that published version or of any later version published by the Free 
Software Foundation. If the Library as you received it does not specify a version 
number of the GNU Lesser General Public License, you may choose any version of the 
GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future 
versions of the GNU Lesser General Public License shall apply, that proxy's public 
statement of acceptance of any version is permanent authorization for you to choose 
that version for the Library.

Shiboken2
Shiboken uses Lesser General Public License (LGPL) version 2.1.

License
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 

51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA

Everyone is permitted to copy and distribute verbatim copies of this license document, 
but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of 
the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and 
change it. By contrast, the GNU General Public Licenses are intended to guarantee 
your freedom to share and change free software--to make sure the software is free for 
all its users.

This license, the Lesser General Public License, applies to some specially designated 
software packages--typically libraries--of the Free Software Foundation and other 
authors who decide to use it. You can use it too, but we suggest you first think carefully 
about whether this license or the ordinary General Public License is the better strategy 
to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our 
General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you wish); that you 
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receive source code or can get it if you want it; that you can change the software and 
use pieces of it in new free programs; and that you are informed that you can do these 
things.

To protect your rights, we need to make restrictions that forbid distributors to deny you 
these rights or to ask you to surrender these rights. These restrictions translate to 
certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must 
give the recipients all the rights that we gave you. You must make sure that they, too, 
receive or can get the source code. If you link other code with the library, you must 
provide complete object files to the recipients, so that they can relink them with the 
library after making changes to the library and recompiling it. And you must show them 
these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we 
offer you this license, which gives you legal permission to copy, distribute and/or modify 
the library.

To protect each distributor, we want to make it very clear that there is no warranty for 
the free library. Also, if the library is modified by someone else and passed on, the 
recipients should know that what they have is not the original version, so that the 
original author's reputation will not be affected by problems that might be introduced by 
others.

Finally, software patents pose a constant threat to the existence of any free program. 
We wish to make sure that a company cannot effectively restrict the users of a free 
program by obtaining a restrictive license from a patent holder. Therefore, we insist that 
any patent license obtained for a version of the library must be consistent with the full 
freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General 
Public License. This license, the GNU Lesser General Public License, applies to 
certain designated libraries, and is quite different from the ordinary General Public 
License. We use this license for certain libraries in order to permit linking those libraries 
into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the 
combination of the two is legally speaking a combined work, a derivative of the original 
library. The ordinary General Public License therefore permits such linking only if the 
entire combination fits its criteria of freedom. The Lesser General Public License 
permits more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to 
protect the user's freedom than the ordinary General Public License. It also provides 
other free software developers Less of an advantage over competing non-free 
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programs. These disadvantages are the reason we use the ordinary General Public 
License for many libraries. However, the Lesser license provides advantages in certain 
special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest 
possible use of a certain library, so that it becomes a de-facto standard. To achieve this, 
non-free programs must be allowed to use the library. A more frequent case is that a 
free library does the same job as widely used non-free libraries. In this case, there is 
little to gain by limiting the free library to free software only, so we use the Lesser 
General Public License.

In other cases, permission to use a particular library in non-free programs enables a 
greater number of people to use a large body of free software. For example, permission 
to use the GNU C Library in non-free programs enables many more people to use the 
whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it 
does ensure that the user of a program that is linked with the Library has the freedom 
and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay 
close attention to the difference between a "work based on the library" and a "work that 
uses the library". The former contains code derived from the library, whereas the latter 
must be combined with the library in order to run.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which 
contains a notice placed by the copyright holder or other authorized party saying it may 
be distributed under the terms of this Lesser General Public License (also called "this 
License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be 
conveniently linked with application programs (which use some of those functions and 
data) to form executables.

The "Library", below, refers to any such software library or work which has been 
distributed under these terms. A "work based on the Library" means either the Library 
or any derivative work under copyright law: that is to say, a work containing the Library 
or a portion of it, either verbatim or with modifications and/or translated 
straightforwardly into another language. (Hereinafter, translation is included without 
limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications 
to it. For a library, complete source code means all the source code for all modules it 
contains, plus any associated interface definition files, plus the scripts used to control 
compilation and installation of the library.
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Activities other than copying, distribution and modification are not covered by this 
License; they are outside its scope. The act of running a program using the Library is 
not restricted, and output from such a program is covered only if its contents constitute 
a work based on the Library (independent of the use of the Library in a tool for writing 
it). Whether that is true depends on what the Library does and what the program that 
uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code 
as you receive it, in any medium, provided that you conspicuously and appropriately 
publish on each copy an appropriate copyright notice and disclaimer of warranty; keep 
intact all the notices that refer to this License and to the absence of any warranty; and 
distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your 
option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming 
a work based on the Library, and copy and distribute such modifications or work under 
the terms of Section 1 above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you 
changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third 
parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be 
supplied by an application program that uses the facility, other than as an argument 
passed when the facility is invoked, then you must make a good faith effort to 
ensure that, in the event an application does not supply such function or table, the 
facility still operates, and performs whatever part of its purpose remains 
meaningful.

(For example, a function in a library to compute square roots has a purpose that is 
entirely well-defined independent of the application. Therefore, Subsection 2d requires 
that any application-supplied function or table used by this function must be optional: if 
the application does not supply it, the square root function must still compute square 
roots.)

These requirements apply to the modified work as a whole. If identifiable sections of 
that work are not derived from the Library, and can be reasonably considered 
independent and separate works in themselves, then this License, and its terms, do not 
apply to those sections when you distribute them as separate works. But when you 
distribute the same sections as part of a whole which is a work based on the Library, 
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the distribution of the whole must be on the terms of this License, whose permissions 
for other licensees extend to the entire whole, and thus to each and every part 
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work 
written entirely by you; rather, the intent is to exercise the right to control the distribution 
of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library 
(or with a work based on the Library) on a volume of a storage or distribution medium 
does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead 
of this License to a given copy of the Library. To do this, you must alter all the notices 
that refer to this License, so that they refer to the ordinary GNU General Public License, 
version 2, instead of to this License. (If a newer version than version 2 of the ordinary 
GNU General Public License has appeared, then you can specify that version instead 
if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary 
GNU General Public License applies to all subsequent copies and derivative works 
made from that copy.

This option is useful when you wish to copy part of the code of the Library into a 
program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 
2) in object code or executable form under the terms of Sections 1 and 2 above 
provided that you accompany it with the complete corresponding machine-readable 
source code, which must be distributed under the terms of Sections 1 and 2 above on 
a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place 
satisfies the requirement to distribute the source code, even though third parties are 
not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed 
to work with the Library by being compiled or linked with it, is called a "work that uses 
the Library". Such a work, in isolation, is not a derivative work of the Library, and 
therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable 
that is a derivative of the Library (because it contains portions of the Library), rather 
than a "work that uses the library". The executable is therefore covered by this License. 
Section 6 states terms for distribution of such executables.
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When a "work that uses the Library" uses material from a header file that is part of the 
Library, the object code for the work may be a derivative work of the Library even 
though the source code is not. Whether this is true is especially significant if the work 
can be linked without the Library, or if the work is itself a library. The threshold for this 
to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and 
accessors, and small macros and small inline functions (ten lines or less in length), then 
the use of the object file is unrestricted, regardless of whether it is legally a derivative 
work. (Executables containing this object code plus portions of the Library will still fall 
under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code 
for the work under the terms of Section 6. Any executables containing that work also 
fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that 
uses the Library" with the Library to produce a work containing portions of the Library, 
and distribute that work under terms of your choice, provided that the terms permit 
modification of the work for the customer's own use and reverse engineering for 
debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it 
and that the Library and its use are covered by this License. You must supply a copy of 
this License. If the work during execution displays copyright notices, you must include 
the copyright notice for the Library among them, as well as a reference directing the 
user to the copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable 
source code for the Library including whatever changes were used in the work 
(which must be distributed under Sections 1 and 2 above); and, if the work is an 
executable linked with the Library, with the complete machine-readable "work that 
uses the Library", as object code and/or source code, so that the user can modify 
the Library and then relink to produce a modified executable containing the 
modified Library. (It is understood that the user who changes the contents of 
definitions files in the Library will not necessarily be able to recompile the 
application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable 
mechanism is one that (1) uses at run time a copy of the library already present on 
the user's computer system, rather than copying library functions into the 
executable, and (2) will operate properly with a modified version of the library, if the 
user installs one, as long as the modified version is interface-compatible with the 
version that the work was made with.
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c) Accompany the work with a written offer, valid for at least three years, to give the 
same user the materials specified in Subsection 6a, above, for a charge no more 
than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated 
place, offer equivalent access to copy the above specified materials from the same 
place.

e) Verify that the user has already received a copy of these materials or that you 
have already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include 
any data and utility programs needed for reproducing the executable from it. However, 
as a special exception, the materials to be distributed need not include anything that is 
normally distributed (in either source or binary form) with the major components 
(compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other 
proprietary libraries that do not normally accompany the operating system. Such a 
contradiction means you cannot use both them and the Library together in an 
executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in 
a single library together with other library facilities not covered by this License, and 
distribute such a combined library, provided that the separate distribution of the work 
based on the Library and of the other library facilities is otherwise permitted, and 
provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the 
Library, uncombined with any other library facilities. This must be distributed under 
the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work 
based on the Library, and explaining where to find the accompanying uncombined 
form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as 
expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense, link with, or distribute the Library is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or rights, 
from you under this License will not have their licenses terminated so long as such 
parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, 
nothing else grants you permission to modify or distribute the Library or its derivative 
works. These actions are prohibited by law if you do not accept this License. Therefore, 
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by modifying or distributing the Library (or any work based on the Library), you indicate 
your acceptance of this License to do so, and all its terms and conditions for copying, 
distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the 
recipient automatically receives a license from the original licensor to copy, distribute, 
link with or modify the Library subject to these terms and conditions. You may not 
impose any further restrictions on the recipients' exercise of the rights granted herein. 
You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for 
any other reason (not limited to patent issues), conditions are imposed on you (whether 
by court order, agreement or otherwise) that contradict the conditions of this License, 
they do not excuse you from the conditions of this License. If you cannot distribute so 
as to satisfy simultaneously your obligations under this License and any other pertinent 
obligations, then as a consequence you may not distribute the Library at all. For 
example, if a patent license would not permit royalty-free redistribution of the Library by 
all those who receive copies directly or indirectly through you, then the only way you 
could satisfy both it and this License would be to refrain entirely from distribution of the 
Library.

If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply, and the section as a 
whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other 
property right claims or to contest validity of any such claims; this section has the sole 
purpose of protecting the integrity of the free software distribution system which is 
implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance 
on consistent application of that system; it is up to the author/donor to decide if he or 
she is willing to distribute software through any other system and a licensee cannot 
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence 
of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by 
patents or by copyrighted interfaces, the original copyright holder who places the 
Library under this License may add an explicit geographical distribution limitation 
excluding those countries, so that distribution is permitted only in or among countries 
not thus excluded. In such case, this License incorporates the limitation as if written in 
the body of this License.
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13. The Free Software Foundation may publish revised and/or new versions of the 
Lesser General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or 
concerns.

Each version is given a distinguishing version number. If the Library specifies a version 
number of this License which applies to it and "any later version", you have the option 
of following the terms and conditions either of that version or of any later version 
published by the Free Software Foundation. If the Library does not specify a license 
version number, you may choose any version ever published by the Free Software 
Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose 
distribution conditions are incompatible with these, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, write 
to the Free Software Foundation; we sometimes make exceptions for this. Our decision 
will be guided by the two goals of preserving the free status of all derivatives of our free 
software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE 
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT 
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF 
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY 
YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH 
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries
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If you develop a new library, and you want it to be of the greatest possible use to the 
public, we recommend making it free software that everyone can redistribute and 
change. You can do so by permitting redistribution under these terms (or, alternatively, 
under the terms of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach 
them to the start of each source file to most effectively convey the exclusion of 
warranty; and each file should have at least the "copyright" line and a pointer to where 
the full notice is found.

one line to give the library's name and an idea of what it does.
Copyright (C) year name of author

This library is free software; you can redistribute it and/or modify it under the terms of 
the GNU Lesser General Public License as published by the Free Software 
Foundation; either version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS 
FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for 
more details. 

You should have received a copy of the GNU Lesser General Public License along with 
this library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth 
Floor, Boston, MA  02110-1301  USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, 
to sign a "copyright disclaimer" for the library, if necessary. Here is a sample; alter the 
names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for 
tweaking knobs) written by James Random Hacker.

signature of Ty Coon, 1 April 1990

Ty Coon, President of Vice

xmlio
The xmlio library uses Lesser General Public License (LGPL) version 2 or 
newer.

License
GNU LESSER GENERAL PUBLIC LICENSE
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Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 

51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA

Everyone is permitted to copy and distribute verbatim copies of this license document, 
but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of 
the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and 
change it. By contrast, the GNU General Public Licenses are intended to guarantee 
your freedom to share and change free software--to make sure the software is free for 
all its users.

This license, the Lesser General Public License, applies to some specially designated 
software packages--typically libraries--of the Free Software Foundation and other 
authors who decide to use it. You can use it too, but we suggest you first think carefully 
about whether this license or the ordinary General Public License is the better strategy 
to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our 
General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you wish); that you 
receive source code or can get it if you want it; that you can change the software and 
use pieces of it in new free programs; and that you are informed that you can do these 
things.

To protect your rights, we need to make restrictions that forbid distributors to deny you 
these rights or to ask you to surrender these rights. These restrictions translate to 
certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must 
give the recipients all the rights that we gave you. You must make sure that they, too, 
receive or can get the source code. If you link other code with the library, you must 
provide complete object files to the recipients, so that they can relink them with the 
library after making changes to the library and recompiling it. And you must show them 
these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we 
offer you this license, which gives you legal permission to copy, distribute and/or modify 
the library.
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To protect each distributor, we want to make it very clear that there is no warranty for 
the free library. Also, if the library is modified by someone else and passed on, the 
recipients should know that what they have is not the original version, so that the 
original author's reputation will not be affected by problems that might be introduced by 
others.

Finally, software patents pose a constant threat to the existence of any free program. 
We wish to make sure that a company cannot effectively restrict the users of a free 
program by obtaining a restrictive license from a patent holder. Therefore, we insist that 
any patent license obtained for a version of the library must be consistent with the full 
freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General 
Public License. This license, the GNU Lesser General Public License, applies to 
certain designated libraries, and is quite different from the ordinary General Public 
License. We use this license for certain libraries in order to permit linking those libraries 
into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the 
combination of the two is legally speaking a combined work, a derivative of the original 
library. The ordinary General Public License therefore permits such linking only if the 
entire combination fits its criteria of freedom. The Lesser General Public License 
permits more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to 
protect the user's freedom than the ordinary General Public License. It also provides 
other free software developers Less of an advantage over competing non-free 
programs. These disadvantages are the reason we use the ordinary General Public 
License for many libraries. However, the Lesser license provides advantages in certain 
special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest 
possible use of a certain library, so that it becomes a de-facto standard. To achieve this, 
non-free programs must be allowed to use the library. A more frequent case is that a 
free library does the same job as widely used non-free libraries. In this case, there is 
little to gain by limiting the free library to free software only, so we use the Lesser 
General Public License.

In other cases, permission to use a particular library in non-free programs enables a 
greater number of people to use a large body of free software. For example, permission 
to use the GNU C Library in non-free programs enables many more people to use the 
whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it 
does ensure that the user of a program that is linked with the Library has the freedom 
and the wherewithal to run that program using a modified version of the Library.
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The precise terms and conditions for copying, distribution and modification follow. Pay 
close attention to the difference between a "work based on the library" and a "work that 
uses the library". The former contains code derived from the library, whereas the latter 
must be combined with the library in order to run.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which 
contains a notice placed by the copyright holder or other authorized party saying it may 
be distributed under the terms of this Lesser General Public License (also called "this 
License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be 
conveniently linked with application programs (which use some of those functions and 
data) to form executables.

The "Library", below, refers to any such software library or work which has been 
distributed under these terms. A "work based on the Library" means either the Library 
or any derivative work under copyright law: that is to say, a work containing the Library 
or a portion of it, either verbatim or with modifications and/or translated 
straightforwardly into another language. (Hereinafter, translation is included without 
limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications 
to it. For a library, complete source code means all the source code for all modules it 
contains, plus any associated interface definition files, plus the scripts used to control 
compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this 
License; they are outside its scope. The act of running a program using the Library is 
not restricted, and output from such a program is covered only if its contents constitute 
a work based on the Library (independent of the use of the Library in a tool for writing 
it). Whether that is true depends on what the Library does and what the program that 
uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code 
as you receive it, in any medium, provided that you conspicuously and appropriately 
publish on each copy an appropriate copyright notice and disclaimer of warranty; keep 
intact all the notices that refer to this License and to the absence of any warranty; and 
distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your 
option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming 
a work based on the Library, and copy and distribute such modifications or work under 
the terms of Section 1 above, provided that you also meet all of these conditions:



Silhouette User Guide    

• • • •••

Appendix H - Licenses Used by Silhouette  941 
• • • •••

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you 
changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third 
parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be 
supplied by an application program that uses the facility, other than as an argument 
passed when the facility is invoked, then you must make a good faith effort to 
ensure that, in the event an application does not supply such function or table, the 
facility still operates, and performs whatever part of its purpose remains 
meaningful.

(For example, a function in a library to compute square roots has a purpose that is 
entirely well-defined independent of the application. Therefore, Subsection 2d requires 
that any application-supplied function or table used by this function must be optional: if 
the application does not supply it, the square root function must still compute square 
roots.)

These requirements apply to the modified work as a whole. If identifiable sections of 
that work are not derived from the Library, and can be reasonably considered 
independent and separate works in themselves, then this License, and its terms, do not 
apply to those sections when you distribute them as separate works. But when you 
distribute the same sections as part of a whole which is a work based on the Library, 
the distribution of the whole must be on the terms of this License, whose permissions 
for other licensees extend to the entire whole, and thus to each and every part 
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work 
written entirely by you; rather, the intent is to exercise the right to control the distribution 
of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library 
(or with a work based on the Library) on a volume of a storage or distribution medium 
does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead 
of this License to a given copy of the Library. To do this, you must alter all the notices 
that refer to this License, so that they refer to the ordinary GNU General Public License, 
version 2, instead of to this License. (If a newer version than version 2 of the ordinary 
GNU General Public License has appeared, then you can specify that version instead 
if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary 
GNU General Public License applies to all subsequent copies and derivative works 
made from that copy.



Silhouette User Guide    

• • • •••

Appendix H - Licenses Used by Silhouette  942 
• • • •••

This option is useful when you wish to copy part of the code of the Library into a 
program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 
2) in object code or executable form under the terms of Sections 1 and 2 above 
provided that you accompany it with the complete corresponding machine-readable 
source code, which must be distributed under the terms of Sections 1 and 2 above on 
a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place 
satisfies the requirement to distribute the source code, even though third parties are 
not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed 
to work with the Library by being compiled or linked with it, is called a "work that uses 
the Library". Such a work, in isolation, is not a derivative work of the Library, and 
therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable 
that is a derivative of the Library (because it contains portions of the Library), rather 
than a "work that uses the library". The executable is therefore covered by this License. 
Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the 
Library, the object code for the work may be a derivative work of the Library even 
though the source code is not. Whether this is true is especially significant if the work 
can be linked without the Library, or if the work is itself a library. The threshold for this 
to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and 
accessors, and small macros and small inline functions (ten lines or less in length), then 
the use of the object file is unrestricted, regardless of whether it is legally a derivative 
work. (Executables containing this object code plus portions of the Library will still fall 
under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code 
for the work under the terms of Section 6. Any executables containing that work also 
fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that 
uses the Library" with the Library to produce a work containing portions of the Library, 
and distribute that work under terms of your choice, provided that the terms permit 
modification of the work for the customer's own use and reverse engineering for 
debugging such modifications.
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You must give prominent notice with each copy of the work that the Library is used in it 
and that the Library and its use are covered by this License. You must supply a copy of 
this License. If the work during execution displays copyright notices, you must include 
the copyright notice for the Library among them, as well as a reference directing the 
user to the copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable 
source code for the Library including whatever changes were used in the work 
(which must be distributed under Sections 1 and 2 above); and, if the work is an 
executable linked with the Library, with the complete machine-readable "work that 
uses the Library", as object code and/or source code, so that the user can modify 
the Library and then relink to produce a modified executable containing the 
modified Library. (It is understood that the user who changes the contents of 
definitions files in the Library will not necessarily be able to recompile the 
application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable 
mechanism is one that (1) uses at run time a copy of the library already present on 
the user's computer system, rather than copying library functions into the 
executable, and (2) will operate properly with a modified version of the library, if the 
user installs one, as long as the modified version is interface-compatible with the 
version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the 
same user the materials specified in Subsection 6a, above, for a charge no more 
than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated 
place, offer equivalent access to copy the above specified materials from the same 
place.

e) Verify that the user has already received a copy of these materials or that you 
have already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include 
any data and utility programs needed for reproducing the executable from it. However, 
as a special exception, the materials to be distributed need not include anything that is 
normally distributed (in either source or binary form) with the major components 
(compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other 
proprietary libraries that do not normally accompany the operating system. Such a 
contradiction means you cannot use both them and the Library together in an 
executable that you distribute.
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7. You may place library facilities that are a work based on the Library side-by-side in 
a single library together with other library facilities not covered by this License, and 
distribute such a combined library, provided that the separate distribution of the work 
based on the Library and of the other library facilities is otherwise permitted, and 
provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the 
Library, uncombined with any other library facilities. This must be distributed under 
the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work 
based on the Library, and explaining where to find the accompanying uncombined 
form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as 
expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense, link with, or distribute the Library is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or rights, 
from you under this License will not have their licenses terminated so long as such 
parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, 
nothing else grants you permission to modify or distribute the Library or its derivative 
works. These actions are prohibited by law if you do not accept this License. Therefore, 
by modifying or distributing the Library (or any work based on the Library), you indicate 
your acceptance of this License to do so, and all its terms and conditions for copying, 
distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the 
recipient automatically receives a license from the original licensor to copy, distribute, 
link with or modify the Library subject to these terms and conditions. You may not 
impose any further restrictions on the recipients' exercise of the rights granted herein. 
You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for 
any other reason (not limited to patent issues), conditions are imposed on you (whether 
by court order, agreement or otherwise) that contradict the conditions of this License, 
they do not excuse you from the conditions of this License. If you cannot distribute so 
as to satisfy simultaneously your obligations under this License and any other pertinent 
obligations, then as a consequence you may not distribute the Library at all. For 
example, if a patent license would not permit royalty-free redistribution of the Library by 
all those who receive copies directly or indirectly through you, then the only way you 
could satisfy both it and this License would be to refrain entirely from distribution of the 
Library.
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If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply, and the section as a 
whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other 
property right claims or to contest validity of any such claims; this section has the sole 
purpose of protecting the integrity of the free software distribution system which is 
implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance 
on consistent application of that system; it is up to the author/donor to decide if he or 
she is willing to distribute software through any other system and a licensee cannot 
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence 
of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by 
patents or by copyrighted interfaces, the original copyright holder who places the 
Library under this License may add an explicit geographical distribution limitation 
excluding those countries, so that distribution is permitted only in or among countries 
not thus excluded. In such case, this License incorporates the limitation as if written in 
the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the 
Lesser General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or 
concerns.

Each version is given a distinguishing version number. If the Library specifies a version 
number of this License which applies to it and "any later version", you have the option 
of following the terms and conditions either of that version or of any later version 
published by the Free Software Foundation. If the Library does not specify a license 
version number, you may choose any version ever published by the Free Software 
Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose 
distribution conditions are incompatible with these, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, write 
to the Free Software Foundation; we sometimes make exceptions for this. Our decision 
will be guided by the two goals of preserving the free status of all derivatives of our free 
software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE 
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT 
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HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF 
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY 
YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH 
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the 
public, we recommend making it free software that everyone can redistribute and 
change. You can do so by permitting redistribution under these terms (or, alternatively, 
under the terms of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach 
them to the start of each source file to most effectively convey the exclusion of 
warranty; and each file should have at least the "copyright" line and a pointer to where 
the full notice is found.

one line to give the library's name and an idea of what it does.
Copyright (C) year name of author

This library is free software; you can redistribute it and/or modify it under the terms of 
the GNU Lesser General Public License as published by the Free Software 
Foundation; either version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS 
FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for 
more details. 
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You should have received a copy of the GNU Lesser General Public License along with 
this library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth 
Floor, Boston, MA  02110-1301  USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, 
to sign a "copyright disclaimer" for the library, if necessary. Here is a sample; alter the 
names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for 
tweaking knobs) written by James Random Hacker.

signature of Ty Coon, 1 April 1990

Ty Coon, President of Vice
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